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About the Report Designer 1

The Report Designer feature can be purchased with the Lucent CentreVu 
Supervisor software. The Report Designer allows you to create reports that 
are tailored to your call center needs. The reports you create using the 
Report Designer can be run from the Supervisor application.

The Report Designer allows you to create reports from scratch, edit standard 
CMS and Supervisor reports, and copy items from one report to another 
report. 

When you are using the Report Designer to edit an existing report or create a 
new one, you will generally begin by creating or modifying an SQL query. 
Using the database items contained in the table(s) referenced in the query, 
you can populate fields, grids, and charts for the report. The fields, grids, 
and charts can then be sized, moved, and changed on the report.

When you are done creating or editing a report, the report is saved on the 
CMS server. If you assigned Global user permissions to the report, other 
Supervisor users with the appropriate permissions can run the report.

When creating real-time, historical, and integrated reports, the Report 
Designer lets you:
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● Copy existing report designs, including standard report designs
● Edit reports by adding, moving, copying, and deleting fields, grids, or 

charts.
● Define ACD data for report fields, grids, and charts
● Enter text for field labels, column headers, row headers, or special 

instructions

For historical reports only, the Report Designer lets you:
● Merge data in a report field to include data from different entities within 

an ACD (for example, defining a field that represents the percentage of 
calls an agent answered compared to all calls handled by that agent's 
split or skill)

● Merge data in a report field to include data with different time frames 
(for example, defining a field that represents the percentage of calls 
answered in an intrahour interval compared to all calls answered in the 
day)

● Include data from custom data tables that you create and populate 
within the CentreVu CMS database.

For integrated reports only, the Report Designer lets you:
● Display real-time and historical data on the same report
● Display cumulative data that shows up-to-the-moment data since a 

specified interval start time in the past 24 hours.

Note If you create custom database tables, as described in Chapter 
17, make sure that you name the tables with the prefix “c_”. If 
you do not use the c_ convention, the custom tables will not 
automatically be backed up.

Caution If you create custom data tables, then you need to make sure 
there is enough disk space available to store the data. CMS 
does not automatically check the available space. If you fill 
up your disk with custom data, then you will lose or damage 
stored custom and ACD data.

See the CentreVu  CMS R3V5 Administration (585-215-820) 
document for more information about disk storage.

Warning

Do not tamper with standard ACD data in the CMS database. 
If you do, then you will lose stored data.
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Contents of This Document 1

This book describes what you need to know to use the Report Designer to 
create new reports and edit existing reports. The book is organized as 
follows:

● Chapter 1, Introduction — gives you background information on the 
Report Designer application and general information about this book.

● Chapter 2, Report Designer Basics — teaches you the basic information 
that you need to know in order to use the Report Designer. The 
procedures included in this chapter are Starting the Report Designer, 
Exiting the Report Designer, Report Designer Menus, Steps Required to 
Create a New Report, and Steps Required to Edit an Existing Report.

● Chapter 3, Using the Report Manager — teaches you the basic 
procedures you need to know in order to use the Report Manager 
feature of Supervisor. The procedures included in this chapter are 
Viewing a Report’s Properties, Copying a Report to the Designer 
Category, Copying a Designer Report to a File, Copying a Designer 
Report from a File, Deleting a Report from the Designer Category, and 
Opening the Report Designer Using the Edit or New Button.

● Chapter 4, Design Mode Basics — teaches you basic procedures that 
you will use in the Report Designer design mode. The procedures 
included in this chapter are Copying an Item and Pasting the Item Into 
the Same Report, Copying an Item from One Report and Pasting the 
Item Into Another Report, Cutting an Item from a Report, Deleting an 
Item from the Report, Using Drag-and-Drop to Arrange Items on the 
Report, Resizing an Item on the Report, and Selecting Multiple Items on 
the Report.

● Chapter 5, Edit | Inputs — shows you how to edit the existing input 
fields that are used on the input window for the report you are editing. 
The procedures included in this chapter are Adding Input Fields to the 
Input Window, Deleting Input Fields from Input Window, Editing the 
Order of Input Fields, Editing the Appearance of Input Fields, and 
Viewing the Input Window.

● Chapter 6, Edit | Queries — shows you how to edit the existing queries 
and create new queries for the report you are editing. The sections 
included in this chapter are Defining Queries for a Report, Creating a 
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New Real-Time or Historical Query, Creating a New Integrated Query, 
Editing an Existing Query, Copying a Query, and Deleting a Query.

● Chapter 7, Insert | Chart — teaches you to insert a chart on a report.

● Chapter 8, Insert | Field — teaches you to insert a field on a report.

● Chapter 9, Insert | Grid — teaches you to insert a grid on a report.

● Chapter 10, Insert | Text — teaches you to insert text on a report.

● Chapter 11, Format | Chart — gives you general information about the 
tabs that you access from the Chart option of the Format menu.

● Chapter 12, Format | Grid — gives you general information about the 
tabs that you access from the Grid option of the Format menu.

● Chapter 13, Format | Field — gives you general information about the 
window that you access from the Format option of the Format menu.

● Chapter 14, Format | Text — gives you general information about the 
window that you access from the Text option of the Format menu.

● Chapter 15, Error Messages — lists the most common errors that you 
will encounter as a result of errors in queries that you create for 
reports.

● Chapter 16, How CentreVu CMS Stores and Retrieves Data — gives 
you general information about how the CMS server stores and 
retrieves the data that is used in the reports.

● Chapter 17, SQL Query Basics and Working with CMS Database 
Tables — gives you general information about how INFORMIX SQL 
queries work and how the INFORMIX tables that are used in CMS are 
structured. If you are not familiar with SQL queries, you need to read 
this chapter before you attempt to create a query for your report.

● Appendix A, CMS Database Items and Calculations — lists all of the 
standard database items and calculations that are used in CMS.
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Conventions Used in This Document 1

The following conventions are used in this book:

● The instructions given in this book are based on the assumption that 
you are familiar with your computer and the Windows operating system, 
including standard window conventions, such as using the F1 key to 
activate Help.

● In order to use this book successfully, you must be familiar with the 
Supervisor application and have some knowledge of how CMS reports 
work.

For instructions on using the Supervisor application, refer to the 
CentreVu Supervisor User’s Guide (585-215-829). For information on CMS 
reports, refer to the CentreVu CMS Reports document (585-215-821).

● Windows 3.x refers to the following operating systems:

— Windows 3.1

— Windows for Workgroups 3.11

— Windows NT 3.51.

● Unless the right button is specified, use the left mouse button whenever 
you are instructed to click or select an item.

● Menu names and option names are shown in bold text. For example: 
Choose Save from the File menu.

● References to windows are capitalized. For example, Manual Login 
window.

● Italics are used to reference other documents, to reference file names, 
and for trademarks.

● Sections and chapters that are referred to in text are shown in quotes. 
For example: See Chapter 1, “Introduction,” for an outline of the 
information in this book.

● A graphic of each Supervisor window is not included in this book. 
Graphics are provided to give you general information about a type of 
window, or to help clarify a procedure that is being described. The 
examples in this book are taken from Supervisor running in Windows 95.
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The following documents include additional information about the CMS or 
Supervisor:

● CentreVu Supervisor Installation and Getting Started (585-215-830)

● CentreVu Supervisor User’s Guide (585-215-829)

● CentreVu CMS Administration (585-215-820)

● CentreVu CMS Real-Time and Historical Reports (585-215-821).

831.bk : introduction.fm  Page 6  Wednesday, November 27, 1996  1:46 PM



Introduction  2-1

2
Report Designer 
Basics 2

Introduction 2

This chapter outlines the features of the Report Designer and teaches you 
general use of the Report Designer.

The following sections are included in this chapter:

● About the Report Designer

● Starting the Report Designer

● Exiting the Report Designer

● Report Designer Menus

● Steps Required to Create a New Report

● Steps Required to Edit an Existing Report.
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You can start the Report Designer using one of three methods:

● Selecting a report from the Designer category in any folder and clicking 
the Edit button on the Reports Selector window

● Clicking the New button on the Reports Selector window to create a 
new report.

● Running a report and then selecting Design from the Report menu on 
the report.

Any one of these methods of starting the Report Designer will take you to 
the Design Mode window (the window will be blank if you are creating a 
new report or will have report information if you are editing an existing 
report), as shown below:
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You can close the Report Designer using any of the standard Windows 
methods:

● Select Exit from the Report menu,

● Double-click the System button, or

● Select the Close button at the top of the window.

If you try to exit the Report Designer without first saving the report you 
have been working on, a warning gives you the opportunity to save the 
report before closing the Report Designer.
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Report Designer Menus 2

This section details the Report Designer Design Mode window. The 
following picture illustrates the Report Designer Design Mode window:

Menu Bar 2

The menu bar lists the available drop-down menus. The following menus 
are available from the Report Designer Design Mode window:

● Report

● Edit

● Format

● Options

● Insert

● Help.

The following paragraphs outline the options available from each menu.

Menu Bar

Title Bar Maximize/Minimize/Close
Window Sizing Buttons

System Menu Box
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Report 2

From this menu, you can test the report you are working on, save the 
report, and exit the Design Mode window. The Report menu has the 
following options:

Menu Item Action

Run Selecting Run takes you out of design mode and runs 
the report you are working on. You will use Run to 
test the changes/additions you have made to a report.

Save Selecting Save saves the report on which you have 
been working.

Save As Selecting Save As allows you to save the report on 
which you have been working with a new name or 
with the current name.

Exit Selecting Exit closes the Report Designer without 
saving the changes/additions you have made to the 
report. You are prompted to save changes if you made 
any modifications to the report.
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You will use the Edit menu (shown below) to add information to and 
delete information from the report output window, and to create the 
report input window and the queries that are used to retrieve data for 
the output. The Edit menu has the following options:

Menu Item Action

Undo 
Cut/Delete

If you accidentally cut or delete an item from the 
report that you are designing, you can select Undo 
Cut/Delete to place the item back on the report.

Cut Selecting Cut removes the item that you have selected 
from the report and places it on the Windows 
clipboard.

Copy Selecting Copy copies the item(s) that you have 
selected on the report and places it on the Windows 
clipboard. You can only copy entire grids and entire 
charts. It is not possible to copy only a portion of a 
grid or chart. If you would like to rearrange the order 
of the columns on a grid, use the Format Grid window.

Note: you can copy from one report to another report. 
To do so, complete these steps:

1. Open the report from which you want to copy.

2. Select the items that you want to copy.

3. Select Copy from the Edit menu.

4. Open the report to which you want to copy. 

5. Select Paste from the Edit menu.
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Paste Selecting Paste places the item(s) currently on the 
Windows clipboard to the report that is currently 
selected in Design Mode.

Delete Selecting Delete removes the currently selected 
item(s) from the report.

Inputs Selecting Inputs starts the Select Inputs assistant, 
which is where you choose the items that will be 
included on the report input window for this report.
For instructions on how to use the Select Inputs 
assistant, see the “Edit | Inputs” chapter of this book.

Queries Selecting Queries starts the Create a Query assistant, 
which is where you define the SQL queries that will be 
used to retrieve the data to be displayed on the report.
For instructions on how to use the Create a Query 
assistant, see the “Edit | Queries” chapter of this 
book.

Menu Item Action
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From this menu, you can edit the charts, grids, and fields that appear on 
the report. The Format menu has the following options:

Menu Item Action

Chart Selecting Chart opens the Chart Format Options 
window. The Chart Format Options window gives 
you access to the General, Axis, Data, Data Labels, 
Fonts, Legend, Series Labels, Title, Type, and 3D 
Effects tabs for formatting charts on reports. 
For more information on using the Chart Format 
Options window, see the “Format | Chart” chapter in 
this book

Field Selecting Field opens the Field Format Options 
window. The Field Format Options window is where 
you will choose the formats for fields defined in 
queries.
For more information on using the Field Format 
Options window, see the “Format | Field” chapter in 
this book.

Grid Selecting Grid opens the Grid Format Options 
window. The Grid Format Options window gives you 
access to the General, Data, Fonts, Format, Headers, 
Sort, and Summary tabs for formatting grids on 
reports.
For more information on the Grid Format Options 
window, see the “Format | Grid” chapter in this book.
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Sort by Selecting Sort by opens the Grid Format Options 
window with the Sort tab active. The Grid Format 
Options window gives you access to the General and 
Sort by tabs for formatting grids on reports.
For more information on the Grid Format Options 
window, see the “Format | Grid” chapter in this book.

Text Selecting Text when a text item on the report is 
selected opens the Text Format Options window. The 
Text Format Options window allows you to change 
the font display characteristics for the selected text.
For more information on the Text Format Options 
window, see the “Format | Text” chapter in this book.

Menu Item Action
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From this menu, you can define whether or not a status bar will appear 
on the report and set the alignment of text fields to grids. The Options 
menu has the following options:

Menu Item Action

Status Bar Selecting Status Bar includes a status bar on the 
bottom of the report you are designing. Status Bar is 
selected when there is a check mark next to the menu 
item.

Align To 
Grid

Selecting Align To Grid aligns the currently selected 
items on the report to the Design Mode grid when 
they are moved. The Design Mode grid is the grid that 
is shown on the window, behind any charts, grids, or 
text, when you are in Design Mode. Align To Grid is 
selected when there is a check mark next to the menu 
item.
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Insert 2

From this menu, you can add charts, grids, fields, and text to the report. 
The Insert menu has the following options:

Menu Item Action

Chart Selecting Chart opens the Chart Assistant, which is 
where you define the contents of a chart (graphical 
presentation of the report information).
This menu item is grayed-out if no queries have been 
defined.
For more information on using the Chart Assistant, see 
the “Insert | Chart” chapter in this book.

Field Selecting Field opens the Field Assistant, which is 
where you define the contents of a field to be placed 
on the report.
For more information on using the Field Assistant, see 
the “Insert | Field” chapter in this book.

Grid Selecting Grid opens the Grid Assistant, which is 
where you define the contents of a grid (standard CMS 
report presentation format) to be placed on the report.
This menu item is grayed-out if no queries have been 
defined.
For more information on using the Grid Assistant, see 
the “Insert | Grid” chapter in this book.

Text Selecting Text opens the Text Assistant, which is where 
you can enter plain text that will appear on the report.
For more information on using the Text Assistant, see 
the “Insert | Text” chapter in this book.
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You can access Supervisor on-line help for the Report Designer from all 
of the windows in the Report Designer. There are three ways of 
accessing the help:
● Pressing the F1 key — displays help specific to the current window.
● Selecting the Help button (if available) — displays help specific to 

the current window.
● Selecting Help from the menu bar (shown below) — allows you to 

choose from the following options:

Menu Item Action

Contents Selecting Contents opens the Supervisor on-
line help table of contents.

Search for Help On Selecting Search opens the Search window. 
Follow the instructions within this window to 
easily select specific help information on a 
given topic.

Index Selecting Index opens a Supervisor help 
alphabetical index.

Technical Support Selecting Technical Support opens a window 
that provides Technical Support information.

About Selecting About opens the Supervisor Help 
About window, which shows the software 
version number.
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Other Attributes of the Design Mode Window 2

In addition to the available menus, the Design Mode window also makes 
use of the following standard Windows conventions:

● System Menu Box — the system menu box allows you to perform 
common windows conventions, such as closing the current window or 
application.

● Title Bar — the title bar shows the name of the application.

● Maximize, Minimize, and Close Buttons — these buttons adjust the 
size of the window, or close the window.
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Steps Required to Create a New Report 2

There are 10 tasks you need to complete to create a custom report. If you 
consistently do all of these tasks for each report you create, then your 
reports will run properly and you will be able to create them efficiently. The 
tasks are:

1. Access the Report Designer in Design Mode (Chapter 2)
Access the Report Designer so that you can design the report.

2. Define the Inputs for the Report Input Window (Chapter 5)
Define inputs for the report input window so that users can run the 
report using parameters they choose (that is, what split, agent, 
time, date, etc.).
NOTE: Inputs can also be defined while you are creating a query. 
To do so, select the Inputs button on the WHERE clause window.

3. Define the Queries for the Report. (Chapter 6)
Define which rows of data from specific CMS database tables will 
supply data for the grids and charts on the report.

4. Insert Charts, Grids, and Fields on the Report (Chapters 7, 8, and 
9).
Define what data from the queries should appear in each chart, 
field, or grid on the report.

5. Enter Report Text (Chapter 14) (optional)
Enter text to provide headings for the grids and charts on the 
report, and to provide additional information, such as the report 
name.

6. Define Fields to Show Run Time/Date and User Inputs 
(Chapter 8) (optional)
Define fields on the report to show when the report was run and 
what items the report covers (as defined in the report input 
window).
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7. Edit the Appearance of the Report (Chapter 4)
Edit a report design using the Cut, Copy, and Paste Edit menu 
options and standard Windows drag-and-drop conventions. Editing 
an existing report design lets you rearrange and delete sections of 
the report quickly and easily. 

8. Save the Report Design (Chapter 2)
Save the report you have been working on prior to testing the 
report.

9. Define a Report’s Properties (Chapter 3).
Define the name that you use both to run the report and to access 
the report design if you want to change the design. Define access to 
determine whether other users can run the report and copy the 
report’s design to create their own custom reports. Define the type 
as real-time, historical, or integrated.

10. Test (Run) the Report Design (Chapter 2)
Test your report immediately after designing and saving it. Testing 
helps eliminate wasted time in running a report whose design is 
incomplete.
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There are 11 tasks you need to complete to edit an exiting report in the 
Report Designer. If you consistently do all of these tasks for each report you 
want to edit, then your reports will run properly and you will be able to 
create them efficiently. The tasks are:

1. Copy an Existing Report to the Designer Category (Chapter 3)
Copy an existing report so that you start the design process with 
existing report headings, data fields, queries, charts, grids, and 
other report features. When you copy a report to the Designer 
category, the original report remains intact and is still located in the 
original report category.
NOTE: You can also run a report and then select Design from the 
Report menu. This takes you directly into design mode, and you 
will be asked if you want to save the report (with a new name, in 
the Designer category) when you exit design mode.

2. Define a Report’s Properties (Chapter 3).
Define the name that you use both to run the report and to access 
the report design if you want to change the design. Define access to 
determine whether other users can run the report and copy the 
report’s design to create their own custom reports. Define the type 
as real-time, historical, or integrated.
When you copy a report to the Designer category using the Report 
Manager, the Properties window automatically displays as part of 
the copy process. 

3. Access the Report Designer in Design Mode (Chapter 2)
Access the Report Designer so that you can design the report.

4. Edit the Appearance of the Report (Chapter 4)
Edit a report design using the Cut, Copy, and Paste Edit menu 
options and standard Windows drag-and-drop conventions. Editing 
an existing report design lets you rearrange and delete sections of 
the report quickly and easily. 
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5. Define Inputs for the Report Input Window (Chapter 5)
(optional)
Define inputs for the report input window so that users can run the 
report using parameters they choose (that is, what split, agent, 
time, date, etc.).
If you copy a report design, the definition of that report’s input 
window is copied. You can then modify the input fields as required.
NOTE: Inputs can also be defined while you are creating a query. 
To do so, select the Inputs button on the WHERE clause window.

6. Define the Queries for the Report. (Chapter 6)
(optional)
Define which rows of data from specific CMS database tables will 
supply data for the grids and charts on the report.
If you copy a report design, the definitions of that report’s queries 
are copied. You can then modify the queries, as required.

7. Insert Charts, Grids, and Fields on the Report (Chapters 7, 8, and 
9). (optional)
Define what data from the queries should appear in each chart, 
field, or grid on the report.
If you copy a report design, the definitions of that report’s charts, 
fields, and grids are copied. You can then modify the data as 
required.

8. Enter Report Text (Chapter 10) (optional)
Enter text to provide headings for the grids and charts on the 
report, and to provide additional information, such as the report 
name.
If you copy a report design the text of that report is copied. You can 
then modify the text, as required.

9. Define Fields to Show Run Time/Date and User Inputs 
(Chapter 8) (optional)
Define fields on the report to show when the report was run and 
what items the report covers (as defined in the report input 
window).
If you copy a report design these fields are copied. You can modify 
them as required.
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10. Save the Report Design (Chapter 2)
Save the report you have been working on prior to testing the 
report.

11. Test (Run) the Report Design (Chapter 2)
Test your report immediately after designing and saving it. Testing 
helps eliminate wasted time in running a report whose design is 
incomplete.
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Introduction 3

This chapter teaches you to use the report manager feature of the Supervisor 
application. The sections of the chapter are:

● About Report Manager

● Viewing Report Properties

● Copying a Report to the Designer Category

● Copying a Designer Report to a File

● Copying a Designer Report from a File

● Deleting a Report from the Custom or Designer Category

● Starting the Report Designer using the New or the Edit Button.
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About the Report Manager 3

The report manager is the feature of the Supervisor application that allows 
you to view report properties, copy reports, and access the Report Designer 
to edit reports or create new reports.

The report manager is incorporated into the Reports Selector window, as 
shown below:

You can use the Properties, Copy, and Edit buttons on the Report Selector 
window to manage the standard CMS and Supervisor reports, and to Copy 
reports to the Designer category for editing. You can use the New button to 
create a new Designer report from scratch. You can use the Delete button to 
delete reports from the Designer category (standard CMS, CMS Custom, 
and standard Supervisor reports cannot be deleted).

Note For information on using the Add Bookmark button, see the 
Supervisor User Guide (585-215-829)
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Viewing or Changing a Report’s Properties 3

The Report Manager gives you the ability to view report properties, such as 
the report name, description, owner, type, folder, category, and scope 
(Everyone or Only Me), and the folder the report is stored in.

To view a report’s properties, complete the following steps:

1. Open the Report Selector window.

2. Select the report for which you want to view properties.

3. Click the Properties button.

The Properties window for the report displays:

From the Properties window, you can change the name, description, 
owner, and scope of a report.

4. To change the Name, Description, or Owner of a report, place the 
cursor in the appropriate field and make your edits. To change the 
scope, or who the Report is Available to, of a report, select either the 
Everyone or Only Me radio button. When you are done making your 
changes, select the OK button to save the changes.

If you attempt to give a report the same name as an existing designer 
report, the Report Already Exists window displays. This window allows 
you to overwrite the existing report or to give the report you are saving 
a different name.
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Using the Report Manager, you can copy a report from any category (Agent, 
Other, Queue/Agent, Split/Skill, Trunk/Trunk Group, VDN, Vector, 
Custom, or Designer) and folder (Real-Time, Historical, or Integrated) into 
the Designer category of any folder. 

To copy a report, complete the following steps:

1. Open the Report Selector window.

2. Select the report that you want to copy.

3. Click the Copy button.

The Copy Report window displays. This window allows you to select 
where you are copying the report to (the Designer category, a PC file, or 
from a PC file to the CMS server).

4. Select the To Designer Category radio button.

5. Select the OK button.

Note Reports that are created or edited using the Report Designer can 
only be accessed from the Supervisor interface to the CMS server. 

Therefore, if you edit a CMS Custom Report using the Report 
Designer, the changes to that report will not be available when the 
report is run from the Terminal Emulator or another terminal 
interface to the CMS.
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The Copy Report To Designer Window displays, which is where you 
will define the name, description, folder, and scope of the report. 

To define the properties information for a copied report, complete the 
following steps:

6. Enter a name for your report in the Name field. The name can have up 
to 40 characters, including blanks. Because the name you give your 
report should be unique, you may want to look at existing report names 
before entering a name for your report.

7. Move the cursor to the Description field and enter a description of the 
report. The description can have up to 100 characters, including blanks. 
It is not required that you enter a report description.

8. Move the cursor to the Folder field. Use the pull-down list to select Real-
Time, Historical, or Integrated. The report will be stored in the Designer 
category of the folder you select here.

When you edit the report you will access the database for the folder you 
select here. If you select Real-Time, you will not be able to access the 
Historical database tables to define queries for the report. If you select 
Historical, you will not be able to access the Real-Time database tables to 

Warning

Do not use the \ (backslash), ; (semicolon), ’ (grave accent), ~ 
(tilde), “ (double quote), | (pipe), * (asterisk), or ? (question 
mark) characters in your description of the report.
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define queries for the report. However, if you select Integrated, you will 
be able to access both the Real-Time and Historical databases to define 
queries for the report.

You must select the Historical or Integrated folder if you want to 
include:
● Exceptions data
● Agent trace data
● Call record data.

9. Select the Everyone radio button to make the report accessible to all 
CMS users who have the appropriate permissions, or select the Only 
Me radio button to make the report accessible only to yourself.

Assigning “Everyone” access to the report allows other users to run the 
report and to copy the report to create new designer reports.

Assigning “Only Me”access to the report means that only you (and the 
CMS administrator(s)) can run the report. In addition, no other users, 
except for CMS administrators, can copy the report design for use in 
their own designer reports.

10. Select OK to save the report properties.

After you have copied the report to the Designer category, you can use 
the Edit button to access the Report Designer and edit the report.

Note It is a good idea initially to make your reports available only to 
yourself until they have been debugged and run successfully. 
This prevents the possibility of other users running reports that 
you have saved but not yet tested.

Note No other CMS user other than a user with CMS administration 
permissions can modify a report design you create, regardless of 
whether the report is accessible by all or only by you. A user 
with CMS administration permissions always has the ability to 
modify your report design, even if you make it available only to 
yourself.
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Copying a Designer Report to a File 3

You can use the Report Manager Copy button to copy any designer report 
that you create to a file, either on diskette, on your hard drive, or on a 
network drive. You can use this feature to easily transport designer reports 
from one PC to another.

To copy a report, complete the following steps:

1. Open the Report Selector window.

2. Select the Designer Category

3. Select the designer report that you want to copy.

4. Click the Copy button.

The Copy Report window displays with the To a PC File option 
enabled. This window allows you to select where you are copying the 
report to (the Designer category, a PC file, or from a PC file to the CMS 
server).

5. Select the To a PC File radio button.

6. Select the OK button.

Note If a report was created by Lucent Technologies Professional Services, 
only a user with CMS administration permissions can copy the 
report.

831.bk : Using the report manager.fm  Page 7  Wednesday, November 27, 1996  1:46 PM



3-8 Copying a Designer Report to a File

Using the Report Manager

The Save Report to PC File window displays.

This window is a standard Windows browse window.

7. Select the File name and Folder to which you want to save the report.

8. Select the OK button.

9. The file is saved and, upon successful completion of the save, a 
confirmation window displays.

Note You can copy the report to any drive to which you have access, 
including the floppy (usually a:\) drive on your PC.

Note You can save the report to a network drive by selecting the 
Network button, which allows you to access the network drives 
that you have permissions for.
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Copying a Designer Report from a File 3

You can use the Report Manager Copy button to copy any designer report 
that has been saved to a file (either on diskette or on a network drive) onto 
the CMS server. 

To copy a report from a file to the server, complete the following steps:

1. Open the Report Selector window.

2. Click the Copy button.

The Copy Report window displays. This window allows you to select 
where you are copying the report to (the Designer category, a PC file, or 
from a PC file to the CMS server).

3. Select the From a PC File to the CMS Server radio button.

4. Select the OK button.

The Load Report From PC File window displays.
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This window is a standard Windows browse window.

5. Select the file that you want to copy to the CMS server.

6. Select the OK button.

7. The file is copied to the CMS server and, upon successful completion of 
the copy, a confirmation window displays.

If a report with the same name already exists on the CMS server, the 
following window displays:

Select the Overwrite the existing report radio button to replace the 
report that currently resides on the CMS server. Select the Save the 
report being copied as radio button and enter a new name for the report 
if you want to retain the version of the report that currently resides on 
the CMS server.
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Deleting a Report from the Designer Category 3

The Report Manager allows you to delete any report that resides in the 
Designer category. You cannot delete any of the standard CMS, CMS 
Custom, or standard Supervisor reports (reports that reside in the Agent, 
Other, Queue/Agent, Split/Skill, Trunk/Trunk Group, VDN, Vector, and 
Custom categories).

To delete a Designer report, complete the following steps:

1. Open the Report Selector window.

2. Select the Designer category under any tab.

3. Highlight the name of the report that you want to delete.

4. Click the Delete button.

5. A message confirming the delete displays. Select OK to delete the report 
or Cancel if you do not want to delete the report.
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Opening the Report Designer Using the Edit or 
New Button 3

You can use the Report Manager to open the Report Designer by selecting a 
report from the Designer category and then clicking the Edit button, or by 
clicking the New button to create a new report.

You can also access the Report Designer from a report output window. To do 
so, select Design from the Report menu on the report.
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Introduction 4

This chapter teaches you to how to use the basic Windows features of the 
Report Designer Design Mode window, including:

● Copying an Item and Pasting the Item Into the Same Report

● Copying an Item from One Report and Pasting the Item Into Another 
Report

● Cutting an Item from the Report

● Deleting an Item from the Report

● Using Drag-and-Drop to Arrange Items on the Report

● Resizing an Item on the Report

● Selecting Multiple Items on the Report.
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Copying an Item and Pasting the Item Into the 
Same Report 4

You can copy an item in one report and paste the copy into the same report. 
To do so, complete the following steps:

1. Open the report from which you want to copy.

2. Select the item(s) that you want to copy.

3. Select Copy from the Edit menu, or press CTRL+C.

4. Select Paste from the Edit menu, or press CTRL+V.

The item(s) is placed in the upper left-hand corner of the Design Mode 
window.
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Copying an Item from One Report and Pasting 
the Item Into Another Report 4

You can copy items from one report to another report. To do so, you can 
open both reports in design mode and use either the drag-and-drop method, 
or you can complete the following steps:

1. Open the report from which you want to copy.

2. Select the items that you want to copy.

3. Select Copy from the Edit menu,

OR

Press CTRL+C.

4. Open the report to which you want to copy.

5. Select Paste from the Edit menu,

OR

Press CTRL+V.

Note Note that both reports must be open in design mode in order to 
copy from one report to another report.

If you want to copy an item from a report that is not a Designer 
report, complete the following steps:

1. Run the report.

2. Select Design from the Report menu.

3. Copy the item to the clipboard (using the steps above).

4. Select Run from the Report menu.

As long as you do not make any changes to the report, you will 
automatically be returned to the run mode. If you inadvertently 
make changes to the report, a message displays that gives you the 
option to save the changes. Select No if you do not want to save the 
changes.
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Cutting an Item from the Report 4

Selecting Cut removes the currently selected item from the report and places 
it on the Windows clipboard.

To cut an item from a report and place the information on the Windows 
clipboard, complete these steps:

1. Select the item by placing your mouse cursor on the item and clicking.

2. Select Cut from the Edit menu, 

OR

Press CTRL+X.

831.bk : Design Mode Basics.fm  Page 4  Wednesday, November 27, 1996  1:46 PM



 Deleting an Item from the Report 4-5

Design Mode Basics

C
ha

pt
er

 4

Deleting an Item from the Report 4

Selecting Delete permanently removes the currently selected item(s) from 
the report.

To delete an item from a report, complete the following steps:

1. Select the item by placing your mouse cursor on the item and clicking.

2. Select Delete from the Edit menu

or 

Press the DELETE key.

The item is removed from the report and is no longer available to be pasted 
on the report. If you accidentally delete an item that you would like to keep 
on the report, you can select Undo from the Edit menu (if you haven’t done 
anything else). If you do not immediately realize that you inadvertently 
deleted an item, you can use the Insert menu to recreate the item.
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Using Drag-and-Drop to Arrange Items on the 
Report 4

You can move one or more items around on a report using the Windows 
drag-and-drop method. To do this, complete these steps:

1. Select an item(s) by pointing the mouse cursor at the item and clicking 
one time.

You can select additional items by holding down the CTRL key and 
clicking the mouse cursor on the items.

You will know when an item is selected because there will be either a 
frame around the item or sizing handles will display on the corners of 
the item.

2. Hold down the left mouse button.

3. Move the mouse cursor to the position in which you would like the item 
to reside.

4. Let go of the mouse button.
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Resizing an Item on the Report 4

To resize an item on a report, complete the following steps:

1. Select the item by placing the mouse cursor over the item and clicking 
one time.

2. Place the mouse arrow over one of the sizing bars on the item.

3. Hold down the CTRL key and press the left mouse button.

4. Drag the mouse cursor until the item is the appropriate size.

5. Release the mouse button.
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Selecting Multiple Items on the Report 4

To select multiple items on a report (for instance, to copy more than one item 
at a time), complete the following steps:

1. Select the first item.

2. Hold down the CTRL key.

3. Select the second item.

4. Repeat Steps 2 and 3 until all of the items you want selected are selected.
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Introduction 5

This chapter teaches you about report input fields and gives you instruction 
on how to add, delete, and edit the input fields for a Report Designer report. 
To access the windows that let you do these things, select Inputs from the 
Edit menu. The sections in this chapter are:

● About Report Input Fields

● Adding Input Fields to the Input Window

● Deleting Input fields from the Input Window

● Editing the Order of Input Fields

● Editing the Appearance of Input Fields

● Setting Up Inputs for a Multi-ACD Report

● Viewing the Input Window.
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About Report Input Fields 5

To run a report, you first access a Report Input window. The Report Input 
window gives you control over what data (which splits/skills, trunks, dates, 
intrahour intervals, and so on) are included in the report.

To define report input fields for a designer report, use the Define Input 
window. When you or another user runs the report, this input window 
appears with the field prompt(s) and the input field(s) you defined.

You define fields for the Report Input window using the steps described in 
the following pages.

In the example of an input window that is shown below, the user has 
entered a split number of 1, a date of 07/01/96, and intrahour intervals from 
8:00 a.m. to 11:00 a.m.

Because the report this input window is associated with is an Historical 
Interval report, CMS will retrieve the data for the report from the historical 
database tables, which are designated with an “h” (hagent, hsplit, htrunk, 
etc.). For more information on how CMS stores and retrieves data, refer to 
Chapter 15, “How CMS Stores and Retrieves Data” and Appendix A, 
“Database Items and Calculations,” in this book.
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Adding Input Fields to the Input Window 5

Defining the type of an input field enables CMS to do the following when a 
user runs the report:

● Check that the user's entries are valid system values and are values CMS 
can use to search the database tables.

● Check that the user has permissions to run a report for the entries.

● Allow the user to enter names defined in the Dictionary subsystem.

To define the input fields for a report, complete the following steps:

1. Select Inputs from the Edit menu.

The Edit Inputs “Select inputs for this report” window displays, as 
shown below. If you are editing an existing report, the items that already 
appear on the input window for the report are shown in the Inputs list. 
If you are creating a new report, the Inputs list is blank.

Note Only add inputs that are used in the report queries. If you add 
additional inputs (that are not used in the queries), then irrelevant 
information that references those inputs will display on the report.
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2. In the Input Types list, highlight the first input you want to require for 
the report. See the following table for definitions of the available Input 
Types.

3. Select the Add button.

The item displays on the Inputs list.

4. Repeat Step 2 until you have added all of the inputs required for the 
report.

Table 5-1:  Report Input Field Types

For this type of input: The user must enter the following information:

ACD An ACD number or name.

Agent An agent name (as defined in the Dictionary) or 
agent login ID.

NOTE: The Agent input field can only be a single-
value input for integrated reports.

Agent group An agent group name (as defined in the 
Dictionary).

Agent state An agent state name (standard or new name as 
defined in the Dictionary). Standard names are 
ACD, AUX, ACW, and so on.

Call Work Code A call work code name or number.

Date A date must be entered. Dates can be entered in 
region-specific format or as a relative number (for 
example, -7 for 7 days ago).

Extension An extension number of one to five digits (as 
administered for System 75/Generic 1/Generic 3) 
or three to five digits (as administered for System 
85/Generic 2).

Login ID A login ID of one to nine digits (as administered 
for System 75/Generic 1/Generic 3) or four digits 
(as administered for System 85/Generic 2).
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Number A number, which may include digits to the right of 
the decimal point. This type applies if your 
variable field asks for specific values about ACD 
performance (for example, number of ACD calls or 
percent within service level).

Split/Skill A split/skill number or name.

String A character string. Select this type only if one of 
the following is true:
1. Your variable field is linked to a custom 
database item that you identify in INFORMIX* as a 
CHAR column.

2. Your variable field is linked to a standard 
database item that is a CHAR column, AND you 
want to allow the user to do pattern searching 
when running the report. See the following 
section, “Input Fields That Allow Pattern 
Matching”.

Time
(duration)

A number, including decimals, of seconds. This 
type only applies if your variable field asks for 
specific values regarding ACD performance (for 
example, time in AUX work, average speed of 
answer, or average talk time).

Time 
(point in time)

A specific time of day in hh:mm format, either as 
24-hour time or with AM or PM appended.

Trunk A trunk name or number.
NOTE: The Trunk input field can only be a single-
value input for integrated reports.

Trunk group The number or name of a trunk group.

Table 5-1:  Report Input Field Types (Contd)

For this type of input: The user must enter the following information:
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CMS can search for values in certain database items according to wild 
card search patterns. As a result, you can create a report that allows 
inputs based on character strings, plus either * (matches on blank and 

Trunk state A trunk state name (standard name or new name 
as defined in the Dictionary subsystem). Standard 
names are IDLE, SEIZED, QUEUED, and so 
on.

NOTE: If you use Trunk state as an input in an 
integrated report, the input must be used in a real-
time query. It cannot be used in an integrated 
query.

VDN A Vector Directory Number of one to five digits (as 
administered for System 75/Generic 1/Generic 3) 
or three to five digits (as administered for System 
85/Generic 2) or a VDN name.

NOTE: The VDN input field can only be a single-
value input for integrated reports.

Vector A vector number or name.
NOTE: The Vector input field can only be a single-
value input for integrated reports.

Note If you are defining a real-time report, you cannot and do not need 
to define an “Update Rate in Seconds” input field because the field 
is automatically included in the Report Input window.
If you are defining a historical report, you cannot and do not need 
to define a “Report Destination” input field because the field is 
automatically included in the Report Input window.

If you are defining an integrated report, you cannot and do not 
need to define a “Start Time” input field because the field is 
automatically included in the Report Input window.

Table 5-1:  Report Input Field Types (Contd)

For this type of input: The user must enter the following information:
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all characters) or ? (matches on any single character). CMS then 
includes data for all items that match the character strings the user 
entered.

The standard database items that allow this type of searching are:
● VDN (the value is a VDN number)
● EXTENSION (the value is an extension number)
● LOGID (the value is an agent login ID)
● EQLOC (the value is a 9-digit trunk location number)
● CWC (the value is a call work code)
● ROW_DATE (the value is a date)

In addition, any custom database items that you define as CHAR 
columns in INFORMIX also allow this type of searching.

As an example of matching with * , if an input field were a String  
type and were associated with the LOGID database item, the user could 
enter 1* , and CMS would include data for all agents with login IDs that 
start with 1 (1, 10, 1238, 190, and so on, depending on the switch's 
administered login length). As an example of matching with ? , if an 
input field were a String  type and were associated with the VDN 
database item, the user could enter 21?0 , and CMS would include data 
for all VDNs that start with 21, end with 0, and have any single 
character appearing between the 21 and the 0 (2100, 2110, 2120, 2130, 
and so on).

Caution If you select String for an input field, CMS does not check 
a user's inputs in that field for appropriate read permissions 
or valid switch parameters. If you want CMS to check 
permissions for a VDN input field, you must select the VDN 
field type. If you want CMS to check switch parameters for a 
VDN, login ID, extension, or call work code input field, you 
must select that field type, not String . In addition, if you 
select String  for a field, the user will not be able to enter 
Dictionary names. So, again, if you want to let the user enter 
VDN, login ID, or call work code names to run a report, you 
must select that specific field type, not String .
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To delete one of the inputs you have added for a report input window, 
complete the following steps:

1. Select Inputs from the Edit menu

2. On the Inputs table, highlight the row of the item you want to delete by 
clicking on the left-hand (numbered) column of the row.

3. Select the Remove button.

Note If a field is used in a query, the input cannot be removed until the 
query is removed or modified to eliminate the reference to the 
input.
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Editing the Order of Input Fields 5

You can change the order in which input fields appear on the report input 
window by completing the following steps:

1. Select Inputs from the Edit menu

2. Add the Input Types that will appear on the input window to the 
Inputs table.

3. Select the entire row of the input for which you want to change positions 
by clicking on the left-hand (numbered) column of the row.

4. Use the Up and Down buttons to move the entire row up/down one 
row at a time.

5. Using the Inputs list, you can edit the name of the prompt for each input 
field, control whether multiple values are allowed in the input field, and 
define the ACD with which the input will be associated.

6. When you are done editing the order of the input fields, select OK.
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Using the Inputs list, you can edit the name of the prompt for each input 
field, control whether multiple values are allowed in the input field, and 
define the ACD with which the input will be associated.

When you add an item from the Input Types list to the Inputs list, the 
columns of the Inputs table are populated with the default values for that 
input item. The columns of the Inputs table are:

Column Function

Type The Type column shows the input field name. You can use 
the pull-down list to the right of the column to change the 
input in a particular row to another type.

Multi-
value

Select the Multi-Value check box if you want to allow users 
to enter multiple values in the input field.
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Prompt The prompt column shows the text that will display on the 
report input window for this input field. You can edit the 
text for the prompt by selecting the cell in the table and 
then typing the text that you want to display. If you want 
to delete the existing prompt text, use the backspace key to 
erase the letters.

You can enter a name that is up to 30 characters long, 
including blank spaces.
The prompt name should describe the information (what 
split/skill, what date, what time, etc.) a user must enter in 
the field when ordering the report. For example, if you 
want the user to enter a date, “Date” would be an 
appropriate prompt. However, if the user can enter more 
than one date in the field, “Dates” would be more 
appropriate.

Associated 
ACD

The Associated ACD column lets you use the Current 
ACD or assign a specific ACD to be used for this input. 
The default for this column is Current ACD. If you want to 
allow the user to pick a specific ACD for the input field, 
use the pull-down list to the right of the column to select 
ACD. If the Associated ACD column is blank, the input 
cannot be associated with a specific ACD.
Select Current ACD if either of the following conditions is 
true:
● You have only one ACD.
● You always want the report to show data for the user's 

current ACD.

Select ACD: if the people who will be running the report 
have read permissions for more than one ACD. Allowing 
the user to select the ACD for the input is most useful 
when you are creating a multi-ACD report. 

Column Function
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Default 
Value

You can define a default value for most input fields. To do 
this, select the browse button to the right of the column. 
The available values for this type of input are displayed. 
Highlight one and select OK.

NOTE: If you select a default value, the user can change 
the value on the input window.

Column Function
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Setting Up Inputs for a Multi-ACD Report 5

Two types of multi-ACD reports are available:

● Multi-ACD reports that show data for multiple splits/skills on multiple 
ACDs, and 

● Multi-ACD reports that show data for multiple VDNs on multiple 
ACDs.

If you are creating a multi-ACD report, you need to make sure that you set 
up the inputs as detailed below so that the query for the report will work 
properly.

The following instructions show you how to create the inputs for a multi-
ACD report that allows inputs for up to four ACDs:

1. Select Inputs from the Edit menu.

2. Select ACD from the Input Types box.

3. Select the Add button.

4. Repeat Steps 2 and 3 three times.

Note The following instructions use the split/skill multi-ACD report inputs 
as the example. To create the inputs for a VDN multi-ACD report, use 
these same instructions, but use the VDN input instead of the Split/Skill 
input.
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The Inputs table will look like this:

5. Select Split/Skill on the Input Types box.

6. Select the Add button.

7. Repeat Steps 5 and 6 three times.
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The Inputs table will look like this:

8. For the Split/Skill(2) prompt (line 6 of the Inputs table), use the 
Associated ACD drop-down list to select ACD(2) as the associated ACD.

9. For the Split/Skill(3) prompt (line 7 of the Inputs table), use the 
Associated ACD drop-down list to select ACD(3) as the associated ACD.

10. For the Split/Skill(4) prompt (line 8 of the Inputs table), use the 
Associated ACD drop-down list to select ACD(4) as the associated ACD.
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The Inputs table looks like this:

11. Select OK to save the inputs for this multi-ACD report.
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Viewing the Input Window 5

You can view what the input window will look like at any point during the 
process of designing the report by selecting Run from the Report menu.

To return to design mode from the report input menu, select the Cancel 
button.
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A report consists of fields, charts, and grids which display data that is 
retrieved from the CMS database tables. The definition of what data is 
retrieved for a specific report is done using queries. This chapter teaches you 
to create queries for reports using the Query Assistant, which is accessed by 
selecting Query from the Edit menu. The sections of this chapter are:

● Defining Queries for a Report

● Creating a Real-Time or Historical Query

● Creating an Integrated Query

● Editing an Existing Real-Time or Historical Query

● Editing an Existing Integrated Query

● Copying a Query

● Deleting a Query.
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Defining Queries for a Report 6

To complete the definition of a report's grids, charts, or fields, you must 
define the queries that select the rows of the appropriate tables in the CMS 
database.

Queries are values for either database items or calculations. In most cases, 
the queries specify the input variables rather than specific values as criteria 
for retrieving information from the database. The input variables allow CMS 
to use the values entered in the Report Input window as the query criteria 
for the report. 

Queries tell CentreVu CMS two things:

● Where to get the data, and

● How to use the data.

CentreVu CMS picks out values from a table with both row and column 
identifiers. CentreVu CMS identifies rows of data according to the user's 
inputs and the row search conditions you define. CentreVu CMS identifies 
columns according to the data expression you define here.

For more information about SQL queries and the CMS Database Tables, refer 
to the “SQL Queries and CMS Database Tables Basics” chapter of this book 
and Appendix A, “Database Items and Calculations,” in this document.

Note If you change the prompt in the Edit Inputs window, it is 
automatically updated in the query.
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Creating a Real-Time or Historical Query 6

To create a new query to be used in a designer report, complete the 
following steps from the Report Designer Design Mode window:

1. Select Query from the Edit menu.

The Query Select “Select an existing query or add a new one” window 
displays.

2. Select the New button.

831.bk : edit_queries.fm  Page 3  Wednesday, November 27, 1996  1:46 PM



6-4 Creating a Real-Time or Historical Query

Edit | Queries -- Defining Data for Report Fields

The Query Assistant “Select a database and one or more tables for the 
query” window in displays:

3. Depending on the type of report you are creating, select the Database 
radio button next to Real-Time or Historical.

The tables that are available for the type of database (Real-Time, 
Historical, or Integrated) selected display.

4. In the Table list, highlight the name(s) of the table(s) which includes the 
database items that you want to include in the query. For Real-Time 
reports, you can select only one table name. For Historical reports, you 
can select up to three table names.

Note that the calculations that are associated with the database items in 
the table(s) you choose will also be available for you to use in your 
query.

Note For instructions on creating an integrated query, see the 
“Creating an Integrated Query” section in this chapter.
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For information on the database items and calculations available in each 
table, see Appendix A, “Database Items and Calculations,” in this 
document.

5. Select the Next button.

The Query Assistant “Add the database items and calculations for the 
SELECT portion of the query” window displays, as shown below. On 
this window, you will add and remove database items and calculations 
that will be included in the query.

6. In either the Database Items or Calculations box, highlight the first 
database item or calculation that you will reference in the query.

In the Other box, you can type the names of Database Items or 
Calculations, strings, or constants that you want to use in the query. For 
instance, if you know that you would like the report to include 
information that subtracts the quantity of one database item from the 
quantity of another database item (for instance, ACDCALLS - 
ACDAUXOUTCALLS), then you could type a “-” in the Other box and 
add it to the list of Query Items. When you create the WHERE clause for 
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the query, you can specify a calculation of ACDCALLS - 
ACDAUXOUTCALLS for the report.

7. Select the Add button, or double click on the item.

The item is listed in the Query Items box.

8. Repeat Steps 6 and 7 until all of the database items and calculations that 
you believe will be referenced in the query are listed in the Query Items 
box.

9. Select the Next button.

Note Constants that have been defined in the Dictionary are listed in 
the Calculations box in addition to the calculations.

Note You can remove an item from the Query Items box by 
highlighting the item and selecting the Remove button.

You can rearrange the order of the items in the Query Items 
box using the Move Up and Move Down buttons.

You can edit an item in the Query Items box by highlighting 
the item and selecting the Edit button. When you select the Edit 
button, the following window displays:

An example of how you might want to edit an item would be to 
create a custom calculation in the edit box. For instance, you 
may add “callsoffered -” to the abncalls item shown above, so 
that the item would then read “callsoffered - abncalls” and that 
is the calculation that would be available for you to use in the 
query.
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The Query Assistant “Choose functions for the SELECT items” window 
displays:

You will use this window to assign aggregate (AVG, MAX, MIN, and 
SUM) functions to the Query Items. A function is a prefix that is 
attached to a database item, a calculation, parts of a calculation, or a 
calculation name. CMS will display only one value on the report if an 
aggregate function (SUM, AVG, MIN, or MAX) is assigned to a database 
item or calculation.

10. Highlight the first Query Item to which you want to assign an aggregate 
function.

11. Highlight the Function that you would like to assign to the item.

The available functions are:

Note If you are creating a query that uses Integrated Data, the steps 
differ from this point on. See the “Creating an Integrated Query” 
section for the correct steps.
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● MAX — The MAX aggregate function retrieves the highest value for 
a calculation or database item over the time frame of the report. For 
example, if the Intrahour Split table contained data as shown in 
Figure 6-1 and you assigned the MAX function to the ACDCALLS 
database item, then ran the report for Split 1 for all intervals on 
07/02/93, CMS would find all of the rows that are shown in bold. 
However, CMS would display only the value 418 (shown in the 
box), which is the maximum number of ACD calls in any single 
interval on 07/02/93. Likewise, if you assigned the MAX function 
to the ACDTIME and ACDCALLS database items and then defined 
a where clause of ACDTIME/ACDCALLS for a report field, CMS 
would display the value 101.53 (which is the highest average talk 
time in any single interval on 07/02/93).

Figure 6-1:  Sample Intrahour Split Table Data
● MIN — The MIN aggregate function retrieves the lowest value for a 

calculation or database item over the time frame of the report. For 
example, using the previous example, if you assigned the MIN 
function to the ACDCALLS database item (instead of the MAX 
function) and then ran the report for Split 1 for all intervals on 
07/02/93, CMS would display only the value 394 which is the 
smallest number of ACD calls in any single interval on 07/02/93.
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391
142
480
491
297
399
299
138
400
300
225
394
323
105
418
246
100
417
247

2
3
1
2
3
1
2
3
1
2
3
1
2
3
1
2
3
1
2

1000
1000
1100
1100
1100
0800
0800
0800
0900
0900
0900
1000
1000
1000
1100
1100
1100
0800
0800

070193
070193
070193
070193
070193
070293
070293
070293
070293
070293
070293
070293
070293
070293
070293
070293
070293
070393
070393

.................................................. 1299
1340
589
980

1256
704

1188
1322
367

1109
1745
2569
7616
1452
402
549
789
203
603

...............................................26308
37856
10281
21173
34819
12115

40002
29881

15628
24303
36178
11523
29602
37651
12530
26789
33389
9786

19768
...............................................
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● SUM — The SUM aggregate function retrieves the sum of all values 
for a calculation or database item over the time frame of the report. 
For example, if the Intrahour Split table contained data as shown in 
Figure 6-1 and you assign the SUM function to the ACDCALLS 
database item, then ran the report for Split 1 and all intervals on 
07/02/93, CMS would add all of the values for the ACDCALLS 
column on that date to display the value 1611. 

● AVG — The AVG aggregate function retrieves the average of all 
values found over the time frame of the report. Using the sample 
table in Figure 6-1, if you assigned the AVG function to the 
ACDCALLS database item, and then ran the report for Split 1 for all 
intervals on 07/02/95, the value 402.75, which is the average of 399, 
400, 394, and 418, would be displayed on the report.

12. Repeat Steps 10 and 11 until you have assigned Functions to the 
appropriate Query Items.

13. Select the Next button.

14. If you did not select more than one Historical database table for your 
query, skip to Step 19.

Note If you are creating a Real-Time query, you must assign 
Functions to all of the query items, or to none of the query 
items. Therefore, if any one of the query items does not have an 
applicable aggregate function, you cannot assign an aggregate 
function to any of the query items.
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If you selected the Historical Database for your query and are using 
more than one table in the query, the “Specify all field joins for the 
tables” window displays

This window allows you to require that items between two or three 
tables be equal in order to be used in the report. For instance, you might 
want to select the “acd” item from each agent and make a join clause to 
ensure that the report is for the same ACD information across the tables.

15. Highlight an item in one of the table lists.

16. Highlight an item in one or both of the remaining table lists.

17. Select the Join button. 

The join clause is shown in the Join Criteria box.

18. Repeat Steps 15 through 17 until all of the necessary join clauses are 
listed.
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19. The Query Assistant “Enter the SQL WHERE criteria” window displays, 
as shown below.

This window is where you will define the SQL “where” clauses that will 
be used to retrieve data for the report. The SQL where clause tells the 
CMS to retrieve the data defined in the SELECT box that matches the 
criteria defined in the WHERE box. The SELECT box specifies which 
columns of data to consider in the database table(s). The WHERE box 
species which rows of data to consider in the database table(s).

For more information on SQL where clauses, see the “SQL Query and 
CMS Database Tables Basics” chapter of this book.

Note If you are creating an Historical query, a Unique check box 
displays next to the SELECT box. Select this check box to make 
this query unique in the current report. What this means is that, 
if the query returns multiple rows of the same data, then only 
one row of the data will display on the report.
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This window includes the following elements:

Item Purpose

SELECT 
box

Shows the Query Items that were defined on the 
previous windows, including the database items and 
calculations and any associated functions assigned to 
the items, and the database table from which the 
database items and calculations are to be retrieved.

The information displayed in the SELECT box cannot 
be edited.

Operand1 
box

Lists the database items and calculations that can be 
used in the WHERE clause.

Operator 
box

Lists the standard mathematical operations that can be 
used in the WHERE clause.

Operand2 
box

Lists the database items, calculations, and inputs that 
can be used in the WHERE clause and as inputs for the 
input window.

WHERE 
box

Shows the current WHERE clause.

AND 
button

Places an AND before the currently selected 
Operand1, Operator, and Operand2.

OR button Places an OR before the currently selected Operand1, 
Operator, and Operand2.

New Input Takes you to the Edit Inputs window, where you can 
add new input fields for the Report Input window. 
Any new inputs you add will appear in the Operand2 
box.

Test button Allows you to test the query for basic SQL syntax 
errors.
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20. In the Operand1 box, highlight the first database item or calculation 
which you want considered in the WHERE clause.

21. In the Operator box, highlight the appropriate operation.

22. In the Operand2 box, highlight the second item (input, database item, 
calculation, or item defined in the Other box on the “Add the database 
items and calculations for the SELECT portion of the query” window) 
which you want considered in the WHERE clause.

For example, using the data shown in the window sample above, if you 
wanted the report to select the data from the table when the number of 
ACDCALLS is greater than the number of ACWINCALLS, then you 
would select acdcalls in the Operand1 box, the > sign in the Operator 
box, and ACWINCALLS in the Operand2 box.

23. Select the AND or the OR button, as appropriate.

If you place “and” between clauses, then both of the clauses must be 
true in order for CMS to retrieve the SELECT data from the table.

If you place “or” between clauses, then either of the clauses can be true 
in order for CMS to retrieve the SELECT data from the table.

24. Repeat Steps 20 through 23 until you have completed the query.

Note The ACD operand is automatically added to the beginning of 
each WHERE clause.

Note You can add your own text in the WHERE clause (such as 
parenthesis and numbers) by placing your cursor where you 
would like the text to appear and then typing in the text.

Note If you are creating a report that will display data for multiple 
splits/skills or VDNs on multiple ACDs, you can type 
MULTI_ACD in the where clause, instead of entering each 
individual OR statement. This will only work if you have 
correctly set up the inputs for the multi-ACD report. See the 
Edit | Inputs chapter for information on setting up the inputs 
for a multi-ACD report.
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25. Select the Test button.

CMS checks the syntax of the query and returns a message with any 
errors.

For information on the most common query errors, see Chapter 15, 
“Error Messages,” in this book. 

Note that some errors are not detected until you run the report.

26. Correct any of the errors detected in the Test.

27. Select the Next button.

The Query Assistant “Enter a name for this query” window displays:

28. In the Name text box, type the name that you would like to assign to the 
query you created.

29. Select the Done button.
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Creating an Integrated Query 6

To create a new query to be used in a designer report, complete the 
following steps from the Report Designer Design Mode window:

1. Select Query from the Edit menu.

The Query Select window displays:

2. Select the New button.
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The Query Assistant “Select a database and one or more tables for the 
query” window in displays:

3. Select the Database radio button next to Integrated.

The tables that are available for integrated reports display.

4. In the Table list, highlight the name of the table which includes the 
database items or calculations that you want to include in the query.

For integrated reports, you can select one table per query.

For information on the database items and calculations available in each 
table, see Appendix A, “Database Items and Calculations,” in this 
document.

5. Select the Next button.

The Query Assistant “Add the database items and calculations for the 
SELECT portion of the query” window displays, as shown below. On 
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this window, you will add and remove database items and calculations 
that will be included in the query.

6. In either the Database Items or Calculations box, highlight the first 
database item or calculation that you will reference in the query.

7. Select the Add button.

The item is listed in the Query Items box.

8. Repeat Steps 6 and 7 until all of the database items and calculations that 
you believe will be referenced in the query are listed in the Query Items 
box.

9. Select the Next button.
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The Query Assistant “Enter the start time for this integrated query” 
window displays:

10. Select the Input Start Time or Select Start Time Now radio button. 

If you select the Select Start Time Now radio button, you need to define 
the time that the integrated data will always begin accumulating for this 
report.

If you select the Input Start Time, a “Start Time” field will be added to 
the report input window and users can individually define the time that 
data will begin accumulating for the report.

11. Select the Next button.

831.bk : edit_queries.fm  Page 18  Wednesday, November 27, 1996  1:46 PM



 Creating an Integrated Query 6-19

Edit | Queries -- Defining Data for Report Fields

C
ha

pt
er

 6

The Query Assistant “Select the input used to indicate the xxx for this 
query” window displays:

On this window, you can choose the input item that will be used for the 
query.

12. Highlight the input(s) you would like to use as criteria for the query. You 
can create a new input by selecting the New Input button, which takes 
you to the Edit Inputs assistant.

13. Select the Next button.

Note Only the inputs that apply to the table you selected for this 
query will appear.

831.bk : edit_queries.fm  Page 19  Wednesday, November 27, 1996  1:46 PM



6-20 Creating an Integrated Query

Edit | Queries -- Defining Data for Report Fields

The Query Assistant “Enter a name for this query” window displays:

14. In the Name text box, type the name that you would like to assign to the 
query you created.

15. Select the Done button.
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Editing an Existing Real-Time or Historical 
Query 6

To edit an existing real-time or historical query used in a designer report, 
complete the following steps from the Report Designer Design Mode 
window:

1. Select Query from the Edit menu.

The Query Select window displays:

2. In the Queries box, highlight the name of the query you would like to 
edit.

3. Select the Edit button.

The Query Assistant “Add the database items and calculations for the 
SELECT portion of the query” window displays, as shown below. The 
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Database Items and Calculations that are already included in the query 
are listed in the Query Items list.

4. If you would like to add database items or calculations to the Query 
Items list, highlight the item in the Database Items or Calculations box 
and then select the Add button.

If you would like to remove a database item or calculation from the 
Query Items list, highlight the item in the list and then select the 
Remove button.

If you would like to edit a database item or calculation on the Query 
Items list, highlight the item in the list and then select the Edit button. 
The following window displays:
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An example of how you might want to edit an item would be to create a 
custom calculation in the edit box. For instance, you may add 
“callsoffered -” to the abncalls item shown above, so that the item would 
then read “callsoffered - abncalls” and that is the calculation that would 
be available for you to use in the query.

5. Repeat Step 4 until all of the database items and calculations that you 
believe will be referenced in the query are listed in the Query Items box.

6. Select the Where button.

The Query Assistant “Enter the SQL WHERE criteria” window displays, 
as shown below.

This window is where you will define the SQL “where” clauses that will 
be used to retrieve data for the report. The SQL where clause tells the 
CMS to retrieve the data defined in the SELECT box that matches the 
criteria defined in the WHERE box.

For more information on SQL where clauses, see the “SQL Query and 
CMS Database Tables Basics” chapter of this book.
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This window includes the following elements:

7. In the Operand1 box, highlight the first database item or calculation 
which you want considered in the WHERE clause.

8. In the Operator box, highlight the appropriate operation.

9. In the Operand2 box, highlight the second database item or calculation 
which you want considered in the WHERE clause.

Item Purpose

SELECT 
box

Shows the Query Items that were defined on the 
previous windows, including the database items and 
calculations and any associated functions assigned to 
the items, and the database table from which the 
database items and calculations are to be retrieved.

Operand1 
box

Lists the database items and calculations that can be 
used in the WHERE clause.

Operator 
box

Lists the standard mathematical operations that can be 
used in the WHERE clause.

Operand2 
box

Lists the database items and calculations that can be 
used in the WHERE clause.

WHERE 
box

Shows the current WHERE clause.

AND 
button

Places an AND before the currently selected 
Operand1, Operator, and Operand2.

OR button Places an OR before the currently selected Operand1, 
Operator, and Operand2.

New Input Takes you to the Edit Inputs window, where you can 
add new input fields for the Report Input window.

Test button Allows you to test the query for basic SQL syntax 
errors.
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For example, using the data shown in the window sample above, if you 
wanted the report to select the data from the table when the number of 
ACDCALLS is greater than the number of ACWINCALLS, then you 
would select acdcalls in the Operand1 box, the > sign in the Operator 
box, and ACWINCALLS in the Operand2 box.

10. Select the AND or the OR button, as appropriate.

If you place “and” between clauses, then both of the clauses must be 
true in order for CMS to retrieve the SELECT data from the table.

If you place “or” between clauses, then either of the clauses can be true 
in order for CMS to retrieve the SELECT data from the table.

11. Repeat Steps 7 through 10 until you have completed the query.

12. Select the Test button.

CMS checks the syntax of the query and returns a message with any 
errors.

13. Correct any of the errors detected in the Test.

14. Select the Save button.

15. The changes to the query are saved and the Query Select window 
displays.

Note You can add your own text in the WHERE clause (such as 
parenthesis and numbers) by placing your cursor where you 
would like the text to appear and then typing in the text.
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Editing an Existing Integrated Query 6

To edit an existing integrated query used in a designer report, complete the 
following steps from the Report Designer Design Mode window:

1. Select Query from the Edit menu.

The Query Select window displays:

2. In the Queries box, highlight the name of the integrated query you 
would like to edit.

3. Select the Edit button.

The Query Assistant “Add the database items and calculations for the 
SELECT portion of the query” window displays, as shown below. On 
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this window, you will add and remove database items and calculations 
that will be included in the query.

4. In either the Database Items or Calculations box, highlight the first 
database item or calculation that you will reference in the query.

5. Select the Add button or double click on the item.

The item is listed in the Query Items box.

6. Repeat Steps 4 and 5 until all of the database items and calculations that 
you believe will be referenced in the query are listed in the Query Items 
box.

7. Select the Next button.
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The Query Assistant “Enter the start time for this integrated query” 
window displays:

8. Select the Input Start Time or Select Start Time Now radio button. 

If you select the Select Start Time Now radio button, you need to define 
the time that the integrated data will always begin accumulating for this 
report.

If you select the Input Start Time, a “Start Time” field will be added to 
the report input window and users can individually define the time that 
data will begin accumulating for the report.

9. Select the Next button.
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The Query Assistant “Select the input used to indicate the xxx for this 
query” window displays:

On this window, you can choose the input item that will be used for the 
query.

10. Highlight the input(s) you would like to use as criteria for the query. 
You can create a new input by selecting the New Input button, which 
takes you to the Edit Inputs assistant.

11. Select the Save button.

Note Only the inputs that apply to the table you selected for this 
query will appear.
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Copying a Query 6

To copy an existing query, complete the following steps from the Report 
Designer Design Mode:

1. Select Query from the Edit menu.

The Query Select window displays:

2. In the Queries box, highlight the name of the query you would like to 
copy.

3. Select the Copy button.
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The Copy Query window displays:

4. In the To text box, type the name you would like to assign to the copied 
query.

5. Select the OK button.

The query is copied to the new name and the Query Select window 
displays, including the new query in the Queries list.
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Deleting a Query 6

To delete an existing query, complete the following steps from the Report 
Designer Design Mode:

1. Select Query from the Edit menu.

The Query Select window displays:

2. In the Queries box, highlight the name of the query you would like to 
delete.

3. Select the Delete button.

A message confirming the delete displays.

4. Select OK to delete the query.

Caution If you delete a query that is used in the report, the report will not 
run.
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Once you have defined queries (see the Edit | Queries chapter) to be used 
for a report, you can use those queries to add a chart to your report using the 
Chart Assistant, which is accessed by selecting Chart from the Insert menu.

This chapter includes the following sections:

● Inserting a chart on the report

● Using the Chart Assistant “Select the query and data items you wish to 
plot on the chart” window (Steps 2 through 4)

● Using the Chart Assistant “Specify a chart type” window (Steps 5 
through 9)

● Using the Chart Assistant “Make category and series selections” 
window (Steps 10 - 15).
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Note There are two things to keep in mind when inserting charts onto the 
report:
• When you insert a chart on a report, the chart is shown with 

sample data to help you visualize how the chart will appear 
when you run the report.

• Each item is initially inserted in the upper left hand corner of the 
report. You will need to drag-and-drop the chart to the location 
at which you would like it to display on the report 

Note If you would like to edit a chart, select the chart and then choose 
Chart from the Format menu.
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Inserting a Chart on a Report 7

To insert a chart in your report, complete the following steps:

1. Select Chart from the Insert menu.

The first window of the Chart Assistant displays:

2. From the Queries drop-down list, select the query from which you want 
to take data for the chart. Note that any queries that have been created, 
but still include errors are grayed-out.

Note If the report includes both a chart and a grid, you need to place the 
chart above the grid on the report. The reason for this is that, if the 
grid spans multiple pages when printed and the chart is below the 
grid on the report, then the grid will print on top of the chart.

Note Do not position any fields or text on top of the chart because the 
chart will display on top of the field/text and the field/text will not 
be visible.
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The Available Data box is populated with the data that was previously 
defined for the query.

3. Use the Add, Add All, Remove, and Remove All buttons to add and 
remove items from the Available Data box to the Data on Chart box.

Use the Move Up and Move Down buttons to arrange the items in the 
order in which you would like them displayed on the chart.

Items that are added to the Data on Chart box will be shown in the chart 
you are creating.

The maximum number of columns that can be included on a chart is 16.

If you are creating a chart that will use categories and series as controls 
on the axis, you need to make sure that the first item listed on the Data 
on Chart box is the item that you want to use as the series for the chart.

4. Select the Next button.

The “Specify a chart type” window of the Chart Assistant displays:
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5. Select the 2D radio button if you would like the chart to display in two 
dimensional format.

Select the 3D radio button if you would like the chart to display in three 
dimensional format.

6. Select which type of chart you would like to display from the Chart 
Types box. If you are not sure what each type of chart will look like, you 
can highlight the type and an example of the chart displays on the right-
hand side of the window.

7. Select the Stacked, % Axis, and Gradient check boxes, as appropriate. 
Note that you must select Stacked if you want to select % Axis.

8. Select the Rolling check box if you want the real-time chart report to 
scroll through the refreshes as they occur. If you select the Rolling check 
box, you need to define the Number of Data Points (refreshes) that will 
be included on the chart.

9. Select the Next button.

Note Any of the options you select in the following steps can be changed 
at any time after you insert the chart on the report by selecting the 
Format | Chart menu item.
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The “Make category and series selections” window displays:

This window is where you define how the data will be displayed on the 
axes of the chart 

There are three columns used to define the category and series for the 
chart. The information gathered by each column is as follows:
● Column 1 — Category (can be “none”)
● Column 2 — Series (usually Split)
● Column 3 — Data

In the following example, the Category (Column 1) is the Time that was 
selected on the input window, the Series are the Splits that were selected 
on the input window, and the Data is the data that was retrieved from 
the CentreVu CMS database for those splits/skills on the specified date 
for the specified time period. 
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10. In the Category Available Data box, select the database item that you 
would like to use as the category for the chart. The Category is usually 
“none” for real-time charts, or a time database item for historical charts. 
As you select from the list of available items, the currently selected item 
moves to the top of the Available Data list and the example on the right 
side of the window reflects what the chart might look like with that item 
selected as the chart Category.

11. Select the Show Value as Name check box if you would like to show the 
selected category as a Dictionary name. Note that this check box is only 
available when the selected category is an item that can be defined in the 
Dictionary.

12. Select the Format in which the category will display. Use the drop-down 
list to select for the applicable formats for the selected category. If you 
would like to view all of the available formats for all types of data, select 
the Show All Formats check box.

Category
Series

Data

(Column 1)
(Column 2)

(Column 3)
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13. Select the One Data Value per Row check box to show one line of data 
when multiple rows of data are retrieved in the query. When One Data 
Value per Row is selected, the first item listed in the Category Available 
Items box is the item that is used for the chart category.

The previous example showed a report with One Data Value per Row 
selected. Below is an example of the same report, using the same 
Category item (STARTTIME), without One Data Value per Row 
selected.

In the first example, you can see that the report shows one “row” of data 
for the interval beginning at 10:00 AM, one “row” of data that includes 
information for each split/skill for the interval beginning at 10:30 AM, 
and one “row” of data for the interval beginning at 11:00 AM. In the 
second example, There is a “row” of data shown for each split/skill for 
each interval.

14. Select the Done button.
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The time or date when a report is run is not stored in any database table. 
CMS, if requested, displays information from the start time specified by the 
user (for integrated and historical data).Similarly, CMS knows what the 
currently selected ACD is when you run a report and can display the current 
ACD name or number on the report.

The Field Assistant (accessed by selecting Field from the Insert menu) 
allows you to insert fields in a designer report to display the report's run-
time, run-date, current ACD, data, and/or any of the fields that were 
required in the report input window. 

See the following sections for instructions on adding any of the available 
types of fields to the report.

● Using the Field Assistant “Select a field type” window

● Inserting an ACD field on the report

● Inserting a Data Item field on the report, including Using the Field 
Assistant “Select a query and associated data item for this field” 
window

● Inserting an Input Value field on the report, including using the Field 
Assistant “Select an input for your field” window.
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● Inserting a Start Time field on the report

● Inserting a Time Report Run field on the report.

Note Each item is initially inserted in the upper left hand corner of the 
report. You will need to drag-and-drop the field to the location at 
which you would like it to display on the report 

Note If you would like to edit a field, select the field and then choose 
Field from the Format menu.
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Using the Field Assistant “Select a field type” 
window 8

To use this window, complete the following steps:

1. Select Field from the Insert menu.

The Field Assistant “Select a field type” window opens.

2. Select an item from the Types list.

3. If you highlighted ACD Name, Report Data Start Time, or Time Report 
Run, skip to Step 4.

If you highlighted Data Item, then select the Next button. Go to the 
Field Assistant “Select a query and associated data item for this field” 
window, which appears when you select Data Item from the Types list.

If you highlighted Input Value, then select the Next button. Go to the 
Field Assistant “Select an input for your field” window, which appears 
when you select a Input Value from the Types list. 

4. Select the Done button.

The field is inserted in the upper left-hand corner of the report.
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Inserting an ACD Name Field on the Report 8

To insert the name of the ACD for which the report was run, complete the 
following steps:

1. Select Field from the Insert menu.

The Field Assistant wizard opens.

2. Highlight ACD Name in the Types box.

3. Select the Done button.

The ACD name field is placed in the upper left-hand corner of the 
report.

4. Click on the item and drag-and-drop it to the location at which you 
would like it displayed in the report.

Note Do not position the field on top of any grids or charts because the 
grid/chart will display on top of the field and the field will not be 
visible.
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Inserting Data Item Fields on the Report 8

To insert data item fields on the report, complete the following steps:

1. Select Field from the Insert menu.

The Field Assistant wizard opens.

2. Highlight Data Items in the Types box.

3. Select the Next button.

The “Select a query and associated data item for this field” window 
displays.

Note Do not position the field on top of any grids or charts because the 
grid/chart will display on top of the field and the field will not be 
visible.

Note Before you can insert a data item on a report, the data item must be 
used in a query that is associated with this report.
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4. Highlight the name of the query from which you would like to select the 
data item.

5. The available data items for the selected query display in the Available 
Data box.

6. Highlight the data item that you want to display on the report.

7. Select the Done button.

The Data Item field is placed in the upper left-hand corner of the report.

8. Click on the item and drag-and-drop it to the location at which you 
would like it displayed in the report.
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Inserting Input Value Fields on the Report 8

To insert input value fields on the report, complete the following steps:

1. Select Field from the Insert menu.

The Field Assistant wizard opens.

2. Highlight Input Value in the Types box.

3. Select the Next button.

The “Select an input for your field” window displays.

4. Highlight the name of the input that you would like to show on the 
report

OR

Note Do not position the field on top of any grids or charts because the 
grid/chart will display on top of the field and the field will not be 
visible.

831.bk : insert_field.fm  Page 7  Wednesday, November 27, 1996  1:46 PM



8-8 Inserting Input Value Fields on the Report

Insert | Field -- Creating Text Fields on the Report

Create a new input by selecting the New Input button. The Edit Inputs 
wizard opens. For information on creating inputs for a report, see the 
Edit | Inputs chapter of this book.

5. Select the Done button.

The Input Value field is placed in the upper left-hand corner of the 
report.

6. Click on the item and drag-and-drop it to the location at which you 
would like it displayed in the report.
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Inserting Report Data Start Time Field on the 
Report 8

To insert the initial start time (the time at which data began accumulating) 
for an integrated report, complete the following steps:

1. Select Field from the Insert menu.

The Field Assistant wizard opens.

2. Highlight Report Data Start Time in the Types box.

3. Select the Done button.

The Report Data Start Time field is placed in the upper left-hand corner 
of the report.

4. Click on the item and drag-and-drop it to the location at which you 
would like it displayed in the report.

Note Do not position the field on top of any grids or charts because the 
grid/chart will display on top of the field and the field will not be 
visible.

Note This type of field applies only to integrated reports.
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Inserting Time Report Run Field on the Report 8

To insert on the report the time at which the report was run, complete the 
following steps:

1. Select Field from the Insert menu.

The Field Assistant wizard opens.

2. Highlight Time Report Run in the Types box.

3. Select the Done button.

The Time Report Run field is placed in the upper left-hand corner of the 
report.

4. Click on the item and drag-and-drop it to the location at which you 
would like it displayed in the report.

Note Do not position the field on top of any grids or charts because the 
grid/chart will display on top of the field and the field will not be 
visible.
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Introduction 9

Once you have defined queries (see the Edit | Queries chapter) to be used 
for a report, you can use those queries to add a grid to the report using the 
Grid Assistant, which is accessed by selecting Grid from the Insert menu.

This chapter teaches you to use the Insert | Grid menu option. The sections 
of the chapter are:

● Inserting a grid on the report

● Using the Grid Assistant “Select a query and associated database items 
for the grid” window (Steps 2 through 4)

● Using the Grid Assistant “Select a grid layout” window (Steps 5 through 
9)

● Using the Grid Assistant “Select an existing query for the Summary line 
on your gird, or create a new one” window (Steps 10 through 11). 

Note Each item is initially inserted in the upper left hand corner of the 
report. You will need to drag-and-drop the grid to the location at 
which you would like it to display on the report 

Note If you would like to edit a grid, select the grid and then choose Grid 
from the Format menu.
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Inserting a Grid on the Report 9

To insert a grid on a report, complete these steps:

1. Select Grid from the Insert menu.

The “Select a query and associated database items for the grid” window 
of the Grid Assistant displays:

2. From the Queries drop-down list, select the query from which you want 
to take data for the grid. Note that any queries that have been created, 
but still include errors are greyed-out.

Note If the report includes both a chart and a grid, you need to place the 
chart above the grid on the report. The reason for this is that, if the 
grid spans multiple pages when printed and the chart is below the 
grid on the report, then the grid will print on top of the chart.

Note Do not position text and fields on top of the grid because the grid 
will display on top of the text/field and the text/field will not be 
visible.

831.bk : insert_grid.fm  Page 2  Wednesday, November 27, 1996  1:46 PM



 Inserting a Grid on the Report 9-3

Insert | Grid -- Creating Grids on the Report

C
ha

pt
er

 9

The Available Data box is populated with the data that was previously 
defined for the query.

3. Use the Add, Add All, Remove, and Remove All buttons to add and 
remove items from the Available Data box to the Data on Grid box.

Use the Move Up and Move Down buttons to place the data items 
shown in the Data on Grid box in the order in which you want them to 
appear on the grid.

Items that are added to the Data on Grid box will be shown in the grid 
you are creating.

4. Select the Next button.

The “Select a grid layout” window displays.

Note Any of the options you select in Steps 5 through 10 can be changed 
after you have inserted the grid on the report by selecting the 
Format | Grid menu item.
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5. Define the Orientation of the grid by selecting either the Horizontal or 
the Vertical radio button.

6. Add a Summary line to the grid by selecting the Top radio button to 
place the Totals line at the top of the grid (as standard CMS reports do) 
or the Bottom radio button to place the Totals line at the bottom of the 
grid. Select the None radio button if you do not want to include a Totals 
line on this grid.

7. Select the Headers On check box if you would like to include column 
headers on the grid.

8. Select the Grid Lines On check box if you would like the grid to include 
lines between the columns and rows.

9. If you elected to include no Summary line on the grid, select the Done 
button. The Grid Assistant closes and the grid is placed on the report 
template.

If you elected to include a Summary line on the grid, select the Next 
button.
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The “Select an existing query for the Summary line on your grid, or 
create a new one” window displays.

10. If you would like to create a new query for the summary line on this 
grid, complete the following steps:

a. Select the Build a New Query radio button.

b. Type a name for the summary query in the Name field.

c. Edit the table to include the database items and summary 
information that you feel is appropriate for this summary query.

d. Select the Done button.

If you would like to use an existing query for the summary line on this 
grid, complete the following steps:

a. Select the Select an Existing Query radio button.
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The “Select an Existing query for the Summary line on your grid, or 
create a new one” window for the existing query selection displays.

b. Select the name of one of the existing queries from the drop-down 
Queries list.

11. Select the Done button.
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The Report Designer allows you to include text strings (with no associated 
data) on your report. You will use the Text option from the Insert menu to 
add items such as the report name to your designer reports. 

This chapter teaches you to use the Insert | Text menu option. 

Note Each item is initially inserted in the upper left hand corner of the 
report. You will need to drag-and-drop the text to the location at 
which you would like it to display on the report 

Note If you would like to edit text, select the text and then choose Text 
from the Format menu.
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Inserting Text on the Report 10

To insert a text string on a report, complete these steps:

1. Select Text from the Insert menu.

The Text Assistant displays:

2. Type the text that you want to appear on the report in the Text contents 
field.

3. If you want to select a specific font for the text, select the Font button.

If you want to leave the font set to the default, go to Step 6.

The Font selector window, which is a standard Windows window, 
displays.

4. Select the Font, Style, Point size, Effects, and Script that will apply to 
the text string you are creating.

5. Select the OK button.

The Font selector window closes.

6. On the Text Assistant window, select the OK button to insert the text 
string and close the window.

OR

Note Do not position the text on top of any grids or charts because the 
grid/chart will display on top of the text and the text will not be 
visible.
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Select the Apply button to apply the changes you have made and keep 
the window open.

The text is inserted, by default, in the upper left-hand corner of the 
Design Mode window. You can use the cut, copy, or drag-and-drop 
method, as outlined in Chapter 4, to move the text to the appropriate 
location on the report.
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Introduction 11

The Report Designer allows you to format report charts after they have been 
inserted on the report. You will use the Chart option from the Format menu 
to edit charts on your designer reports. 

This chapter teaches you to use the Format | Chart menu option. The 
sections of this chapter are:

Formatting a Chart in a Report
● General Tab
● Axis Tab
● Data Tab
● Data Labels Tab
● Fonts Tab
● Series Labels Tab
● Legend Tab
● Title Tab
● Type Tab
● 3D Effects Tab.
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Formatting a Chart in a Report 11

Selecting Chart from the Format menu opens the Chart Format Options 
window. The Chart Format Options window gives you access to the 
General, Axis, Data, Data Labels, Fonts, Series Labels, Legend, Title, Type, 
and 3D Effects tabs for formatting charts on reports.

Charts provide a graphical representation of data. Values or data points are 
displayed in formats such as bars, lines, filled areas, and pie charts. These 
data points are grouped into series that are identified with unique colors. In 
many chart types, one data point from each series is grouped together by 
category across an axis. A chart can also have a title and a legend. Categories 
are plotted along the x-axis, values are plotted along the y-axis. A two-
dimensional chart shows series next to each other, while a three-dimensional 
chart plots series along the z-axis. 

Note The changes you make to a report’s format affect only your view of 
the report. The changes do not affect how other CMS users see the 
report unless you are in Design Mode.

Title

Legend

X-Axis

Y-Axis

Z-Axis

Series Labels
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If the report you are designing includes a chart, you can format how the 
chart is displayed and what is displayed on the chart. The formatting is 
done in the Chart Format Options window, which is accessed by:

● Double-clicking on a chart in the report,

● Selecting Chart from the Format menu, or

● Selecting Format Chart from the right mouse button pop-up menu.

The following sections describe each of the tabs.
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The General tab allows you to specify several general options that apply to 
the chart.

General Tab Options 11

The following chart parameters can be changed:

● Background Color — You can specify whether the backdrop of the chart 
is a solid color or whether it is displayed as a gradient, a smooth 
transition from one color to another. The gradient transition can be one 
of the following: Horizontal, Vertical, Rectangle, or Oval. The quality 
of the gradient effect will vary depending on the video card installed in 
the PC, or the capabilities of the printer for printed reports.

● Options — Select the check boxes, as appropriate, to include or grid 
lines, chart borders, and legend borders on the report.

● Real-Time — If the chart is part of a real-time report and is a rolling 
chart, you can specify the number of data points to be displayed in the 
chart. Permitted values are 2 through 100, with 10 being the default. A 
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rolling chart is a line chart that is initially displayed with no data points. 
For each refresh of the report, a data point is added. As data points are 
added, the chart “rolls” from left to right. When enough refreshes have 
occurred that the chart is displaying the number of specified data 
points, at the next refresh, the oldest data point is dropped from the 
display and the newest data point is displayed.

Using the General Tab 11

To use the General tab, complete the following steps:

1. In the Background Color box, select the Report Background, Solid, or 
Gradient radio button.
● If you select Report Background, the background of the report will 

default to the color you set on the Options Report Colors tab which 
is accessed from the Controller Tools menu.

● If you select Solid, you can set the color of the report background by 
clicking on the square next to the Background Color option.

● If you select Gradient, the report background will combine the two 
colors you select in the squares to the right of the Gradient Colors 
option.

You can select the type of gradient that will be used from the drop-down 
list below the Gradient option. The available types are Horizontal, 
Vertical, Rectangle, and Oval.

2. In the Options box, select the check boxes, as appropriate.
● Select Grid Lines On to include the lines between rows and 

columns on any grid that appears on the chart.
● Select Chart Border On to include a border around the chart.
● Select Legend Border On to include a border around the chart 

legend.

3. If the report you are designing is a real-time report, or if this is a real-
time component of an integrated report, you can elect to make the chart 
a rolling chart. To do this, select the Rolling Chart check box and then 
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define the Number of Data Points that you would like displayed on the 
chart. Permitted values for the number of data points are 2 through 100.

4. Select the Apply button to make the changes and keep the Chart Format 
Options window open.

Select the OK button to make the changes and close the Chart Format 
Options window.

831.bk : format_chart.fm  Page 6  Wednesday, November 27, 1996  1:46 PM



 Axis Tab 11-7

Format | Chart

C
ha

pt
er

 1
1

Axis Tab 11

The Axis tab allows you to specify the title that will display on each axis of 
the chart report.

Axis Tab Options 11

The following chart parameters can be changed:

● Axis Display — makes each of the axes visible or invisible. The choices 
are X Axis, Y Axis, 2nd Y Axis, and Z Axis. 

The 2nd Y Axis is only available for bar charts. Selecting this check box 
will display the y-axis information on the right-hand side of the bar 
chart (in contrast to the standard y-axis display on the left-hand side of 
the chart).

The Z Axis is only available for 3D bar charts. Selecting this check box 
will make the chart display with a z-axis, making it appear 3-
dimensional.
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● Category — select the category (database item) that will be used as the 
x-axis on the chart. You can use the drop-down menu to select any of the 
database items you included in the query for this chart. 

— Category for X-Axis: (same as the Available Items box in the Insert 
Query Chart Assistant), select the database item that you would like 
to use as the category for the chart. The Category is usually “none” 
for real-time charts, or a time database item for historical charts.

— Show Value as Name: shows the selected category as a Dictionary 
name.

— Format: use the drop-down list to select for the applicable formats 
for the selected category. If you would like to view all of the 
available formats for all types of data, select the Show All Formats 
check box.

There are three columns used to define the category and series for the 
chart. The information gathered by each column is as follows:
● Column 1 — Category (can be “none”)
● Column 2 — Series (usually Split)
● Column 3 — Data

In the following example, the Category (Column 1) is the Time that was 
selected on the input window, the Series are the Splits that were selected 
on the input window, and the Data is the data that was retrieved from 
the CentreVu CMS database for those splits/skills on the specified date 
for the specified time period.
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● One data value per row — shows one line of data when multiple rows 
of data are retrieved in the query. When One Data Value per Row is 
selected, the first item listed in the Category for X-Axis drop-down list is 
the item that is used for the chart category.

The previous example showed a report with One Data Value per Row 
selected. Below is an example of the same report, using the same 
Category item (STARTTIME), without One Data Value per Row 
selected.

Category
Series

Data

(Column 1)
(Column 2)

(Column 3)
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In the first example, you can see that the report shows one “row” of data 
for the interval beginning at 10:00 AM, one “row” of data that includes 
information for each split/skill for the interval beginning at 10:30 AM, 
and one “row” of data for the interval beginning at 11:00 AM. In the 
second example, There is a “row” of data shown for each split/skill for 
each interval.
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Using the Axis Tab 11

To use the Axis tab, complete the following steps:

1. Depending on the type of chart (bar, line, area, step, clustered bar, 
horizontal bar, or pie, as selected on the Type tab) you are formatting, 
select the appropriate Axis check box.

2. Type the Title you would like assigned to axis in the appropriate text 
box.

3. In the Category for X-Axis box (same as the Available Items box in the 
Insert Query Chart Assistant), select the database item that you would 
like to use as the category for the chart. The Category is usually “none” 
for real-time charts, or a time database item for historical charts. 

4. Select the Show Value as Name check box if you would like to show the 
selected category as a Dictionary name. Note that this check box is only 
available when the selected category is an item that can be defined in the 
Dictionary.

5. Select the Format in which the category will display. Use the drop-down 
list to select for the applicable formats for the selected category. If you 
would like to view all of the available formats for all types of data, select 
the Show All Formats check box.

6. Select the One Data Value per Row check box to show one line of data 
when multiple rows of data are retrieved in the query. When One Data 
Value per Row is selected, the first item listed in the Category for X-Axis 
drop-down list is the item that is used for the chart category.

7. Select the Apply button to make the changes and keep the Chart Format 
Options window open.

Select the OK button to make the changes and close the Chart Format 
Options window.
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Data Tab 11

The Data tab lets you add and remove data items to be used in the chart. The 
available data items are the data items that are specified in the query that 
this chart uses.

Data Tab Options 11

The following chart parameters can be changed:

● Available Data — Lists all of the data items that are available, based on 
the query that is being used, for the chart or grid.

● Data on Chart — Displays the data items that are currently used in the 
chart.
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Using the Data Tab 11

To use the Data tab window, complete these steps:

1. To add data items to the chart, select an item from the Available Data 
list and click the Add button.

2. To remove data items from the chart, select an item from the Data on 
Chart list and click the Delete button.

3. To rearrange the order in which items appear on the chart, select and 
item on the Data on Chart list and use the Up and Down buttons to 
move the item to the appropriate place on the list.

4. Select the Apply button to make the changes and keep the Chart Format 
Options window open.

Select the OK button to make the changes and close the Chart Format 
Options window.
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Data Labels Tab 11

The Data Labels tab allows you to define where the labels of each data point 
on the chart will appear and to define how the labels will be displayed.

Data Labels Tab Options 11

The following parameters can be specified:

● None — No labels displayed.

● Above Point — The label is displayed above the data point. This 
location is valid only for bar, line, area, and step charts.

● Below Point — The label is displayed below the data point. This 
location is valid only for bar, line, area, and step charts.

● Center — The label is displayed centered on the data point. This 
location is valid only for bar, line, area, and step charts.

● Base — The label is displayed along the category axis, directly beneath 
the data point. This location is valid only for bar, line, area, and step 
charts. 
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● Inside — The label is displayed inside a pie slice. This location is valid 
only for pie charts.

● Outside — The label is displayed outside a pie slice. This location is 
valid only for pie charts.

● Left — The label is displayed to the left of the related data point.

● Right — The label is displayed to the right of the related data point.

If data point labels are displayed, you can specify that they include one of 
the following:
● Value — The value of the data point appears in the label.
● Percent — The value of the data point appears in the label as a 

percentage.
● Series Name — The series name is used to label the data point.
● Category Name — The category name is used to label the data point.

Using the Data Labels Tab 11

To use the Data Labels tab, complete the following steps:

1. In the Location box, select the radio button next to the option (None, 
Above Point, Below Point, Center, Base, Inside, Outside) that 
corresponds with the location in which you would like the data point 
labels to display on the chart.

2. In the Show Label Text box, select the radio button next to the option 
(Value, Percent, Series Name, Category Name) that corresponds with 
how you would like the data point labels to display on the chart.

3. Select the Apply button to make the changes and keep the Chart Format 
Options window open.

Select the OK button to make the changes and close the Chart Format 
Options window.

Note The position of data point labels can affect the readability of the 
chart. The label text may overlap in some situations, making it 
difficult or impossible to read the labels.
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Format | Chart

Fonts Tab 11

The Chart Format Options Fonts tab allows you to edit the fonts of the title, 
data point labels, legend, axes and series labels on the chart report.

Fonts Tab Options 11

● Fonts — Lists all of the available report items for which you can edit the 
fonts.

● Choose Font — takes you to the Font selector window, where you can 
edit the font size and style for each type of text.
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Using the Fonts Tab 11

To change the fonts, complete the following steps:

1. Select the Choose font button next to the report item for which you 
would like to change the font.

2. The Font window, which is a standard Windows window, displays.

3. Select the Font, Font style, Size, Effects, Color, and Script which you 
want assigned to the selected text.

4. Select the OK button.

5. The Chart Format Options window displays.

6. Select the Apply button to make the changes and keep the Chart Format 
Options window open.

Select the OK button to make the changes and close the Chart Format 
Options window.
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Legend Tab 11

The Legend tab allows you to control the location of the chart legend.

Legend Tab Options 11

The available options on the Legend tab are as follows:

● Visible check box — allows you to display or not display report 
legends.

● Location of legend — if you elect to have report legends visible, you can 
select where the legend displays. The available options are Top left, Top 
(center), Top right, Left, Right, Bottom left, Bottom (center), and Bottom 
right.

Note Since legends take up space, the drawn chart will be smaller if you 
have selected Visible. To increase the size of the chart, do not select 
the Visible option or maximize the report window.
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Using the Legend Tab 11

To use the Legend tab, complete the following steps:

1. Select the Visible check box to make the legend of the chart appear on 
the report.

2. Select the Location (Top Left, Top, Top Right, Left, Right, Bottom Left, 
Bottom, or Bottom Right) in which you would like the legend to appear 
on the chart.

3. Select the Apply button to make the changes and keep the Chart Format 
Options window open.

Select the OK button to make the changes and close the Chart Format 
Options window.
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Series Labels Tab 11

The Chart Format Options Series Labels tab is where you can edit the labels 
(headings) that are assigned to each data item that is used in a chart.

Series Labels Tab Options 11

● Labels table — Shows the labels that are currently used in the chart. To 
edit the text, place the cursor in the Label column and type the 
appropriate information.
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Using the Series Labels Tab 11

To use the Series Labels tab, complete the following steps:

1. Place the cursor in the table cell that contains the label (heading) you 
would like to modify.

2. Type the new name or edit the existing name.

3. Select the Apply button to make the changes and keep the Chart Format 
Options window open.

Select the OK button to make the changes and close the Chart Format 
Options window.
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Title Tab 11

The Title tab allows you to control the location of the chart title.

Title Tab Options 11

The available options on the Title tab are as follows:

● Visible check box — allows you to display or not display report titles. 

● Location of title — if you elect to have report titles visible, you can select 
where the titles display. The available options are Top left, Top (center), 
Top right, Left, Right, Bottom left, Bottom (center), and Bottom right.

Note Since the title takes up space, the drawn chart will be smaller if you 
have selected Visible. To increase the size of the chart, do not select 
the Visible option or maximize the report window.
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Using the Title Tab 11

To use the Title tab, complete the following steps:

1. Select the Visible check box to make the title of the chart appear on the 
report.

2. In the Title text box, edit the content of the chart title.

3. Select the Location (Top Left, Top, Top Right, Left, Right, Bottom Left, 
Bottom, or Bottom Right) in which you would like the title to appear on 
the chart.

4. Select the Apply button to make the changes and keep the Chart Format 
Options window open.

Select the OK button to make the changes and close the Chart Format 
Options window.
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Type Tab 11

The Type tab lets you change the chart type.

Type Tab Options 11

The available options on the Type tab are:

● 2D and 3D — Changes the chart between 2-dimensional and 3-
dimensional views. 2D charts update faster than 3D charts, so if the 
drawing speed seems too slow, you may want to display charts as 2D.

● Chart Type — Specifies how the data is presented. You choose a chart 
type from the list. The types of charts available vary slightly depending 
on whether a 2D or 3D chart has been selected. All possible chart types 
are listed here:

— Bar Chart (2D and 3D).

— Line Chart (2D and 3D).

— Area Chart (2D and 3D).

— Step Chart (2D and 3D).
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— Horizontal Bar Chart (2D and 3D).

— Clustered Bar Chart (3D only).

— Pie Chart (2D and 3D).

● Stacked check box — Causes the data for all series to be stacked rather 
than shown separately. This check box is disabled for pie charts.

● % Axis check box — causes the value axis (y-axis) to be displayed as 
percentages rather than as actual data values. This can be combined 
with the stacked check box to produce a percentage stacked chart.

Using the Type Tab 11

To use the Type tab, complete the following steps:

1. Select the 2D or 3D radio button, based on whether you would like the 
report to display two-dimensionally or three-dimensionally.

2. Select the Chart Type.

The available types for two-dimensional charts are Bar, Line, Area, Step, 
Horizontal Bar, and Pie.

The available types for three-dimensional charts are Bar, Line, Area, 
Step, Clustered Bar, Horizontal Bar, and Pie.

3. For any type of report, other than Pie, you can select the Stacked check 
box to display all series together rather than separately.

If you select the Stacked check box, you can also select the % Axis check 
box, which causes the y-axis to be displayed as percentages rather than 
as data values.

4. Select the Apply button to make the changes and keep the Chart Format 
Options window open.

Select the OK button to make the changes and close the Chart Format 
Options window.
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3D Effects Tab 11

The 3D Effects tab allows you to control the 3D appearance of the chart. If 
the current chart is a 2D chart, this tab is disabled. 

3D Effects Tab Options 11

The following parameters can be changed:

● Elevation — This is a number from 0 through 90 degrees, and describes 
the relative height from which a chart is viewed. An elevation of 90 
looks directly down on the top of the chart, while an elevation of 0 looks 
directly at the side of the chart. The example charts throughout this 
document use an elevation of 30 degrees.

● Rotation — This is a number from -360 through 360 degrees, and 
specifies the angle that the chart is turned relative to the viewing 
position. The example charts throughout this document use a rotation of 
60 degrees. Rotation does not apply to 3D pie charts.

● Projection — This selects one of three mathematical algorithms used to 
give a 3D appearance on a 2D sheet of paper or computer screen. The 
following values can be chosen:
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— Oblique: The chart has depth but the X-Y plane does not change 
when the chart is rotated or elevated.

— Orthogonal: Perspective is not applied to the chart, resulting in less 
of a 3D effect. The advantage of using this type of projection is that 
vertical lines remain vertical, making some charts easier to read.

— Perspective: This provides the most realistic 3D appearance. Objects 
farther away from you converge toward a vanishing point.
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● Viewing Distance — This is a number from 50 through 1000 that 
represents the distance from which the chart is viewed as a percentage 
of the depth of the chart.

● Width to Height — This is a number from 5 through 2000 that 
represents the percentage of the chart’s height that is used to draw the 
chart’s width.

● Depth to Height — This is a number from 5 through 2000 that 
represents the percentage of the chart’s height that is used to draw the 
chart’s depth.

Using the 3D Effects Tab 11

To use the 3D Effects tab, complete the following steps:

1. Change the degree of Elevation (top to bottom) of the chart by typing a 
new number in the Elevation box.

2. Change the degree of Rotation of the chart by typing a new number in 
the Rotation box.

3. Change the type of Projection used for the chart by selecting a type 
from the Projection drop-down list.

4. Edit the ratios of width to height and depth to height, as appropriate.

5. Select the Apply button to make the changes and keep the Chart Format 
Options window open.

Select the OK button to make the changes and close the Chart Format 
Options window.
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Introduction 12

The Report Designer allows you to format report grids after they have been 
inserted on the report. You will use the Grid option from the Format menu 
to edit grids on your designer reports. 

This chapter teaches you to use the Format | Grid menu option. The 
sections of this chapter are:

● Formatting a Grid in a Report
● General Tab
● Data Tab
● Fonts Tab
● Format Tab
● Headers Tab
● Sort Tab
● Summary Tab.

Note If this grid includes an integrated query, then the Summary tab 
will not display.
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Formatting a Grid in a Report 12

If you are in a report containing a grid (table), you can format how the grid 
is displayed and what is displayed on the grid. The formatting is done in the 
Grid Format Options window, which is accessed by:

● Double-clicking on a column heading in the report, or

● Selecting Format Grid or Sort by from the Format menu list or the right 
mouse button pop-up menu.

— If you select Format Grid, the Grid Format Options window 
displays with the General tab active.

— If you select Sort by, the Grid Format Options window displays 
with the Sort tab active.

The Grid Format Options window allows you to make layout changes to a 
grid. All changes made are saved as part of the report view when you save 
the report.

The following sections describe the Grid Format Options tabs.

Note The changes you make to a report’s format affect only your view of 
the report. The changes do not affect how other Supervisor users see 
the report.
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General Tab 12

The General tab allows you to make format changes to a grid.

General Tab Options 12

The following grid parameters can be changed:

● Show Gridlines — This specifies whether or not grid lines are to be 
shown in the grid.

● Fixed Columns — This specifies the number of columns from the left of 
the grid that are fixed in place and do not scroll. Valid values are in the 
range of 0 through 99. You can use the spin boxes can to select a valid 
value or type the value in.

● Fixed Rows —This specifies the number of rows from the top of the grid 
that are fixed in place and do not scroll. Valid values are in the range of 0 
through 99. You can use the spin boxes to select a valid value or type the 
value in.
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● Orientation — 

— Horizontal — Builds the grid with the column names across the top 
of the grid, so that the grid reads left to right.

— Vertical — Builds the grid with the column names down the left-
hand side of the grid, so that the grid reads top to bottom.

Using the General Tab 12

To use the General tab, complete the following steps:

1. Select the Show Gridlines check box if you want the grid to include 
lines between the columns and rows.

2. In the Fixed Region box, define the number of Columns on the grid that 
will not scroll. You can type the appropriate number or use the up and 
down arrows to select a valid number.

3. In the Fixed Region box, define the number of Rows on the grid that 
will not scroll. You can type the appropriate number or use the up and 
down arrows to select a valid number.

4. In the Orientation box, select the Horizontal radio button if you would 
like the grid to display with the column names across the top of the grid. 
Select the Vertical radio button if you would like the grid to display with 
the column names down the left-hand side of the grid.

5. Select the Apply button to make the changes and keep the Grid Format 
Options window open.

Select the OK button to make the changes and close the Grid Format 
Options window.
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Data Tab 12

Use the Grid Format Data tab to add data items to, remove data items from, 
and reorganize the order of data items on the currently selected grid.

Data Tab Options 12

● Available Data — Lists all of the data items that are available, based on 
the query that is being used, for the chart or grid.

● Data on Grid — Displays the data items that are currently used in the 
grid.
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Format | Grid

Using the Data Tab 12

To use the Data tab window, complete these steps:

1. To add data items to the grid, select an item from the Available Data list 
and click the Add button.

2. To remove data items from the grid, select an item from the Data on 
Grid list and click the Delete button.

3. To rearrange the order in which items appear on the grid, select and 
item on the Data on Grid list and use the Up and Down buttons to 
move the item to the appropriate place on the list.

4. Select the Apply button to make the changes and keep the Grid Format 
Options window open.

Select the OK button to make the changes and close the Grid Format 
Options window.
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Fonts Tab 12

The Grid Format Options Fonts tab allows you to edit the fonts of the data, 
headers, and summary information on the grid report.

Fonts Tab Options 12

● Fonts — Lists all of the available report items for which you can edit the 
fonts.

● Choose Font — takes you to the Font selector window, where you can 
edit the font size and style for each type of text.
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Format | Grid

Using the Fonts Tab 12

To change the fonts, complete the following steps:

1. Select the Choose font button next to the report item for which you 
would like to change the font.

2. The Font window, which is a standard Windows window, displays.

3. Select the Font, Font style, Size, Effects, Color, and Script which you 
want assigned to the selected text.

4. Select the OK button.

The Grid Format Options window displays.

5. Select the Apply button to make the changes and keep the Grid Format 
Options window open.

Select the OK button to make the changes and close the Grid Format 
Options window.
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Format Tab 12

The Grid Format tab allows you to alter the format of each column that is 
included in the grid. The Database Items that make up the columns of the 
grid are listed in the Item column of the Grid table. For each Item, you can 
assign a variety of formatting characteristics.

Format Tab Options 12

● Item — Shows the database item (and table from which the data is 
retrieved) that is used for this column of the grid.

● Show Value As — Use the drop-down list to select the format in which 
you would like the value to be displayed. The Show Value As 
formatting only applies to data types that can be defined in the 
Dictionary.

● Align — Allows you to select the alignment of a field or column in a 
grid. Available options for alignment are Left, Right, and Center.
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Format | Grid

● Format — The options available for the format will depend on the type 
of item you are editing. For instance, a field that displays time will allow 
you to choose from a variety of time formats. A field that is a number 
will allow you to choose from a variety of number formats.

● Show All Formats — You can select the Show All Formats check box to 
display the formats that are available for all field types. Note that the 
selection of this check box is only active during the current use of the 
Format Grid window. The next time you access the window, the check 
box will not be selected.

● Zeros as Blanks — Select this check box to display cells on the grid that 
contain zeros as blank. If you do not select the check box, the cells that 
contain zeros will display zeros.

● Merge with Next — Select the check box to merge this column with the 
column to the right on the grid.

Using the Format Tab 12

To use the Format tab, complete the following steps:

1. In the Item column of the table, select the data item for which you 
would like to edit the formatting on the grid.

2. In the Show Value As column, use the drop-down list to select how you 
would like to have the data item displayed in the grid. The available 
values will vary, depending on the data item.

3. In the Align column, use the drop-down list to select how you would 
like the data item to be aligned on the grid. Available values are Left, 
Right, and Center.

4. In the Format column (if available), select the time format or the number 
format (as appropriate) in which you would like the data item 
displayed. The available choices reflect the specific data item you are 
formatting.

5. In the Show All Formats column, select the check box if you would like 
the Format column to display all of the available data formats, 
regardless of the type of data item that you are working with.
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6. In the Zeros as Blanks column, select the check box if you would like to 
display cells on the grid that contain zeros as blank. If you do not select 
the check box, the cells that contain zeros will display zeros.

7. In the Merge with Next column, select the check box to merge this 
column with the column to the right on the grid.
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Format | Grid

Headers Tab 12

The Headers tab allows you to turn grid headers on and off and to edit the 
text that appears in each column heading of the grid.

Headers Tab Options 12

● Header Option — Select the Show Headers check box if you would like 
the grid report to include the headers.

● Grid Header — This table shows the column headings that are currently 
used on the report.
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Using the Headers Tab 12

To change the column headings on the grid, complete these steps:

1. Place the cursor in the table cell that contains the heading you would 
like to modify.

2. Type the new name or edit the existing name.

3. Select the Apply button to make the changes and keep the Grid Format 
Options window open.

Select the OK button to make the changes and close the Grid Format 
Options window.
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Format | Grid

Sort Tab 12

The Sort tab allows you to specify the order in which the information on the 
real-time grid report is displayed. 

Sort Tab Options 12

● Sort by — When you are setting up display order for a real-time report, 
specify the sort column (Sort By) and the sort order (Ascending or 
Descending). The drop-down list for the Sort By lists all of the database 
table and item names used in the report.

Sort By Criteria Sort Order
Drop-Down Lists
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Using the Sort Tab 12

When you are setting up display order for a real-time or integrated report, 
specify the sort column (Sort By) and the sort order (Ascending or 
Descending). The drop-down list for the Sort By lists all of the database table 
and item names used in the report.

Some examples of sorting are as follows:

● Viewing a list of agents alphabetically — select “Name” from the first 
Sort By drop-down list, select Ascending as the sort order, and leave the 
other two Sort By boxes set to “(none)”.

● Searching for agents who have been in a certain state for too long — 
select “WORKMODE” from the first Sort By drop-down list, then select 
“TIME” from the second Sort By drop-down list, and then select 
Descending as the sort order for the second Sort By.

Note Sorting may cause the report to take longer to refresh. If you wish to 
speed up the refresh rate, turn off the sort options by selecting 
“(none)” for all of the Sort By criteria.
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Summary Tab 12

Use the Grid Format Summary tab to include or exclude summary lines 
from the currently select grid. You can include a summary line for each 
query that is used in the report.

Summary Tab Options 12

● Summary Options — Allows you to include or exclude summary 
(totals) lines on grid reports.

Select the check box to include a summary line on the grid, then select 
the query for which you would like to include a summary.

Note If this grid includes an integrated query, then the Summary tab will 
not display.
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Using the Summary Tab 12

To include a summary line, complete the following steps:

1. Select the Show Summary check box.

2. Select a query from the Query box.

3. Select the Top or the Bottom radio button, based on where you would 
like the summary line to be located.

4. Select the Apply button to make the changes and keep the Grid Format 
Options window open.

Select the OK button to make the changes and close the Grid Format 
Options window.
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Introduction 13

The Report Designer allows you to format report fields after they have been 
inserted on the report. You will use the Field option from the Format menu 
to edit fields on your designer reports. 

This chapter teaches you to use the Format | Field menu option. The 
sections of this chapter are:

● Field Format Window Elements

● Using the Field Format Window.
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Field Format Window Elements 13

Selecting Field from the Format menu opens the Field Format Options 
window. The Field Format Options window is where you will choose the 
formats for fields defined in queries.

The Field Format window includes the following options:

● Field Label Location box — 

— Visible check box — allows you to display or not display report 
legends.

— Location of legend — if you elect to have report legends visible, 
you can select where the legend displays. The available options are 
Top left, Top (center), Top right, Left, Right, Bottom left, Bottom 
(center), and Bottom right.

● Label box — Type a brief description of the field. For instance, for a 
field that displays the name of the split/skill for which the report was 
run, you might label the field “Split/Skill”.
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● Font box — Opens the Font window, which allows you to change the 
Font, Font style, Size, Effects, Color, or Script box, or the OK, Cancel, or 
Help button to access quick definitions of the window elements.

● Field Content Format box — Shows the query and the database item 
that this field is associated with.

● Align box — Allows you to select the alignment of a field or column in a 
grid. Available options for alignment are Left, Right, and Center.

● Format — Use the drop-down list to select the format in which you 
would like the value to be displayed.

● Show Value as Name — Shows the field as name.

● Font box — Opens the Font window, which allows you to change the 
Font, Font style, Size, Effects, Color, or Script box.

Note Under field content, Effects and Color are not available.
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Using the Field Format Options Window 13

To format a field on your report, complete the following steps:

1. Select the field on the report.

2. Select Field from the Format menu.

The Field Format Options window displays. This window allows you to 
create a label (heading) for the field and to edit the format of the field 
itself.

3. To create or change a label (heading) for the field, complete the 
following steps in the Field Label box:

a. Select the Visible check box.

b. Select the Location (Above, Below, Left, or Right) at which you 
would like the label to appear in relation to the field by selecting the 
appropriate radio button.

c. In the Label field, type the word(s) that you would like the label to 
display.

d. To change the font of the label, select the Font button to access the 
Font window.

4. To edit the format of the field, complete the following steps in the Field 
Content box:

a. Select the format in which the field will display from the Format 
drop-down list.

The options available for the field format will depend on the type of 
field you are editing. For instance, field that displays time will allow 
you to choose from a variety of time formats. A field that is a 
number will allow you to choose from a variety of number formats.

You can select the Show All Formats check box to display the 
formats that are available for all field types.

b. Select the alignment of the field from the Align drop-down list.

The options available for alignment are Left, Right, and Center.
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c. Select the Show Value as Name check box if you are editing a field 
that displays a CMS entity (split/skill, agent, etc.) that can be named 
in the Dictionary and you would like the Dictionary name for the 
field to display instead of the number.

d. To change the font of the field, select the Font button to access the 
Font window.

5. Select Apply to apply the changes, but keep the Field Format Options 
window open for additional changes.

Select OK to apply the font changes and close the Field Format Options 
window.
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Introduction 14

The Report Designer allows you to format the font style and size of text that 
appears on a report. You will use the Text option from the Format menu to 
edit text on a report. 

This chapter teaches you to use the Format | Text menu option.
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Selecting Text from the Format menu when a text item on the report is 
selected opens the Text Format Options window. The Text Format Options 
window allows you to change the font display characteristics for the 
selected text.

● Text contents — Type the word or phrase that you would like to insert 
on the report in this text box.

● Text font — Opens the Font window, which allows you to change the 
Font, Font style, Size, Effects, Color, or Script box, or the OK, Cancel, or 
Help button to access quick definitions of the window elements.
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Formatting Text on the Report 14

To format text on a report, complete these steps:

1. Select the text on the report.

2. Select Text from the Format menu.

The Insert Text window displays:

3. Select the Font button. 

The Font selector window, which is a standard Windows window, 
displays.

4. Select the Font, Style, Point size, Effects, and Script that will apply to 
the text string you are editing.

5. Select the OK button.

The Font selector window closes.

6. On the Text Format Options window, select the OK button to accept the 
font changes and close the window.

Select the Apply button to apply the changes you have made and keep 
the window open.
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Introduction 15

This chapter describes the kinds of error messages that Report Designer 
displays and tells you what to do when error messages appear. 

Test design error messages are divided into three categories:

● Phase 1 Error Messages

● Phase 2 Historical Error Messages

● Phase 2 Real-Time Error Messages.

The errors described in this chapter usually are the result of a problem in the 
query that you are testing.
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This section contains Phase 1 error messages. Table 15-2 lists the messages 
alphabetically, and includes a cause and a recommended solution for each 
message. 

Table 15-2:  Phase 1 Error Messages 

Message: $<variable name> not defined

Cause: The where clause contains a variable that is not defined.

Solution: Define the variable using the define input action or remove 
the variable from the row search criteria.

Message: Cannot mix aggregates and nonaggregates in 
the select

Cause: You cannot specify both aggregate columns and 
nonaggregate columns in the same select for real-time 
reports.

Solution: Create two identical row search conditions and apply one to 
the aggregate columns and one to the nonaggregate 
columns.

Message: Cannot use the SYN function for order by

Cause: You cannot use a synonym to sort the output in the query.

Solution: Remove the aggregate from the Order by  field. Use grid 
sorting to order the item.

Message: CMS system error - Check the error log

Cause: A CentreVu CMS system error occurred while the select 
executed. The error should be recorded in the error log.
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Solution: Check the error in the error log to initiate corrective action.
CAUTION: If you run a report that merges data from two 
tables (particularly tables with large amounts of data) into a 
single field and your Select rows where statement is 
not specific enough, you may get this error message. The 
specific cause may be that the number of selected rows is 
very large, and CentreVu CMS does not have enough space to 
create temporary files. If this is the case, you should add 
additional “where” clauses to the row search criteria.

Message: CMS system error - Data collection off

Cause: CentreVu CMS cannot test the row search criteria while data 
collection is off.

Solution: Turn data collection on and rerun test of report design.

Message: CMS system error - Too much data retrieved - 
try a more restrictive search

Cause: Too much data was retrieved with the given row search 
criteria.

Solution: Add more conditions to the row search criteria so that fewer 
rows are retrieved.

Message: CMS system error - Updating translations

Cause: CentreVu CMS cannot test the row search criteria while 
CentreVu CMS is receiving the set of configuration data from 
the switch.

Solution: Wait until configuration data has been sent. Then rerun the 
test of report design.

Message: keyword AVG invalid in where clause

Cause: You cannot use the keyword AVG in row search criteria.

Solution: Remove the keyword AVG from the row search criteria.

Message: keyword BETWEEN invalid for real-time

Table 15-2:  Phase 1 Error Messages  (Contd)
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Cause: You cannot use the keyword BETWEEN in row search 
criteria for a real-time report.

Solution: Remove the keyword BETWEEN from the row search 
criteria.

Message: keyword COUNT invalid in where clause

Cause: You cannot use the keyword COUNT in row search criteria.

Solution: Remove the keyword COUNT from the row search criteria.

Message: keyword MAX invalid in where clause.

Cause: You cannot use the keyword MAX in row search criteria.

Solution: Remove the keyword MAX from the row search criteria.

Message: keyword MIN invalid in where clause.

Cause: You cannot use the keyword MIN in row search criteria.

Solution: Remove the keyword MIN from the row search criteria.

Message: keyword SUM invalid in where clause.

Cause: You cannot use the keyword SUM in row search criteria.

Solution: Remove the keyword SUM from the row search criteria.

Message: keyword SYN invalid in where clause.

Cause: You cannot use the keyword SYN in row search criteria.

Solution: Remove the keyword SYN from the row search criteria.

Table 15-2:  Phase 1 Error Messages  (Contd)
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This section contains the INFORMIX* error codes most likely to appear for 
CentreVu CMS historical reports. Each code includes a description of the 
error and the recommended corrective action.

These errors are reported in the following format:

INFORMIX error: <error number>

In addition, a circumflex (^) may appear in the listed Select statement(s) to 
mark the location of an error.

*INFORMIX is a registered trademark of Informix Software, Inc.

Note If an error code appears that is not listed in this document, see the 
INFORMIX SQL Relational Database Management System Reference Guide for 
INFORMIX SQL.

Table 15-3:  Phase 2 Historical Error Codes 

Error Description/Solution

201 Description: A syntax error has occurred.

Solution: Check that you have not misspelled an RDSQL 
statement, placed key words out of sequence, or included an 
INFORMIX-SQL reserved word in your query.

202 Description: An illegal character has been found in the statement.

Solution: Remove the illegal character (often a nonprintable 
control character) and resubmit the statement

203 Description: An illegal integer has been found in the statement.

Solution: Integers must be whole numbers from -2,147483,647 to 
2,147,483,647. Check that you have not included a number with a 
fractional portion or a number outside the acceptable range. 
Check also that you have not inadvertently entered a letter in 
place of a number (for example, 125p3 instead of 12503 ).
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204 Description: An illegal floating-point number has been found in 
the statement.

Solution: Check that you have not inadvertently entered a letter 
in place of a number (for example, 125p3 instead of 125.03 ).

206 Description: The specified table name is not in the database.

Solution: Check the spelling of the table name in your statement.

217 Description: Column column-name not found in any table in the 
query.

Solution: Correct the spelling of the database item and ensure 
that the item exists in the database table. Check for the presence 
of required commas and quotes.

219 Description: Wildcard matching may not be used with 
noncharacter types.

Solution: Wildcards (*, ?) and characters enclosed in brackets [ ] 
can be used only with CHAR data types. Check the data type for 
the offending column.

220 Description: There is no FROM clause in the query.

Solution: Must include a FROM clause in the query. Check that 
you do not have an illegal character ($, #, &, etc., or a CONTROL 
character) in the line prior to the FROM keyword.

223 Description: Duplicate table name table-name in the FROM 
clause.

Solution: Remove the redundant table name from the statement 
or use an alias to rename one of the tables.

228 Description: cannot have negative characters.

Solution: Check that you have not included a negative CHAR 
data type (for example, -a or -p ) in your statement.

Table 15-3:  Phase 2 Historical Error Codes  (Contd)

Error Description/Solution
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278 Description: Too many ORDER BY columns; maximum is eight.

Solution: Reduce the number of columns included in the ORDER 
BY clause to eight or less.

280 Description: Total size of ORDER BY columns exceeds 120 bytes.

Solution: Reduce the number of columns included in the ORDER 
BY clause so that the total number of characters is less than or 
equal to 120 (perhaps delete a CHAR column of 30 or more 
characters).

282 Description: Found a quote for which there is no matching quote.

Solution: Check that all quoted strings are properly terminated 
with a quote.

284 Description: A subquery has not returned exactly one value.

Solution: Check data for the subquery. Restructure the subquery 
by adding more components in the WHERE clause so that only 
one value is returned.

297 Description: The SELECT list may not contain a subquery.

Solution: Remove the subquery from the SELECT list in the 
statement.

300 Description: There are too many GROUP BY columns (maximum 
is eight).

Solution: Reduce to eight or less the number of nonaggregate 
database items that are assigned the same row search ID as that 
assigned to an aggregate function.

301 Description: The total size of the GROUP BY columns exceeds 
120 characters. 

Table 15-3:  Phase 2 Historical Error Codes  (Contd)

Error Description/Solution
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Solution: The total number of characters in all columns listed in 
the GROUP BY list exceeds 120 characters. Reduce the number of 
nonaggregate database items that are assigned to a row search ID 
that is also assigned to an aggregate function.

303 Description: Expression mixes columns with aggregates.

Solution: Restructure your query so that columns and aggregates 
are not included in the same expression.

309 Description: ORDER BY database item must be included in a 
report field to which the row search ID is assigned.

Solution: Check that database items included in the ORDER BY 
clause appear in the report and are assigned to row search ID.

324 Description: Ambiguous database item.

Solution: A database item in your row search criteria exists in 
more than one table also cited in your row search criteria. 
Prepend each database item with the appropriate table name.

352 Description: Database item not found.

Solution: Check the spelling of the database item.

367 Description: Sums and averages cannot be computed for 
character columns.

Solution: Check that you have not included a database item of a 
string type (VDN, LOGID, etc.) in the aggregate function 
statement.

522 Description: A database item in a field/bar does not exist in the 
table specified in the field’s row search ID.

Solution: Check the Select statement that has the error. The 
database item that does not exist in the table will be marked with 
a circumflex (^). Change or delete the database item or change the 
table in the field’s row search ID.

Table 15-3:  Phase 2 Historical Error Codes  (Contd)

Error Description/Solution
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809 Description: RDSQL syntax error has occurred.

Solution: Check that you have not misspelled an RDSQL 
statement, placed key words out of sequence, or included an 
INFORMIX SQL reserved word in your query.

1202 Description: An attempt was made to divide by zero.

Solution: Check that you are not attempting to divide a 
numerical column type by a character column type (for example. 
16/Jones ) or that the value of the divisor does not equal zero.

1203 Description: Values used in a MATCH must both be type 
CHARACTER.

Solution: Check that the values included in your MATCH 
condition are both CHAR types. Use an alternate comparison 
condition for nonCHAR types.

1204 Description: Invalid year in date.

Solution: Acceptable years are 0001 to 9999. If two digits are 
used, RDSQL assumes the year is 19xx. Check the value entered 
in the date field.

1205 Description: Invalid month in date.

Solution: Months must be represented as the number of the 
month (1 through 12). Check the value entered in the date field.

1206 Description: Invalid day in date.

Solution: Days must be represented as the number of the day (01 
through 31). Check the value entered in the date field.

1226 Description: Decimal or money value exceeds maximum 
precision.

Solution: Increase the precision of the DECIMAL or MONEY 
field.

Table 15-3:  Phase 2 Historical Error Codes  (Contd)

Error Description/Solution
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This section contains the Real-Time Database Manager error codes. Each 
code includes a description of the error and a recommended solution.

These errors are reported in the following format:

CMS Database Manager error: <error number>

In addition, a circumflex (^) appears in the listed Select statement(s) to mark 
the location of an error.

Table 15-4:  Phase 2 Real-Time Error Codes 

Error Description/Solution

1 Description: A syntax error has occurred.

 Solution: Check the select for misspelled keywords or keywords 
that are out of order.

2 Description: An illegal character has been found in the select 
statement.

 Solution: Remove the illegal character (often a nonprintable 
control character).

3 Description: The specified table name is invalid.

 Solution: Check the spelling of the table name and for required 
commas in the From tables  field.

4 Description: An invalid column has been specified (it is not found 
in any of the specified tables).

Solution: Check the spelling of the column names.

5 Description: A mixture of aggregates and nonaggregates are 
being selected, and this is not allowed in real-time reports. (This 
error code can also mean mismatched types in comparison.)
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Solution: Create two identical row search conditions, and apply 
one to the aggregate columns and one to the nonaggregate 
columns.

6 Description: Bad column in the order by clause.

Solution: Check that the column name in the order by clause is 
spelled correctly and that it is being selected by one of the fields 
included in this row search.

7 Description: Bad index in order by clause.

Solution: Order by clause has to have a column in the “select” 
clause or a number that indicates a position of the column in the 
“select” clause.

8 Description: Bad argument given to an aggregate function. For 
example, you cannot take the SUM or AVG of a character column.

Solution: Check the arguments for the aggregates and be sure that 
data type is appropriate.

9 Description: In the “Select” of one of the fields associated with 
this row search, an action is being performed with the wrong data 
types. For example, you cannot use arithmetic with character 
fields.

Solution: Check for these types of errors in the fields associated 
with the row search.

10 Description: Error with subquery.

Solution: There may be a subquery in the WHERE clause that 
CMS does not support. Check the subqueries. This typically 
happens with an Agent Group report (a “select” embedded within 
a “select”).

11 Description: CMS system error.

Solution: Check the error logs.

Table 15-4:  Phase 2 Real-Time Error Codes  (Contd)

Error Description/Solution
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12 Description: Memory allocation error.

Solution: Check the error logs.

13 Description: Query cannot select more than one table.

Solution: Check the error logs.

Table 15-4:  Phase 2 Real-Time Error Codes  (Contd)

Error Description/Solution
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Introduction 16

The most important and difficult part of designing a report is defining the 
data that goes in the report. To define report data, you must first understand 
how CentreVu CMS stores and retrieves data. 

This chapter provides the following CentreVu Call Management System 
(CentreVu CMS) information:

● Standard CentreVu CMS reports that cannot be customized

● CentreVu CMS database items that are not in any standard reports, but 
can be used in reports

● How CentreVu CMS stores and retrieves data.
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How CentreVu  CMS Stores Data 16

CentreVu CMS stores data in the CentreVu CMS database. The database is 
divided into 52 different tables. A table is an array of columns and rows that 
stores data for a type of ACD element (split/skill, agent, trunk, trunk group, 
VDN, vector, call work code, forecasting, agent trace, call records, or 
exceptions) and for a specific time frame (for the current intrahour interval, 
for past intrahour intervals, for past day - summarized by day, and so on). 
Figure 16-2 shows how a small piece of a table (the Current Interval Agent 
table, in this case) might look in the database.
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Figure 16-2:  Sample CentreVu  CMS Table (Current Interval Agent Table)

Note The example in Figure 16-2 shows data for the current intrahour 
interval for agents 1001 to 3009. Because data in this table is in real 
time, data changes second by second. The example represents a 
snapshot (or the most recent update) of the table.
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Figure 16-3 shows how a small piece of the Historical Intrahour Interval 
Split table looks.

Figure 16-3:  Sample CentreVu  CMS Table 
(Historical Intrahour Interval Split Table)
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The CentreVu CMS database uses names to refer to columns of data in a 
table. These names are called database items in CentreVu CMS. In 
Figure 16-2 and Figure 16-3, database items are indicated with arrows 
pointing to their associated columns. The Current Interval Agent and 
Intrahour Interval Split tables actually contain many more columns (and 
hence many more database items) than are shown in the figures. For a 
complete listing of database items, see Appendix A, “Database Items and 
Calculations,” in the CentreVu  CMS R3V5 Reports (585-215-821) document.

Each row in a table contains data that is related by the value(s) of one or 
more of the columns. In Figure 16-2, each row in the Current Interval Agent 
table contains data related by agent login ID. If you look at the row for login 
ID 1006 (displayed in bold), you see that the agent is logged into Split 1 on 
extension 5671 and is currently in AUX work mode. In addition, up to this 
point in the current interval, the agent has had:

● 20 ACD calls (ACDCALLS)

● 245 seconds of ACD talk time (ACDTIME) .

A column that causes the values in a row to be related is called an index. An 
index stores data sequentially and adds structure for the storage of data in 
the other columns. For each value in an index column, the remaining values 
in the corresponding row are related to that value. Thus, in Figure 16-2, the 
LOGID database item is an index.

In Figure 16-3, each row in the Intrahour Interval Split table contains data 
related by date, interval, and split. If you look at the row for Split 1 for the 10 
o'clock interval on July 1, 1993 (displayed in bold), you see that Split 1 had: 

● 509 ACD calls (ACDCALLS )

● 43 abandoned calls (ABANDONS)

● 35,401 cumulative seconds of ACD talk time for all ACD
calls (ACDTIME )

● 851 cumulative seconds of wait time for all calls that abandoned before 
being answered (ABNTIME ).

Note The example in Figure 16-3 shows data from July 1 to July 3, 1993, 
and simulates data for an ACD that has only three splits, 60-minute 
intrahour intervals, and activity each day from 8:00 a.m. to 12:00 
p.m. only.
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How CentreVu  CMS Retrieves Data 16

CentreVu CMS retrieves data from the database based on three types of 
information you supply when you design a report:

● The name of the table

● The database items in the table

● The rows of data in the table.

To tell CentreVu CMS how to retrieve data, you must tell CentreVu CMS to 
access the appropriate database table. Then, for each report field, you assign 
the appropriate database items. When you run the report, CentreVu CMS 
will find, in the table, the columns of data associated with the database 
items.
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Figure 16-4:  Sample 1 of Selection of Database Item
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Next, you identify the appropriate rows that supply data. If you want agents 
in Split 1, you must tell CentreVu CMS to find rows that have the value 1 for 
the SPLIT database item. When you run the report, CentreVu CMS finds 
the appropriate rows of data in the cagent table (see rows with arrows in 
Figure 16-5).

Figure 16-5:  Sample 1 of Selection of Table Rows
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The data that CentreVu CMS reports is the data found in the intersection of 
the selected database items and rows. Therefore, the report shows data as 
shown in Figure 16-6:

Figure 16-6:  Sample Report 1

As mentioned earlier, CentreVu CMS uses indexes to create a structure for 
storing data. Similarly, CentreVu CMS uses these indexes to search for data. 
Indexes allow CentreVu CMS to find data much faster than if data were 
stored more randomly. Therefore, when you design a report, the rows of 
data for the report should be defined on the basis of index values.

As another example of how CentreVu CMS retrieves report data, if you want 
a custom intrahour interval split report that lists, by intrahour interval, data 

a. INFORMIX is a registered trademark of Informix Software, Inc.

Note Actually, when you design a report, you normally set up the row 
selection so that the users running the report can choose the rows in 
the report's input window. For example, to run the report in 
Figure 16-6, you would set up the row selection so users would fill 
out a Report Input window that asked them for a Split number. 

Note The indexes for each standard table are fixed and cannot be 
changed, deleted or added to. However, if you define a custom table 
in the CentreVu CMS database via INFORMIXa SQL, you can define 
any indexes desired for that new table. See the “SQL Query Basics” 
chapter for instructions on creating new database tables.

Split: 1

Current ACD ACD Average
Agent ID: State Calls Time Talk Time

1001 AVAIL 21 988 47:00
1002 AVAIL 19 777 40:09
1003 ACD 15 400 26:07
1004 ACD 9 58 6:44
1005 ACD 11 644 58:54
1006 AUX 20 245 12:25
1008 ACW 18 603 33:50
1010 AVAIL 18 203 11:28
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for a split in a single day, then you must tell CentreVu CMS to access the 
hsplit (Historical Intrahour Interval Split) table. You must then assign the 
appropriate database items to the fields. When you run the report, CentreVu 
CMS finds the columns of data associated with the database items in the 
hsplit table (see Figure 16-7).

Figure 16-7:  Sample 2 of Database Item Selection
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Next, you must identify the appropriate rows that supply data. You might 
want data for the following:

● Split 1, which means you must identify rows that have the value 1 for 
the SPLIT database item.

● The date 07/02/93, which means you must identify rows with the value 
070293 for the ROWDATE database item.

● The intrahour intervals 8:00 a.m. to 11:00 a.m., which means you must 
identify rows with the values 0800 through 1100 for the one database 
item.
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CentreVu CMS then finds the appropriate rows of data (see the boxed rows 
in Figure 16-8).

Figure 16-8:  Sample 2 of Selection of Table Rows
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The data that CentreVu CMS reports is the data found in the intersection of 
the selected database items and columns. Thus, the report shows data as 
follows:

Figure 16-9:  Sample Report 2

Defining data is the central task of creating and designing a report. 
However, you must do many other tasks to create a report. 

Split: 1

ACD
Interval Calls Abandons

08:00am 399 36

Date: 07/02/93

09:00am 400 46
10:00am 394 40
11:00am 418 41
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Introduction 17

The CMS is a relational database that is made of a series of database tables. 
The tables are made up of rows of database items and columns of data. CMS 
reports retrieve data from the database tables and format the data into 
readable grids, charts, and fields.

Reports use SQL (Structured Query Language) queries to retrieve specific 
data from the database tables. You can create and edit queries using the Edit 
| Queries feature of the Report Designer. This chapter gives you information 
about SQL queries, concentrating on the use of WHERE clauses. For 
extensive information on SQL, please refer to your INFORMIX 
documentation.

The sections in this chapter are:

● SQL Query Basics

● CMS Database Table Basics

● Creating a Custom Data Table

● Modifying a Table
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About SQL Queries 17

Reports use SQL (Structured Query Language) queries to retrieve specific 
data from the database tables. You can create and edit queries using the Edit 
| Queries feature of the Report Designer. This section gives you information 
about SQL queries, concentrating on the use of WHERE clauses. For 
extensive information on SQL, please refer to your INFORMIX 
documentation.

SQL queries use WHERE clauses to define the rows and columns of data to 
retrieve from the database tables. The following paragraphs give you 
information on how to create and use where clauses in your queries.

Basic WHERE Clause 17

A basic clause has the following format:

Expression Relational_Operator Value

The Expression can be a database item or calculation. The Value is a 
whole number. Relational operators available for a WHERE clause are as 
follows:

As an example of a basic WHERE clause, if you are creating a real-time 
report using data from the Current Interval Split table and you have three 
report fields for the report:

Split:  (the SPLIT database item)

= equal to

< > or != not equal to

> greater than

>= greater than or equal to

< less than

<= less than or equal to
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ACD Calls: (the ACDCALLS database item)

Average Talk Time: (the calculation ACDTIME/ACDCALLS)

Then the WHERE clause might be:

Select rows where SPLIT = 5

When you run the report, CentreVu CMS finds the row in the table 
(Figure 17-10) for Split 5 and fills in the report fields with data from that row 
(in bold in the figure).

Figure 17-10:  Sample Current Interval Split Table

Thus, the report fields show the following data:

Split: 5

ACD Calls: 451

Average Talk Time: 61 (the result of 27635/451 )

Note This example of row search criteria would also include the selection 
of an ACD. See “WHERE Clause for Selecting Rows from an ACD” 
later in this section.
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WHERE Clause with Variable 17

The previous examples create hard coded row search conditions. That is, 
when you run the report, CentreVu CMS always searches for the values you 
entered in the WHERE clause. However, instead of a hard coded value, you 
can enter a variable name in a clause. A variable name tells CentreVu CMS to 
search for whatever value(s) you or another user choose when you run the 
report. You must define a variable on the Define Input window before using 
it in a WHERE clause. The variable name then links a report input field to 
the WHERE clause that uses the value(s) entered.

Multiple WHERE Clauses 17

To put two or more clauses in a statement, use and or or . Use and to 
define two or more clauses where CentreVu CMS finds only rows that meet 
all conditions. For example, the following statement searches for rows where 
splits had an average speed of answer greater than 30 seconds and 
abandons greater than 100.

Select rows where: ANSTIME/ACDCALLS > 30 and ABANDONS > 100

Use or to define two conditions where CentreVu CMS finds rows that meet 
either condition but not necessarily both. For example, the following 
statement searches for rows where splits had too many abandoned calls or 
too many extension-out calls.

Select rows where: ABANDONS>15 or 
AUXOUTCALLS+ACWOUTCALLS>7

WHERE Clause with a Range/List Variable 17

If a variable name, as defined in the Define Input window, has been 
assigned the Multi-Value option, your WHERE clause must use the equals 
sign (=) with the variable name. In addition, if a variable name has the 
Multi-Value option, the WHERE clause for that variable name should 
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appear in the Select rows where  field before any WHERE clause that 
does not have a Multi-Value variable.

WHERE Clause for Selecting Rows from an ACD 17

In your WHERE statement, Report Designer always includes a clause to 
select the ACD (ACD = $acd )

If you use this default clause, you do not need to define the variable in the 
Define Input window because CMS understands $acd to be the current 
ACD. However, if you wish, you can define a different variable name for the 
ACD database item so the user can specify the desired ACD(s) when 
ordering the report (such as in Multi-ACD reports). You can also hardcode 
the ACD in a WHERE clause, as in the following example.

Select rows where: ACD = 1

WHERE Clause for Excluding Rows of Data 17

If you want to exclude Split 5 from the report, but include all other splits, 
you might enter a WHERE clause as follows:

Select rows where: SPLIT != 5
or
Select rows where: SPLIT <> 5

Caution If a variable name has the Multi-Value option and the 
WHERE clause for that variable name appears in the 
Select rows where  field after a WHERE clause that does 
not have a Multi-Value variable, the report will not show 
accurate data when you run it.
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CMS Database Table Basics 17

The CMS database is a relational database that is made of a series of 
database tables. The tables are made up of rows of database items and 
columns of data. CMS reports retrieve data from the database tables and 
format the data into readable grids, charts, and fields.

This section teaches you about CMS database items and calculations, which 
are names given to commonly used combinations of database items. The 
section also includes a list of all of the available database tables in the CMS.

The following section teaches you to create and edit CMS database tables 
using INFORMIX.

For more information on the CMS database tables and definitions of the 
database items in each table, see Appendix A, “Database Items and 
Calculations” in the CentreVu CMS Reports (585-215-821) document.The 
CentreVu CMS database table names are:

Table 17-5:  Real-Time Table Names 

Name Data Stored

csplit Split/Skill data for the current interval.

psplit Split/Skill data for the previous interval.

cagent Agent data for the current interval.

pagent Agent data for the previous interval.

ctkgrp Trunk group data for the current interval.

ptkgrp Trunk group data for the previous interval.

ctrunk Trunk data for the current interval.

ptrunk Trunk data for the previous interval.

cvector Vector data for the current interval.

pvector Vector data for the previous interval.

cvdn VDN data for the current interval.

pvdn VDN data for the previous interval.

ccwc Call Work Code (CWC) data for the current interval.
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pcwc CWC data for the previous interval.

Table 17-6:  Historical Table Names 

Name Data Stored

hsplit Split/Skill data for each intrahour interval.

dsplit Split/Skill data summarized by day.

wsplit Split/Skill data summarized by week.

msplit Split/Skill data summarized by month.

hagent Agent data for each intrahour interval.

dagent Agent data summarized by day.

wagent Agent data summarized by week.

magent Agent data summarized by month

htkgrp Trunk group data for each intrahour interval.

dtkgrp Trunk group data summarized by day.

wtkgrp Trunk group data summarized by week.

mtkgrp Trunk group data summarized by month.

htrunk Trunk data for intrahour interval.

dtrunk Trunk data summarized by day.

wtrunk Trunk data summarized by week.

mtrunk Trunk data summarized by month.

hvector Vector data for each intrahour interval.

dvector Vector data summarized by day.

wvector Vector data summarized by week.

mvector Vector data summarized by month.

hvdn VDN data for each intrahour interval.

Table 17-5:  Real-Time Table Names  (Contd)

Name Data Stored
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Database Items 17

A database item is the name of a column of data in a table, either standard or 
custom. When you enter a database item, you must always add the name of 
a table and a period (.) as a prefix if more than on table is included in the 
query. The format is <table name>.<database item>.

dvdn VDN data summarized by day.

wvdn VDN data summarized by week.

mvdn VDN data summarized by month.

hcwc CWC data for each intrahour interval.

dcwc CWC data summarized by day.

wcwc CWC data summarized by week.

mcwc CWC data summarized by month.

call_rec Call record data.

agex Agent exceptions.

spex Split exceptions

tgex Trunk group exceptions.

vecex Vector exceptions.

vdnex VDN exceptions.

linkex Link down exceptions.

mctex Malicious call trace exceptions.

f_cday Forecast current day configuration data by split/skill.

f_cdayrep Current day forecast data by split/skill.

haglog Agent login/logout.

ag_actv Agent trace.

call_rec Call records.

Table 17-6:  Historical Table Names  (Contd)

Name Data Stored
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Examples:

dsplit.ACDCALLS

hagent.STARTTIME

ctkgrp.NUMINUSE

Standard Database Items 17

Standard database items are listed in the Dictionary subsystem as 
having all upper-case letters (as in the preceding examples).

A standard database item can store:
● Identifiers (for example, SPLIT , VDN, LOGID , and so on)
● Timed data (for example, ACDTIME, ABANTIME, AUXOUTIME, and 

so on)
● Event counts (for example, ACDCALLS, INTERFLOWCALLS, 

ABNCALLS, and so on)
● For real-time and agent trace reports, current state data (for 

example, WORKMODE, DURATION, NUMINUSE, and so on).

See the “Database Items and Calculations” appendix in the CentreVu 
CMS and Supervisor Reports book for a description of database tables and 
items including the exceptions, forecast, and login/logout tables. 

Custom Database Items 17

You must enter a custom database item, with the custom table name as a 
prefix, exactly as you defined it in the Dictionary subsystem. The data 

Note Standard database items are often shared by more than one 
table. For example, ABNCALLS can identify a column in the 
Current Interval Split, Daily Split, or Intrahour Agent tables (or 
many other tables). 

CentreVu CMS can determine the exact database item only 
when it is identified with a table.
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identified by a custom database item depends entirely on the data you 
entered for the item in the custom table.

Constants 17

A constant is the name of a fixed numerical value (whole number or 
decimal) that you define in the Dictionary subsystem. Constant names can 
be up to 20 characters long. A constant could represent a per-minute usage 
rate for trunks, a daily or hourly wage rate, or a service objective (like 
number of abandons, number of ACD calls, or percent within service level). 
A constant could also represent an average for the estimated dollar loss of 
an abandoned call, which could then be used to calculate daily loss of 
revenue due to abandoned calls. No standard constants exist in CentreVu 
CMS when it is first installed. Therefore, you must define every constant 
you want to use.

Using constants makes sense only if you have a fixed value that you want to 
use under one or both of the following conditions:

● The constant is a value that you will use in a number of different custom 
reports (for example, an average wage rate).

● You would not be able to remember the numerical value, but could 
remember a name assigned to the value (for example, for the $9.00 
hourly wage rate for an agent called Smith, you could have a constant 
called Smithwage .)

Note When you create a custom database table, as described in this 
chapter, keep in mind that all custom database table names need 
to begin with the “c_” prefix. If you do not name the tables with 
the c_, they will not automatically be backed up and they will 
not show up in the Query Assistant.

Note The CentreVu CMS real-time database only allows whole 
numbers in queries. If you need a value to be a decimal (for 
example, 9.5), use whole numbers and division to arrive at the 
correct number (so, in order to have 9.5 in a query, you would 
use 19/2 as the query entry).
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Calculations 17

A calculation is a combination of database items and arithmetic operators. 
You can also include constants in a calculation. The arithmetic operators are:

Some examples of calculations are:

dsplit.ACDCALLS/dsplit.ACDTIME

hagent.AUXOUTTIME+hagent.ACWOUTTIME

100*((cagent.I_ACDTIME+cagent.I_ACWTIME)/
cagent.I_STAFFTIME)

Arithmetic operations are generally performed in order from left to right. 
However, multiplication and division operations are performed before 
addition and subtraction operations, unless the addition or subtraction 
operations are enclosed in parentheses. Operations in parentheses are 
always performed first. If more than one set of parentheses is used, the 
operation in the set farthest to the left is performed first. If one set of 
parentheses is inside of another set, the operation of the inner set is 
performed first.

Calculation names 17

A calculation name is a name, as defined in the Dictionary subsystem, 
that can substitute for the actual calculation. The calculation name can 
be a standard name (used in standard reports) or a name you define. 
You cannot append a table name to a calculation name. Therefore, you 
must specify a table name in the Table for calculations  field.

A calculation name normally reflects the purpose of the calculation. As a 
result, entering a name is an easier, more meaningful way to define data 
for a report field. More importantly, if you use a calculation name in 
many custom reports and later decide to change the calculation, you can 
simply make your changes once in the Dictionary subsystem. CentreVu 

+ add
- subtract
* multiply
/ divide

( ) perform first
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CMS then applies those changes to every report that uses the calculation 
name.

For example, if there are several different custom split reports, and in 
each report, a field uses the standard calculation name 
<PERCENT_ACD_TIME>. <PERCENT_ACD_TIME> represents the 
calculation 100*((I_ACDTIME+I_ACWTIME)/I_STAFFTIME). This 
calculation, when assigned to the Intrahour Split table, finds the 
percentage of time a split's agents spent on ACD calls while logged in. 
The calculation includes talk time (I_ACDTIME) and after-call-work 
time (I_ACWTIME). If you no longer wish to include after-call-work time 
in the calculation, then you can change the calculation in the Dictionary 
subsystem such that <PERCENT_ACD_TIME> represents 
100*(I_ACDTIME/I_STAFFTIME). Any custom report that uses the 
calculation name PERCENT_ACD_TIME reflects the new calculation.

Data from More Than One Table 17

A calculation can merge data from more than one table in a report field.

For example, you may want the percentage of a split's ACD calls that an 
agent handled in a day. Thus, you can enter a calculation that merges 
data from the Daily Agent and Daily Split tables, as in the following 
example.

dagent.ACDCALLS/dsplit.ACDCALLS

When you merge data from two tables, you must define your row search 
conditions in a special way.

Caution If you change the calculation for a standard calculation 
name, the change affects any standard report, as well as any 
custom report, that uses that calculation name.

Caution You should not add table names to your custom calculations 
in the Dictionary subsystem. Doing so makes the assigned 
calculation name less flexible for use in custom reports. Also, 
if you append table names to the Dictionary calculation and 
then also assign a table name to the calculation name in the 
Field window, the report will fail.

Note You cannot use calculation names for a field in which you 
merge data from two tables.
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Creating a Custom Data Table 17

The section of the CentreVu Call Management System (CentreVu CMS) 
database that stores historical ACD data uses the INFORMIX *-SQL 
Relational Database Management System. All historical ACD data available 
for use in custom reports is stored in tables in the CentreVu CMS database. 
You can access INFORMIX and the CentreVu CMS database to build your 
own data tables to contain financial information, schedule information, 
product or service information, or any other type of information you want. 
You can then design historical custom reports to display the data, with or 
without ACD data.

* INFORMIX is a registered trademark of Informix Software, Inc.

Note Instructions on the use of INFORMIX SQL appear in this document 
as a convenience. These instructions are not intended as a substitute 
for the INFORMIX documentation. Except where noted, the 
standard rules of INFORMIX SQL apply, as documented in the 
INFORMIX-SQL Relational Database Management System User Guide 
for INFORMIX SQL Version 4.10. This document is delivered with 
your CentreVu CMS software and documents.

Caution CentreVu CMS does not automatically check the database for disk 
space used by data in custom tables. As a result, you can 
inadvertently fill up your disk with custom data. When this 
happens, you can lose or damage custom data and ACD data. 
Therefore, if you create custom data tables, be careful to check the 
amount of disk space available regularly. See the CentreVu CMS 
R3V5 Administration (585-215-820) document for more 
information on disk storage.
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To define a custom database table, complete the steps defined in the 
following sections.

a. UNIX is a registered trademark of Novell, Inc.

Caution If you back up data using the Maintenance — Backup Data 
window, you will save the data stored in custom INFORMIX 
tables, but you will not save the custom table definitions (table 
names, column names, data types, and so on) unless the custom 
tables were named with the “c_” prefix. As a result, if you lose 
the custom table definitions because of a disk crash, power hit, or 
some other reason, you cannot restore these table definitions via 
the Backup Data window nor can you restore custom data saved 
via the Backup Data window.

Therefore, you should periodically back up data using the UNIX a 

system. Then, if you lose INFORMIX table definitions and/or 
custom data, you can restore the table definitions via UNIX, and 
then, if necessary, restore the custom data. See the CentreVu  
CMS R3V5 Administration (585-215-820) document for procedures 
on backing up data via the UNIX system.

Note The CentreVu CMS supports only the following INFORMIX data 
types:

• SQLSMFLOAT
• SQLFLOAT
• SQLMONEY
• SQLDECIMAL
• SQLSMINT
• SQLINT
• SQLSERIAL
• SQLDATE
• SQLCHAR
• SQLNULL.
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Step 1: Access the CentreVu  CMS Database in
INFORMIX 17

To access the CentreVu CMS database in INFORMIX, use the following steps:

Note In order to perform these procedures, you must have purchased the 
INFORMIX SQL software.

To access the INFORMIX SQL software, you need to log into the CMS 
using CentreVu Terminal.

1a. Press the  SLK. → The Commands submenu appears.

1b. Select the UNIX option. → All windows and menus 
disappear, and the UNIX prompt 
appears.

1c. At the $ prompt, type the 
following command: 
DBPATH=/cms/db/inf .  

Press the  key. Type 
export DBPATH .  Press the 

 key.

→ The UNIX prompt reappears.

1d. At the $ prompt, type the 
following pathname: 
/usr/informix/bin/isql .

 Press the  key.

→ The INFORMIX logo appears, 
followed by the INFORMIX 
Main Menu.

Commands

Return

Return

Return
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Step 2: Build the Table 17

In INFORMIX, you can select menu items in one of two ways:

● Use the arrow keys (→ or ←) to move the cursor to the menu option. 
Then, press .

● Type the first character of the menu option.

Note To escape from a step and go back to the previous step, press the 
Delete key on your keyboard.

2a. At the INFORMIX Main Menu, 
select Table .

→ The Select Database screen 
appears.

2b. Type cms , and press . → The Table menu appears.

2c. Select Create . → The Create Table screen 
appears.

2d. Type a name of up to 18 
characters for the table you are 
building. The table name must 
begin with c_ (a lower-case “c” 
and underscore). For example, 
type c_workcode . Press the 

 key.

→ The Create Table menu 
appears with a highlighted box 
beneath “Column Name.”

2e. Select Add . → The Add Name screen appears.

Return

Return

Return
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The available data types are:

2f. Type a name of up to 18 
characters for the column you 
are adding. If desired, you can 
use names of standard 
CentreVu CMS database items 
only if you enter the name in 
lowercase letters in the 
Dictionary subsystem. The 
Dictionary: Custom Items 
window accepts only 
lowercase letters for custom 
item names that are the same 
as standard database items. 

Press the  key.

→ The Add Type screen 
appears.

Char Character (CHAR) columns store any combination 
of letters, numbers, and symbols.

Number Numeric columns store numbers. The numbers 
stored can be one of the following five types:

• Decimal. A decimal is a number that contains a 
decimal point.

• Smallint. A Smallint column stores integers 
from -32,767 to +32,767.

• Integer. An Integer column stores integers from 
-2,147,483,647 to +2,147,483,647.

• Smallfloat. A Smallfloat column stores floating 
point numbers with up to seven significant dig-
its.

• Float. A Float column stores floating point num-
bers with up to 14 significant digits.

Serial Serial columns store a unique sequence number in 
each row of the table.

Return
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Date Date columns store calendar dates with the format 
mm/dd/yy or dd/mm/yy, depending on your 
Windows operating system.

date-Time The date-Time data type is not supported by CMS.

You must type T in order to select date-Time. 

A date-Time column allows you to specify a database 
qualifier of year, month, day, hour, or minute.

Interval The Interval data type is not supported by CMS. 

An interval column allows you to specify an interval 
qualifier of year, month, day, hour, or minute.

Money The Money data type is not supported by CMS.

If you data will be dollars and cents, you should use 
Decimal.

2g. Select the type of data that the 
field will store.

→ The additional prompts that 
appear differ depending on 
your selected data type.

2h. Complete the definition of the 
column by responding to the 
additional prompts that 
appear. Which prompts appear 
and what order they appear in 
depend on the data type you 
selected The following table 
lists the possible prompts.

→ When you have responded to 
all of the prompts for the 
column, a new highlighted line 
appears in the table, and the 
Add Name  field reappears at 
the top of the screen.

2i. Repeat Steps 2f through 2h for 
each column you want to add.
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Prompt What to Do

PRECISION Select either Smallfloat  or Float . 
PRECISION appears for the Float  type.

INDEX Enter y if you want to make the column an 
index. INDEX appears for all types except 
Serial . A column with the Serial data 
type automatically becomes an index.

Make the column an index only if the column 
will be used for row searches and the table will 
contain more than 200 rows of data.

DUPLICATES Enter y if you want to allow the column to 
contain the same value in different rows. For 
example, if the column were to contain the last 
names of people, you would probably want to 
allow multiple entries (because, for example, 
you might have many different people with 
the last name of Smith).

However, if you were creating a column of 
social security numbers, then you would enter 
n to prevent multiple entries of the same 
number. DUPLICATES appears for all types 
except Serial .

NULLS Enter y if you want to allow the column to 
have rows with no values (versus requiring 
values). For example, if your table is a list of 
customer data and the column you are adding 
is for the customer’s employer, you might 
want to allow the NULL value for the case 
where the person is unemployed. 

Enter n if you want to require a value in each 
row. NULLS appears for all types except 
Serial.
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ADD STARTING 
NUMBER

Enter the number that INFORMIX should use 
as a starting point for numbering rows. 
INFORMIX identifies the first row in the table 
with the number you enter. As each new row 
of data is added to the table, INFORMIX 
assigns that row the next number in the 
sequence. ADD STARTING NUMBER appears 
only for Serial .

NUMERIC Type the first letter of the numeric you want: 
Integer, Smallint, Decimal, or Float.

LENGTH Enter the number of digits the column will 
store for a single piece of data. LENGTH 
appears for Char and Decimal types

SCALE Enter the number of digits that should appear 
to the right of the decimal point. The decimal 
digits, but not the decimal point, occupy part 
of the field length you specified in the 
LENGTH field. SCALE appears after the 
LENGTH for Decimal .

2j. When you have added all 

columns, press the  key 
until the Create Table screen 
appears.

→ The Create Table menu 
appears.

2k. Select Exit . → The Build-new-table menu 
appears.

Prompt What to Do

Return
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2l. Select Build-new-table . → The Table menu reappears. If 
no errors are found, then your 
table has been added. If errors 
are found, then you must go 
back to the Alter Table screen 
and correct these errors. You 
must then repeat steps 2k and 
2l until the Table menu 
reappears.

2m. Select Exit  to return to the 
INFORMIX Main Menu.

→ The INFORMIX Main Menu 
appears.
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Step 3: Add Data to the Table 17

To help you add data to the table, you must first create a data entry form 
associated with your table. For more information about forms, see “Creating 
Your Own Forms” in the INFORMIX-SQL Relational Database Management 
System User Guide. For more information about adding data, see “Entering 
Data,” in the same document.

3a. On the Main Menu, select 
FORM.

→ The FORM menu appears.

3b. Select GENERATE. → The GENERATE FORM 
screen appears.

3c. Enter a name (up to ten 
characters) for the form 
associated with your table. (If 
possible, use the same name as 
the table you created.) Press 

.

→ The CHOOSE TABLE screen 
appears.

3d. Enter the name of the table you 
want to enter data for, and 

press .

→ The Table-selection-complete 
menu appears.

3e. Select Table-selection-
complete .

→ The screen form specification 
was successfully compiled 
appears when processing of 
the form is complete, then the 
FORM menu appears.

3f. Select Run. → The RUN FORM window 
displays the table you selected.

3g. Press the  key. → The PERFORM menu 
appears.

3h. Select Add. → The cursor moves to the first 
column in the table.

Return

Return

Return
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3i. Enter data for the first column 
of the table, and press the 

 key. 

→ The cursor moves to the next 
column.

NOTE: If you get an error 
message, you may have 
entered data in the wrong 
format.

3j. Repeat Step 3i for each column.

3k. Press the  key to save the 
row of data. 

→ Row added  appears. The row 
of data has been added to the 
table and saved.

3l. Repeat Steps 3h through 3k for 
each row of data you want to 
add.

3m. Type e (for Exit) three times 
to exit INFORMIX.

→ The UNIX prompt appears.

3n. Press  . → The CentreVu CMS windows 
and menus that were 
displayed before you accessed 
UNIX reappear.

Note To design a report that uses data from the table, you must also enter 
the column names (database items) in the Dictionary: Database 
Item: Custom Items window.

Caution CentreVu CMS does not automatically check the database for disk 
space used by data in custom tables. As a result, you can 
inadvertently fill up your disk with custom data. When this 
happens, you can lose or damage custom data and ACD data. 
Therefore, if you create custom data tables, be careful to regularly 
check the amount of disk space available. See the CentreVu CMS 
R3V5 Administration (585-215-820) document for more 
information on disk storage.

Return

Esc

Ctrl B
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Modifying a Table 17

Use the following steps to add, change, or delete columns in an existing 
table.

Adding a Column to a Table 17

1. On the INFORMIX Main 
Menu, select Table .

→ The Select Database screen 
appears.

2. Press the  key. → The TABLE menu appears.

3. Select Alter . → The ALTER TABLE screen 
appears. A list of existing 
tables also appears.

4. Enter the name of the table you 
want to change, and press 

. 

→ The ALTER TABLE menu 
appears.

1. Select Add to add a new 
column.

→ The ADD NAME screen 
appears.

2. Complete the fields for the 
new column.

3. Press the  key when you 
have finished adding the 
column(s), and go to Step 3 of 
“Deleting a Column.”

→ The ALTER TABLE menu 
appears.

Return

Return

Del
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Changing a Column 17

Deleting a Column 17

1. Select Modify  to change a 
column.

→ The MODIFY NAME screen 
appears.

2. Use the arrow keys to select a 
field to change.

3. Press the  key when you 
have finished changing the 
column(s), and go to Step 3 of 
“Deleting a Column” in this 
section.

→ The ALTER TABLE menu 
appears.

1. To delete a column, use the 
arrow keys to move the cursor 
to the column. Select Drop .

→ The REMOVE screen appears.

2. Select YES to remove the 
column.

→ The column disappears, and 
the ALTER TABLE menu 
appears.

3. At the ALTER TABLE menu, 
select Exit  when you are 
finished changing the table.

→ The Build-new-table menu 
appears.

4. Select Build-new-table  to 
save your changes. Select 
Discard-new-table to 
ignore your changes.

Del
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Changing Data in a Table 17

Use the following steps to add, change, or delete data in an existing table.

Adding Rows of Data to a Table 17

1. On the INFORMIX Main 
Menu, select  Form .

→ The FORM menu appears.

2. Select Run. → The RUN FORM screen and a 
list of forms appear.

3. Enter the name of a form, and 

press . 

→ The PERFORM menu appears.

1. Select Add to add rows of 
data.

→ The table's column fields 
appear with the cursor in the 
first field.

2. Enter data in the fields. Use 

 or  to move 
between fields.

3. Press  when you have 
added a row of data.

→ The PERFORM menu 
reappears. The message Row 
added also appears.

Return

Return Tab

Esc
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Changing Rows of Data in a Table 17

Deleting Rows of Data From a Table 17

1. To change data in a row, 
display the data you want to 
change. 

To do this, select Query .

→ The table's column fields 
appear, with the cursor resting 
in the first field.

2. Enter data in a column you 
want to search on, and press 

.

→ The column fields fill with data 
for that row.

3. Select Update , and press the 

 key.

→ The Update screen appears.

4. Use the arrow keys to move 
the cursor to the data you want 
to change. Overtype the data, 

and press .

→ The PERFORM menu 
reappears. The message 
This row has been 
changed also appears.

1. To delete a row of data, repeat 
Steps 1 and 2 of “Changing 
Rows of Data in a Table” in this 
section. 

Press .

→ The PERFORM menu 
reappears.

2. Select Remove. → The REMOVE ROW screen 
appears.

3. Select YES to delete the row. → The row of data disappears. 
The message Row deleted  
appears.

Esc

Return

Esc

Esc
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A Database Items and Calculations

General Information 1

This appendix is written for CentreVu Call Management System (CentreVu 
CMS) and Supervisor users who need to understand the use of database 
items and how CentreVu CMS calculates amounts for reports. It is also 
written to help users decide which database items and calculations to use in 
custom reports.

This appendix describes the CentreVu CMS database tables, the items in the 
database tables, and the standard Dictionary calculations that use the 
database items.

The appendix is organized as follows:

● How Database Items and Calculations Are Presented

● Terminology

● Database Table Names

● Interactions with Switch Features and Tracking of Switch Capabilities

● Split/Skill Database Items

● Agent Database Items

● Trunk Group Database Items
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● Trunk Database Items

● Vector Database Items

● VDN Database Items

● Call Work Codes Database Items

● Agent Login/Logout Database Items

● Agent Trace Database Items

● Call Record Database Items

● Exceptions Historical Database Items

● Agent State and Row Search Values Cross-Reference

● Call Disposition and Row Search Values Cross-Reference

● Standard Dictionary Calculations
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AHow Database Items and Calculations Are 

Presented 1

This section outlines how the CentreVu CMS database items and calculations 
are presented later in the appendix.

Database Items 1

This appendix defines every database item used in CentreVu CMS reports. 

Database Item Tables 1

The database items are presented in a table format, according to ACD 
element (split/skill, agent, vector, VDN, trunk, trunk group, exception, 
etc.). Below is an example of how the table information is presented: 

The following database item tables are included in this appendix:
● Split/Skill
● Agent
● Trunk Group
● Trunk
● Vector
● VDN
● Call Work Codes

Table 1: Sample Database Item Table

Database Item Description Type

DATABASE ITEM The definition of the database item is given here. Any 
additional information, such as other database items that 
are included in the sum of the database item, or specific 
switches that the database item applies to, is also listed.

C, A, 
or S
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● Agent Login/Logout
● Agent Trace
● Current Day Configuration (forecasting)
● Current Day Report (forecasting)
● Call Record
● Exceptions.

Many database items appear in more than one database table. When an 
item is in more than one table, the definition may or may not be the 
same from table to table.

Database items that are used in the description of another database item 
are in boldface type.

The index database items in each table are marked. Indexes add 
structure to table rows so that CentreVu CMS can retrieve data faster. 
The row search criteria you define for custom reports should be based 
on indexes whenever possible. For historical custom reports, always 
include a “where” clause based on the ROW_DATE database item.

Each database item contains one of the following types of data:

C =Cumulative data: accumulates throughout the collection interval. 
Most real-time database items contain cumulative data.

A =Administrative data: administered on the switch or on CentreVu 
CMS. For example, the database item INTRVL in the split/skill real-time 
table contains the number of minutes in the intrahour interval (15, 30, 
60) currently assigned to the specified split/skill on CentreVu CMS.

S =Status data: gives the current status (a snapshot of a particular ACD 
element). For example, the database item INQUEUE in the split/skill 
real-time table contains the number of split/skill calls currently waiting 
in queue.

The letter C, A, or S appears in the Type column for each database item.

Cumulative and Administrative data items apply to historical and real-
time database items. Status items apply only to real-time database 
items. 

In addition to the types of data described above, items in the CentreVu 
CMS database can be either call-based or interval-based. Most CentreVu 
CMS database items are call-based. Call-based data is committed to the 
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database after a call completes. Therefore, if a call starts and ends in 
different collection intervals, all of the data is recorded in the interval in 
which the call and any after call work are completed.

Interval-based data represents the amount of time during a collection 
interval spent doing a particular activity. Interval-based items are 
updated throughout the collection interval and timing is restarted at the 
end of the interval. Most interval-based items start with I_ or TI_. The 
database items ALLINUSETIME (trunk-group tables) and 
MBUSYTIME (trunk and trunk-group tables) are also interval-based.

Interval-based items should only be used to calculate percentages such 
as percentage of time staffed or in AUX work. Interval-based items 
should not be used, for example, to calculate average talk time; use call-
based items for this type of calculation. Furthermore, because call-based 
and interval-based items may not track the same events, a calculation 
should use only one type of item and comparisons of call-based 
calculations and interval-based calculations may not be relevant or 
meaningful. For example, the call-based ACD time and interval-based 
ACD time for an agent will not be equal if the agent handled one or 
more ACD calls that crossed over interval boundaries.

Switch Cross-Reference Tables 1

CentreVu CMS database items apply to specific switches. After each 
database item table, is a switch cross-reference table. The switch cross-
reference tables list each database item by switch release. Below is an 
example of how the table information is presented:

Note Report data may not add up if the report has a combination of 
call-based and interval-based items.

Table 1-1:  Sample Switch Cross-Reference Table

Database Item G1
System
85 G2.1 G2.2 G3V1

G3V2/
G3V3 G3V4 ECS

DATABASE ITEM X X X X X X X X

Switch releases that this database item applies to are 
marked with X’s.
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Calculations 1

CentreVu CMS uses calculations of database items in many reports. All 
standard CentreVu CMS Dictionary calculations are listed alphabetically and 
described at the end of this appendix. You can use standard calculations in 
custom reports, or you can create new ones. You should never modify 
standard calculations or the meaning of the data will be changed. Below is 
an example of how the table information is presented:

Table 2: Sample Standard Dictionary Calculations Table

Calculation Name Calculation Description

CALCULATION NAME
(as it appears in the 
CentreVu CMS Dictionary)

Mathematical definition of 
the calculation.

Short description of the 
calculation.
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The following terms are often used in the database item descriptions. 

Abandoned 
Call

A call in which the caller hung up before the call was answered or 
connected. Calls also can be considered abandoned if certain 
timers in the switch time out. See the explanations of the Wait 
Answer Supervision Timer (WAST), the Phantom-Abandon Calls, 
and the Trunk No Answer Timeout (G3V2 and later) (NATO) later 
in this appendix. These timers are used primarily in locations 
where the central office trunks lack disconnect supervision.

Calls may abandon during many phases of processing, including 
during vector processing, after being queued to a split/skill, while 
ringing at an agent or station. The calls that are counted as 
abandons differ depending on the table. The agent table counts as 
abandons those split/skill ACD calls that abandoned while 
ringing at the agent. The split/skill table counts as abandons those 
calls that abandoned while queued to the split/skill or while 
ringing at an agent in the split/skill. The VDN table counts as 
abandons those ACD calls that abandoned while in the VDN, 
including calls in vector processing not yet queued to a split/skill 
(for example, calls that abandoned while listening to an 
announcement), calls queued to one or more splits/skills, calls 
ringing at agents (ACD calls). The definitions in each table state 
which abandons are counted in that table. 

ACD Call A call that queued to a split/skill and was answered by an agent in 
that split/skill or a call that queued as a direct agent call and was 
answered by the agent to whom it was queued. 

831.bk : A_Database_Items_and_Calculations.fm  Page 7  Wednesday, November 27, 1996  1:46 PM



A-8 Terminology

Appendix A - Database Items and Calculations

After Call 
Work 
(ACW)

Work done when the agent is not on a call. There are two types of 
after call work (ACW): call-related ACW and ACW not associated 
with a call. An agent enters a call-related ACW state by 
completing a manual-in call or, on Generic 1 and Generic 3 
switches, by pressing the ACW feature button during an 
automatic-in call, then completing the call. CentreVu CMS tracks 
call-related after call work in the call-based ACWTIME item and 
in the interval-based I_ACWTIME item. 

An agent on a Generic 1 or Generic 3 switch can enter the ACW 
state without having an associated call by pressing the ACW 
feature button while available or in the AUX mode. CentreVu CMS 
will track this ACW time in the I_ACWTIME item, but not in the 
ACWTIME item.

For Generic 1 and Generic 3 switches without the EAS feature, the 
ACW time not associated with an ACD call will be tracked for the 
split whose ACW feature button the agent pressed. For Generic 3 
with EAS, the ACW time not associated with an ACD call will be 
tracked for the first skill administered for and successfully logged 
into by the agent. 

In Generic 3 Version 3 and later Generic releases, an agent in after 
call work who reconnects to a held AUXIN or AUXOUT call will 
return to the after call work mode when the AUXIN/OUT call is 
terminated. The after call work time accrued following the 
termination of the AUXIN/OUT call is after call work not 
associated with an ACD call, thus only counts as I_ACWTIME, not 
as ACWTIME.

For Generic 3 releases prior to Generic 3 Version 3, an agent who 
reconnected to a held AUXIN or AUXOUT call from the after call 
work mode returned to the available state upon completion of the 
call.

Agent The login ID that staffed the extension. This term is often extended 
to mean the person who used the id to staff the extension. In all 
cases, the term agent implies measurement by CentreVu CMS.

831.bk : A_Database_Items_and_Calculations.fm  Page 8  Wednesday, November 27, 1996  1:46 PM



 Terminology A-9

Appendix A - Database Items and Calculations

A
pp

en
di

x 
AAgent 

position 
(no EAS)

The combination of the agent login ID and the split the agent 
logged into. Agents logged into multiple splits have multiple 
positions associated with them. Call data are collected for each 
agent/split combination separately, so that it is possible to report 
on the calls handled and time spent by agents in each of the splits 
they were in. To report on the total work performed by the agent, 
call data must be summed for the agent over all the splits in which 
he or she worked.

Agent 
position 
(with EAS)

The login ID of the agent, regardless of the number of skills 
assigned to the agent. Data are still collected for the agent by skill, 
so the total work for the agent must be summed over all skills in 
which the agent worked. 

Answered 
Call

The agent's state changes to ACD or DACD. The term answered 
is used only for split/skill and direct agent ACD calls. (See 
Connected for non-ACD calls.) For manual answer agents, the call 
is answered when the agent selects the ringing line appearance. 
For automatic answer agents, the call is answered directly after the 
zip tone is applied.

Automatic-
In Mode 
(AI)

In this call answering mode, an agent who releases an ACD call 
receives another ACD call immediately, or if timed ACW is in use, 
after the timed ACW period expires, if there is a call queued. 

AUX Work 
Mode

A work mode in which agents are engaged in non-ACD work. 
This may represent a break or lunch, training, mail, team 
meetings, etc. Extension (non-ACD) calls agents make or receive 
while available in auto-in or manual-in mode are tracked as 
AUXOUT or AUXIN calls.

Connected 
Call

A non-ACD call that rang and did not abandoned at an extension 
(not a split/skill or direct agent call). The System 85 and Generic 
2.1 switches do not notify CentreVu CMS when non-ACD calls 
abandon, so all non-ACD calls that route to an extension are 
tracked as connected calls for these switch releases. For Generic 1, 
Generic 3, and Generic 2.2 switches, only calls that routed to an 
extension are tracked as connected calls.

Default 
Skill 
(Generic 2.2 
EAS)

Every skill that ends with a “0” is called a “default skill,” since 
every agent in the skill group is logged into this skill by default. 
The default skill is the first skill for each skill group. 
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Direct 
Agent ACD 
Call 
(Generic 3)

A call that queues for a specific agent. Direct agent ACD calls can 
be generated by an ASAI adjunct (Generic 3) or by calling an 
agent's login id (Generic 3 switches with EAS), given the proper 
class of restriction for the caller and for the receiving agent. Direct 
agent ACD calls are tracked as ACD calls along with split/skill 
ACD calls in the trunk, trunk group, VDN and vector tables. 
Direct agent ACD calls are tracked separately from split/skill 
ACD calls in the agent tables. Direct agent ACD calls are not 
tracked in the split/skill tables (since they are not split/skill ACD 
calls).

External 
Call

Calls made to off-switch destinations. This includes calls to other 
switches in a DCS network.

Extension 
Call

Calls originated by agents and non-ACD calls received by agents. 
For the Generic 2.2 and Generic 3 switches, these include calls an 
agent makes to set up a conference or a transfer. 

Hold A call placed on hold as a result of the agent pressing the HOLD 
feature button or the hard hold feature access code, by using the 
TRANSFER or CONFERENCE feature button or by flashing the 
switch hook. CentreVu CMS tracks calls on hold only for the switch 
releases that notify CentreVu CMS when calls are placed on hold. 
Releases that notify CentreVu CMS are System 85 and Generic 2.1 
for split/skill ACD calls placed on hold via the HOLD key or 
feature access code. Generic 2.2 and Generic 3 switches notify 
CentreVu CMS for all calls.

Manual-In 
Mode (MI)

A call answering mode in which an agent who releases an ACD 
call is put into the after call work (ACW) mode and must manually 
request another ACD call by pushing the MI button.

Nonprimary
Split/Skill 
(G3 
Vectoring, 
G2.2 EAS)

The second and third splits/skills to which the call queues in a 
VDN are called “non-primary splits/skills.” They are also referred 
to as secondary and tertiary splits/skills, respectively.

Nonzero (0) 
Skill 
(Generic 2.2 
EAS)

Any skill that does not end in “0” is called a “nonzero” skill. 
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Split/Skill 
(G3 
Vectoring, 
G2.2 EAS)

The first split/skill the call queues to in a VDN is called the 
“primary” split/skill. If the call leaves vector processing and 
queues to another split/skill (for example, routes to a split/skill 
extension, or routes to another VDN), then that new split/skill 
becomes the primary split/skill. If the call leaves vector processing 
and does not queue to another split/skill (for example, routes to 
an extension), then there is no new primary split/skill. 

Queued A split/skill or direct agent call that has been directed to a 
split/skill. In the case of the Generic 1 and Generic 3 switches, 
even though the call may never have physically occupied a queue 
slot on the switch (because it could be delivered immediately to an 
agent), CentreVu CMS is still notified that the call queued to the 
split/skill. 

Secondary 
Split/Skill 
(G3 
Vectoring, 
G2.2 EAS)

The second split/skill the call queues to in a VDN is called the 
secondary split/skill. 

Skill Group 
(Generic 2.2 
EAS)

A group of ten skills. Each consecutive ten skills ending with 
digits 0 through 9 constitute a skill tens group. For example, skills 
10-19 form a skill tens group, as do skills 340-349. 

Split/Skill 
ACD Call

A call that queued to a split/skill and was answered by an agent in 
that split/skill.

Station An unmeasured extension; that is, an extension that is not 
currently staffed by an agent or is not a member of an unmeasured 
split/skill or hunt group. 

Tertiary 
Split/Skill 
(G3 
Vectoring, 
G2.2 EAS)

The third split/skill the call queues to in a VDN is called the 
tertiary split/skill. 
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Top Skill The agent’s top skill is the agent’s first-administered, highest-level 
skill. This concept is the most useful when you have a Generic 3 
switch (with EAS) and with agents who are using skill level call 
handling preference. In this case, the agent’s top skill represents 
the skill for which the agent is most likely to receive a call. Agents 
for whom a given skill is the top skill are the agents that a skill 
supervisor can count on to handle calls for the skill.

NOTE: This concept is not useful for agents using the greatest 
need call handling preference or for agents who are not Generic 3 
(with EAS) agents. In these cases, the top skill data is still 
populated. When using the Generic 2.2 (with EAS) switch, the 
agent’s top skill is always the “zero skill.” For non-EAS agents, the 
top “skill” is the split the agent has been logged into the longest.

Zero (0) 
Skill 
(Generic 2.2 
EAS)

See Default Skill.
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To select data for custom reports, you must use the names listed in Table 3 
and Table 4. The database items are described in later sections of this 
appendix.

Table 3: Real-Time Table Names 

Name Data Stored

csplit Split/Skill data for the current interval.

psplit Split/Skill data for the previous interval.

cagent Agent data for the current interval.

pagent Agent data for the previous interval.

ctkgrp Trunk group data for the current interval.

ptkgrp Trunk group data for the previous interval.

ctrunk Trunk data for the current interval.

ptrunk Trunk data for the previous interval.

cvector Vector data for the current interval.

pvector Vector data for the previous interval.

cvdn VDN data for the current interval.

pvdn VDN data for the previous interval.

ccwc Call Work Code (CWC) data for the current interval.

pcwc CWC data for the previous interval.
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Table 4: Historical Table Names 

Name Data Stored

hsplit Split/Skill data for each intrahour interval.

dsplit Split/Skill data summarized by day.

wsplit Split/Skill data summarized by week.

msplit Split/Skill data summarized by month.

hagent Agent data for each intrahour interval.

dagent Agent data summarized by day.

wagent Agent data summarized by week.

magent Agent data summarized by month.

htkgrp Trunk group data for each intrahour interval.

dtkgrp Trunk group data summarized by day.

wtkgrp Trunk group data summarized by week.

mtkgrp Trunk group data summarized by month.

htrunk Trunk data for intrahour interval.

dtrunk Trunk data summarized by day.

wtrunk Trunk data summarized by week.

mtrunk Trunk data summarized by month.

hvector Vector data for each intrahour interval.

dvector Vector data summarized by day.

wvector Vector data summarized by week.

mvector Vector data summarized by month.

hvdn VDN data for each intrahour interval.

dvdn VDN data summarized by day.
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wvdn VDN data summarized by week.

mvdn VDN data summarized by month.

hcwc CWC data for each intrahour interval.

dcwc CWC data summarized by day.

wcwc CWC data summarized by week.

mcwc CWC data summarized by month.

call_rec Call record data.

agex Agent exceptions.

spex Split exceptions.

tgex Trunk group exceptions.

vecex Vector exceptions.

vdnex VDN exceptions.

linkex Link down exceptions.

mctex Malicious call trace exceptions.

f_cday Forecast current day configuration data by split/skill.
(not available through Report Designer)

f_cdayrep Current day forecast data by split/skill.
(not available through Report Designer)

haglog Agent login and logout information.

ag_actv Agent activity trace data.

Table 4: Historical Table Names  (Contd)

Name Data Stored
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Interactions with Switch Features and 
Tracking of Switch Capabilities 1

The following features and switch capabilities have an impact on CentreVu 
CMS database items.

Adjunct-Placed and Adjunct-Routed Calls 1

For Generic 2.2 switches with the ASAI Gateway Interface feature and 
Generic 3 switches with the ASAI feature, CentreVu CMS tracks outbound 
calls placed by an adjunct processor or host computer on behalf of an agent 
and adjunct-routed calls. Database items that start with O_ track outbound 
split/skill calls and database items that contain ADJ track adjunct-routed 
calls. Adjunct-placed outbound split/skill calls are also included as part of 
ACD database items such as ACDCALLS, ACDTIME, and ACWTIME. 
Inbound split/skill calls can be calculated as ACDCALLS -O_ACDCALLS.

Look-Ahead Interflow Calls 1

For Generic 2.2 and Generic 3 switches, CentreVu CMS separately tracks 
look-ahead interflow calls attempted and completed using database items 
that start with LOOK. Look-ahead interflow calls are a subset of interflow 
calls.

For System 85 and Generic 2.1 switches, CentreVu CMS tracks look-ahead 
interflow calls as part of interflow calls only. The LOOK database items are 
not available for these switches.

Personal Call Tracking 1

For the Generic 2.2 and Generic 3 switches, CentreVu CMS tracks hold time, 
transfers and conferences for personal calls (non-ACD or extension calls).
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With this feature, CentreVu CMS is allowed to separately track AUXIN and 
AUXOUT time for calls made and received when an agent has an ACD call 
on hold. These calls are now distinguished from time spent on other AUXIN 
or AUXOUT calls. 

Also for Generic 3 and Generic 2.2 switches, in the VDN tables, connect calls, 
abandoned calls and their times will be tracked for calls that “route to” an 
extension. Call pickup calls are tracked as personal calls, even if an ACD call 
is picked up by an agent in the same split/skill.

Personal Call Tracking offers the following data tracking capabilities:

● Data is available for calls on hold, time for calls on hold, and calls 
abandoned from hold. Without personal call tracking, time for calls on 
hold was counted as talk time.

● CentreVu CMS split and agent data reflect calls made while another call 
is on hold.

● When an agent places a call on hold, the agent returns to his or her 
previous state before the call unless the previous state was AVAIL. If the 
agent was in the AVAIL state, the agent is placed in the OTHER state 
until the agent dials a valid number (if the number dialed is invalid, the 
agent remains in OTHER), reconnects to the held call, or the held call 
abandons. When the agent reconnects to the held call, the agent returns 
to the original state for the call. 

● Agents do not have a HOLD state. Hold time is associated with a call 
placed on hold. Agent states reflect the current activity of the agent. 

● HOLDTIME is the time the call spent on hold. HOLDCALLS is the 
number of calls that were placed on hold at least once, and 
HOLDABNCALLS is the number of calls that were abandoned while 
on hold.

● I_OTHERTIME is the time during the collection interval that the agent 
was doing other work. 

For Generic 3 switches, this includes time while in the Auto-In or 
Manual-In mode during which the agent put a call on hold and 
performed no further action, the agent placed a call or activated a 
feature, or a personal call rang with no further activity.
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When an agent dials a valid extension, the agent's state changes to 
AUXOUT (if the agent was in AUX or OTHER) or to ACWOUT (if the 
agent was in ACW).

Abandoned Calls 1

In general, any call that hangs up before an agent or station answers. On 
Generic 3 switches, any VDN calls (whether ACD calls or not) that route to 
extensions and are then abandoned are counted as abandoned calls for the 
VDN. (See Phantom-Abandon Calls.) On System 85 and Generic 2 switches, 
VDN non-ACD calls that route to extensions and then abandon are counted 
as connect calls.

Phantom-Abandon Calls 1

In international areas where central offices do not provide the switch with 
disconnect supervision, all calls with talk times that are less than an 
administrable threshold can be counted as abandoned calls. CentreVu CMS 
supports a phantom-abandon call timer that can be administered to count 
calls with talk times less than 10 seconds as a phantom- abandoned call. 

The Phantom-Abandon Call Timer can be set from 1-10 seconds. Any calls 
whose total talk time or connect time is less than the set number of seconds 
are pegged as PHANTOMABNS, instead of ACDCALLS. The abandon 
time for phantom calls is the time:

● For splits: from the time the call queued until the agent or answering 
station hangs up.

● For VDNs: from the time the call encountered the VDN until the agent 
or answering station hangs up.

● For vectors: from the time the call entered the vector until the agent or 
answering station hangs up.

When a call leaves a vector via a “route to split” command, the call is not 
pegged as an outflow, and can be pegged as a phantom- abandon call if 
the call duration is shorter than the administered phantom-abandon 
time.
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The database item PHANTOMABNS records the total number of such calls. 
Also, these calls are counted as abandoned calls (ABNCALLS) rather than 
answered calls (ACDCALLS). The abandon time for these calls is equivalent 
to the time elapsed when the agent released the call.

When the phantom-abandon call timer is not enabled, short ACD calls are 
not counted as phantom-abandons, and the values of the PHANTOMABNS 
database items are 0.

Any call that has been put on HOLD, TRANSFERRED, or CONFERENCED 
is not recorded as a phantom-abandon, even if its duration is less than the 
setting of the phantom-abandon call timer.

Transferred and Conferenced Calls 1

With Personal Call Tracking, CentreVu CMS tracks transferred and 
conferenced calls as follows:

● Transferred and conferenced calls are tracked as held calls while the 
call(s) wait to be transferred or added to a conference.

● When an agent ends a conference call, the agent returns to the call state 
prior to setting up the conference.

● If an agent is talking, places the ACD call on hold to transfer the call, 
and then completes the transfer, the agent goes to the AVAIL state 
(Auto-In) or to the ACW state (Manual-In) following the transfer.

● Transferred or conferenced unmeasured split, trunk group, or VDN calls 
are now tracked. Prior to Personal Call Tracking, these calls were not 
tracked.

Audio Difficulty 1

CentreVu CMS records the trunk associated with audio difficulty for 
personal calls if the trunk group is measured. Prior to Personal Call 
Tracking, audio difficulty was restricted to ACD calls. 
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Direct Agent Calling (G3) 1

Direct agent calls are tracked separately from other ACD calls in the 
CentreVu CMS database tables. Since direct agent calls are not split/skill 
calls but are calls to a specific agent, most of the direct agent data are 
collected in the agent tables in items starting with DA_ or I_DA. Direct 
agent calls are counted as ACD calls in trunk, trunk group, VDN and vector 
tables. 

Reports can be customized to include direct agent data. In the real-time 
split/skill table, the number of agents on direct agent calls and the number 
of agents in ACW associated with direct agent calls are collected, but they 
are subsets of the number of agents in the OTHER agent state; that is, they 
are doing work but not for the split/skill. Only the OTHER value appears 
on standard real-time reports. The number of direct agent calls queued and 
ringing appears on the Queue/Agent Summary report.

For Generic 3 switches, a direct agent call can be initiated by an adjunct.

For Generic 3 Version 2 and later Generic 3 switch releases with the EAS 
feature, a direct agent call can be initiated by dialing the agent’s login 
number or through the “route to number” vector command. The call is 
treated like an ACD call and is delivered to the agent before any split/skill 
ACD calls queue.

Multiple Call Handling (G2, System 85, G3V3) 1

The Multiple Call Handling feature allows an ACD agent to put a call on 
hold and push the Auto-In or Manual-In key to take another ACD call. 
CentreVu CMS tracks the hold state as a call state, not an agent state. This 
means that hold time is counted for each call. For example, an agent who 
places two calls on hold for 5 minutes to answer a third accrues 10 minutes 
hold time for the two calls in the space of only 5 minutes on the clock. 

For Generic 2.1 and System 85 switches, an agent with ACD calls on hold 
continues to accrue interval-based talk time. The call-based ACD talk time is 
stopped while the calls are on hold, until the agent reconnects to one of 
them.
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The Forced Multiple Call Handling feature in Generic 3 Version 4 switches 
allow an ACD call to ring at an agent’s voice terminal even if that agent is 
already talking on an ACD call. In this case, the agent continues to accrue 
talk time until the agent puts the current call on hold or releases it.

Hold Tracking (G3, G2, System 85) 1

CentreVu CMS tracks and reports hold state for calls put on hold for Generic 
3, Generic 2, and System 85 switches. This means that CentreVu CMS is 
notified when an agent puts a call on hold. For 
Generic 3 and Generic 2.2 switches, CentreVu CMS tracks all calls put on 
hold. For Generic 2.1 and System 85 switches, CentreVu CMS tracks split 
ACD calls put on hold. 

Ringing (G3, G2, System 85) 1

CentreVu CMS displays the number of agents with split/skill ACD calls and 
direct agent calls ringing at their voice terminals. This information is 
meaningful only if agents' voice terminals are administered to ring rather 
than receive zip tone. The switch sends a message to CentreVu CMS when a 
call is directed to an agent and alerting begins. Currently, this is only 
supported on System 85, Generic 2, and Generic 3 switches. If you do not 
have one of these switches, the ring state columns in standard reports 
display blanks.

Transfer Tracking 1

For Generic 3 and Generic 2.2 switches, CentreVu CMS tracks all transferred 
calls made by measured agents. For Generic 2.1 and System 85 switches, 
transferred calls to a VDN are tracked in the VDN tables. The agent and 
split/skill reports display these transfers. 
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Transfers into a split/skill, agent, or VDN are not tracked explicitly (for 
example, the party initiating the transfer is credited with a transfer, not the 
party receiving the transfer).

Conference Tracking (G2.2 and G3) 1

CentreVu CMS tracks conferenced calls for Generic 2.2 and Generic 3 
switches. Agents who transfer a call by conferencing and then dropping off 
are credited with a conference and not a transfer. 

Call Pickup 1

CentreVu CMS tracks ACD calls that are answered by an agent using the Call 
Pickup feature as AUXIN calls.

Agents in Multiple Splits/Skills 1

CentreVu CMS requires agents to log into multiple splits/skills using the 
same login ID for all splits/skills. This allows CentreVu CMS to track the 
agent as a single person and to coordinate the data for that agent. 

Real-time reports assume that agents can only be doing one thing at a time. 
Agents can be in the following states: AVAIL, ACD, ACW, AUX, DACD, 
DACW, RING, UNKNOWN, OTHER, or UNSTAFFED. When an agent logs 
into multiple splits/skills, the split/skill number(s) are shown on the 
report(s) for the states (ACD, DACD, ACW, AVAIL, and RING) associated 
with the call. For example, if an agent logged into split/skill 1 and split/skill 
2 and answered an ACD call for Split/Skill 2, the split/skill number shown 
in the standard real-time report(s) is “2.”

For splits, as long as the agent is not on a call or the agent is in AUX and is 
available in at least some splits, real-time reports show all the splits in which 
the agent is available. For skills, the agent cannot be available in some skills 
and not available in others unless Multiple Call Handling (MCH) is active. 
The Skill Status report shows all the agent's login skills. If an ACD call is 
ringing the agent's voice terminal, the real-time report shows the RING 
state. If a personal call is ringing at the agent's voice terminal, the real-time 
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report shows the OTHER state. No split/skill is shown for the AUX and 
UNKNOWN states because these states are not split/skill related unless the 
agent is on a call (AUXIN or AUXOUT) in which case, the split/skill is 
shown in the report. The agent is shown as being in AUX only if the agent is 
in AUX in all splits/skills.

With real-time split/skill reports, if an agent is available in split 1 and in 
AUX in split 2 and you request the Split/Skill report which displays both 
splits, the report shows the agent is AVAIL in split 1 and OTHER in split 2. 

Multiple-Split/ Skill Queuing (G3) 1

On a Generic 3 switch, calls can be queued to as many as three splits/skills 
simultaneously. For the first split/skill to which a call is queued (primary 
split/skill), CentreVu CMS counts an answer, outflow (leaves vector 
processing or is answered by an agent in another split/skill), or abandon. 
For the second or third split/skill to which a call is queued, CentreVu CMS 
counts an answer and an inflow if the call is answered in that split/skill. If 
the call is answered in another split, the call outflows, or the caller 
abandons, CentreVu CMS counts the call as dequeued.

In the following Multiple-Split/Skill Queuing example, you see the call 
queue to split/skill 1 first, then queue to split/skill 2 after 15 seconds. After 
another 10 seconds, the call enters split/skill 3's queue. The call is now 
queued to splits/skills 1, 2, and 3 at the same time. See the example for 

Note If a call rings in a second or third split and then abandons, an inflow and 
abandon are counted for that split; an outflow or dequeue is counted for 
the other splits.
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disposition of the call for all three splits if the call was abandoned, was 
answered, or routed to a VDN.

Agent State Tracking at Login 1

CentreVu CMS does not know what state agents are in immediately after 
they have logged in (or right after the link to the switch has come up) until 
notified by the switch. The time the agent spent in this state is tracked as 
I_OTHERTIME and TI_OTHERTIME and the agent's state is displayed as 
OTHER. 

For System 85 and Generic 2 switches, the time between logging in and 
moving to the AUX state depends on the time it takes for the agent logging 
in to release the call or go on-hook, completing the login sequence.

For Generic 1 and Generic 3 switches, the time between logging in and 
moving to the AUX state depends on the time it takes for the agent logging 

Figure 1-1:  Multiple-Split/Skill Queuing Example
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in to release the call or go on-hook or for the switch to time the call out 
(about 5 to 10 seconds).

Converse Vector Command (G3V2 and later) 1

The “converse” command integrates Voice Response Units (VRUs) and the 
Vectoring feature. The “converse” command allows voice-response scripts 
to be executed while, for example, a call waits in queue. This command also 
allows data to be passed between the switch and a VRU or from the VRU 
through the switch to an ASAI adjunct processor.

There is no vector or VDN tracking for this command. If the VRU ports are 
administered as a measured split/skill, then agent and split/skill tracking is 
available.

Go To Vector 1

When a “go to vector” command is executed, an outflow and a “goto call” 
are counted for the first vector and an inflow is counted for the second 
vector. The timing and statistics associated with the first vector for that call 
stop and are started for the second vector. The call remains in the original 
VDN, however, and tracking in that VDN continues.

Outbound Call Management (OCM) 1

Outbound call management calls to splits/skills are included as a subset of 
the ACD call database items (talk time, ringing, ACW, etc.). OCM calls also 
have their own database items which start with O_ in the agent, split/skill, 
trunk and trunk group tables. Inbound split/skill calls can be calculated as 
ACDCALLS - O_ACDCALLS. See the “Adjunct-Placed and Adjunct-
Routed Calls” section for more information.
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Redirection on No Answer (G3V2 and later) 1

When a ringing call times out, the call can be requeued to the same 
split/skill or to a Vector Directory Number (VDN) by the Redirection on No 
Answer feature (available only on a DEFINITY ECS). When redirected to the 
same split/skill, an outflow and an inflow are counted for the split/skill. 
Thus, the redirected call appears as two offered calls to the split/skill. The 
database item NOANSREDIR is also incremented. The unique calls offered 
to the split/skill can then be calculated by subtracting the value of 
NOANSREDIR from CALLSOFFERED. 

When a ringing call times out and is routed to a VDN (Generic 3 Version 4), 
an outflow and NOANSREDIR are incremented.

Tracking of Times/Duration 1

In the trunk, trunk group, and VDN tables, the TIME items typically 
cumulates until the trunk drops at the end of the call, unless the items are 
queue time or ring time or other similar items. 

In the split/skill and vector tables, the TIME items typically cumulates until 
the call leaves the split/skill/vector and the disposition is known (for 
example, when the call outflows or when the caller starts hearing the forced 
busy).

Trunk No Answer Timeout (G3V2 and later) 1

This timer starts when the switch first seizes the trunk and is stopped when 
answer supervision is sent for the call. If it times out, the call is dropped by 
the switch and the CentreVu CMS counts the call as an abandoned call. (This 

Note This assumes that the split/skill is set up so that normal split/skill 
calls do not cover back to the same split/skill except through the 
Redirection on No Answer feature. If they can cover back to the 
same split/skill, each call that does this is counted as an outflow and 
inflow to that same split/skill. In this case, NOANSREDIR is not 
incremented.
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timer is for switches in countries that lack disconnect supervision for trunks. 
The assumption is that the caller abandoned long ago.)

Vector Disconnect Timer (G3V2 and later) 1

The Vector Disconnect Timer is started when a call begins vector processing 
and stops when the call is routed successfully. This means that the call rings 
at a destination or the trunk is connected to a destination. In the case of 
adjunct routing, the timer is stopped at the point at which the call is routed 
successfully. If the timer times out, the call is dropped by the switch and the 
CentreVu CMS records a forced disconnect for the call.

Wait Answer Supervision Timer (WAST) 1

This timer is started when a call begins ringing at an agent or station. It is 
stopped if the call is answered or connected or redirected. Once a redirected 
call begins ringing, the timer is restarted. In the case of redirection on no 
answer, if the call cannot be redirected, the WAST is restarted. If the WAST 
times out, the call is dropped by the switch and the CentreVu CMS records 
an abandon (from ringing) for the call. 
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Split/Skill Database Items 1

The Split/Skill database item descriptions (Table 1) apply to real-time and 
historical items. 

The Relationship(s) column provides a list of the database item 
relationships for the Split/Skill Database table.

The Type column refers to Cumulative (C), Administrative (A), or Status 
(S) data. Cumulative and Administrative items typically apply to both the 
current and previous interval real-time table. Status items apply only to the 
current interval real-time tables.

Real-Time split/skill database items apply to the Current Interval 
Split/Skill (csplit ) and Previous Interval Split/Skill (psplit ) tables. 
The real-time indexes are ACD and SPLIT.

Historical split/skill database items apply to the Intrahour Split/Skill 
(hsplit ), Daily Split/Skill (dsplit ), Weekly Split/Skill (wsplit ), and 
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Monthly Split/Skill (msplit ) tables, except as noted. The historical indexes 
are SPLIT and ROW_DATE. 

Table 5: Split/Skill Database Items 

Database Item Description Type

ABNCALLS The number of CALLSOFFERED that were abandoned 
while in queue or ringing for this split/skill.

For System 85, Generic 2.1, and Generic 3 Version 1 
switches with the Vectoring feature, this also includes 
calls that were queued to the split/skill and abandoned 
while listening to a forced disconnect announcement. 

NOTE: When a call abandons while queued to multiple 
splits/skills and abandons from queue, only the primary 
split/skill increments ABNCALLS (calls that are ringing 
an agent and then abandon peg as abandons for the 
split/skill they were ringing).

This also includes calls with talk times less than the 
phantom-abandoned call timer value, if it is set.

ABNCALLS = ABNCALLS1 + ABNCALLS2 + 
ABNCALLS3 + ABNCALLS4 + ABNCALLS5 + 
ABNCALLS6 + ABNCALLS7 + ABNCALLS8 + 
ABNCALLS9 + ABNCALLS10

ABNCALLS includes ABNCALLS1-10, 
ABNRINGCALLS, O_ABNCALLS, PHANTOMABNS, 
SLVLABNS.

C

ABNCALLS1-10 The number of ABNCALLS that were abandoned 
during the collection interval in each of the service level 
increments PERIOD1 through PERIOD9 (as defined on 
the ACD Administration: Call Profile window). 
ABNCALLS10 counts calls that abandoned after 
PERIOD9.

NOTE: If call profiles are not set, then the data gets 
stored into the first interval (ABNCALLS1).

C

ABNRINGCALLS The number of ABNCALLS that abandoned while 
ringing at an agent position. 

Available for ring tracking with Generic 2 and Generic 3 
switches.

C
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ABNTIME The time callers spent waiting in queue and ringing at 
the agent’s voice terminal before abandoning the call.

For phantom-abandon calls, this includes the time from 
when the call queues until the agent releases the call.

C

ACCEPTABLE The number of ACDCALLS answered by an agent 
within the predefined acceptable service level 
(SERVICELEVEL), as defined on the ACD 
Administration: Call Profile window.

C

ACD (index) The ACD number for which data was collected. A

ACDAUXOUTCALLS The number of AUXOUTCALLS agents in the split/skill 
made with at least one split/skill ACD call for this 
split/skill on hold. For agents in multiple skills with 
multiple call handling (Generic 3 Version 3 switch and 
later), the call is recorded for the skill of the last ACD call 
the agent put on hold. 

ACDAUXOUTCALLS includes calls made to transfer or 
conference the ACD call. 

Available with Generic 2.2 and Generic 3 switches.

C

ACDCALLS The number of CALLSOFFERED calls that were 
answered by an agent in the split/skill.

ACDCALLS = ACDCALLS1 + ACDCALLS2 + 
ACDCALLS3 + ACDCALLS4 + ACDCALLS5 + 
ACDCALLS6 + ACDCALLS7 + ACDCALLS8 + 
ACDCALLS9 + ACDCALLS10

ACDCALLS includes ACCEPTABLE, ACDCALLS1-10, 
BACKUPCALLS, CONFERENCE, HIGHCALLS, 
HOLDCALLS, LOWCALLS, MEDCALLS, 
O_ACDCALLS, TOPCALLS, and TRANSFERRED.

C

Table 5: Split/Skill Database Items  (Contd)

Database Item Description Type
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ACDCALLS1-10 The number of ACDCALLS during the collection 
interval that were answered in each of the service level 
increments PERIOD1 through PERIOD9 (as defined on 
the ACD Administration: Call Profile window). 
ACDCALLS10 is the number of calls answered after the 
last increment PERIOD9.

NOTE: If call profiles are not set, then the data gets 
stored into the first interval (ACDCALLS1).

C

ACDTIME The talk time of all ACDCALLS (does not include 
HOLDTIME, but does include O_ACDTIME).

C

ACWINCALLS The number of inbound extension calls received by 
agents while in ACW for this split/skill ACD calls or in 
ACW not associated with a call if it is the oldest login.

C

ACWINTIME The talk time of all ACWINCALLS.

ACWINTIME does not include hold time on Generic 2.2 
and Generic 3 switches. It does include time spent on 
calls received while in ACW not associated with an ACD 
call.

C

ACWOUTADJCALLS The number of ACWOUTCALLS that were placed by an 
adjunct on behalf of an agent (keyboard-dialed). If such 
calls are placed to off-switch destinations, then they are 
also counted as ACWOUTOFFCALLS. 

Available for outbound calls on Generic 2.2 switches 
with the ASAI Gateway Interface feature and Generic 3 
switches with the ASAI feature.

C

ACWOUTCALLS The number of outbound extension calls made by agents 
while in ACW for this split/skill ACD calls or in ACW 
not associated with a call if it is the oldest login.

ACWOUTCALLS includes ACWOUTADJCALLS and 
ACWOUTOFFCALLS

C

Table 5: Split/Skill Database Items  (Contd)

Database Item Description Type
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ACWOUTOFFCALLS The number of ACWOUTCALLS that were made to a 
destination outside the switch. If such calls are placed by 
an adjunct on behalf of an agent, they are also counted as 
ACWOUTADJCALLS. 

Available for external calls with Generic 2.2 and Generic 
3 switches.

C

ACWOUTOFFTIME The talk time of all ACWOUTOFFCALLS (does not 
include time on hold). 

Available for external calls with Generic 2.2 and Generic 
3 switches.

C

ACWOUTTIME The talk time of all ACWOUTCALLS.

ACWOUTTIME does not include hold time on Generic 
2.2 and Generic 3 switches. It does include time spent on 
calls made while in ACW not associated with an ACD 
call.

ACWOUTTIME includes ACWOUTOFFTIME.

C

ACWTIME The duration of all after call work associated with 
ACDCALLS.

NOTE: ACWTIME does not include time spent in ACW 
not associated with an ACD call (that is, the agent 
pressed the ACW button while not on an ACD call). 
However, both ACWINTIME and ACWOUTTIME do 
include time spent on calls made or received while in 
ACW not associated with an ACD call. Therefore, the 
sum of ACWINTIME and ACWOUTTIME may be 
greater than ACWTIME.

ACWTIME includes ACWINTIME, ACWOUTTIME, 
and O_ACWTIME.

C

Table 5: Split/Skill Database Items  (Contd)

Database Item Description Type
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AGINRING
(real-time)

The current number of POSITIONS at which split/skill 
or direct agent calls are ringing (for example, ACD call 
ringing for this split/skill and are not doing anything 
else). 

NOTE: When an agent makes or answers a personal call 
while an ACD call is ringing, that position is no longer 
counted in AGINRING (because the agent is then on an 
AUXIN/OUT call). 

Agents talking on ACD calls who receive a forced MCH 
call (Generic 3 Version 4 switches only) are not counted 
in AGINRING (they are counted in ONACD) or 
OTHER.

Available with Generic 2 and Generic 3 switches for ring 
tracking.

S

ANSTIME The time spent by callers in queue or ringing before 
being answered by an agent.

C

ASA
(real-time)

The switch-provided rolling average speed of answer for 
this split/skill. This value is sent to CentreVu CMS 
whenever it changes on the switch (for example, when a 
call is answered).

EWT and ASA should not be expected to match. ASA 
gives a historical perspective, while EWT changes 
constantly to match current conditions such as queue 
length and staffing changes.

Available with Generic 3 Version 4 switches for vectoring 
feature enhancements.

S

ASSISTS The number of times the supervisor was called 
(supervisor assists) by agents on split/skill calls, direct 
agent ACD calls, or in call-related ACW for this 
split/skill. 

C

Table 5: Split/Skill Database Items  (Contd)

Database Item Description Type
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AUXINCALLS The number of inbound extension calls received by 
agents while in AUX (auxiliary work), AVAILABLE, or, 
for Generic 2.2 and Generic 3 switches, with an ACD or 
AUXIN/AUXOUT call on hold.

AUXINCALLS are recorded in the SPLIT that is 
OLDEST_LOGON for agents in multiple splits/skills.

C

AUXINTIME The talk time of all AUXINCALLS (does not include 
hold time on Generic 2.2 and Generic 3 switches).

C

AUXOUTADJCALLS The number of AUXOUTCALLS that were placed by an 
adjunct on behalf of an agent (keyboard-dialed). If such 
calls are placed to off-switch destinations, then they are 
also counted as AUXOUTOFFCALLS.

Available for outbound calls on Generic 2.2 switches 
with the ASAI Gateway Interface feature and Generic 3 
switches with the ASAI feature.

C

AUXOUTCALLS The number of outbound extension calls made by agents 
while in AUX (auxiliary work), AVAILABLE, or for 
Generic 2.2 and Generic 3 switches with an ACD or 
AUXIN/AUXOUT call on hold. AUXOUTCALLS are 
recorded for the SPLIT which is the OLDEST_LOGON, 
unless the agent made the call with an ACD call on hold. 
In this case, they are recorded for the split/skill of the 
ACD call.

AUXOUTCALLS includes ACDAUXOUTCALLS, 
AUXOUTADJCALLS, and AUXOUTOFFCALLS.

C

AUXOUTOFFCALLS The number of AUXOUTCALLS that were made to a 
destination outside the switch. If such calls are placed by 
an adjunct on behalf of an agent, they are also counted as 
AUXOUTADJCALLS. 

Available for external calls with Generic 2.2 and Generic 
3 switches.

C

Table 5: Split/Skill Database Items  (Contd)

Database Item Description Type

831.bk : A_Database_Items_and_Calculations.fm  Page 34  Wednesday, November 27, 1996  1:46 PM



 Split/Skill Database Items A-35

Appendix A - Database Items and Calculations

A
pp

en
di

x 
A

AUXOUTOFFTIME The talk time of all AUXOUTOFFCALLS (does not 
include hold time). AUXOUTOFFTIME is included in 
AUXOUTTIME. 

Available for external calls on Generic 2.2 and Generic 3 
switches. 

C

AUXOUTTIME Talk time of all AUXOUTCALLS. AUXOUTTIME does 
not include hold time on Generic 2.2 and Generic 3 
switches.

AUXOUTTIME includes AUXOUTOFFTIME.

C

AVAILABLE
(real-time)

The current Number of POSITIONS that are available 
in this split/skill.

S

BACKUPCALLS The number of ACDCALLS that were delivered to this 
split/skill by a vector command other than “queue to 
main”. This includes calls delivered by “messaging 
split/skill”, “check backup”, “route to” split/skill, and 
“redirect on no answer” vector commands. 

Calls that are redirected back to the split/skill from 
ringing by the “redirect on no answer” feature that are 
subsequently answered by an agent in the split/skill are 
also counted as backup calls.

Available on System 85, Generic 2, and Generic 3 
switches with the Vectoring feature. 

C

BUSYCALLS The number of CALLSOFFERED calls that were given a 
busy signal by the switch. This happens when a “busy” 
vector command is executed while the call is queued to 
this split/skill (and this is the primary split/skill the call 
is queued to) or if a call queued to this split/skill 
forwards to another split/skill whose queue is full.

On Generic 3 and later switches, a busy is given because 
a non-vector controlled split has a full queue, no queue 
and no available agents, or no agents that are staffed.

C

BUSYTIME The time callers waited in queue until hearing a busy 
tone for all BUSYCALLS.

C
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CALLSOFFERED The number of calls that queued to the split/skill and 
that completed during the interval. This does NOT 
include calls on the Generic 1 or Generic 3 switches that 
could not queue to the split/skill because the queue was 
full or there was no queue.

CALLSOFFERED = ACDCALLS + ABNCALLS + 
BUSYCALLS + DISCCALLS + OUTFLOWCALLS + 
DEQUECALLS

CALLSOFFERED includes ABNCALLS, RINGCALLS, 
OTHERCALLS, and INFLOWCALLS

C

CONFERENCE The number of ACDCALLS that were conferenced at 
least once.

Available on Generic 2.2 and Generic 3 switches.

C

DA_ACWINCALLS The number of inbound extension calls agents answered 
while in after call work mode for direct agent ACD calls 
that were queued through this split/skill.

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling.

C

DA_ACWINTIME The talk time of inbound extension calls agents 
answered while in the after call work mode for direct 
agent ACD calls queued through this split/skill.

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling.

C

DA_ACWOCALLS The number of outbound extension calls agents made 
while in the after call work mode for direct agent call 
ACD calls queued through this split/skill.

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling.

C

DA_ACWOTIME The talk time of outbound extension calls the agent 
made while in the after call work mode for a direct agent 
ACD call.

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling.

C
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DA_INACW
(real-time)

The current number of POSITIONS that are in after call 
work associated with direct agent calls. This includes 
agents who are on ACWIN/ACWOUT calls. 
DA_INACW is a subset of OTHER.

NOTE: The total number of agents in after call work = 
INACW + DA_INACW.

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling.

S

DA_INQUEUE
(real-time)

The current number of direct agent ACD calls waiting in 
this split’s/skill’s queue. 

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling.

S

DA_INRING
(real-time)

The current number of direct agent ACD calls ringing at 
an agent’s voice terminal that was queued in this 
split/skill.

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling.

S

DA_OLDESTCALL
(real-time)

The length of time that the oldest direct agent ACD call 
has been waiting in queue and ringing at an agent 
position. 

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling.

S

DA_ONACD
(real-time)

The current number of POSITIONS that are on direct 
agent ACD calls. DA_ONACD is a subset of OTHER. 

NOTE: The total number of agents on split/skill and 
direct agent ACD calls = ONACD + DA_ONACD. 

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling.

S
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DEQUECALLS The number of calls that queued to this split/skill as a 
nonprimary split/skill, but whose disposition was 
recorded in another split/skill (as answered, abandoned, 
outflowed, busy, or forced disconnect). 

Requires vectoring for multiple split/skill queueing on a 
Generic 2.2 switch with EAS or a Generic 3 switch.

C

DEQUETIME The amount of time DEQUECALLS waited in this 
split/skill queue before dequeuing. 

Requires vectoring for multiple split/skill queueing on a 
Generic 2.2 switch with EAS or a Generic 3 switch.

C

DISCCALLS For Generic 2.2, Generic 3 Version 2, and later Generic 3 
switches, this is the number of CALLSOFFERED that 
were disconnected by the switch via the “disconnect” 
vector command.

For the Generic 3 Version 2 and later switch releases, this 
also includes the number of CALLSOFFERED that were 
disconnected by the switch when the vector disconnect 
timer expired.

For the vectoring feature on System 85, Generic 2.1, and 
Generic 3 Version 1 switches, this is the number of 
CALLSOFFERED that were given a forced disconnect 
announcement, then were disconnected by the switch.

C
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DISCTIME The time all DISCCALLS spent in this split’s/skill’s 
queue.

For Generic 2.2 and Generic 3 Version 2 switches, this is 
the time until the trunk drops, in the case where the 
caller hangs up without listening to the entire 
announcement. 

For the Generic 3 Version 2 and later switches, if the call 
is disconnected due to the expiration of the vector 
disconnect timer, this is the time until the caller is 
disconnected by the switch.

For the vectoring feature on System 85, Generic 2.1, or 
Generic 3 Version 1 switches, this is the time until the 
announcement ends and the caller is disconnected by the 
switch.

C

EVENT1-9 The number of times each event (stroke count) feature 
button (feature button 1 to 9) was pressed by agents on 
split/skill or direct agent ACD calls or in after call work 
associated with an ACD call for this split/skill. 

Available with System 85, Generic 2, and Generic 3 
switches.

C

EWTHIGH
(real-time)

The switch-calculated expected wait time for calls 
queued at high priority to this split/skill. The expected 
wait time is an estimate of how long a caller will wait in 
queue at HIGH priority until being served. Time spent 
ringing at the agent is not included in this estimate.

EWT and ASA should not be expected to match. ASA 
gives a historical perspective, while EWT changes 
constantly to match current conditions such as queue 
length and staffing changes.

Available with Generic 3 Version 4 switches for 
Vectoring enhancements.

S
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EWTLOW
(real-time)

The switch-calculated expected wait time for calls 
queued at low priority to this split/skill. The expected 
wait time is an estimate of how long a caller will wait in 
queue at LOW priority until being served. Time spent 
ringing at the agent is not included in this estimate.

EWT and ASA should not be expected to match. ASA 
gives a historical perspective, while EWT changes 
constantly to match current conditions such as queue 
length and staffing changes.

Available with Generic 3 Version 4 switches for 
Vectoring enhancements.

S

EWTMEDIUM
(real-time)

The switch-calculated expected wait time for calls 
queued at medium priority to this split/skill. The 
expected wait time is an estimate of how long a caller 
will wait in queue at MEDIUM priority until being 
served. Time spent ringing at the agent is not included in 
this estimate.

EWT and ASA should not be expected to match. ASA 
gives a historical perspective, while EWT changes 
constantly to match current conditions such as queue 
length and staffing changes.

Available with Generic 3 Version 4 switches for 
Vectoring enhancements.

S

EWTTOP
(real-time)

The switch-calculated expected wait time for calls 
queued at top priority to this split/skill. The expected 
wait time is an estimate of how long a caller will wait in 
queue at TOP priority until being served. Time spent 
ringing at the agent is not included in this estimate.

EWT and ASA should not be expected to match. ASA 
gives a historical perspective, while EWT changes 
constantly to match current conditions such as queue 
length and staffing changes.

Available with Generic 3 Version 4 switches for 
Vectoring enhancements.

S
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HIGHCALLS The number of ACDCALLS with high priority that were 
answered by agents in this split/skill (for example, 
answered calls that were queued to the split/skill with 
high priority by a “queue to main” or “check backup” 
vector command. 

For Generic 3 switches with the Vectoring feature, this 
includes calls that were queued to a split/skill with 
priority using the “route to” or “messaging split/skill” 
vector commands, and calls that queued directly to a 
split/skill with priority. (Priority in these cases is 
determined by the class of restriction of the originator, 
which is an agent, an extension, a trunk group or a 
VDN.)

Available on System 85, Generic 2, and Generic 3 
switches with the Vectoring feature.

C

HOLDABNCALLS The number of times split/skill ACD callers abandoned 
the call while on hold. 

Available on System 85, Generic 2, and Generic 3 
switches.

C

HOLDCALLS The number of split/skill ACD calls that were placed on 
hold at least once. 

Available on System 85, Generic 2, and Generic 3 
switches.

HOLDCALLS includes HOLDABNCALLS.

C

HOLDTIME The time spent by split/skill ACD callers on hold. 

Available on System 85, Generic 2, and Generic 3 
switches.

C

I_ACDAUXINTIME The time during the collection interval that POSITIONS 
were talking on AUXIN calls with a split/skill ACD call 
on hold where SPLIT is OLDEST_LOGON. 

Available on Generic 2.2 and Generic 3 switches.

C
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I_ACDAUX_
OUTTIME

The time during the collection interval that POSITIONS 
spent dialing (Generic 2.2 switches) and talking on 
AUXOUT calls with a split/skill ACD call for this 
split/skill on hold. 

NOTE: In a multiple call handling environment with 
agents in multiple skills, the ACD call for this skill must 
have been the last ACD call to have been put on hold 
before the agent made the AUXOUT call.

Available on Generic 2.2 and Generic 3 switches.

C

I_ACDOTHERTIME The time during the collection interval that POSITIONS 
spent in the OTHER state (dialing an outgoing call with 
a Generic 3 switch, with a ringing extension call with 
Generic 3 switch, or with calls on hold and with no other 
state selected) with a split/skill ACD call on hold. 

Available on Generic 2.2 and Generic 3 switches.

C

I_ACDTIME Time during the collection interval that POSITIONS 
were on split/skill ACD calls for this split/skill. This 
includes time on O_ACDCALLS as well as on 
ACDCALLS.

C

I_ACWINTIME The time during the collection interval that POSITIONS 
were in ACW for this split/skill, either associated with a 
split/skill ACD call or not associated with a call, and on 
inbound extension calls. This does not include time 
inbound extension calls spent on hold.

Available on Generic 2.2 and Generic 3 switches.

C

I_ACWOUTTIME The time during the collection interval that POSITIONS 
were in ACW for this split/skill, either associated with 
this split/skill ACD call or not associated with a call, and 
on outbound extension calls. This does not include time 
outbound extension calls spent on hold.

Available on Generic 2.2 and Generic 3 switches.

C
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I_ACWTIME The time during the collection interval that POSITIONS 
were in ACW for this split/skill, either associated with a 
split/skill ACD call or not associated with a call. This 
I_ACWTIME includes I_ACWINTIME and 
I_ACWOUTTIME.

C

I_ARRIVED The number of calls that queued to this split/skill during 
this interval.

C

I_AUXINTIME The time during the collection interval that POSITIONS 
were in AUX work, AVAILABLE, or, for Generic 2.2 and 
Generic 3 switches, had an ACD or AUXIN/AUXOUT 
call on hold and were on inbound extension calls.

I_AUXINTIME includes I_ACDAUXINTIME.

C

I_AUXOUTTIME The time during the collection interval that POSITIONS 
were in AUX work, AVAILABLE or, for Generic 2.2 and 
Generic 3 switches, had an ACD or AUXIN/AUXOUT 
call on hold and were on outbound extension calls.

I_AUXOUTTIME includes I_ACDAUX_OUTTIME.

C

I_AUXTIME The time during the collection interval that POSITIONS 
were in AUX in this split/skill.

I_AUXTIME = I_AUXTIME0 + I_AUXTIME1 + 
I_AUXTIME2 + I_AUXTIME3 + I_AUXTIME4 + 
I_AUXTIME5 + I_AUXTIME6 + I_AUXTIME7 + 
I_AUXTIME8 + I_AUXTIME9

I_AUXTIME includes I_AUXTIME0...
I_AUXTIME9, I_AUXINTIME, I_AUXOUTTIME, and 
I_TAUXTIME.

C

I_AUXTIME0 The time during the collection interval that POSITIONS 
were in AUX for reason code 0 in this split/skill. This 
includes time on extension calls from this AUX state. For 
switches with AUX reason codes active, this represents 
time agents spent in “system” AUX. For switches 
without AUX reason codes active, I_AUXTIME0 is the 
same as I_AUXTIME.

C
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I_AUXTIME1-9 Time during the collection interval that POSITIONS 
were in AUX for each reason code 1-9 in this skill. This 
includes time on extension calls from each AUX state.

Available for the ECS and later switches with EAS.

C

I_AVAILTIME The time during the collection interval that POSITIONS 
were available for calls from this split/skill.

I_AVAILTIME includes I_TAVAILTIME

C

I_DA_ACDTIME The time that POSITIONS spent talking on direct agent 
ACD calls queued through this split/skill. 
I_DA_ACDTIME is a subset of I_OTHERTIME.

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling.

C

I_DA_ACWTIME The time that POSITIONS spent in after call work for 
direct agent ACD calls queued through this split/skill. 
I_DA_ACWTIME is a subset of I_OTHERTIME.

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling.

C
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I_OTHERTIME The time during the collection interval that POSITIONS 
were doing other work. 

For Generic 3 switches, other work includes: while in 
Auto-In or Manual-In mode, an agent put any call on 
hold and performed no further action; the agent had a 
direct agent call ringing, was on a direct agent call or in 
ACW for a direct agent call; the agent dialed to place a 
call or activate a feature; or an extension-in call rang at 
the agent’s voice terminal with no other activity. 

For Generic 2.2, agents were in Auto-in or Manual-in, 
put a call on hold using the Hold button or switchhook 
flash and performed no further action.

For Generic 2.2 with EAS, Generic 1 and Generic 3 
switches, agents were logged into multiple splits/skills 
and doing work for a split/skill other than this one (with 
an ACD call ringing, talking on an ACD call, or in ACW 
for a split/skill other than this one).

For Generic 3 switches with EAS and multiple call 
handling, agents are available in other, multiple call 
handling skills, but not in this skill.

For all switches, I_OTHERTIME is collected for the time 
period after the link to the switch comes up or after the 
agent logs in and before the CentreVu CMS receives 
notification of the agent's state from the switch.

I_OTHERTIME includes I_ACDOTHERTIME, 
I_DA_ACDTIME, and I_DA_ACWTIME.

C
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I_RINGTIME The time during the collection interval that agents were 
in the ringing state for calls to this split/skill. If the agent 
changes work modes or answers/makes another call 
instead of answering the ringing call, I_RINGTIME will 
stop accumulating. RINGTIME is the time the caller 
spends ringing and is independent of agent activity. 

NOTE: With forced multiple call handling (Generic 3 
Version 4 and later), if an ACD call rings at the agent’s 
voice terminal while the agent is talking on another call, 
I_RINGTIME does not accumulate.

Available on Generic 2 and Generic 3 switches for ring 
tracking.

C

I_STAFFTIME The time during the collection interval that POSITIONS 
were staffed (logged in).

I_STAFFTIME = I_AVAILTIME + I_ACDTIME + 
I_ACWTIME + I_AUXTIME + I_RINGTIME + 
I_OTHERTIME

I_STAFFTIME includes I_ACDTIME, I_ACWTIME, 
I_AUXTIME, I_AVAILTIME, I_OTHERTIME, and 
I_RINGTIME.

C

I_TAUXTIME The time top agents in this split/skill were in AUX 
mode. This includes time on AUXIN/AUXOUT calls, 
received or made without an ACD call on hold. (Time on 
AUXIN/AUXOUT calls with an ACD call on hold is 
tracked in I_ACDAUXINTIME and 
I_ACDAUX_OUTTIME.)

Available with a Generic 3 switch with the EAS feature 
for top skills.

I_TAVAILTIME The time top agents in this split/skill were available to 
receive calls for this split/skill.

Available with a Generic 3 switch with the EAS feature 
for top skills.

C
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INACW
(real-time)

The current number of POSITIONS that are in after call 
work for this split/skill. This includes agents on 
ACWIN/ACWOUT calls as well as agents in ACW not 
associated with an ACD call. It does not include agents 
in ACW for direct agent ACD calls.

INACW includes ONACWIN and ONACWOUT.

S

INAUX
(real-time)

The current number of POSITIONS that are in auxiliary 
work for all splits/skills, or on AUXIN/AUXOUT calls.

INAUX = INAUX0 + INAUX1 + INAUX2 + INAUX3 + 
INAUX4 + INAUX5 + INAUX6 + INAUX7 + INAUX8 + 
INAUX9

INAUX includes INAUX0...INAUX9, 
ONACDAUXOUT, ONAUXIN, and ONAUXOUT.

S

INAUX0 The current number of POSITIONS that are in auxiliary 
work with reason code 0 for all splits/skills including 
agents on AUXIN/AUXOUT calls. Reason code 0 is for 
“system” AUX work when reason codes are active (ECS 
with EAS and later EAS). For switches without EAS and 
for releases prior to the ECS, INAUX0 will be the same as 
INAUX.

S

INAUX1-9 The current number of POSITIONS that are in auxiliary 
work with each of the reason codes 1-9 for all 
splits/skills including agents on AUXIN/AUXOUT 
calls.

Available for the ECS.

S
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INCOMPLETE Indicates whether or not data is complete for this 
collection interval. Data is incomplete whenever the link 
goes down and whenever tracking is aborted for calls, 
due to trunk failures (System 85 and Generic 2 switches), 
the trunk going maintenance busy with a call active 
(Generic 1 and Generic 3 switches), or protocol failures 
with data collection active. The value for interval tables 
indicates whether data is incomplete for the interval (0 = 
data complete, 1 = data incomplete). The value in the 
daily, weekly, and monthly tables indicates the number 
of incomplete intervals in the day, week, or month.

C
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INFLOWCALLS The number of calls that were redirected to the 
split/skill’s queue from another queue. 

For Generic 3 with vectoring and Generic 2.2 with EAS 
and multiple split/skill queueing, calls answered by an 
agent in a non-primary split/skill are counted as inflows 
to that split/skill. Calls that abandon from ringing at an 
agent’s voice terminal in a non-primary split/skill are 
also counted as inflows to that split/skill.

On Generic 3 Version 2 and later switches, calls that ring 
at an agent’s voice terminal and then are requeued to the 
same split/skill by the Redirection on No Answer 
feature and are counted as inflows to that split/skill.

On Generic 2.2 switches with EAS, calls that queue to the 
“zero” skill after having been queued to a “nonzero” 
skill are not counted as inflows to the “zero” skill. 
Similarly, calls that queue to a “nonzero” skill after 
having been queued to a “zero” skill are not counted as 
inflows to the “nonzero” skill. Calls that are queued to 
one skill group and are subsequently queued to another 
are not counted as inflows to the subsequent skill group.

For Generic 2, System 85 with vectoring, calls that queue 
to a split and then subsequently queue to a new split by 
a “queue to main” or “check backup” split vector 
command and are counted as inflows to the new split.

When a call leaves the VDN (for example, by routing to 
another VDN) or leaves vector processing, (for example, 
by routing to a split/skill) the next split/skill to which a 
call queues will not be credited with an inflow.

C

INQUEUE
(real-time)

The current number of split/skill ACD calls waiting in 
queue.

S

INRING
(real-time)

The current number of split/skill ACD calls which are 
ringing at agent positions for this split/skill. 

Available on Generic 2 and Generic 3 switches for ring 
tracking.

S
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INTERFLOWCALLS The number of OUTFLOWCALLS that were redirected 
to an off-switch destination—a destination outside the 
switch.

C

INTRVL The number of minutes in the intrahour interval (15, 30, 
60).

INTRVL applies to intrahour intervals only.

A

LOWCALLS For switches with vectoring, this is the number of 
ACDCALLS with low priority that were answered by 
this split/skill. For switches without vectoring, this is the 
number of ACDCALLS with no priority that were 
answered by this split/skill.

C

MAXINQUEUE The maximum number of simultaneously calls in this 
split’s/skill’s queue during the collection interval.

C

MAXOCWTIME The maximum amount of time that a call, recorded 
during the collection interval, waited in queue and 
ringing before an agent answered in this split/skill, the 
caller abandoned, or the call was redirected, received a 
busy signal, or was disconnected.

C

MAXSTAFFED The maximum number of agent POSITIONS that were 
simultaneously staffed during the collection interval.

MAXSTAFFED includes MAXTOP.

C

MAXTOP Maximum number of top agents that were staffed 
during the collection interval in this split/skill.

C
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MEDCALLS For switches with vectoring, the number of ACDCALLS 
with medium priority that were answered by agents in 
the split/skill. For example, answered calls that were 
queued to the split/skill with medium priority by a 
“queue to main” or “check backup” vector command. 

For Generic 3 switches with vectoring, MEDCALLS 
includes calls that were queued to a split with no priority 
using the “route to” or “messaging split” vector 
commands, calls that queued directly to a non-vector-
controlled split with no priority, and calls that 
intraflowed to a split with no priority.

For switches without vectoring, the number of 
ACDCALLS with “yes” priority that were answered by 
agents in the split/skill.

C

NOANSREDIR The number of split/skill ACD calls that rang at agent 
positions in the split/skill and then were automatically 
redirected back to the split/skill queue or to a VDN by 
the Redirection on No Answer feature because they were 
not answered. 

Redirection On No Answer to a split/skill is available on 
DEFINITY ECS or Generic 3 Version 2 or later switches. 
Redirection On No Answer to a VDN is only available 
on DEFINITY ECS.

NOTE: When a call is requeued to the same split/skill 
using the Redirection on No Answer feature, it is 
counted as an outflow from the split/skill and an inflow 
to the same split/skill. This is NOT true for calls that are 
redirected to a VDN using the Redirection on No 
Answer feature, rather than redirecting the call back to 
the same split/skill. Such calls count as outflows from 
the original split or skill, but do not count as inflows to 
the next split/skill to which they are queued through the 
new VDN. It is also counted as a NOANSREDIR call and 
so can be subtracted out from the outflows and from the 
inflows to calculate the number of outflows and inflows 
that were not due to requeuing the call to the same split.

C
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O_ABNCALLS The number of ABNCALLS that were placed by an 
adjunct, that is, the number of outbound predictive 
dialing calls that were abandoned by the far end.

Available for outbound calls on Generic 2.2 switches 
with the ASAI Gateway Interface feature and Generic 3 
switches with the ASAI feature.

C

O_ACDCALLS The number of ACDCALLS that were placed by an 
adjunct (outbound predictive dialing).

O_ACDCALLS includes DA_ACDCALLS.

Available for outbound calls on Generic 2.2 switches 
with the ASAI Gateway Interface feature and Generic 3 
switches with the ASAI feature.

C

O_ACDTIME The talk time of all O_ACDCALLS (does not include 
HOLDTIME). 

Available for outbound calls on Generic 2.2 switches 
with the ASAI Gateway Interface feature and Generic 3 
switches with the ASAI feature.

ACDTIME includes O_ACDTIME.

C

O_ACWTIME The duration of all after call work associated with 
O_ACDCALLS.

Available for outbound calls on Generic 2.2 switches 
with the ASAI Gateway Interface feature and Generic 3 
switches with the ASAI feature.

ACWTIME includes O_ACWTIME.

C

O_OTHERCALLS The number of outbound calls queued to this split/skill 
that were not answered or abandoned as ACD split/skill 
calls. These include forced busy calls and calls with 
unknown dispositions.

Available for outbound calls on Generic 2.2 switches 
with the ASAI Gateway Interface feature and Generic 3 
switches with the ASAI feature.

C
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OLDESTCALL
(real-time)

The number of seconds the oldest split/skill ACD call 
has waited in queue or ringing.

S

ONACD
(real-time)

The current number of POSITIONS that are on inbound 
and outbound ACD calls to this split/skill.

ONACD includes ONACDOUT.

S

ONACDAUXOUT
(real-time)

The current number of POSITIONS that are on 
AUXOUT calls and have an ACD call for this split/skill 
on hold. For agents in multiple skills with multiple call 
handling, the last call the agent put on hold was for this 
skill. 

Available for Generic 2.2 and Generic 3 switches.

S

ONACDOUT
(real-time)

The current number of POSITIONS that are on 
outbound calls placed by an adjunct to this split/skill. 

Available for outbound calls on Generic 2.2 switches 
with the ASAI Gateway Interface feature and Generic 3 
switches with the ASAI feature.

S

ONACWIN
(real-time)

The current number of POSITIONS that are in ACW for 
this split/skill and on inbound extension calls. These 
agents also appear in INACW.

ONACWIN includes agents receiving extension calls 
from ACW associated with split/skill ACD calls and 
from ACW not associated with an ACD call. 

S

ONACWOUT
(real-time)

The current number of POSITIONS that are in ACW for 
this split/skill and on outbound extension calls. These 
agents also appear in INACW.

ONACWOUT includes agents making extension calls 
from ACW associated with split/skill ACD calls and 
from ACW not associated with an ACD call. 

S

ONAUXIN
(real-time)

The current number of POSITIONS that are in AUX 
work or AVAILABLE, or, for Generic 2.2 and Generic 3 
switches, including agents who have an ACD or 
AUXIN/AUXOUT call on hold, and on inbound 
extension calls, where SPLIT is OLDEST LOGON.

S
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ONAUXOUT
(real-time)

The current number of POSITIONS that are in AUX 
work or AVAILABLE or, for Generic 2.2 and Generic 3 
switches, including agents who have an ACD or 
AUXIN/AUXOUT call attributed to this split/skill on 
hold, and on outbound extension calls.

S

ONHOLD
(real-time)

The current number of split/skill ACD calls for this 
split/skill on hold at agent positions.

Available on System 85, Generic 2, and Generic 3 
switches.

S

OTHER
(real-time)

The current number of POSITIONS that are doing 
OTHER work. For Generic 3 switches, other work 
includes: while in Auto-In or Manual-In mode, an agent 
put any call on hold and performed no further action; 
the agent is on a direct agent call or in ACW for a direct 
agent call; the agent is dialing to place a call or to 
activate a feature; an extension call or a direct agent 
ACD call is ringing with no other activity.

For Generic 2.2 switch, the agent in Auto-In/Manual-In 
put a call on hold using the Hold button or the 
switchhook flash and has performed no further action.

For Generic 2.2 switch with the EAS feature, Generic 1 
and Generic 3 switches, agents are logged into multiple 
splits/skill other than this one (on an ACD call that is 
ringing or in ACW).

For Generic 3 with EAS switches with multiple call 
handling, agents are available for other, multiple call 
handling, skills.

Agent POSITIONS will show up in OTHER directly 
after the link to the switch comes up and directly after 
the agents log in before the CMS is notified of the agent’s 
work state.

OTHER includes DA_INACW and DA_ONACD.

S
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OTHERCALLS The number of calls offered to this split/skill that did not 
abandon and were not answered by an ACD agent for 
this split/skill.

OTHERCALLS = BUSYCALLS + DISCCALLS + 
OUTFLOWCALLS + DEQUEUECALLS

C

OTHERTIME The time OTHERCALLS spent waiting and ringing in 
this split’s/skill’s queue until the disposition was 
known.

NOTE: OTHERTIME relates to time for OTHERCALLS 
and is not related to I_OTHERTIME, which is the time 
agents spent in the OTHER state.

OTHERTIME = BUSYTIME + DISCTIME + 
OUTFLOWTIME + DEQUETIME

C
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OUTFLOWCALLS The number of CALLSOFFERED that were redirected to 
another destination while queued to this split/skill. This 
can happen under different circumstances, depending 
on the switch release and on whether vectoring is active 
or not.

For Generic 1 or Generic 3 switches without vectoring, 
outflows are counted:

• if the call intraflowed or interflowed.
• if the split/skill call forwarding was active
• if a ringing ACD call was answered using call pickup
• if ringing ACD calls that redirects on no answer.

For Generic 3 switches with vectoring, outflows are 
counted:

• if ringing ACD calls that redirects on no answer.
• if the call rang at an agent in this split/skill and was 

answered using call pickup
• if the call was routed to another VDN
• if the call routed to a number or digits
• if the call queued to a messaging split/skill
• if the call queued to this split/skill as the primary 

split/skill and was answered by an agent in another 
split/skill, rang at an agent in another split/skill and 
then abandoned or was redirected by the Redirection 
on No Answer feature (for Generic 3 Version 2 and 
later switch releases).

For System 85 or Generic 2 switches without vectoring, 
outflows are counted when calls intraflow to another 
split or extension.

For System 85 or Generic 2 switches with vectoring 
(except for Generic 2.2 with EAS), outflows are counted:

• if the call was routed to another VDN
• if the call is routed to a number
• if the call queued to another split (using “queue to 

main” or “check backup”).

OUTFLOWCALLS includes INTERFLOWCALLS, 
NOANSREDIR, and SLVLOUTFLOWS.

C
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OUTFLOWCALLS 
(Contd)

For Generic 2.2 with EAS, outflows are counted:
• if the call was routed to another VDN
• if the call is routed to a number
• if the call is queued to this skill which is a nonzero skill 

as primary and then is queued to the “zero” skill
• if a call is queued to this skill which is a “zero” skill 

and then is queued to a “nonzero” skill
• if a call is queued to this skill as primary in one skill 

tens group and then is subsequently queued to another 
skill tens group.

C

OUTFLOWTIME The time OUTFLOWCALLS waited in queue or ringing 
at the agent’s voice terminal before being redirected.

C

PERIOD 1-9 The length, in seconds, of each service level increment as 
defined in the ACD Administration: Call Profile 
window. Each increment represents a progressively 
longer wait time. CentreVu CMS counts answered or 
abandoned calls that wait beyond the last increment 
(PERIOD9) in either ACDCALLS10 or ABNCALLS10.

A

PERIODCHG Indicates whether or not service level increments 
PERIOD1-9 (as defined on the ACD Administration: 
Call Profile window) changed during the collection 
interval. Valid values for PERIODCHG are YES and 
NO.

A

PHANTOMABNS The number of split/skill ACD calls with talk time less 
than the value of the phantom-abandoned call timer.

C

POSITIONS The current number of agent positions that are assigned 
to this SPLIT (non-EAS) or current number of agent 
positions logged into this skill (EAS).

A

RINGCALLS The number of this split/skill's calls that rang at agent 
positions.

Available on a Generic 2 and Generic 3 switch for ring 
tracking.

RINGCALLS includes ACDCALLS and 
NOANSREDIR.

C
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RINGTIME The time this split/skill's calls spent ringing at agent 
positions independent of final disposition and other 
agent activity. I_RINGTIME is the time the agent 
spends with ringing calls and is affected by other agent 
activity. RINGTIME is the time the caller spends 
ringing and is independent of agent activity. 

Available on a Generic 2 and Generic 3 switch for ring 
tracking.

C

ROW_DATE
(index)

The date on which data was collected. C

SERVICELEVEL The number of seconds within which calls must be 
answered in order to be considered acceptable for this 
split/skill (as defined on the ACD Administration: Call 
Profile window).

A

SLVLABNS The number of ABNCALLS whose time to abandon was 
less than or equal to this split/skill’s SERVICELEVEL.

C

SLVLOUTFLOWS The number of OUTFLOWCALLS whose time to 
outflow was less than or equal to this split/skill’s 
SERVICELEVEL.

C

SPLIT
(index)

The split/skill number for which data was collected. A

STAFFED
(real-time)

The current number of POSITIONS that are staffed 
(logged in).

STAFFED includes AGINRING, AVAILABLE, 
ONACD, INACW, INAUX, and OTHER.

S

STARTTIME The start time for the interval data was collected.

Applies to the interval table only.

C

SVCLEVELCHG Indicates whether or not the service level was changed 
during the collection interval. Valid values for 
SVCLEVELCHG are YES and NO.

A
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TAGINRING The number of top agents logged into the skill who have 
ACD calls ringing and who are not doing anything else.

Available with Generic 3 and Generic 2.2 switches with 
the EAS feature. However, “top” database items are only 
significant for Generic 3 switches and the ECS with EAS.

S

TAVAILABLE The number of top agents logged into the skill who are 
available in the skill.

Available with Generic 3 and Generic 2.2 switches with 
the EAS feature. However, “top” database items are only 
significant for Generic 3 switches and the ECS with EAS.

S

TDA_INACW The number of top agents logged into the skill who are 
in after call work associated with direct agent calls. 
TDA_INACW is a subset of TOTHER.

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling.

Available with Generic 3 and Generic 2.2 switches with 
the EAS feature. However, “top” database items are only 
significant for Generic 3 switches and the ECS with EAS.

S

TDA_ONACD The number of top agents logged into the skill who are 
talking on direct agent calls. TDA_ONACD is a subset 
of TOTHER.

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling.

Available with Generic 3 and Generic 2.2 switches with 
the EAS feature. However, “top” database items are only 
significant for Generic 3 switches and the ECS with EAS. 

S
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TINACW The number of top agents logged into the skill who are 
in after call work for ACD calls to the skill. This includes 
top agents on ACWIN/ACWOUT calls, as well as agents 
who are in after call work not associated with an ACD 
call.

Available with Generic 3 and Generic 2.2 switches with 
the EAS feature. However, “top” database items are only 
significant for Generic 3 switches and the ECS with EAS.

TINACW includes TONACWIN and TONACWOUT.

S

TINAUX The number of top agents logged into the skill who are 
in the AUX work mode. This includes agents on 
AUXIN/AUXOUT calls.

Available with Generic 3 and Generic 2.2 switches with 
the EAS feature. However, “top” database items are only 
significant for Generic 3 switches and the ECS with EAS.

TINAUX includes TINAUX0...TINAUX9, 
TONACDAUXOUT, TONAUXIN, and TONAUXOUT.

S

TINAUX0 The number of top agents logged into the skill who are 
in the AUX work for reason code 0 for all splits/skills or 
on AUXIN/AUXOUT calls for AUX with reason code 0. 
Reason code 0 is for “system” AUX work when reason 
codes are active (ECS with EAS). For switches without 
EAS and for releases prior to the ECS, TINAUX0 will be 
the same as TINAUX.

Available with Generic 3 and Generic 2.2 switches with 
the EAS feature. However, “top” database items are only 
significant for Generic 3 switches and the ECS with EAS.

TINAUX1-9 The number of top agents logged into the skill who are 
in AUX work for each of the reason codes 1-9. This 
includes agents on AUXIN/AUXOUT calls from AUX 
with the appropriate reason code.

Available with Generic 3 and Generic 2.2 switches with 
the EAS feature. However, “top” database items are only 
significant for Generic 3 switches and the ECS with EAS.

S
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TONACD The number of top agents logged into the skill who are 
on inbound and outbound ACD calls for the skill.

Available with Generic 3 and Generic 2.2 switches with 
the EAS feature. However, “top” database items are only 
significant for Generic 3 switches and the ECS with EAS.

TONACD includes TONACDOUT.

S

TONACDAUXOUT The number of top agents logged into the skill who are 
on AUXOUT calls with an ACD call for the skill on hold.

Available with Generic 3 and Generic 2.2 switches with 
the EAS feature. However, “top” database items are only 
significant for Generic 3 switches and the ECS with EAS.

S

TONACDOUT The number of top agents that are on outbound calls 
placed by an adjunct to this skill. 

Available with Generic 3 and Generic 2.2 switches with 
the EAS feature. However, “top” database items are only 
significant for Generic 3 switches and the ECS with EAS.

Available for outbound calls on Generic 2.2 switches 
with the ASAI Gateway Interface feature and Generic 3 
switches with the ASAI feature.

S

TONACWIN The number of top agents that are in ACW for this skill 
and on inbound extension calls. These agents also 
appear in TINACW.

Available with Generic 3 and Generic 2.2 switches with 
the EAS feature. However, “top” database items are only 
significant for Generic 3 switches and the ECS with EAS.

S

TONACWOUT The number of top agents that are in ACW for this skill 
and on outbound extension calls. These agents also 
appear in TINACW.

Available with Generic 3 and Generic 2.2 switches with 
the EAS feature. However, “top” database items are only 
significant for Generic 3 switches and the ECS with EAS.

S
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TONAUXIN The number of top agents that are in AUX work or 
AVAILABLE, including agents with an ACD or 
AUXIN/AUXOUT call attributed to this split/skill on 
hold and on inbound extension calls.

Available with Generic 3 and Generic 2.2 switches with 
the EAS feature. However, “top” database items are only 
significant for Generic 3 switches and the ECS with EAS.

S

TONAUXOUT The number of top agents that are in AUX work or 
AVAILABLE, including agents with an ACD or 
AUXIN/AUXOUT call attributed to this split/skill on 
hold and on inbound extension calls.

Available with Generic 3 and Generic 2.2 switches with 
the EAS feature. However, “top” database items are only 
significant for Generic 3 switches and the ECS with EAS.

S

TOPCALLS The number of ACDCALLS with top priority that were 
answered by agents in this split/skill. 

Available with System 85, Generic 2, and Generic 3 
switches with vectoring.

C
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TOTHER The number of top agents that are doing other work. For 
Generic 3, while in Auto-in or Manual-In mode: the 
agent put any call on hold and has performed no further 
action; the agent is on a direct agent call or in ACW for a 
direct agent call; the agent is dialing to place a call or to 
activate a feature; an extension call or a direct agent ACD 
call is ringing with no other activity.

Agents are logged into multiple splits/skills and doing 
work for a split/skill other than this one (on an ACD 
call, in ACW, or ACD calls ringing).

For Generic 3 EAS with multiple call handling, agents 
are available for other, multiple call handling, skills.

Agent POSITIONS will show up in TOTHER directly 
after the link to the switch comes up and directly after 
the agents log in before the CentreVu CMS is notified of 
the agent’s work state.

Available with Generic 3 and Generic 2.2 switches with 
the EAS feature. However, “top” database items are only 
significant for Generic 3 switches and the ECS with EAS.

TOTHER includes TDA_INACW and TDA_ONACD.

S

TRANSFERRED The number of ACDCALLS that were transferred to 
another destination.

For Generic 1 switch, includes transfers to a measured 
split or from a measured trunk to a measured trunk.

For System 85 and Generic 2.1 switches, includes 
transfers to a measured VDN or split.

For Generic 2.2 or Generic 3 switches, includes all 
split/skill calls transferred.

C
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Switch Cross- Reference 1

Table 1-2 lists which Split/Skill database items are supported by each of the 
switch releases.

TSTAFFED The current number of top agents that are staffed in 
SPLIT.

Available with Generic 3 and Generic 2.2 switches with 
the EAS feature. However, “top” database items are 
significant only for Generic 3 switches and the ECS with 
EAS.

TSTAFFED includes TAGINRING, TAVAILABLE, 
TINACD, TINACW, TINAUX, and TOTHER.

S

Note The following is a key to the database items tables:
• Items marked “X” indicate that the database item is supported by a 

switch.
• Items marked “EAS” require that the Expert Agent Selection fea-

ture be active on the switch for the items to be populated. 
• Items marked “e” are populated for the releases shown, but the 

values are only meaningful for EAS releases. 
• Items marked “t” are populated for the releases shown, but the 

values are only meaningful for Generic 3 EAS releases, with skill 
level distribution of calls.
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Table 1-2:  Switch Cross-Reference for Split/Skill Database Items 

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
G3V3 G3V4 ECS

ABNCALLS X X X X X X X X

ABNCALLS1-10 X X X X X X X X

ABNRINGCALLS X X X X X X

ABNTIME X X X X X X X X

ACCEPTABLE X X X X X X X X

ACD (index) X X X X X X X X

ACDAUXOUTCALLS X X X X X

ACDCALLS X X X X X X X X

ACDCALLS1-10 X X X X X X X X

ACDTIME X X X X X X X X

ACWINCALLS X X X X X X X X

ACWINTIME X X X X X X X X

ACWOUTADJCALLS X X X X X

ACWOUTCALLS X X X X X X X X

ACWOUTOFFCALLS X X X X X

ACWOUTOFFTIME X X X X X

ACWOUTTIME X X X X X X X X

ACWTIME X X X X X X X X

AGINRING X X X X X X

ANSTIME X X X X X X X X

ASA X X

ASSISTS X X X X X X X X
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AUXINCALLS X X X X X X X X

AUXINTIME X X X X X X X X

AUXOUTADJCALLS X X X X X

AUXOUTCALLS X X X X X X X X

AUXOUTOFFCALLS X X X X X

AUXOUTOFFTIME X X X X X

AUXOUTTIME X X X X X X X X

AVAILABLE X X X X X X X X

BACKUPCALLS X X X X X X X

BUSYCALLS X X X X X X X X

BUSYTIME X X X X X X X X

CALLSOFFERED X X X X X X X X

CONFERENCE X X X X X

DA_ACWINCALLS X X X X

DA_ACWINTIME X X X X

DA_ACWOCALLS X X X X

DA_ACWOTIME X X X X

DA_INACW X X X X

DA_INQUEUE X X X X

DA_INRING X X X X

DA_OLDESTCALL X X X X

DA_ONACD X X X X

DEQUECALLS EAS X X X X

Table 1-2:  Switch Cross-Reference for Split/Skill Database Items  (Contd)

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
G3V3 G3V4 ECS
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DEQUETIME EAS X X X X

DISCCALLS X X X X X X X

DISCTIME X X X X X X X

EVENT1-9 X X X X X X X

EWTHIGH X X

EWTLOW X X

EWTMEDIUM X X

EWTTOP X X

HIGHCALLS X X X X X X X

HOLDABNCALLS X X X X X X X

HOLDCALLS X X X X X X X

HOLDTIME X X X X X X X

I_ACDAUXINTIME X X X X X

I_ACDAUX_OUTTIME X X X X X

I_ACDOTHERTIME X X X X X

I_ACDTIME X X X X X X X X

I_ACWINTIME X X X X X X X X

I_ACWOUTTIME X X X X X X X X

I_ACWTIME X X X X X X X X

I_ARRIVED X X X X X X X X

I_AUXINTIME X X X X X X X X

I_AUXOUTTIME X X X X X X X X

Table 1-2:  Switch Cross-Reference for Split/Skill Database Items  (Contd)

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
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I_AUXTIME X X X X X X X X

I_AUXTIME0 X X X X X X X X

I_AUXTIME1-9 EAS

I_AVAILTIME X X X X X X X X

I_DA_ACDTIME X X X X

I_DA_ACWTIME X X X X

I_OTHERTIME X X X X X X X X

I_RINGTIME X X X X X X

I_STAFFTIME X X X X X X X X

I_TAUXTIME X X X X X X X X

I_TAVAILABLE X X X X X X X X

INACW X X X X X X X X

INAUX X X X X X X X X

INAUX0 X X X X X X X X

INAUX1-9 EAS

INCOMPLETE X X X X X X X X

INFLOWCALLS X X X X X X X X

INQUEUE X X X X X X X X

INRING X X X X X X

INTERFLOWCALLS X X X X X X X X

INTRVL X X X X X X X X

LOWCALLS X X X X X X X X

MAXINQUEUE X X X X X X X X

Table 1-2:  Switch Cross-Reference for Split/Skill Database Items  (Contd)

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
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MAXOCWTIME X X X X X X X X

MAXSTAFFED X X X X X X X X

MAXTOP t t t t t t t t

MEDCALLS X X X X X X X X

NOANSREDIR X X X

O_ABNCALLS X X X X X

O_ACDCALLS X X X X X

O_ACDTIME X X X X X

O_ACWTIME X X X X X

O_OTHERCALLS X X X X X

OLDESTCALL X X X X X X X X

ONACD X X X X X X X X

ONACDAUXOUT X X X X X

ONACDOUT X X X X X

ONACWIN X X X X X X X X

ONACWOUT X X X X X X X X

ONAUXIN X X X X X X X X

ONAUXOUT X X X X X X X X

ONHOLD X X X X X X X

OTHER X X X X X X X X

OTHERCALLS X X X X X X X X

OTHERTIME X X X X X X X X

Table 1-2:  Switch Cross-Reference for Split/Skill Database Items  (Contd)

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
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OUTFLOWCALLS X X X X X X X X

OUTFLOWTIME X X X X X X X X

PERIOD 1-9 X X X X X X X X

PERIODCHG X X X X X X X X

PHANTOMABNS X X X X

POSITIONS X X X X X X X X

RINGCALLS X X X X X X

RINGTIME X X X X X X

ROW_DATE X X X X X X X X

SERVICELEVEL X X X X X X X X

SLVLABNS X X X X X X X X

SLVLOUTFLOWS X X X X X X X X

SPLIT X X X X X X X X

STAFFED X X X X X X X X

STARTTIME X X X X X X X X

SVCLEVELCHG X X X X X X X X

TAGINRING t t t t t t t t

TAVAILABLE t t t t t t t t

TDA_INACW t t t t

TDA_ONACD t t t t

TINACW t t t t t t t t

TINAUX t t t t t t t t

TINAUX0 t t t t t t t t

Table 1-2:  Switch Cross-Reference for Split/Skill Database Items  (Contd)

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
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TINAUX1-9 EAS

TONACD t t t t t t t t

TONACDAUXOUT t t t t t

TONACDOUT t t t t t

TONACWIN t t t t t t t t

TONACWOUT t t t t t t t t

TONAUXIN t t t t t t t t

TONAUXOUT t t t t t t t t

TOPCALLS X X X X X X X

TOTHER t t t t t t t t

TRANSFERRED X X X X X X X X

TSTAFFED t t t t t t t t

Table 1-2:  Switch Cross-Reference for Split/Skill Database Items  (Contd)

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
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Agent Database Items 1

The Agent database item descriptions (Table 6) apply to real-time and 
historical items. 

The Type column refers to Cumulative (C), Administrative (A), or Status 
(S) data. Cumulative and Administrative items typically apply to both the 
current and previous interval real-time table. Status items apply only to the 
current interval real-time tables.

Real-Time agent database items apply to the Current Interval Agent 
(cagent ) and Previous Interval Agent (pagent ) tables. The real-time 
indexes are ACD, LOGID, POSITION, and SPLIT. 

Historical agent database items apply to the Intrahour Agent (hagent ), 
Daily Agent (dagent ), Weekly Agent (wagent ), and Monthly Agent 
(magent ) tables, except as noted. The historical indexes are LOGID, SPLIT, 
and ROW_DATE.

Table 6: Agent Database Items 

Database Item Description Type

ABNCALLS The number of split/skill ACD calls that were 
abandoned while ringing the agent's voice terminal 
(after being directed to the agent voice terminal, but 
before being answered). This includes calls considered 
abandoned because their talk time was less than the 
phantom-abandoned call timer.

For Generic 3 switches, ABNCALLS includes 
PHANTOMABNS.

Available on Generic 2 and Generic 3 switches.

C

ABNTIME The time split/skill ACD callers waited while ringing 
the agent’s voice terminal before being abandoned. 

For Generic 3 switches, ABNTIME includes the time 
from when ringing starts until the agent releases the call 
for phantom-abandoned calls.

Available on Generic 2 and Generic 3 switches.

C

ACD (index) The ACD number for which data were collected. A
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ACD_RELEASE The number of split/skill ACD calls that the agent 
released or dropped before the far end released. 

NOTE: The transfers and conferences are always 
recorded as agent-released calls.

Available for Generic 3 switches.

C

ACDAUXOUTCALLS The number of AUXOUTCALLS the agent made with at 
least one split/skill or direct agent ACD call on hold. 
This includes calls made to transfer or conference the 
ACD call.

Available on Generic 2.2 and Generic 3 switches.

C

ACDCALLS The number of calls that were queued to SPLIT and 
answered by this agent in this SPLIT.

ACDCALLS includes ACD_RELEASE and 
O_ACDCALLS.

C

ACDONHOLD
(real-time)

The number of direct agent and split/skill ACD calls on 
hold for the agent.

Available on System 85, Generic 2, and Generic 3 
switches.

S

ACDTIME The talk time of all ACDCALLS.

ACDTIME includes O_ACDTIME. It does not include 
HOLDTIME except System 85 and Generic 2.1 
switches.

C

ACWINCALLS The number of inbound extension calls received by the 
agent while in ACW for this split. This includes ACW for 
split/skill and direct agent ACD calls and ACW not 
associated with a call.

C

ACWINTIME Talk time of all ACWINCALLS (does not include 
HOLDTIME except on System 85 and Generic 2.1 
switches).

ACWINTIME includes DA_ACWINCALLS.

C

Table 6: Agent Database Items  (Contd)

Database Item Description Type
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ACWOUTADJCALLS The number of ACWOUTCALLS that were placed by an 
adjunct on behalf of an agent (keyboard-dialed). If such 
calls are placed to off-switch destinations, then they are 
also counted as ACWOUTOFFCALLS.

Available on the Generic 2.2 switch with the ASAI 
Gateway Interface feature and on the Generic 3 switch 
with the ASAI feature.

C

ACWOUTCALLS The number of outbound extension calls made by the 
agent or on behalf of the agent while in ACW for this 
split. This includes ACW for split/skill ACD calls and 
ACW not associated with a call. 

ACWOUTCALLS includes ACWOUTADJCALLS, 
ACWOUTOFFCALLS, and DA_ACWOCALLS.

C

ACWOUTOFFCALLS The number of ACWOUTCALLS that were made to an 
off-switch location. If these calls were placed by an 
adjunct on behalf of the agent (keyboard-dialed), then 
they are also counted as ACWOUTADJCALLS.

Available for external calls on Generic 2.2 and Generic 3 
switches.

C

ACWOUTOFFTIME The talk time of all ACWOUTOFFCALLS (does not 
include HOLDTIME). ACWOUTOFFTIME is included 
in ACWOUTTIME.

Available for external calls on Generic 2.2 and Generic 3 
switches.

C

ACWOUTTIME The talk time of all ACWOUTCALLS (does not include 
HOLDTIME except System 85 and Generic 2.1). This 
includes time on ACWOUTADJCALLS and on 
ACWOUTOFFCALLS.

ACWOUTTIME includes ACWOUTOFFTIME.

C

Table 6: Agent Database Items  (Contd)

Database Item Description Type
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ACWTIME The duration of all after call work associated with 
ACDCALLS, including ACWINTIME and 
ACWOUTCALLS received/made during call-associated 
ACW.

NOTE: ACWTIME does not include the time spent in 
ACW not associated with an ACD call (that is, the agent 
pressed the ACW button while not on an ACD call). 
However, both ACWINTIME and ACWOUTTIME do 
include time spent on calls made or received while in 
ACW not associated with an ACD call. Therefore, the 
sum of ACWINTIME and ACWOUTIME may be greater 
than ACWTIME.

ACWTIME includes ACWINTIME, ACWOUTTIME, 
DA_ACWTIME, and O_ACWTIME.

C

AGSTATE
(real-time)

The agent's current WORKMODE and call 
DIRECTION, for example, AUXOUT.

S

AGTIME
(real-time)

The elapsed time since the last agent WORKMODE 
change for any split/skill. This item is not reset if the 
DIRECTION changes, but WORKMODE remains the 
same. For example, if the agent goes from AUX to 
AUXOUT to AUX, AGTIME continues without resetting.

S

ANSRINGTIME The time split/skill and direct agent ACD calls spent 
ringing at the agent's voice terminal before being 
answered. 

Available for ring-tracking on Generic 2 and Generic 3 
switches.

C

ASSIST
(real-time)

A request for supervisor assistance is active for this 
agent for any split/skill.

S

ASSISTS The number of times the split/skill supervisor was 
called (supervisor assists) by the agent who was on a 
split/skill or direct agent ACD call or in call-related after 
call work (ACW).

C

Table 6: Agent Database Items  (Contd)

Database Item Description Type
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AUXINCALLS The number of inbound extension calls the agent 
received while in AUX (auxiliary work), AVAILABLE, 
or, for Generic 2.2 and Generic 3 switches, with an ACD 
or AUXIN/AUXOUT call on hold.

C

AUXINTIME The talk time of all AUXINCALLS (does not include 
HOLDTIME except on System 85 and Generic 2.1 
switches).

C

AUXOUTADJCALLS The number of AUXOUTCALLS an adjunct processor 
or host computer placed on behalf of the agent 
(keyboard dialed). If such calls are placed to off-switch 
destinations, then they are also counted as 
AUXOUTOFFCALLS.

Available for outbound calls on Generic 2.2 switches 
with the ASAI Gateway Interface feature and Generic 3 
switches with the ASAI feature.

C

AUXOUTCALLS The number of outbound extension calls made by the 
agent or on behalf of the agent while in AUX work, 
AVAILABLE or, for Generic 2.2 and Generic 3 switches, 
with an ACD or AUXIN/AUXOUT call on hold. 

NOTE: Calls the agent makes to transfer or conference 
an ACD call are included as AUXOUT calls.

AUXOUTCALLS includes ACDAUXOUTCALLS, 
AUXOUTADJCALLS, and AUXOUTOFFCALLS.

C

AUXOUTOFFCALLS The number of AUXOUTCALLS that were made to an 
off-switch location. If these calls were placed by an 
adjunct on behalf of the agent (keyboard-dialed), then 
they are also counted as AUXOUTADJCALLS.

Available for external calls on Generic 2.2 and Generic 3 
switches.

C

AUXOUTOFFTIME The talk time of all AUXOUTOFFCALLS (does not 
include HOLDTIME). This time is included in 
AUXOUTTIME.

Available for external calls on Generic 2.2 and Generic 3 
switches.

C

Table 6: Agent Database Items  (Contd)

Database Item Description Type
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AUXOUTTIME The talk time of all AUXOUTCALLS (does not include 
HOLDTIME except on Generic 2.1 and System 85 
switches). This includes time on AUXOUTOFFCALLS 
and AUXOUTADJCALLS.

AUXOUTTIME includes AUXOUTOFFTIME.

C

AUXREASON The reason code associated with the agent’s current 
state. This is blank if the agent is not in the AUX state. 
For agents in AUX on releases that are earlier than 
DEFINITY ECS or that do not have EAS and reason 
codes active, this will only be 0.

S

AWORKMODE The current work mode for the agent. This item is 
identical to WORKMODE, except when the agent is 
available in some, but not all, splits/skills. In this case, 
AWORKMODE is only set to AVAIL if the agent is 
available in SPLIT. Otherwise, AWORKMODE is set to 
OTHER.

S

CHANGED
(real-time)

Time of day that new agent activity started (for example, 
when WORKMODE or DIRECTION changed). Valid 
values are blank and time-of-day.

S

CONFERENCE The number of times the agent completed a conference, 
that is, pushed the conference key a second time).

Available on Generic 3 and Generic 2.2 switches.

C

DA_ABNCALLS The number of direct agent ACD calls that were 
abandoned by callers while in queue or ringing the 
agent's voice terminal. This includes calls considered 
abandoned because their talk time was less than the 
phantom-abandon call timer.

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling.

C

Table 6: Agent Database Items  (Contd)

Database Item Description Type
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DA_ABNTIME The time DA_ABNCALLS spent queued and ringing 
before the caller abandoned. This includes the time until 
the agent releases the call for phantom-abandoned calls. 

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling.

C

DA_ACDCALLS The number of direct agent ACD calls that the agent 
answered.

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling.

DA_ACDCALLS includes DA_RELEASE.

C

DA_ACDTIME The talk time of all DA_ACDCALLS (does not include 
HOLDTIME). 

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling.

C

DA_ACWINCALLS The number of inbound extension calls answered by the 
agent while in ACW for direct agent ACD calls.

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling.

C

DA_ACWINTIME The talk time of all DA_ACWINCALLS (does not 
include HOLDTIME). 

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling.

C

DA_
ACWOADJCALLS

The number of DA_ACWINCALLS that were placed by 
an ASAI adjunct on behalf of the agent (keyboard-
dialed). If these calls were placed to off-switch 
destinations, they are also counted as 
DA_ACWOFFCALLS.

Requires a Generic 3 switch with the ASAI. 

C

Table 6: Agent Database Items  (Contd)

Database Item Description Type
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DA_ACWOCALLS The number of outbound extension calls made by the 
agent while in ACW for direct agent ACD calls.

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling.

DA_ACWOCALLS includes DA_ACWOADJCALLS 
and DA_ACWOOFFCALLS.

C

DA_
ACWOOFFCALLS

The number of DA_ACWOCALLS that were made to an 
off-switch location. If these calls were placed by an 
adjunct on behalf of the agent (keyboard-dialed), they 
are also counted as DA_ACWOADJCALLS.

Requires a Generic 3 switch with ASAI. 

C

DA_ACWOOFFTIME The talk time of all DA_ACWOOFFCALLS (does not 
include HOLDTIME). DA_ACWOOFFTIME is 
included in DA_ACWOTIME.

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling. 

C

DA_ACWOTIME The talk time of all DA_ACWOCALLS (does not include 
HOLDTIME).

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling. 

DA_ACWOTIME includes DA_ACWOOFFTIME.

C

DA_ACWTIME The duration of ACW associated with DA_ACDCALLS, 
including time on DA_ACWINCALLS and 
DA_ACWOCALLS. 

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling.

DA_ACWTIME includes DA_ACWINTIME and 
DA_ACWOTIME.

C

DA_ANSTIME The time spent by callers in direct agent queue and 
ringing before being answered.

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling. 

C

Table 6: Agent Database Items  (Contd)

Database Item Description Type
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DA_INQUEUE
(real-time)

The current number of direct agent calls waiting in any 
split/skill’s queue for this agent. 

Available on Generic 3 switches with direct agent calling 
(the ASAI or EAS feature is required).

S

DA_OLDESTCALL
 (real-time)

The length of time that the current oldest direct agent 
call has waited in any split/skill queue for this agent. 

Available on Generic 3 switches with direct agent calling 
(the ASAI or EAS feature is required).

S

DA_OTHERCALLS The number of direct agent calls that were redirected to 
another destination. 
For example, by call pickup, coverage or Redirection on 
No Answer.

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling. 

C

DA_OTHERTIME The time spent in queue or ringing by 
DA_OTHERCALLS before being redirected.

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling. 

C

DA_RELEASE The number of direct agent ACD calls released or 
dropped by the agent before the far end released. 

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling. 

C

DA_SKILL The skill currently assigned as the agent’s direct agent 
skill. Direct agent calls to the agent are queued to this 
skill.

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling. 

S

DESTINATION
(real-time)

The type of outbound call destination for the call the 
agent is active on for any split/skill. Valid values are 
blank, PBX, and OFF.

S

Table 6: Agent Database Items  (Contd)

Database Item Description Type
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DIRECTION
(real-time)

The direction of the call the agent is currently handling 
for any split/skill. Valid values are blank, IN, OUT, or as 
defined in Dictionary). If the agent is not on a call, the 
value is blank.

S

DURATION 
(real-time)

The duration of current WORKMODE and 
DIRECTION for this SPLIT (for example, length of time 
in current AGSTATE for this SPLIT).

S

EVENT1-9 The number of times each event (stroke count) feature 
button (1 to 9) was pressed while the agent was on an 
ACD call or in call-related after call work.

Available on System 85, Generic 2, and Generic 3 
switches.

C

EXTENSION The extension number for which data was collected. A

HOLDABNCALLS The number of times callers abandoned from hold.

For Generic 3 and Generic 2.2 switches, 
HOLDABNCALLS includes all calls held.

For System 85 and Generic 2.1 switches, 
HOLDABNCALLS includes split calls held.

C

HOLDACDTIME The time split/skill and direct agent ACD calls spent on 
hold at the agent’s voice terminal. This includes time on 
AUXIN or AUXOUT calls with the ACD calls on hold.

C

HOLDCALLS The number of calls that were placed on hold at least 
once. 

For Generic 3 and Generic 2.2 switches, HOLDCALLS 
includes all calls.

For System 85 and Generic 2.1 switches, HOLDCALLS 
includes split calls only.

HOLDCALLS includes HOLDABNCALLS.

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling. 

C

Table 6: Agent Database Items  (Contd)

Database Item Description Type
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HOLDTIME The time spent by callers on hold.

For Generic 3 and Generic 2.2 switches, HOLDTIME 
includes all calls.

For System 85 and Generic 2.1 switches, HOLDTIME 
includes split calls only.

HOLDTIME includes HOLDACDTIME.

C

I_ACDAUXINTIME The time during the collection interval that the agent 
spent talking on AUXIN calls with at least one split/skill 
or direct agent ACD call on hold. For agents in multiple 
splits/skills, this time is recorded in the record in which 
SPLIT is OLDEST_LOGON. 

Available on Generic 2.2 and Generic 3 switches.

C

I_ACDAUX_
OUTTIME

The time during the collection interval that the agent 
spent dialing (Generic 2.2) and talking on AUXOUT calls 
with at least one split/skill or direct agent ACD call for 
this split/skill with the call on hold.

Available on Generic 2.2 and Generic 3 switches. 

C

I_ACDOTHERTIME The time during the collection interval that the agent 
spent in the OTHER state (dialing an outgoing call, with 
a ringing personal call [Generic 3 switches], or with calls 
on hold and with no other state selected) with at least 
one split/skill or direct agent ACD call on hold. 

Available on Generic 2.2 and Generic 3 switches.

C

I_ACDTIME The time during the collection interval that the agent 
was talking on ACD calls for SPLIT. This includes time 
spent on O_ACDCALLS. Does not include HOLDTIME 
except on System 85 and Generic 2.1 switches.

C

I_ACWINTIME The time during the collection interval that the agent 
was in ACW for SPLIT and on inbound extension calls. 
This includes ACW for split/skill ACD calls and ACW 
not associated with a call. I_ACWINTIME does not 
include the time inbound ACW calls spent on hold 
except for System 85 and Generic 2.1 switches.

C

Table 6: Agent Database Items  (Contd)

Database Item Description Type
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I_ACWOUTTIME The time during the collection interval that the agent 
was in ACW for SPLIT and on outbound extension calls. 
This includes ACW for split/skill ACD calls and ACW 
not associated with a call. I_ACWOUTTIME does not 
include the time outbound ACW calls spent on hold 
except for System 85 and Generic 2.1 switches.

C

I_ACWTIME The time during the collection interval that the agent 
was in ACW for SPLIT. This includes ACW for 
split/skill ACD calls and ACW not associated with a 
call.

NOTE: I_ACWINTIME and I_ACWOUTTIME include 
time in ACW for direct agent calls, but I_ACWTIME 
does not include this time. Therefore, the sum of 
I_ACWINTIME and I_ACWOUTTIME may be greater 
than I_ACWTIME.

I_ACWTIME includes I_ACWINTIME and 
I_ACWOUTTIME.

C

I_AUXINTIME The time during the collection interval that the agent 
was in AUX work, AVAILABLE, or for Generic 2.2 and 
Generic 3 switches, including time when an ACD or 
AUXIN/AUXOUT call is on hold and on inbound 
extension calls and SPLIT was the OLDEST_LOGON. 

I_AUXINTIME includes I_ACDAUXINTIME. It does 
not include HOLDTIME except for System 85 and 
Generic 2.1 switches.

C
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I_AUXOUTTIME The time during the collection interval that the agent 
was in AUX work, AVAILABLE, or, for Generic 2.2 and 
Generic 3 switches, including time when an ACD or 
AUXIN/AUXOUT call on hold and on outbound 
extension calls. In the cases where the agent was in AUX 
work, AVAILABLE or had an AUXIN/AUXOUT call on 
hold, the AUXOUT time and calls are recorded for the 
SPLIT that is the OLDEST_LOGON. In the case where 
the agent had an ACD call on hold, SPLIT is the split or 
skill associated with the last ACD call put on hold. Does 
not include time AUXOUT calls spent on hold except for 
System 85 and Generic 2.1 switches.

I_AUXOUTTIME includes I_ACDAUX_OUTTIME.

C

I_AUXTIME The time the agent spent in AUX work in SPLIT. When 
an agent is in AUX work in multiple splits/skills, this 
time is recorded in each split or skill in which the agent 
is in AUX.

I_AUXTIME includes I_AUXINTIME and 
I_AUXOUTTIME.

C

I_AVAILTIME The time during the collection interval that the agent 
was available for calls in this split/skill.

C

I_DA_ACDTIME The time during the collection interval that the agent 
spent talking on direct agent calls. Does not include 
HOLDTIME. 

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling. 

C

I_DA_ACWTIME The time during the collection interval that the agent 
was doing after call work associated with direct agent 
ACD calls. 

Requires a Generic 3 switch with the ASAI or EAS 
feature for direct agent calling. 

C
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I_OTHERTIME The time during the collection interval that the agent 
was doing other work. 

For Generic 3 switches, other work includes: while in 
Auto-In or Manual-In mode, an agent put any call on 
hold and performed no further action; the agent had a 
direct agent call ringing, was on a direct agent call or in 
ACW for a direct agent call; the agent dialed to place a 
call or activate a feature; or a personal call rang at the 
agent with no other activity. 

For Generic 1 and Generic 3 switches without EAS, 
agents were logged into multiple splits and doing work 
for a split other than this one (on an ACD call, in call-
related ACW, or ACD call ringing). 

For Generic 2.2, the agent pushed the Hold button or 
flashed the switchhook from auto-in or manual-in mode.

For Generic 2.2 and Generic 3 switches with EAS, the 
agent was logged into multiple skills and doing work for 
a skill other than this one (on an ACD call, in call-related 
ACW, multiple-call handling skills). 

For all switches, I_OTHERTIME is collected for the time 
period after the link to the switch comes up or after the 
agent logs in and before the CentreVu CMS receives 
notification of the agent's state from the switch.

I_OTHERTIME includes I_ACDOTHERTIME.

C

I_RINGTIME The time during the collection interval that the agent had 
split/skill and direct agent ACD calls ringing. If the 
agent changes work modes or makes/receives another 
call instead of answering the ringing call, I_RINGTIME 
will stop accumulating. RINGTIME is the time the caller 
spends ringing and is independent of agent activity.

Available on a Generic 2 and Generic 3 switch for ring 
tracking.

C
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I_STAFFTIME The time during the collection interval that the agent 
was staffed (logged in) in this split/skill.

I_STAFFTIME includes I_ACDTIME, I_ACWTIME, 
I_AUXTIME, I_AVAILABLE, I_DA_ACDTIME, 
I_DA_ACWTIME, I_OTHERTIME, and I_RINGTIME.

C

INCOMPLETE This indicates whether or not data is complete for this 
collection interval. Data is incomplete whenever the link 
goes down and whenever tracking is aborted for calls, 
due to trunk failures (System 85 and Generic 2 switches), 
the trunk going maintenance busy with a call active 
(Generic 1 and Generic 3 switches), or to protocol 
failures. 

The value for interval tables indicates whether data is 
incomplete for the interval (0 = data complete, 1 = data 
incomplete). The value in the daily, weekly, and monthly 
tables indicates the number of incomplete intervals in 
the day, week, or month.

C

INTRVL The number of minutes in the intrahour interval (15, 30, 
60).

INTRVL applies to intrahour intervals only.

A

LEVEL The skill level (1-16) associated with SPLIT.

Requires an ECS with EAS.

S

LOGID 
(index)

The Login ID that was used to staff the EXTENSION. 
Agents in multiple splits/skills have one LOGID.

A

LOGONSKILL
(real-time)

The first split/skill the agent logged in with.

Requires a Generic 2.2 or Generic 3 switch with EAS.

S

LOGONSKILL2-20
(real-time)

The second through twentieth skills the agent logged in 
with.

The number of skills per agent depends on the type of 
switch.

Requires a Generic 2.2 or Generic 3 switch with EAS.

S

Table 6: Agent Database Items  (Contd)
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LOGONSTART
(real-time)

The time of day that the agent logon session started for 
this SPLIT. This field is not set unless the agent is logged 
in. If the agent has not logged in during the collection 
interval, the value will be blank. Valid values are blank 
and time-of-day.

S

MALICIOUS
(real-time)

This indicates whether a malicious call trace is active for 
the agent for any split/skill. 

Available on Generic 2 and Generic 3 switches (except 
for Generic 3i Version 1 switches).

S

MOVEPENDING
(real-time)

A move to a new split or skill or a change of skills is 
pending for this agent. This is only available for G3V4 
and later switch releases with the “Move Agent While 
Staffed” feature.

S

NOANSREDIR The number of split/skill and direct agent ACD calls 
that rang at this agent’s voice terminal and then were 
automatically redirected by the Redirection on No 
Answer feature because they were not answered. 
Split/skill ACD calls are requeued to the split/skill or to 
a VDN, direct agent ACD calls are redirected to the 
agent’s coverage path.

Redirection On No Answer to a split/skill is available on 
DEFINITY ECS or Generic 3 Version 2 or later switches. 
Redirection On No Answer to a VDN is only available 
on DEFINITY ECS.

C

O_ACDCALLS The number of ACDCALLS and DA_ACDCALLS that 
were placed by an adjunct (predictive dialing).

Available for outbound calling on a Generic 2.2 switch 
with the ASAI Gateway Interface feature and on a 
Generic 3 switch with the ASAI feature.

C

O_ACDTIME The talk time of all O_ACDCALLS (does not include 
HOLDTIME). This time is included in ACDTIME.

Available for outbound calling on a Generic 2.2 switch 
with the ASAI Gateway Interface feature and on a 
Generic 3 switch with the ASAI feature.

C
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O_ACWTIME The duration of all after call work associated with the 
O_ACDCALLS. This time is included in ACWTIME. 

Available for outbound calling on a Generic 2.2 switch 
with the ASAI Gateway Interface feature and on a 
Generic 3 switch with the ASAI feature.

C

OLDEST_LOGON 
(real-time)

The split/skill the agent has been logged into the 
longest.

For Generic 2.2 switches with EAS, this is always the 
default (zero) skill.

For Generic 3 switches with EAS, this is always the first 
administered skill.

S

ONHOLD 
(real-time)

The current number of calls for any split/skill on hold at 
the agent's station.

For Generic 2.2 and Generic 3 switches, ONHOLD 
includes all calls.

For System 85 and Generic 2.1 switches, ONHOLD 
includes split ACD calls only.

ONHOLD includes ACDONHOLD.

S

ORIGIN
(real-time)

The outbound call origination for the call the agent is 
currently talking on for any split/skill. Valid values for 
ORIGIN are blank, PHONE, and KEYBOARD (adjunct-
dialed).

S

PENDINGSPLIT
(real-time)

The split or skill to which the agent will be moved. The 
move is pending until the agent is idle. In the case of a 
change of multiple skills in one request, 
PENDINGSPLIT is set to the first new skill for the 
agent. It is possible for PENDINGSPLIT to be blank or 
0, even when MOVEPENDING is set. This can happen 
when the link to the switch comes up and a move is 
pending for an agent.

Available on Generic 3 Version 4 and later switches.

S
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PHANTOMABNS The number of ACD calls with talk time less than the 
value of the phantom- abandoned call timer.

Available on Generic 3 switches.

C

POSITION
(index)

The position number associated with this EXTENSION. 
Agents in multiple splits without EAS have multiple 
POSITIONs. Agents in multiple skills with EAS have a 
single POSITION.

A

PREFERENCE The agent’s call handling preference. Valid values are 
blank, skill level (LVL) or greatest need (NEED).

Requires an ECS with EAS.

S

RINGCALLS The number of split/skill (Generic 2 and Generic 3 
switches) and direct agent ACD calls (Generic 3 
switches) that rang at the agent's position. 

Available on Generic 2 and Generic 3 switches for ring 
tracking.

RINGCALLS includes NOANSREDIR.

C

RINGTIME The time split/skill and direct agent ACD calls spent 
ringing at the agent's position (independent of 
disposition or other agent activity). I_RINGTIME is the 
time the agent spends in the ringing state and is affected 
by other agent activity. RINGTIME is the time the caller 
spends ringing and is independent of agent activity. 

Available on Generic 2 and Generic 3 switches.

RINGTIME includes ANSRINGTIME.

C

ROW_DATE (index) The date on which data was collected. C
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SKILLTYPE
(real-time)

The type (“p” for primary or “s” for secondary) of the 
first skill that the agent logged into. 

Requires Generic 2.2 or Generic 3 Version 2 switches 
with EAS.

NOTE: For the ECS and later EAS releases, skill level 1 
will be represented by “p”, skill level 2 by “s” and skill 
levels 3-16 by blank. Users of more than 2 skill levels 
should use SKLEVEL items instead of SKILLTYPE 
items.

S

SKILLTYPE2-4
(real-time)

The type (“p” for primary or “s” for secondary) of the 
second, third, and fourth skills the agent logged into. 

Requires Generic 2.2 or Generic 3 Version 2 switches 
with EAS.

NOTE: For the ECS and later EAS releases, skill level 1 
will be represented by “p”, skill level 2 by “s” and skill 
levels 3-16 by blank. Users of more than 2 skill levels 
should use SKLEVEL items instead of SKILLTYPE 
items.

S

SKLEVEL The skill level (from 1-16) associated with the first skill 
the agent logged into.

Requires an ECS with EAS.

S

SKLEVEL2-20 The skill level (from 1-16) associated with the second 
through twentieth skills the agent logged into.

Requires an ECS with EAS. 

S

SPLIT 
(index)

The split number that this EXTENSION is assigned to or 
the skill number that the agent logged into.

A

STARTED 
(real-time)

Time of day that WORKMODE began. Valid values are 
NULL and time-of day.

S

STARTTIME The start time for the interval for which the data was 
collected. 

NOTE: Applies only to the Interval table.

C
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TI_AUXTIME Time during the collection interval that the agent was in 
AUX for all splits/skills or on AUXINCALLS or 
AUXOUTCALLS. “TI_” time is only stored for the 
split/skill logged in to the longest. “TI_” time needs to 
be summed across the splits/skills the agents may log in 
to, in case the login order changes during the collection 
interval.

sum(TI_AUXTIME) = sum(TI_AUXTIME0 +
TI_AUXTIME1 + TI_AUXTIME2 + TI_AUXTIME3 + 
TI_AUXTIME4 + TI_AUXTIME5 + TI_AUXTIME6 + 
TI_AUXTIME7 + TI_AUXTIME8 + TI_AUXTIME9), 
over all splits/skills the agent was logged into.

TI_AUXTIME includes TI_AUXTIME0...AUXTIME9, 
I_AUXINTIME, and I_AUXOUTTIME.

Requires an ECS with the EAS feature.

C

TI_AUXTIME0 The time the agent spent in AUX with reason code 0. 
This is time in “system” AUX for switches with AUX 
reason codes active. It is the same as TI_AUXTIME for 
switches without AUX reason codes active. “TI_” time is 
only stored for the skill logged in to the longest. “TI_” 
time needs to be summed across the skills the agents 
may log in to, in case the login order changes during the 
collection interval.

Requires an ECS with the EAS feature.

C

TI_AUXTIME1-9 The time the agent spent in AUX with reason codes 1-9. 
“TI_” time is only stored for the skill logged in to the 
longest. “TI_” time needs to be summed across the skills 
the agents may log in to, in case the login order changes 
during the collection interval.

Requires an ECS with the EAS feature.

C
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TI_AVAILTIME The time during the collection interval that the agent 
was in the available state for split/skill or direct agent 
ACD calls in any split/skill. TI_AVAILTIME is recorded 
for the split/skill that was the OLDEST_LOGON. 

For non-EAS operation, if an agent logged into multiple 
splits and is in AUX mode in one split and is available 
for ACD calls in another split, the agent will accrue 
I_AVAILTIME for the split in which the agent is 
available and TI_AVAILTIME in the split logged into 
the longest. 

“TI_” time is only stored for the split/skill logged into 
the longest. “TI_” time needs to be summed across the 
splits/skills the agents may log in to, in case the login 
order changes during the collection interval.

C

TI_OTHERTIME The time during the collection interval that the agent 
was doing other work in all splits/skills.

For Generic 3 switches, other work includes: while in 
Auto-In or Manual-In mode, the agent put any call on 
hold and performed no further action, the agent dialed 
to place a call or to activate a feature, or an extension call 
rang with no other activity.

For Generic 2.2 switches, the agent pushed the Hold 
button or flashed the switchhook from auto-in or 
manual-in mode and performed no further action.

For all switches, TI_OTHERTIME is collected for the 
time period after the link to the switch comes up or after 
the agent logs in and before the CentreVu CMS receives 
notification of the agent's state from the switch. 

“TI_” time is only stored for the split/skill logged into 
the longest. “TI_” time needs to be summed across the 
splits/skills the agents may log in to, in case the login 
order changes during the collection interval.

TI_OTHERTIME includes I_ACDOTHERTIME.

C
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TI_STAFFTIME The time during the collection interval that the agent 
was staffed in any split/skill. “TI_” time is only stored 
for the split/skill logged into the longest. “TI_” time 
needs to be summed across the splits/skills the agents 
may log in to, in case the login order changes during the 
collection interval.

sum(TI_STAFFTIME) = sum(I_ACDTIME + 
I_ACWTIME + I_RINGTIME + I_DA_ACDTIME + 
I_DA_ACWTIME + TI_AUXTIME + TI_AVAILTIME + 
TI_OTHERTIME), over all splits/skills the agent was 
logged into.

TI_STAFFTIME includes I_ACDTIME, I_ACWTIME, 
I_DA_ACDTIME,
I_DA_ACWTIME, I_RINGTIME, TI_AUXTIME, 
TI_AVAILTIME, and TI_OTHERTIME.

C

TOPSKILL The agent’s first-administered, highest-level, measured 
skill, where skill level 1 is the highest, skill level 16 is the 
lowest.

Available on a Generic 3 switch with EAS.

S

TRANSFERRED The number of times the agent completed a transfer, that 
is, pressed the transfer key the second time.

For Generic 1 switches, this includes a measured call to a 
measured split or a measured trunk.

For Generic 2.2 and Generic 3 switches, this includes 
transferring all calls.

For System 85 and Generic 2.1 switches, this includes 
transferring all calls to a measured VDN or split.

C
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TYPE
(real-time)

The skill type (“p” for primary or “s” for secondary) 
associated with SPLIT. 

Available on Generic 3 switches with vectoring.

NOTE: For the ECS and later EAS releases, skill level 1 
will be represented by “p”, skill level 2 by “s” and skill 
levels 3-16 by blank. Users of more than 2 skill levels 
should use SKLEVEL items instead of SKILLTYPE 
items.

S

VDN 
(real-time)

The vector directory number associated with the agent's 
current split/skill or direct agent ACD call. 

Available on a System 85, Generic 2, Generic 3 with 
vectoring, and Generic 3 Version 4 switch with EAS.

S

WORKMODE 
(real-time)

The current work mode of the agent. Valid agent work 
modes include: AVAIL, ACD, ACW, AUX, DACD, 
DACW, RING, UNKNOWN, OTHER, and UNSTAFF. If 
the agent has not been logged in during the collection 
interval, the value will be blank.

S

WORKSKILL 
(real-time)

When an agent is on a split/skill or direct agent ACD 
call or in ACW, this is the split/skill associated with the 
call or ACW. When an agent is available, in AUX or in 
OTHER, this is null (blank). When an agent is on an 
AUXIN/AUXOUT call, this is OLDEST_LOGON 
split/skill. When an agent is on an AUXIN/AUXOUT 
call from the available state, while in AUX or with an 
AUXIN/AUXOUT call on hold, this is 
OLDEST_LOGON split/skill. When an agent is on an 
AUXOUT call with an ACD call on hold, this is the 
split/skill associated with the ACD call.

WORKSKILL differs from WORKSPLIT only in the 
case that the agent is available. In this case, 
WORKSKILL will be blank and WORKSPLIT will 
contain one of the split/skills in which the agent is 
available.

Requires a Generic 2.2 or Generic 3 Version 2 or later 
switch with EAS.

S
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WORKSKLEVEL The skill level associated with the agent’s current 
WORKSKILL, when WORKSKILL is not null.

Requires a Generic 2.2 or Generic 3 Version 2 or later 
switch with EAS.

S

WORKSPLIT 
(real-time)

When an agent is on a split/skill or direct agent ACD 
call or in ACW, this is the split/skill associated with the 
call or ACW. 

When an agent is available, this is one of the splits/skills 
the agent went available in. 

When an agent is on an AUXIN/AUXOUT call from the 
available state, while in AUX or with an 
AUXIN/AUXOUT call on hold, this is 
OLDEST_LOGON split/skill. 

When an agent is on an AUXIN call with an ACD call on 
hold, this is OLDEST_LOGON split/skill. 

When an agent is on an AUXOUT call with an ACD call 
on hold, this is the split/skill associated with the ACD 
call.

WORKSKILL differs from WORKSPLIT only in the 
case that the agent is available. In this case, 
WORKSKILL will be blank and WORKSPLIT will 
contain one of the split/skills in which the agent is 
available. For releases with EAS active, it is 
recommended to use WORKSKILL instead of 
WORKSPLIT in reports.

S

WORKSPLIT2-20
(real-time)

For agents available in multiple splits/skills, other 
splits/skills in which the agent is available. 

Available on Generic 2.2 with EAS, Generic 1 and 
Generic 3 switches.

S
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Switch Cross-Reference 1

Table 7 lists which Agent database items are supported by each of the switch 
releases. 

Note The following is a key to the database items tables:
• Items marked “X” indicate that the database item is supported by a switch.
• Items marked “EAS” require that the Expert Agent Selection feature be active 

on the switch for the items to be populated. 
• Items marked “e” are populated for the releases shown, but the values are 

only meaningful for EAS releases. 
• Items marked “*” are populated for the releases shown, but the values are only 

meaningful for Generic 3 EAS releases, with skill level distribution of calls.

Table 7: Switch Cross-Reference for Agent Database Items 

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
G3V3 G3V4 ECS

ABNCALLS X X X X X X

ABNTIME X X X X X X

ACD X X X X X X X X

ACD_RELEASE X X X X

ACDAUXOUTCALLS X X X X X

ACDCALLS X X X X X X X X

ACDONHOLD X X X X X X X

ACDTIME X X X X X X X X

ACWINCALLS X X X X X X X X

ACWINTIME X X X X X X X X

ACWOUTADJCALLS X X X X X

ACWOUTCALLS X X X X X X X X

ACWOUTOFFCALLS X X X X X

ACWOUTOFFTIME X X X X X
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ACWOUTTIME X X X X X X X X

ACWTIME X X X X X X X X

AGSTATE X X X X X X X X

AGTIME X X X X X X X X

ANSRINGTIME X X X X X X

ASSIST X X X X X X X X

ASSISTS X X X X X X X X

AUXINCALLS X X X X X X X X

AUXINTIME X X X X X X X X

AUXOUTADJCALLS X X X X X

AUXOUTCALLS X X X X X X X X

AUXOUTOFFCALLS X X X X X

AUXOUTOFFTIME X X X X X

AUXOUTTIME X X X X X X X X

AUXREASON Xa X* X* X* X* X* X* X*

AWORKMODE X X X X X X X X

CHANGED X X X X X X X X

CONFERENCE X X X X X

DA_ABNCALLS X X X X

DA_ABNTIME X X X X

DA_ACDCALLS X X X X

DA_ACDTIME X X X X

Table 7: Switch Cross-Reference for Agent Database Items  (Contd)
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DA_ACWINCALLS X X X X

DA_ACWINTIME X X X X

DA_ACWOADJCALLS X X X X

DA_ACWOCALLS X X X X

DA_ACWOOFFCALLS X X X X

DA_ACWOOFFTIME X X X X

DA_ACWOTIME X X X X

DA_ACWTIME X X X X

DA_ANSTIME X X X X

DA_INQUEUE X X X X

DA_OLDESTCALL X X X X

DA_OTHERCALLS X X X X

DA_OTHERTIME X X X X

DA_RELEASE X X X X

DA_SKILL X

DESTINATION X X X X X X X X

DIRECTION X X X X X X X X

DURATION X X X X X X X X

EVENT1-9 X X X X X X X

EXTENSION X X X X X X X X

HOLDABNCALLS X X X X X X X

HOLDACDTIME X X X X X X X

Table 7: Switch Cross-Reference for Agent Database Items  (Contd)

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
G3V3 G3V4 ECS
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A

HOLDCALLS X X X X X X X

HOLDTIME X X X X X X X

I_ACDAUXINTIME X X X X X

I_ACDAUX_OUTTIME X X X X X

I_ACDOTHERTIME X X X X X

I_ACDTIME X X X X X X X X

I_ACWINTIME X X X X X X X X

I_ACWOUTTIME X X X X X X X X

I_ACWTIME X X X X X X X X

I_AUXINTIME X X X X X X X X

I_AUXOUTTIME X X X X X X X X

I_AUXTIME X X X X X X X X

I_AVAILTIME X X X X X X X X

I_DA_ACDTIME X X X X X

I_DA_ACWTIME X X X X X

I_OTHERTIME X X X X X X X X

I_RINGTIME X X X X X X

I_STAFFTIME X X X X X X X X

INCOMPLETE X X X X X X X X

INTRVL X X X X X X X X

LEVEL EAS

LOGID X X X X X X X X

Table 7: Switch Cross-Reference for Agent Database Items  (Contd)

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
G3V3 G3V4 ECS
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LOGONSKILL e e e e e e e e

LOGONSKILL2-4 EAS EAS EAS EAS

LOGONSKILL5 EAS EAS

LOGONSKILL6-20 EAS

LOGONSTART X X X X X X X X

MALICIOUS X X X 
(not 
G3i)

X X X

MOVEPENDING X X

NOANSREDIR X X X

O_ACDCALLS X X X X X

O_ACDTIME X X X X X

O_ACWTIME X X X X X

OLDEST_LOGON X X X X X X X X

ONHOLD X X X X X X X

ORIGIN X X X X X X X X

PENDINGSPLIT X X

PHANTOMABNS X X X X

POSITION X X X X X X X X

PREFERENCE X

RINGCALLS X X X X X X

RINGTIME X X X X X X

ROW_DATE X X X X X X X X

Table 7: Switch Cross-Reference for Agent Database Items  (Contd)

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
G3V3 G3V4 ECS
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SKILLTYPE EAS EAS Xb

SKILLTYPE2-4 EAS EAS X†

SKLEVEL EAS EAS EAS

SKLEVEL2-4 EAS EAS EAS

SKLEVEL5-20 EAS

SPLIT X X X X X X X X

STARTED X X X X X X X X

STARTTIME X X X X X X X X

TI_AUXTIME X X X X X X X X

TI_AUXTIME0 X X X X X X X X

TI_AUXTIME1-9 EAS

TI_AVAILTIME X X X X X X X X

TI_OTHERTIME X X X X X X X X

TI_STAFFTIME X X X X X X X X

TOPSKILL X X X X X X X X

TRANSFERRED X X X X X X X X

TYPE EAS EAS EAS

VDN X X X X X X X

WORKMODE X X X X X X X X

WORKSKLEVEL EAS EAS EAS

WORKSKILL X X X X X X X X

WORKSPLIT X X X X X X X X

Table 7: Switch Cross-Reference for Agent Database Items  (Contd)

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
G3V3 G3V4 ECS
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a. These items are populated with 0 unless the switch release is the ECS or later with EAS 
and reason codes enabled.
b. These items are populated with “p” for skill level 1, “s” for skill level 2, and “blank” for skill 
levels 3-16. Customers with the ECS or later EAS should use the SKLEVEL items instead 
to see all skill levels.

WORKSPLIT2-3 X EAS X X X X

WORKSPLIT4 EAS X X X

WORKSPLIT5 EAS EAS

WORKSPLIT6-20 EAS

Table 7: Switch Cross-Reference for Agent Database Items  (Contd)

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
G3V3 G3V4 ECS
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ATrunk Group Database Items 1

The Trunk Group database item descriptions (Table 8) apply to real-time and 
historical items. 

The Type column refers to Cumulative (C), Administrative (A), or Status 
(S) data. Cumulative and Administrative items typically apply to both the 
current and previous interval real-time table. Status items apply only to the 
current interval real-time tables.

Real-Time trunk group database items apply to the Current Interval Trunk 
Group (ctkgrp ) and Previous Interval Trunk Group (ptkgrp ) tables. The 
real-time indexes are ACD and TKGRP.

Historical trunk group database items apply to the Intrahour Trunk Group 
(htkgrp ), Daily Trunk Group (dtkgrp ), Weekly Trunk Group (wtkgrp ), 
and Monthly Trunk Group (mtkgrp ) tables, except as noted. The historical 
indexes are ROW_DATE and TKGRP.
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Table 8: Trunk Group Database Items 

Database Item Description Type

ABNCALLS The number of calls carried by this trunk group that 
were abandoned by the caller before being answered by 
an agent. Calls directly to unmeasured stations that did 
not go through a measured VDN or split/skill are not 
recorded.

For Generic 2.2 and Generic 3 switches, this is all calls 
abandoned by the caller that were carried by this trunk 
group, except for calls directly to unmeasured stations 
that did not go through a measured VDN or split/skill. 
This includes ACD calls and calls that routed to an agent 
or extension with talk times less than the phantom-
abandoned call timer value.

For Generic 2.1 and System 85 switches, this is ACD calls 
that abandon from the split queue or from ringing, and 
calls that abandon from vector processing. 

For Generic 3 Version 1, Generic 2.1, and System 85 
switches, calls that abandon while listening to a forced 
disconnect are also included in ABNCALLS.

For Generic 1 switches, this is ACD calls that abandon 
from queue or from ringing.

ABNCALLS includes ABNVECCALLS, 
ABNQUEUECALLS, and ABNRINGCALLS.

C

ABNQUECALLS The number of ABNCALLS that were abandoned while 
in a split/skill or direct agent queue.

Available on System 85, Generic 2, and Generic 3 
switches. For System 85 switches, ABNQUECALLS 
includes calls that abandon from ringing.

C

ABNRINGCALLS The number of split/skill ABNCALLS that abandoned 
by the caller while ringing at an agent position. 

Available on Generic 2 and Generic 3 switches.

C
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ABNVECCALLS The number of ABNCALLS that abandoned while in 
vector processing. This includes vector calls that 
abandoned while in queue or while ringing at an agent 
position. 

Available on System 85, Generic 2, and Generic 3 
switches with vectoring.

ABNVECCALLS includes ABNQUECALLS and 
ABNRINGCALLS.

C

ACD (index) ACD number for which data was collected A

ACDCALLS The number of INCALLS that were answered by an 
agent as a split/skill or direct agent ACD call.

ACDCALLS includes BACKUPCALLS.

C

ADJUNCTOUT 
(real-time)

The current number of OUTBOUND calls an adjunct 
processor originated.

Available on Generic 2.2 switches with the ASAI feature 
and Generic 3 switches with the ASAI gateway.

S

ALLINUSE 
(real-time)

This indicates if all trunks in the trunk group are 
currently being used (on calls or maintenance busy). 
Values for ALLINUSE are YES and NO

S

ALLINUSETIME The length of time during the interval that all trunks in 
the trunk group are in use (on calls or maintenance 
busy).

C

AUDIO The number of calls for which audio difficulty problems 
were reported for trunks in this trunk group. 

Available on System 85, Generic 2, and Generic 3 
switches.

C

Table 8: Trunk Group Database Items  (Contd)

Database Item Description Type
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BACKUPCALLS The number of ACDCALLS that were delivered to and 
answered by this split/skill by a vector command other 
than “queue to main”. This includes calls delivered by 
“messaging split/skill”, “check backup”, and “route to 
split/skill” vector commands, direct agent calls, and 
redirect on no answer routing.

Calls answered in a main split/skill can be calculated as 
ACDCALLS - BACKUPCALLS.

Available on System 85, Generic 2, and Generic 3 
switches with vectoring. 

C

BH_ABNCALLS The number of incoming calls carried by the trunk group 
that abandoned during the busy hour.

C

BH_ACDCALLS The number of incoming ACD calls carried by this trunk 
group that were answered by an agent as split/skill or 
direct agent ACD calls and completed during the busy 
hour.

C

BH_ALLINUSETIME The length of time during the busy hour that all trunks 
in the trunk group were in use.

C

BH_BUSYCALLS The number of incoming calls carried by this trunk 
group during the busy hour that were given a busy 
signal by the switch.

C

BH_DISCCALLS The number of incoming calls carried by this trunk 
group during the busy hour that were forced to 
disconnect by the switch.

C

BH_INCALLS The number of incoming calls carried by this trunk 
group that completed during the busy hour.

BH_INCALLS includes BH_ABNCALLS, 
BH_ACDCALLS, and BH_OTHERCALLS.

C

BH_INTIME The trunk holding time of all incoming calls carried by 
this trunk group that completed during the busy hour.

C

Table 8: Trunk Group Database Items  (Contd)

Database Item Description Type
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BH_OABNCALLS The number of outgoing adjunct-originated calls carried 
by the trunk group that abandoned during the busy 
hour.

Available on Generic 2.2 switches with the ASAI 
Gateway Interface feature and Generic 3 switches with 
the ASAI feature.

C

BH_OACDCALLS The number of outgoing adjunct-originated ACD calls 
carried by the trunk group and answered by an agent as 
split/skill or direct agent ACD calls that completed 
during the busy hour.

Available on Generic 2.2 switches with the ASAI 
Gateway Interface feature and Generic 3 switches with 
the ASAI feature.

C

BH_
OOTHERCALLS

The number of outgoing calls carried by the trunk group 
during the busy hour that were not answered or 
abandoned as ACD calls.

BH_OOTHERCALLS includes extension out calls, 
outbound call management calls forced busy or forced 
disconnect, short outgoing calls, and outgoing calls with 
unknown disposition.

C

BH_OTHERCALLS The number of incoming calls carried by the trunk group 
during the busy hour that were not answered or 
abandoned.

BH_OTHERCALLS include extension in calls, calls 
forced busy or disconnected, calls that outflowed off the 
switch, short inbound calls, and inbound calls of 
unknown disposition.

BH_OTHERCALLS includes BH_BUSYCALLS and 
BH_DISCCALLS.

C

BH_OUTCALLS The number of outgoing calls carried by the trunk group 
that completed during the busy hour.

BH_OUTCALLS includes BH_OABNCALLS, 
BH_OACDCALLS, and BH_OOTHERCALLS.

C

Table 8: Trunk Group Database Items  (Contd)

Database Item Description Type
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BH_OUTTIME The trunk holding time of all outgoing calls carried by 
the trunk group that completed during the busy hour.

C

BH_STARTTIME The starting time of the hour for which busy hour data 
was collected. The busy hour is that set of contiguous 
intervals during the day totaling an hour in which the 
trunk holding time for the trunk group was a maximum.

C

BLOCKAGE The number of outbound call attempts that were blocked 
because all trunks were busy.

Available on System 85 and Generic 2 switches.

C

BUSYCALLS The number of INCALLS that were given a busy signal 
by the switch.

This can occur on all switches via the “busy'' vector 
command.

BUSYCALLS can occur on Generic 1 and Generic 3 
switches without vectoring when a split queue is full or 
there are no queue slots, no busy coverage is 
administered, and an announcement has played or the 
trunk is not a CO trunk.

On Generic 3 switches, BUSYCALLS can occur if a call is 
routed to a split/skill with coverage set to “yes” where 
there are no agents available, the queue is full (or there is 
no queue), there is no coverage, and an announcement 
has played or the trunk is not a CO trunk.

Also on Generic 3 switches, BUSYCALLS can occur if a 
call is routed to a direct agent with coverage set to “yes”, 
the agent is not logged in and there is no coverage path 
administered, an announcement has played, or the trunk 
is not a CO trunk.

C

COMPLETED The number of OUTCALLS that were completed (far 
end answered).

Available on Generic 1 and Generic 3 switches.

C

Table 8: Trunk Group Database Items  (Contd)

Database Item Description Type
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CONNECTCALLS The number of INCALLS that were answered at a 
station and were not split/skill or direct agent ACD 
calls.

C

DISCCALLS With Generic 2.2 switches, the number of INCALLS that 
were disconnected by the switch by the “disconnect'' 
vector command. 

With System 85, Generic 2.1, Generic 3 Version 1 and 
Generic 3 Version 2 (prior to load 100) switches, the 
number of INCALLS that were given a forced 
disconnect announcement, listened to the entire 
announcement, then were disconnected by the switch. 
The disconnect announcement is for a disconnect vector 
command.

With Generic 3 Version 2 and later Generic 3 switches, 
the number of INCALLS that executed the “disconnect” 
vector command. This also includes the number of 
INCALLS that were disconnected by the switch when 
the vector disconnect timer expired or that reached the 
end of vector processing without being queued.

C

FAILURES The number of trunk failures for this TKGRP. No time or 
call is recorded in any of the CentreVu CMS tables. Trunk 
failures can be due to trunk sequencing failures (usually 
hardware problems on the trunk or incompatible trunk 
types on either end of a call) or due to internal switch 
errors (such as errors in call processing or vectoring 
translations). 

This item does not include calls with short holding 
times. 

Available on System 85 and Generic 2 switches. The 
FAILURES database item is not populated for Generic 1 
and Generic 3 switches because trunks that fail are 
automatically placed in the maintenance busy state.

C

Table 8: Trunk Group Database Items  (Contd)

Database Item Description Type
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I_INOCC The total time during the collection interval that trunks 
in the trunk group were occupied by incoming calls. If 
an incoming call on a measured trunk is transferred off 
the switch, the incoming trunk remains in use for the call 
and accrues trunk holding time until the caller drops or 
the call is released.

C

I_OUTOCC The time during the collection interval that trunks in this 
trunk group were occupied by outgoing calls.

C

INBOUND 
(real-time)

The current number of trunks in the trunk group that are 
busy on inbound calls.

S

INCALLS The number of inbound calls that were carried by this 
TKGRP and that completed during the collection 
interval.

INCALLS includes ABNCALLS, ACDCALLS, 
OTHERCALLS, CONNECTCALLS, and 
TRANSFERRED.

INCALLS = ACDCALLS + ABNCALLS + 
OTHERCALLS

C

INCOMPLETE This indicates whether or not data is complete for this 
collection interval. Data is incomplete whenever the link 
goes down and whenever tracking is aborted for calls, 
due to trunk failures (System 85 and Generic 2 switches), 
the trunk going maintenance busy with a call active 
(Generic 1 and Generic 3 switches), or protocol failures. 
The value for interval tables indicates whether data is 
incomplete for the interval (0 = data complete, 1 = data 
incomplete). The value in the daily, weekly, and monthly 
tables indicates the number of incomplete intervals in 
the day, week, or month.

C

Table 8: Trunk Group Database Items  (Contd)

Database Item Description Type
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INTIME The trunk holding time for all INCALLS carried by 
trunks in this trunk group that completed during the 
collection interval.

Trunk holding time is the time from the initial trunk 
seizure until the trunk goes idle (that is, until the caller 
drops, the agent releases the call, or the switch 
disconnects the call). If an incoming call on a measured 
trunk is transferred off the switch, the incoming trunk 
remains in use for the call and accrues trunk holding 
time until the caller drops or the call is released.

C

INTRVL The number of minutes in the intrahour interval (15, 30, 
or 60).

INTRVL applies to intrahour tables only.

A

MBUSY
(real-time)

The current number of trunks in the trunk group that are 
maintenance busy.

S

MBUSYTIME The total time during the collection interval that trunks 
in the trunk group were maintenance busy.

C

NUMINUSE 
(real-time)

The current number of TRUNKS that are busy (on calls 
or maintenance busy).

NUMINUSE = INBOUND + OUTBOUND + MBUSY

S

O_ABNCALLS The number of OUTCALLS on this trunk group that 
were offered by an adjunct as split/skill or direct agent 
ACD calls and were abandoned by the far end. 

Available on Generic 2.2 switches with the ASAI 
Gateway Interface feature and Generic 3 switches with 
the ASAI feature.

C

O_ACDCALLS The number of OUTCALLS from this trunk group that 
were offered by an adjunct as split/skill or direct agent 
ACD calls and were answered by an agent.

Available on Generic 2.2 switches with the ASAI 
Gateway Interface feature and Generic 3 switches with 
the ASAI feature.

C

Table 8: Trunk Group Database Items  (Contd)

Database Item Description Type

831.bk : A_Database_Items_and_Calculations.fm  Page 111  Wednesday, November 27, 1996  1:46 P



A-112 Trunk Group Database Items

Appendix A - Database Items and Calculations

O_OTHERCALLS The number of OUTCALLS on this trunk group that 
were not answered or abandoned as ACD split/skill 
calls. These include extension out calls, calls forced busy 
and forced disconnected, short outgoing calls, and calls 
with unknown dispositions.

O_OTHERCALLS includes SHORTCALLS.

C

OTHERCALLS The number of INCALLS carried by this trunk group 
that were not answered as split/skill or direct agent 
ACD calls or abandoned. These include forced busy 
calls, forced disconnect calls, calls that were connected to 
a non-ACD destination, short inbound calls, calls that 
outflowed off the switch, and calls with unknown 
dispositions.

OTHERCALLS includes BUSYCALLS, DISCCALLS, 
SHORTCALLS, and CONNECTCALLS.

OTHERCALLS = INCALLS - ACDCALLS - 
ABNCALLS 

S

OUTBOUND 
(real-time)

The current number of trunks in this trunk group that 
are busy on outbound calls.

OUTBOUND includes ADJUNCTOUT.

S

OUTCALLS The number of outbound calls that were carried by this 
TKGRP and were completed during the collection 
interval.

OUTCALLS includes COMPLETED, O_ABNCALLS, 
O_ACDCALLS, O_OTHERCALLS, TRANSFERRED, 
and SHORTCALLS.

OUTCALLS = O_ACDCALLS + O_ABNCALLS + 
O_OTHERCALLS

C

Table 8: Trunk Group Database Items  (Contd)

Database Item Description Type
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OUTTIME The trunk holding time for all OUTCALLS carried by 
trunks in this trunk group that completed during the 
collection interval. Trunk holding time is the time from 
the initial trunk seizure until the trunk goes idle (that is, 
until the far end drops, the agent releases the call, or the 
switch disconnects the call).

OUTTIME includes SETUPTIME.

C

ROW_DATE
(index)

The day for which data was collected. A

SETUPTIME Amount of time from trunk seizure until OUTCALLS 
completed at the far end.

Available on Generic 1 and Generic 3 switches.

C

SHORTCALLS The number of inbound and outbound calls that 
occupied a trunk in the trunk group for less than 2 
seconds and that did not queue to a split/skill, forward 
to a split/skill, get answered by an agent, get a forced 
busy or forced disconnect from the switch, or produce a 
trunk failure or maintenance busy.

Note that SHORTCALLS includes both inbound and 
outbound calls. Therefore, OTHERCALLS and 
O_OTHERCALLS may each include some 
SHORTCALLS.

C

SPLIT The split/skill to which this TKGRP terminates. A

STARTTIME
(real-time)

The start time of the interval for which data was 
collected.

Applies to the interval table only.

S

TKGRP
(index)

The trunk group number for which data was collected. 
This will be zero if the trunk group carrying the call is 
not measured

A

Table 8: Trunk Group Database Items  (Contd)

Database Item Description Type
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TRANSFERRED The number of calls that were transferred to another 
destination. 

Note the TRANSFERRED includes both inbound and 
outbound calls. Therefore, ACDCALLS and 
O_ACDCALLS, and OTHERCALLS and 
O_OTHERCALLS may each include some 
TRANSFERRED.

For Generic 1 switches, TRANSFERRED includes 
measured call-to-measured split or measured trunk-to-
measured trunk transfers.

For System 85 and Generic 2.1 switches, 
TRANSFERRED includes transfers to measured VDNs 
or splits/skills.

For Generic 3 and Generic 2.2 switches, 
TRANSFERRED includes all calls.

C

TRUNKS The current number of trunks assigned to this TKGRP. A

VDN The VDN to which the TKGRP terminates. 

Available on System 85, Generic 2, and Generic 3 
switches with vectoring.

A

VECTOR The vector to which this trunk group’s VDN terminates. 

Available on System 85, Generic 2, and Generic 3 
switches with vectoring.

A

Table 8: Trunk Group Database Items  (Contd)

Database Item Description Type
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ASwitch Cross-Reference 1

Table 9 lists the Trunk Group database items are supported by each of the 
switch releases.

Table 9: Switch Cross-Reference for Trunk Group Database Items

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
G3V3 G3V4 ECS

ABNCALLS X X X X X X X X

ABNQUECALLS X X X X X X X X

ABNRINGCALLS X X X X X X

ABNVECCALLS X X X X X X X

ACD (index) X X X X X X X X

ACDCALLS X X X X X X X X

ADJUNCTOUT X X X X X

ALLINUSE X X X X X X X X

ALLINUSETIME X X X X X X X X

AUDIO X X X X X X X

BH_ABNCALLS X X X X X X X X

BH_ACDCALLS X X X X X X X X

BH_ALLINUSETIME X X X X X X X X

BH_BUSYCALLS X X X X X X X X

BH_DISCCALLS X X X X X X X

BH_INCALLS X X X X X X X

BH_INTIME X X X X X X X

BH_OABNCALLS X X X X X

BH_OACDCALLS X X X X X

BH_OOTHERCALLS X X X X X X X X
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BH_OTHERCALLS X X X X X X X X

BH_OUTCALLS X X X X X X X X

BH_OUTTIME X X X X X X X X

BH_STARTTIME X X X X X X X X

BACKUPCALLS X X X X X X X

BLOCKAGE X X X

BUSYCALLS X X X X X X X X

COMPLETED X X X X X

CONNECTCALLS X X X X X X X X

DISCCALLS X X X X X X X

FAILURES X X X

I_INOCC X X X X X X X X

I_OUTOCC X X X X X X X X

INBOUND X X X X X X X X

INCALLS X X X X X X X X

INCOMPLETE X X X X X X X X

INTIME X X X X X X X X

INTRVL X X X X X X X X

MBUSY X X X X X X X X

MBUSYTIME X X X X X X X X

NUMINUSE X X X X X X X X

O_ABNCALLS X X X X X

O_ACDCALLS X X X X X

Table 9: Switch Cross-Reference for Trunk Group Database Items (Contd)

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
G3V3 G3V4 ECS
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O_OTHERCALLS X X X X X X X X

OTHERCALLS X X X X X X X X

OUTBOUND X X X X X X X X

OUTCALLS X X X X X X X X

OUTTIME X X X X X X X X

ROW_DATE X X X X X X X X

SETUPTIME X X X X X

SHORTCALLS X X X X X X X X

SPLIT X X X X X X X X

STARTTIME X X X X X X X X

TKGRP X X X X X X X X

TRANSFERRED X X X X X X X X

TRUNKS X X X X X X X X

VDN X X X X X X X

VECTOR X X X X X X X

Table 9: Switch Cross-Reference for Trunk Group Database Items (Contd)

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
G3V3 G3V4 ECS

831.bk : A_Database_Items_and_Calculations.fm  Page 117  Wednesday, November 27, 1996  1:46 P



A-118 Trunk Database Items

Appendix A - Database Items and Calculations

Trunk Database Items 1

The Trunk database item descriptions (Table 10) apply to real-time and 
historical items. 

The Type column refers to Cumulative (C), Administrative (A), or Status 
(S) data. Cumulative and Administrative items typically apply to both the 
current and previous interval real-time table. Status items apply only to the 
current interval real-time tables.

Real-Time trunk database items apply to the Current Interval Trunk 
(ctrunk ) and Previous Interval Agent (ptrunk ) tables. The real-time 
indexes are ACD, ITN, EQLOC, and TKGRP.

Historical trunk database items apply to the Intrahour Trunk (htrunk ), 
Daily Trunk (dtrunk ), Weekly Trunk Group (wtrunk ), and Monthly 
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Trunk (mtrunk ) tables, except as noted. The historical indexes are EQLOC, 
ROW_DATE and TKGRP. 

Table 10: Trunk Database Items 

Database Item Description Type

ABNCALLS The number of calls carried by this trunk that were 
abandoned by the caller before being answered by an 
agent.

For Generic 2.2 and Generic 3 switches, this is all calls 
abandoned by the caller that were carried by this trunk, 
except for calls directly to unmeasured stations that did 
not go through a VDN or split/skill.

For Generic 3 switches, this includes ACD calls and calls 
that routed to an agent or extension with talk times less 
than the phantom-abandoned call timer value.

For Generic 2.1 and System 85 switches, this is ACD calls 
that abandon from the split queue or from ringing, calls 
that abandon from vector processing and calls that 
abandon after being routed to an extension (via the 
“route to'' vector command). 

For Generic 3 Version 1, Generic 2.1, and System 85 
switches, calls that abandon while listening to a forced 
disconnect announcement are also included. 

For Generic 1 switches, this is ACD calls that abandon 
from queue or ringing.

C

ACD (index) The ACD number for which data was collected. A

ACDCALLS The number of INCALLS that were answered by an 
agent as a split/skill or direct agent ACD call.

C

AUDIO The number of calls for which audio difficulty problems 
were reported for this trunk. 

Available on System 85, Generic 2, and Generic 3 
switches.

C

CALLING_LOGID The Login ID of the agent originating the current call on 
this trunk. This is NULL when the trunk idles.

S
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DIRECTION 
(real-time)

The current call direction of the trunk (IN, OUT, or as 
defined in Dictionary). The value is blank (NULL) if the 
trunk is idle.

S

DURATION 
(real-time)

The current length of time the trunk has been in 
TKSTATE.

S

EQLOC
(index)

The physical equipment location (trunk number) for 
which data was collected.

A

EXTENSION 
(real-time)

The extension to which this trunk is currently queued, 
ringing, or connected.

S

FAILURES The number of trunk failures for this trunk. No time or 
call is recorded in any of the CentreVu CMS tables. Trunk 
failures can be due to trunk sequencing failures (usually 
hardware problems on the trunk or incompatible trunk 
types on either end of a call) or due to internal switch 
errors (such as errors in call processing or vectoring 
translations). 

This item does not include calls with short holding 
times.

Available on System 85 and Generic 2 switches. The 
FAILURES database item is not populated for Generic 1 
and Generic 3 switches because trunks that fail are 
automatically placed in the maintenance busy state.

C

I_INOCC The total time during the collection interval that the 
trunk was occupied by inbound calls. If an incoming call 
on a measured trunk is transferred off the switch, the 
incoming trunk remains in use for the call and accrues 
trunk holding time until the caller drops or the call is 
released.

C

I_OUTOCC The total time during the collection interval that this 
trunk was occupied by outbound calls.

C

Table 10: Trunk Database Items  (Contd)

Database Item Description Type
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INCALLS The number of inbound calls carried by this trunk that 
completed during the collection interval. This includes 
SHORTCALLS but does not include FAILURES.

INCALLS = ABNCALLS + ACDCALLS + 
OTHERCALLS

C

INCOMPLETE This indicates whether or not data is complete for this 
collection interval. Data is incomplete whenever the link 
goes down and whenever tracking is aborted for calls, 
due to trunk failures (System 85 and Generic 2 switches), 
the trunk going maintenance busy with a call active 
(Generic 1 and Generic 3 switches), protocol failures, or 
when split/skill or VDN call profile is changed with 
data collection active. The value for interval tables 
indicates whether data is incomplete for the interval (0 = 
data complete, 1 = data incomplete). The value in the 
daily, weekly, and monthly tables indicates the number 
of incomplete intervals in the day, week, or month.

Changing split/skill or VDN call profile data while data 
collection is active only affects the respective split/skill 
or VDN data.

C

INTIME The trunk holding time for all INCALLS carried by this 
trunk that completed during the collection interval.

Trunk holding time is the time from the initial trunk 
seizure until the trunk goes idle (that is, until the caller 
drops, the agent releases the call, or the switch 
disconnects the call). If an incoming call on a measured 
trunk is transferred off the switch, the incoming trunk 
remains in use for the call and accrues trunk holding 
time until the caller drops or the call is released.

C

INTRVL The number of minutes in the intrahour interval (15, 30, 
or 60).

INTRVL applies to intrahour intervals only.

A

ITN
(index) 

The internal trunk number of the trunk. A

Table 10: Trunk Database Items  (Contd)

Database Item Description Type
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LOGID 
(real-time)

The Login ID of the agent handling the call currently 
carried by this trunk. This is blank (NULL) when the 
trunk is idle.

S

MBUSYTIME The total time during the collection interval that this 
trunk was maintenance busy.

C

O_ABNCALLS The number of OUTCALLS on this trunk that were 
offered by an adjunct as split/skill or direct agent ACD 
calls and were answered then abandoned by the far end 
before talking to an agent.

Available on Generic 2.2 switches with the ASAI 
Gateway Interface feature and Generic 3 switches with 
the ASAI feature.

C

O_ACDCALLS The number of OUTCALLS from this trunk that were 
offered by an adjunct as split/skill or direct agent ACD 
calls and were answered by an agent in one of those 
splits/skills. 

Available on Generic 2.2 switches with the ASAI 
Gateway Interface feature and Generic 3 switches with 
the ASAI feature.

C

O_OTHERCALLS The number of OUTCALLS on this trunk that were not 
answered as ACD split/skill calls or abandoned. These 
include extension out calls, forced busy calls, short 
outgoing calls, and calls with unknown dispositions.

O_OTHERCALLS includes SHORTCALLS.

C

OTHERCALLS The number of INCALLS carried by this trunk that were 
not answered or abandoned as split/skill or direct agent 
ACD calls. These include forced busy calls, forced 
disconnect calls, calls that were connected to a non-ACD 
destination, short inbound calls, and calls with unknown 
dispositions.

OTHERCALLS includes BUSYCALLS, DISCCALLS, 
and SHORTCALLS.

OTHERCALLS = INCALLS - ACDCALLS - 
ABNCALLS

S

Table 10: Trunk Database Items  (Contd)

Database Item Description Type
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OUTCALLS The number of outbound calls that were carried by the 
trunk and were completed during the collection interval.

OUTCALLS = O_ACDCALLS + O_ABNCALLS + 
O_OTHERCALLS

C

OUTTIME The trunk holding time for all OUTCALLS carried by 
this trunk that completed during the collection interval. 
Trunk holding time is the time from the initial trunk 
seizure until the trunk goes idle (that is, until the far end 
drops, the agent releases the call, or the switch 
disconnects the call).

C

PRIORITY 
(real-time)

The priority at which call was queued. Without 
vectoring, the values are YES, NO, or as defined in 
Dictionary. With vectoring, the values are LOW, MED, 
HIGH, TOP, or as defined in Dictionary. This is blank 
(NULL) when the call is dequeued (when the call rings 
at an agent, outflows or dequeues from the split/skill, 
the call abandons from queue, the call gets a forced busy 
or a forced disconnect).

Generic 3 switches with vectoring use MED for “no 
priority” and HIGH for “priority” calls that queue 
directly to a split/skill without going through a vector, 
and calls that queue to a split/skill by “route to” number 
or “messaging split/skill” vector commands.

S

PRIORITY2-3 
(real-time)

The priority at which call was queued to a second or 
third split/skill, the values are: LOW, MED, HIGH, TOP, 
or as defined in Dictionary. This is blank (NULL) when 
the call is dequeued (when the call rings at an agent, 
outflows or dequeues from the split/skill, the caller 
abandons from queue, the call gets a forced busy or a 
forced disconnect).

Available on Generic 2.2 with vectoring and EAS, and 
Generic 3 switches with vectoring.

S

Table 10: Trunk Database Items  (Contd)

Database Item Description Type
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QUECOUNT 
(real-time)

The number of ACD split/skill queues that the call is in. 
This is blank (NULL) when the trunk goes idle, gets 
forced busy, gets a forced disconnect, connects to a 
station or agent, or forwards out of the queue. Values: 
NULL, 1-3

S

QUETYPE 
(real-time)

Whether this call entered the queue by the “queue to 
main” or another vector step. QUEUETYPE is NULL for 
direct agent calls, when vectoring is not used, and when 
the call dequeues (is answered, abandoned, gets forced 
busy, or gets a forced disconnect).

Valid values are NULL, MAIN, and BACKUP.

S

QUETYPE2-3 
(real-time)

Whether this call entered the second or third queue by 
the “queue to main” or another vector step. 
QUEUETYPE2 and QUEUETYPE3 are NULL when 
vectoring is not used and when the call dequeues (is 
answered, abandoned, gets forced busy, or gets a forced 
disconnect).

Valid values are NULL, MAIN, and BACKUP.

Available on Generic 2.2 switches with EAS and Generic 
3 switches.

S

ROW_DATE
(index)

The day for which data was collected. A

SHORTCALLS The number of inbound and outbound calls that 
occupied a trunk for less than 2 seconds and that did not 
queue to a split/skill, forward to a split/skill, get 
answered by an agent, get a forced busy or forced 
disconnect from the switch, or produce a trunk failure or 
maintenance busy.

Note that SHORTCALLS includes both inbound and 
outbound calls. Therefore, OTHERCALLS and 
O_OTHERCALLS may each include some 
SHORTCALLS.

C

Table 10: Trunk Database Items  (Contd)

Database Item Description Type
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SPLIT 
(real-time)

The first split/skill number to which the is currently 
queued or split/skill for which call was answered. 
SPLIT is blank (NULL) when the trunk idles.

S

SPLIT2-3 
(real-time)

The split/skill numbers of the second and third 
splits/skills to which the call is queued. This is blank 
(NULL) when the call dequeues (is answered, 
abandoned, gets a forced busy or forced disconnect). 

Available on Generic 2.2 switches with vectoring and 
EAS, and Generic 3 switches with vectoring.

S

STARTED 
(real-time)

The time of day that TKSTATE started. 

Valid values are NULL and time-of-day

S

STARTTIME
(real-time)

The start time of the interval for which data was 
collected.

Applies to the interval table only.

S

TKGRP
(index)

The trunk group number to which the trunk is assigned. A

TKSTATE 
(real-time)

The current state of the call. Trunk states include: IDLE, 
SEIZED, QUEUED, CONN, RING, DABN, FBUSY, 
FDISC, HOLD, MBUSY, UNKNOWN, or as defined in 
Dictionary.

S

VDN 
(real-time)

The VDN that is associated with the current call. This 
stays set until the trunk idles, at which time it is set to 
NULL. 

Available on System 85, Generic 2, and Generic 3 
switches with vectoring. 

S

VECTOR 
(real-time)

The vector that is associated with the current call. This 
stays set until the trunk idles, at which time it is set to 
NULL. 

Available on System 85, Generic 2, and Generic 3 
switches with vectoring. 

S

Table 10: Trunk Database Items  (Contd)

Database Item Description Type
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Switch Cross-Reference 1

Table 11 lists which Trunk database items are supported by each of the 
switch releases.

Table 11: Switch Cross-Reference for Trunk Database Items 

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
G3V3 G3V4 ECS

ABNCALLS X X X X X X X X

ACD X X X X X X X X

ACDCALLS X X X X X X X X

AUDIO X X X X X X X

CALLING_LOGID X X X X X X X X

DIRECTION X X X X X X X X

DURATION X X X X X X X X

EQLOC X X X X X X X X

EXTENSION X X X X X X X X

FAILURES X X X

I_INOCC X X X X X X X X

I_OUTOCC X X X X X X X X

INCALLS X X X X X X X X

INCOMPLETE X X X X X X X X

INTIME X X X X X X X X

INTRVL X X X X X X X X

ITN X X X X X X X X

LOGID X X X X X X X X

MBUSYTIME X X X X X X X X

O_ABNCALLS X X X X X
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O_ACDCALLS X X X X X

O_OTHERCALLS X X X X X X X X

OTHERCALLS X X X X X X X X

OUTCALLS X X X X X X X X

OUTTIME X X X X X X X X

PRIORITY X X X X X X X X

PRIORITY2-3 X 
(EAS)

X X X X

QUECOUNT X X X X X X X X

QUETYPE X X X X X X X

QUETYPE2-3 X 
(EAS)

X X X X

ROW_DATE X X X X X X X X

SHORTCALLS X X X X X X X X

SPLIT X X X X X X X X

SPLIT2-3 X 
(EAS)

X X X X

STARTED X X X X X X X X

STARTTIME X X X X X X X X

TKGRP X X X X X X X X

TKSTATE X X X X X X X X

VDN X X X X X X X

VECTOR X X X X X X X

Table 11: Switch Cross-Reference for Trunk Database Items  (Contd)

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
G3V3 G3V4 ECS
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Vector Database Items 1

Vector database items are available only if the Vectoring feature has been 
purchased and authorized for you to use.

The Vector database item descriptions (Table 12) apply to real-time and 
historical items. 

The Type column refers to Cumulative (C), Administrative (A), or Status 
(S) data. Cumulative and Administrative items typically apply to both the 
current and previous interval real-time table. Status items only apply to the 
current interval real-time tables.

Real-Time vector database items apply to the Current Interval Vector 
(cvector ) and Previous Interval Vector (pvector ) tables. The real-time 
indexes are ACD and VECTOR. 

Historical vector database items apply to the Intrahour Vector (hvector ), 
Daily Vector (dvector ), Weekly Vector (wvector ), and Monthly Vector 
(mvector ) tables, except as noted. The historical indexes are ROW_DATE 
and VECTOR.

Table 12: Vector Database Items 

Database Item Description Type

ABNCALLS The number of INCALLS that were abandoned while 
INPROGRESS for this vector. 

This includes split/skill and direct agent ACD calls that 
abandon from queue or from ringing, calls that abandon 
from vector processing, and for the System 85, Generic 
2.1, and Generic 3 Version 1 switches, calls that hung up 
while listening to a forced disconnect announcement.

ABNCALLS includes ABNQUECALLS, 
ABNRINGCALLS, and PHANTOMABNS.

C

ABNQUECALLS The number of ABNCALLS that hung up while in a 
split/skill or direct agent ACD queue. System 85 switch 
calls that abandon from ringing are included here.

C
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ABNRINGCALLS The number of split/skill or direct agent ABNCALLS 
that were abandoned while ringing at an agent position.

Available on Generic 2 and Generic 3 switches and on 
the ECS.

C

ABNTIME The time caller waited while vector steps were executed, 
the call was queued, and ringing, before the caller hung 
up.

For phantom-abandoned calls, this is the total time from 
when the call enters the vector until the agent released 
the call.

C

ACD
(index)

The ACD number for which data was collected. A

ACDCALLS The number of split/skill and direct agent ACD calls 
that were answered by an agent. Includes calls from 
“queue to main, “check backup”, “messaging 
split/skill”, “route to” split/skill or direct agent, and 
“adjunct routing” to a split/skill or direct agent.

ACDCALLS includes BACKUPCALLS.

C

ADJATTEMPTS The number of adjunct routing attempts for calls in this 
VECTOR. 

Available on the ECS and Generic 3 switches with the 
ASAI feature.

ADJATTEMPTS includes ADJROUTED.

C

ADJROUTED The number of adjunct-routing calls that were redirected 
by an adjunct processor or host computer.

Available on the ECS and Generic 3 switches with the 
ASAI feature.

C

ANSTIME The time that split/skill and direct agent ACD calls 
waited while executing steps in this vector, queuing, and 
ringing before being answered by an agent.

ANSTIME includes RINGTIME.

C

Table 12: Vector Database Items  (Contd)

Database Item Description Type
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BACKUPCALLS The number of ACDCALLS that were queued to the 
answering split/skill using a vector command other 
than “queue to main”. 

BACKUPCALLS includes “messaging split/skill” calls, 
“check backup” calls, and calls that route to a split/skill 
or direct agent, either by the “route to” vector command 
or by adjunct routing. Calls that are redirected back to 
the split/skill using the redirection on no answer feature 
and are subsequently answered are also counted as 
BACKUPCALLS. Calls answered in a main split/skill 
(MAINCALLS) are then calculated as ACDCALLS - 
BACKUPCALLS. However, MAINCALLS does not 
include direct agent calls.

Available on System 85, Generic 2, and Generic 3 
switches and on the ECS with the vectoring feature.

C

BUSYCALLS The number of INCALLS that were given a busy signal 
by the switch.

This can occur on all switches when the “busy'' vector 
command is executed.

On Generic 3 switches, BUSYCALLS can occur if a call is 
routed to a split with coverage set to “yes” where there 
are no agents available, the queue is full (or there is no 
queue), there is no coverage, and an announcement has 
played or the trunk is not a CO trunk.

Also on Generic 3 switches, BUSYCALLS can occur if a 
call is routed to a direct agent with coverage set to “yes”, 
the agent is not logged in and there is no coverage path 
administered, an announcement has played, or the trunk 
is not a CO trunk.

C

BUSYTIME The time BUSYCALLS waited before hearing a busy 
signal. 

C

Table 12: Vector Database Items  (Contd)

Database Item Description Type
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DISCCALLS With Generic 2.2, Generic 3 Version 2, and later Generic 3 
switches and with the ECS, the number of INCALLS 
that executed the “disconnect'' vector command. 

With System 85, Generic 2.1, and Generic 3 Version 1 
switches, the number of INCALLS that were given a 
forced disconnect announcement by the “disconnect” 
vector command and listened to the entire 
announcement, then were disconnected by the switch. 

With Generic 3 Version 2 and later Generic 3 switches 
and with the ECS, DISCCALLS also includes calls 
disconnected due to the expiration of the vector 
disconnect timer and those that were disconnected 
because they reached the end of vector processing 
without being queued.

DISCCALLS includes VDISCCALLS.

C

DISCTIME The time all DISCCALLS spent in this VECTOR. The 
time until the trunk drops following the forced 
disconnect command for those calls recorded as 
DISCCALLS.

For Generic 2.2, Generic 3 Version 2 and later Generic 3 
switches, and for the ECS, if the caller hangs up during 
the forced disconnect announcement, this time is the 
time until the caller hung up.

For System 85, Generic 2.1, and Generic 3 Version 1 
switches, DISCTIME is the time until the announcement 
ends and the caller is disconnected by the switch.

For Generic 3 Version 2 and later Generic 3 switches, and 
for the ECS, DISCTIME also includes the time until the 
trunk drops for calls disconnected due to the expiration 
of the vector disconnect timer or because they reached 
the end of vector processing without being queued.

C

GOTOCALLS The number of OUTFLOWCALLS that were redirected 
to another vector by way of a “go to vector'' command. 

Available on Generic 2.2 and Generic 3 switches and on 
the ECS.

C

Table 12: Vector Database Items  (Contd)

Database Item Description Type
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GOTOTIME The time all GOTOCALLS spent in this vector before 
being redirected to another vector. 

Available on Generic 2.2 and Generic 3 switches and on 
the ECS.

C

INCALLS The number of inbound calls that were processed by this 
vector.

INCALLS includes ABNCALLS, RINGCALLS, 
INFLOWCALLS, and OTHERCALLS.

INCALLS = ACDCALLS + ABNCALLS + 
OTHERCALLS

C

INCOMPLETE This indicates whether or not data is complete for this 
collection interval. Data is incomplete whenever the link 
goes down and whenever tracking is aborted for calls 
due to trunk failures (System 85 and Generic 2 switches), 
the trunk going maintenance busy with a call active 
(Generic 1 and Generic 3 switches and the ECS), or 
protocol failures. The value for interval tables indicates 
whether data is incomplete for the interval (0 = data 
complete, 1 = data incomplete). The value in the daily, 
weekly, and monthly tables indicates the number of 
incomplete intervals in the day, week, or month.

C

INFLOWCALLS The number of calls that were redirected to this vector by 
way of a “go to vector'' or a “route to'' VDN command, 
or by redirection on no answer to a VDN.

C

INPROGRESS
(real-time)

The current number of inbound calls that are being 
processed by this VECTOR until the disposition of the 
call is known (answered, abandoned, outflowed from 
the vector, at the beginning of forced busy, or dropped 
on a forced disconnect).

INPROGRESS includes INQUEUE and INRING.

S

INQUEUE 
(real-time)

The current number of INPROGRESS calls that are in 
split/skill or direct agent ACD queues. System 85 switch 
calls that are ringing at agent positions are included 
here.

S

Table 12: Vector Database Items  (Contd)

Database Item Description Type
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INRING
(real-time)

The current number of INPROGRESS split/skill and 
direct agent ACD calls that are ringing at an agent 
position. 

Available on Generic 2 and Generic 3 switches and on 
the ECS.

S

INTERFLOWCALLS The number of OUTFLOWCALLS that were redirected 
to a destination outside the switch.

INTERFLOWCALLS includes LOOKFLOWCALLS.

C

INTIME The time spent by INCALLS in the VECTOR executing 
steps. INTIME stops accruing when the “Stop'' vector 
step is executed, when the last step in the vector is 
reached, when busy or disconnect is sent, when the call 
is abandoned, when a “go to vector” or “route to'' 
command succeeds, when a ''messaging split/skill” or 
“adjunct routing'' command succeeds, or when the 
split/skill or direct agent ACD call rings at an agent 
position.

C

INTRVL The number of minutes in the interval (15, 30, 60).

INTRVL applies to intrahour intervals only.

A

LOOKATTEMPTS The number of look-ahead interflow attempts for calls 
processed by this VECTOR. 

LOOKATTEMPTS includes LOOKFLOWCALLS.

Available on Generic 2.2 and Generic 3 switches and on 
the ECS with the vectoring and look-ahead Interflow 
features.

C

LOOKFLOWCALLS The number of INTERFLOWCALLS that were 
redirected to another switch by way of the look-ahead 
interflow feature. 

LOOKFLOWCALLS is a subset of 
INTERFLOWCALLS.

Available on Generic 2.2 and Generic 3 switches and on 
the ECS with the vectoring and look-ahead interflow 
features.

C

Table 12: Vector Database Items  (Contd)

Database Item Description Type
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NUMVDNS The current number of VDNs that are assigned to this 
VECTOR.

A

OTHERCALLS The number of INCALLS that were redirected out of the 
vector, given a busy signal, or were disconnected.

OTHERCALLS includes BUSYCALLS, DISCCALLS, 
and OUTFLOWCALLS.

OTHERCALLS = INCALLS - ACDCALLS - 
ABNCALLS

S

OTHERTIME The time OTHERCALLS spent in the vector until the 
disposition was known and the call left the vector.

OTHERTIME includes BUSYTIME, DISCTIME, and 
OUTFLOWTIME.

C

OUTFLOWCALLS The number of INCALLS that were redirected to 
another destination by way of a “go to vector'' command 
or by ''route to'' or ''adjunct routing'' to a destination 
other than a split/skill or direct agent. (Calls that route 
to a split/skill or direct agent by way of a “route to,'' 
“adjunct routing,'' or “messaging split/skill'' command 
are still tracked in the vector.)

OUTFLOWCALLS includes GOTOCALLS and 
INTERFLOWCALLS.

C

OUTFLOWTIME Time all OUTFLOWCALLS spent in the VECTOR 
before being redirected.

OUTFLOWTIME includes GOTOTIME.

C

PHANTOMABNS The number of ACD calls and calls that routed to an 
agent or extension with talk time less than the value of 
the phantom-abandoned call timer.

Available on Generic 3 switches and the ECS.

C

Table 12: Vector Database Items  (Contd)

Database Item Description Type

831.bk : A_Database_Items_and_Calculations.fm  Page 134  Wednesday, November 27, 1996  1:46 P



 Vector Database Items A-135

Appendix A - Database Items and Calculations

A
pp

en
di

x 
A

RINGCALLS The number of split/skill and direct agent ACD calls 
that rang at agent positions.

RINGCALLS includes ACDCALLS.

Available on Generic 2 and Generic 3 switches and the 
ECS.

C

RINGTIME The time split/skill and direct agent ACD calls spent 
ringing at agent positions independent of final 
disposition. 

Available on Generic 2 and Generic 3 switches and the 
ECS.

C

ROW_DATE
(index)

The date for which data was collected. A

STARTTIME
(real-time)

The start time of the interval for which data was 
collected. (Interval table only.)

S

VDISCCALLS The number of calls forced to disconnect because the 
vector disconnect timer timed out or because the call 
reached a vector stop without being queued. “Vector 
stop” means an explicit “stop” vector command, the end 
of the vector, or one-thousandth step executed.

Available on Generic 3 Version 2 and later switches and 
the ECS.

C

VECTOR
(index)

The vector number that this row represents.

Available on System 85, Generic 2, and Generic 3 
switches and on the ECS with the vectoring feature.

A

Table 12: Vector Database Items  (Contd)

Database Item Description Type
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Switch Cross- Reference 1

Table 13 lists which Vector database items are supported by each of the 
switch releases. 

Table 13: Switch Cross-Reference for Vector Database Items 

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
G3V3 G3V4 ECS

ABNCALLS X X X X X X X

ABNQUECALLS X X X X X X X

ABNRINGCALLS X X X X X X

ABNTIME X X X X X X X

ACD X X X X X X X

ACDCALLS X X X X X X X

ADJATTEMPTS X X X X

ADJROUTED X X X X

ANSTIME X X X X X X X

BACKUPCALLS X X X X X X X

BUSYCALLS X X X X X X X

BUSYTIME X X X X X X X

DISCCALLS X X X X X X X

DISCTIME X X X X X X X

GOTOCALLS X X X X X

GOTOTIME X X X X X

INCALLS X X X X X X X

INCOMPLETE X X X X X X X

INFLOWCALLS X X X X X X X

INPROGRESS X X X X X X X
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INQUEUE X X X X X X X

INRING X X X X X X

INTERFLOWCALLS X X X X X X X

INTIME X X X X X X X

INTRVL X X X X X X X

LOOKATTEMPTS X X X X X

LOOKFLOWCALLS X X X X X

NUMVDNS X X X X X X X

OTHERCALLS X X X X X X X

OTHERTIME X X X X X X X

OUTFLOWCALLS X X X X X X X

OUTFLOWTIME X X X X X X X

PHANTOMABNS X X X X

RINGCALLS X X X X X X

RINGTIME X X X X X X

ROW_DATE X X X X X X X

STARTTIME X X X X X X X

VDISCCALLS X X X

VECTOR X X X X X X X

Table 13: Switch Cross-Reference for Vector Database Items  (Contd)

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
G3V3 G3V4 ECS
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VDN Database Items 1

VDN database items are available only if the vectoring feature has been 
purchased and authorized for you to use.

The VDN Database Item descriptions (Table 14) apply to real-time and 
historical items.

The Type column refers to Cumulative (C), Administrative (A), or Status 
(S) data. Cumulative and Administrative items typically apply to both the 
current and previous interval real-time tables. Status items apply only to the 
current interval tables.

Real-Time VDN database items apply to the Current Interval VDN (cvdn ) 
and Previous Interval VDN (pvdn ) tables. The real-time indexes are ACD, 
VDN, and VECTOR. 

Historical VDN database items apply to the Intrahour VDN (hvdn ), Daily 
VDN (dvdn ), Weekly VDN (wvdn), and Monthly VDN (mvdn) tables, 
except as noted. The historical indexes are ROW_DATE and VDN.

Table 14: VDN Database Items 

Database Item Description Type

ABNCALLS The number of INCALLS that were abandoned while 
INPROGRESS for this VDN. This includes split/skill 
and direct agent ACD calls that abandon from queue or 
from ringing, calls that abandon from vector processing, 
calls that abandon after being routed to an extension via 
the “route to'' vector command (for Generic 2.2, Generic 
3 and later switches and for the ECS), and calls that 
abandoned while listening to a forced disconnect 
announcement (for the System 85, Generic 2.1, and 
Generic 3 Version 1 switches).

ABNCALLS includes ACD calls and calls routed to an 
agent or extension with talk times less than the value of 
the phantom-abandoned call timer.

ABNCALLS1-10, ABNQUECALLS, 
ABNRINGCALLS, PHANTOMABNS, and 
SLVLABNS are pegged as ABNCALLS.

C
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ABNCALLS1-10 The number of INCALLS that abandoned in each of the 
service level increments PERIOD1 through PERIOD9 
(as defined on the ACD Administration: VDN Call 
Profile Setup window). ABNCALLS10 counts calls that 
abandoned after PERIOD9.

C

ABNQUECALLS The number of ABNCALLS that were abandoned while 
in a split/skill or direct agent ACD queue. System 85 
calls that are abandoned while ringing at an agent 
position are included here.

C

ABNRINGCALLS The number of split/skill and direct agent ABNCALLS 
that were abandoned by the caller while ringing at an 
agent position. 

Available on Generic 2 and Generic 3 switches and on 
the ECS.

C

ABNTIME The length of time caller waited before abandoning. 

For phantom-abandon calls, ABNTIME is the total time 
from entering the VDN until the agent released the call.

C

ACCEPTABLE The number of ACDCALLS and CONNECTCALLS 
that were answered within the acceptable service level 
(as defined on the ACD Administration: VDN Call 
Profile Setup window).

C

ACD
(index)

The ACD number for which data was collected. A

ACDCALLS The number of split/skill and direct agent ACD calls 
that were answered by an agent. This includes calls from 
vector commands: “queue to main”, “check backup”, 
“messaging split/skill”, “route to” split/skill or direct 
agent, and “adjunct routing” to a split/skill or direct 
agent.

ACDCALLS includes ACDCALLS1-10, ACCEPTABLE, 
ANSCONNCALLS1-10, BACKUPCALLS, and 
TRANSFERRED.

C

Table 14: VDN Database Items  (Contd)

Database Item Description Type
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ACDTIME The talk time of all ACDCALLS, not including 
HOLDTIME.

ACDTIME includes SKILLTIME1 through 
SKILLTIME3.

C

ACTIVECALLS
(real-time)

The switch-generated count of the number of active calls 
in the VDN. This includes only incoming trunk calls 
directly to the VDN. It does not include internal calls to 
the VDN, transfers to the VDN, or calls that route to the 
VDN or redirect from ringing to the VDN after having 
been through another VDN. 

Available on the Generic 3 Version 4 switch and on the 
ECS with the vectoring feature.

S

ACWTIME The time that agents spent in After Call Work associated 
with split/skill or direct agent ACD calls.

ACWTIME includes SKILLACWTIME1-3.

C

ADJATTEMPTS The number of adjunct-routing attempts for calls to this 
VDN.

ADJATTEMPTS includes ADJROUTED.

Available on Generic 3 switches and on the ECS with the 
vectoring and ASAI features.

C

ADJROUTED The number of adjunct routing calls that were redirected 
by the adjunct.

Available on Generic 3 switches and on the ECS with the 
vectoring and ASAI features.

C

ANSCONNCALLS1
-10

The number of times that callers were answered 
(ACDCALLS) and connected (CONNECTCALLS) 
during each of the time periods (service level increments 
PERIOD1 through PERIOD9) set up for VDN call 
profiles. (ANSCONNCALLS10 counts calls answered or 
connected after PERIOD9.) Answered/connected calls 
include split/skill and direct agent ACD calls and 
extension calls by a “route to” or “adjunct routing” 
vector command.

C

Table 14: VDN Database Items  (Contd)

Database Item Description Type
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ANSTIME The time split/skill and direct agent ACD calls spent 
waiting to be answered, in vector processing, in queue, 
and ringing. For extension calls on System 85 and 
Generic 2.1 switches, ANSTIME is the time until ringing 
starts.

ANSTIME includes RINGTIME.

C

ASA
(real-time)

The switch-provided rolling average speed of answer for 
this VDN. This value is sent to CentreVu CMS whenever 
it changes on the switch (for example, when a call is 
answered).

Available on Generic 3 Version 4 switches and on the 
ECS with vectoring.

S

ATAGENT 
(real-time)

The current number of INPROGRESS calls (ACD and 
non-ACD) that have been answered by an agent or a 
station.

S

BACKUPCALLS The number of ACDCALLS that were queued to the 
answering split/skill using a vector command other 
than “queue to main”. This includes calls delivered by 
“messaging”, “check backup”, and “route to split/skill” 
vector commands, and “redirect on no answer” routing. 

BACKUPCALLS includes “messaging split/skill” calls, 
“check backup” calls, and calls that route to a split/skill 
or direct agent, either by the “route to” vector command 
or by adjunct routing. Calls that are redirected back to 
the split/skill using the redirection on no answer feature 
and are subsequently answered are also counted as 
BACKUPCALLS. Calls answered in a main split/skill 
(MAINCALLS) are then calculated as ACDCALLS - 
BACKUPCALLS. However, MAINCALLS does not 
include direct agent calls.

Available on System 85, Generic 2, and Generic 3 
switches and the ECS with the vectoring feature.

C

BH_ABNCALLS The number of INCALLS that were abandoned by 
callers during the busy hour.

C

Table 14: VDN Database Items  (Contd)

Database Item Description Type
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BH_ACDCALLS The number of ACDCALLS that were completed during 
the busy hour.

C

BH_ACDTIME The talk time of ACDCALLS that were completed 
during the busy hour.

C

BH_BUSYCALLS The number of INCALLS that were given a busy signal 
by the switch during the busy hour.

C

BH_DISCCALLS The number of INCALLS that were disconnected by the 
switch during the busy hour.

C

BH_OTHERCALLS The number of other incoming calls (OTHERCALLS) 
that were completed during the busy hour.

C

BH_STARTTIME The starting time of the busy hour. The busy hour is that 
set of contiguous intervals comprising a total of one hour 
in which the number of INCALLS to the VDN reached a 
maximum for the day.

C

BH_VDNCALLS The number of INCALLS to the VDN that completed 
during the busy hour.

C

BUSYCALLS The number of INCALLS that were given a busy signal 
by the switch.

This can occur on all switches via the “busy'' vector 
command.

On Generic 3 switches and the ECS, BUSYCALLS can 
occur if a call is routed to a split/skill with coverage set 
to “yes” where there are no agents available, the queue is 
full (or there is no queue), there is no coverage, and an 
announcement has played or the trunk is not a CO trunk.

Also on Generic 3 switches and the ECS, BUSYCALLS 
can occur if a call is routed to a direct agent with 
coverage set to “yes”, the agent is not logged in and 
there is no coverage path administered, an 
announcement has played, or the trunk is not a CO 
trunk.

C

Table 14: VDN Database Items  (Contd)

Database Item Description Type

831.bk : A_Database_Items_and_Calculations.fm  Page 142  Wednesday, November 27, 1996  1:46 P



 VDN Database Items A-143

Appendix A - Database Items and Calculations

A
pp

en
di

x 
A

BUSYTIME The duration of all BUSYCALLS (until the trunk goes 
idle).

C

CONNECTCALLS The number of non-ACD INCALLS that were delivered 
to a station extension (other than a VDN or direct agent 
login ID) by a “route to” or “adjunct routing” vector 
command and were not abandoned by the callers. 

For System 85 and Generic 2.1 switches, non-ACD 
abandons are not tracked, so all calls that route to a 
station extension (other than a VDN) are included in 
CONNECTCALLS for those switch releases.

CONNECTCALLS includes ANSCONNCALLS1-10.

C

CONNECTTIME The time CONNECTCALLS waited before being 
answered (for the Generic 3 switch and the ECS). For 
System 85 and Generic 2 switches, CONNECTTIME is 
the time before ringing starts.

C

CONNTALKTIME The talk time for all CONNECTCALLS, not including 
HOLDTIME (except on System 85, Generic 2.1, and 
Generic 1 switches).

C

DISCCALLS With Generic 2.2, Generic 3 Version 2 and later Generic 3 
switches, and with the ECS, the number of INCALLS 
that executed the “disconnect'' vector command. 

With System 85, Generic 2.1, and Generic 3 Version 1 
switches, the number of INCALLS that were given a 
forced disconnect announcement by the “disconnect” 
vector command and listened to the entire 
announcement, then were disconnected by the switch. 

With Generic 3 Version 2 and later Generic 3 switches 
and with the ECS, the number also includes calls 
disconnected due to the expiration of the vector 
disconnect timer and those that were disconnected 
because they reached the end of vector processing 
without being queued.

DISCCALLS includes VDISCCALLS.

C

Table 14: VDN Database Items  (Contd)

Database Item Description Type
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DISCTIME The time all DISCCALLS spent in this VDN. The time 
until the trunk drops following the forced disconnect 
command for those calls recorded as DISCCALLS.

For Generic 2.2, Generic 3 Version 2 and later Generic 3 
switches, and for the ECS, if the caller hangs up during 
the forced disconnect announcement, this is the time 
until the caller hangs up.

For System 85, Generic 2.1, and Generic 3 Version 1 
switches, DISCTIME is the time until the announcement 
ends and the caller is disconnected by the switch.

C

HOLDABNCALLS The number of times that callers abandoned while on 
hold.

For Generic 2.2 and Generic 3 switches, and for the ECS, 
HOLDABNCALLS includes all calls.

For System 85 and Generic 2.1 switches, 
HOLDABNCALLS includes split calls only.

C

HOLDACDCALLS The number of split/skill or direct agent ACD calls that 
were placed on hold at least one time.

C

HOLDACDTIME The amount of time split/skill or direct agent ACD 
callers spent on hold.

C

HOLDCALLS The number of calls that were placed on hold at least 
once. 

For Generic 2.2 and Generic 3 switches, and for the ECS, 
HOLDCALLS includes all calls.

For System 85 and Generic 2.1 switches, HOLDCALLS 
includes split calls only.

HOLDCALLS includes HOLDABNCALLS and 
HOLDACDCALLS.

C

Table 14: VDN Database Items  (Contd)

Database Item Description Type
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HOLDTIME The time that callers spent on hold. 

For Generic 2.2 and Generic 3 switches and for the ECS, 
HOLDTIME includes all calls.

For System 85 and Generic 2.1 switches, HOLDTIME 
includes split calls only.

HOLDTIME includes HOLDACDTIME.

C

I_ARRIVED The number of calls that reached the VDN during the 
interval.

C

ILN The internal line number of the VDN extension. A

INCALLS The number of inbound calls that were directed to this 
VDN.

INCALLS includes ABNCALLS, INFLOWCALLS, 
OTHERCALLS, RETURNCALLS, and RINGCALLS 
(which includes ACDCALLS).

INCALLS = ACDCALLS + ABNCALLS + 
OTHERCALLS

C

INCOMPLETE This indicates whether or not data is complete for this 
collection interval. Data is incomplete whenever the link 
goes down and whenever tracking is aborted for calls, 
due to trunk failures (System 85 and Generic 2 switches), 
the trunk going maintenance busy with a call active 
(Generic 1 and Generic 3 switches and the ECS), or 
protocol failures.

The value for interval tables indicates whether data is 
incomplete for the interval (0 = data complete, 1 = data 
incomplete). The value in the daily, weekly, and monthly 
tables indicates the number of incomplete intervals in 
the day, week, or month, respectively.

C

INFLOWCALLS The number of calls that were redirected into the VDN 
by way of a “route to” VDN command, or by Redirection 
on No Answer to this VDN from another VDN.

C

Table 14: VDN Database Items  (Contd)

Database Item Description Type
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INPROGRESS 
(real-time)

The current number of inbound calls that are associated 
with this VDN. Calls are considered to be in progress in 
the VDN until they are routed to another VDN, are 
routed off the switch, are transferred, or the trunk that is 
carrying them goes idle.

INPROGRESS includes ATAGENT and INVECTOR.

S

INQUEUE 
(real-time)

The current number of INPROGRESS calls that are in a 
split/skill or direct agent ACD queue. For System 85 
switches, this includes calls that are ringing at agent 
positions.

S

INRING 
(real-time)

The current number of INPROGRESS split/skill and 
direct agent ACD calls that are ringing at an agent 
position. 

Available on Generic 2 and Generic 3 switches and on 
the ECS.

S

INTERFLOWCALLS The number of OUTFLOWCALLS that were redirected 
to a destination outside the switch.

INTERFLOWCALLS includes LOOKFLOWCALLS.

C

INTIME The time spent by INCALLS in this VDN.

For Generic 2.2 and Generic 3 switches, and for the ECS, 
INTIME = ACDTIME + ABNTIME + ANSTIME + 
HOLDTIME + OTHERTIME

However, on System 85 and Generic 2.1 switches, there 
are multiple call handling scenarios in which call-based 
ACDTIME is stopped before the call ends. In these 
scenarios, INTIME does not add up to ACDTIME + 
ABNTIME + ANSTIME + OTHERTIME + 
HOLDTIME, so hold time cannot be calculated. (The 
scenarios occur when an agent puts an ACD call on hold 
using the HOLD key when another ACD call is already 
on hold, or when a call is dropped while an ACD call is 
on hold.)

C

Table 14: VDN Database Items  (Contd)

Database Item Description Type
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INTRVL The number of minutes in the timed period (15, 30, 60).

INTRVL applies to intrahour intervals only.

A

INVECTOR
(real-time)

The current number of INPROGRESS calls that are 
being processed by a vector. Calls that are in queue and 
calls that are ringing are still counted as INVECTOR. 
Calls are no longer counted as INVECTOR when they 
connect to a station, are answered by an agent, are 
abandoned, or they outflow from the VDN.

INVECTOR includes INQUEUE and INRING.

S

LOOKATTEMPTS The number of look-ahead interflow attempts for calls in 
this VDN.

LOOKATTEMPTS includes LOOKFLOWCALLS.

Available on Generic 2.2 and Generic 3 switches and on 
the ECS with the vectoring and look-ahead interflow 
features.

C

LOOKFLOWCALLS The number of INTERFLOWCALLS that were 
redirected by way of the look-ahead interflow feature.

Available on Generic 2.2 and Generic 3 switches and on 
the ECS with the vectoring and look-ahead interflow 
features.

C

MAXOCWTIME The maximum time during the collection interval that a 
caller waited in the VDN before being answered (ACD 
calls) or connected (non-ACD calls), abandoning, being 
redirected, receiving a busy signal or being 
disconnected. This applies only to the first disposition of 
the call.

C

MAXWAITING The maximum number of calls simultaneously in 
progress in the VDN during the collection interval.

C

Table 14: VDN Database Items  (Contd)

Database Item Description Type
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NOANSREDIR The number of split/skill and direct agent ACD calls 
that rang at agent positions and then were automatically 
redirected by the redirection on no answer feature 
because they were not answered. 

Available on Generic 3 Version 2 and later switches and 
on the ECS.

C

NUMTGS The number of trunk groups assigned to this VDN. A

OLDESTCALL
(real-time)

The number of seconds that the oldest call has been 
waiting in queue and ringing in this VDN.

S

OTHERCALLS OTHERCALLS includes forced busy, forced disconnect, 
outflowed calls and non-ACD calls that were answered 
(CONNECTCALLS).

OTHERCALLS includes BUSYCALLS, 
CONNECTCALLS, DISCCALLS, and 
OUTFLOWCALLS.

OTHERCALLS = INCALLS - ACDCALLS - 
ABNCALLS

S

OTHERTIME The duration of all OTHERCALLS from entering the 
VDN until the calls leave the VDN (the calls drop, are 
sent to another VDN, are transferred, or are sent outside 
the switch).

OTHERTIME includes BUSYTIME, CONNECTTIME, 
CONNTALKTIME, DISCTIME, and OUTFLOWTIME.

C

OUTFLOWCALLS The number of INCALLS that were redirected to 
another VDN or to a destination outside the switch by 
way of a “route to” or “adjunct routing” command, or 
were redirected on no answer to a VDN. Note that calls 
are counted as outflows from the VDN only when they 
are redirected to another VDN or to a destination 
outside the switch, not when they are routed to other 
destinations, such as split/skills or extensions.

OUTFLOWCALLS includes INTERFLOWCALLS and 
SLVLOUTFLOWS.

C

Table 14: VDN Database Items  (Contd)

Database Item Description Type
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OUTFLOWTIME The time all OUTFLOWCALLS spent in this VDN 
before being redirected.

C

PERIOD1-9 The length, in seconds, of each service level increment 
that has been administered for VDN call profiles. Each 
increment represents a progressively longer wait time. 
Calls that wait a longer length of time (beyond the last of 
these nine increments) are counted in either 
ANSCONNCALLS10 or ABNCALLS10.

A

PERIODCHG This indicates whether or not the time periods defined 
for call profiles were changed during the data collection 
interval.

A

PHANTOMABNS The number of split/skill and direct agent ACD calls 
and calls that routed to an agent or extension with talk 
time of less than the value set for the phantom-
abandoned call timer.

Available on Generic 3 switches and on the ECS.

C

RETURNCALLS The number of calls that reached this VDN via the VDN 
return destination feature.

Available on Generic 3 Version 3 and later switches and 
on the ECS.

C

RINGCALLS The number of split/skill and direct agent ACD calls 
that rang at agent positions.

RINGCALLS includes ACDCALLS.

Available on Generic 2 and Generic 3 switches and on 
the ECS.

C

RINGTIME The time split/skill and direct agent ACD calls spent 
ringing at agent positions, independent of final 
disposition. 

Available on Generic 2 and Generic 3 switches and on 
the ECS.

C

ROW_DATE
(index)

The date for which information was collected. A

Table 14: VDN Database Items  (Contd)

Database Item Description Type
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SERVICELEVEL The number of seconds in which calls must be 
answered/connected to be considered acceptable for this 
VDN.

A

SKILLACWTIME1-3 The After Call Work time spent by agents for calls 
answered in each VDN skill preference. 

Available on Generic 2.2 and Generic 3 Version 2 
switches with EAS.

C

SKILLCALLS1-3 Number of calls answered by agents in each VDN skill 
preference. 

Available on Generic 2.2 and Generic 3 Version 2 
switches with EAS.

C

SKILLTIME1-3 Time agents spent talking on calls they answered in each 
VDN skill preference.

Available on Generic 2.2 and Generic 3 Version 2 
switches with EAS.

C

SKILL1-3 First, second, and third VDN skill assigned to this VDN. 

Available on Generic 2.2 and Generic 3 Version 2 and 
later switches and on the ECS with the EAS feature.

A

SLVLABNS The number of ABNCALLS whose time to abandon was 
less than or equal to the time increment administered as 
this VDN’s SERVICELEVEL.

C

SLVLOUTFLOWS The number of OUTFLOWCALLS whose time to 
outflow was less than or equal to the time increment 
administered as this VDN’s SERVICELEVEL.

C

STARTTIME
(Index)

The start time of the interval for which data was 
collected. (Interval table only.)

A

SVCLEVELCHG This indicates whether the service level was changed 
during the data collection interval.

A

Table 14: VDN Database Items  (Contd)

Database Item Description Type
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A

TRANSFERRED The number of calls that were transferred to another 
destination. 

For System 85 and Generic 2.1 switches, 
TRANSFERRED includes all VDN calls blind 
transferred to a measured VDN or split.

For Generic 2.2 and Generic 3 switches and for the ECS, 
TRANSFERRED includes all VDN calls that were 
transferred.

C

VDISCCALLS The number of calls forced disconnected because the 
vector disconnect timer timed out, or because the call 
reached a vector stop without being queued. (“Vector 
stop” means a “stop” vector command, the end of the 
vector, or the one-thousandth vector step.)

Available on Generic 3 Version 2 and later switches and 
on the ECS.

C

VDN
(index)

The vector directory number (extension) that this row 
represents.

A

VECTOR
(index)

The number of the vector to which this VDN is assigned. A

Table 14: VDN Database Items  (Contd)

Database Item Description Type
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Switch Cross- Reference 1

Table 15 lists which VDN database items are supported by each of the 
switch releases.

Table 15: Switch Cross-Reference for VDN Database Items 

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
G3V3 G3V4 ECS

ABNCALLS X X X X X X X

ABNCALLS1-10 X X X X X X X

ABNQUECALLS X X X X X X X

ABNRINGCALLS X X X X X X

ABNTIME X X X X X X X

ACCEPTABLE X X X X X X X

ACD X X X X X X X

ACDCALLS X X X X X X X

ACDTIME X X X X X X X

ACTIVECALLS X X

ACWTIME X X X X X X X

ADJATTEMPTS X X X X

ADJROUTED X X X X

ANSCONNCALLS1-10 X X X X X X X

ANSTIME X X X X X X X

ASA X X

ATAGENT X X X X X X X

BH_ABNCALLS X X X X X X X

BH_ACDCALLS X X X X X X X

BH_ACDTIME X X X X X X X
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A

BH_BUSYCALLS X X X X X X X

BH_DISCCALLS X X X X X X X

BH_OTHERCALLS X X X X X X X

BH_STARTTIME X X X X X X X

BH_VDNCALLS X X X X X X X

BACKUPCALLS X X X X X X X

BUSYCALLS X X X X X X X

BUSYTIME X X X X X X X

CONNECTCALLS X X X X X X X

CONNECTTIME X X X X X X X

CONNTALKTIME X X X X X X X

DISCCALLS X X X X X X X

DISCTIME X X X X X X X

HOLDABNCALLS X X X X X X X

HOLDACDCALLS X X X X X X X

HOLDACDTIME X X X X X X X

HOLDCALLS X X X X X X X

HOLDTIME X X X X X X X

I_ARRIVED X X X X X X X

ILN X X X X X X X

INCALLS X X X X X X X

INCOMPLETE X X X X X X X

Table 15: Switch Cross-Reference for VDN Database Items  (Contd)

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
G3V3 G3V4 ECS
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INFLOWCALLS X X X X X X X

INPROGRESS X X X X X X X

INQUEUE X X X X X X X

INRING X X X X X X

INTERFLOWCALLS X X X X X X X

INTIME X X X X X X X

INTRVL X X X X X X X

INVECTOR X X X X X X X

LOOKATTEMPTS X X X X X

LOOKFLOWCALLS X X X X X

MAXOCWTIME X X X X X X

MAXWAITING X X X X X X X

NOANSREDIR X X X

NUMTGS X X X X X X X

OLDESTCALL X X X X X X X

OTHERCALLS X X X X X X X

OTHERTIME X X X X X X X

OUTFLOWCALLS X X X X X X X

OUTFLOWTIME X X X X X X X

PERIOD1-9 X X X X X X X

PERIODCHG X X X X X X X

PHANTOMABNS X X X X

Table 15: Switch Cross-Reference for VDN Database Items  (Contd)

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
G3V3 G3V4 ECS
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A

RETURNCALLS X 
(V3)

X X

RINGCALLS X X X X X X

RINGTIME X X X X X X

ROW_DATE X X X X X X X

SERVICELEVEL X X X X X X X

SKILL1-3 X 
(EAS)

X 
(EAS)

X 
(EAS)

X 
(EAS)

SKILLACWTIME1-3 X 
(EAS)

X 
(EAS)

X 
(EAS)

X 
(EAS)

SKILLCALLS1-3 X 
(EAS)

X 
(EAS)

X 
(EAS)

X 
(EAS)

SKILLTIME1-3 X 
(EAS)

X 
(EAS)

X 
(EAS)

X 
(EAS)

SLVLABNS X X X X X X X

SLVLOUTFLOWS X X X X X X X

STARTTIME X X X X X X X

SVCLEVELCHG X X X X X X X

TRANSFERRED X X X X X X X

VDISCCALLS X X X

VDN X X X X X X X

VECTOR X X X X X X X

Table 15: Switch Cross-Reference for VDN Database Items  (Contd)

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
G3V3 G3V4 ECS
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Call Work Codes Database Items 1

Call work codes are only available with Generic 3 and Generic 2.2 
switches.

The Call Work Codes database item descriptions (Table 16) apply to real-
time and historical items. 

The Type column refers to Cumulative (C), Administrative (A), or 
Status (S) data. Cumulative and Administrative items typically apply to 
both the current previous interval real-time tables. Status items apply only 
to the current interval real-time table.

Real-Time call work codes apply to the Current Interval CWC (ccwc ) and 
Previous Interval (pcwc ) tables. The real-time indexes are ACD and CWC.

Historical call work codes database items apply to the Intrahour Call Work 
Codes (hcwc ), Daily Call Work Codes (dcwc ), Weekly Call Work Codes 
(wcwc), and Monthly Call Work Codes (mcwc) tables, except as noted. The 
indexes are ROW_DATE and CWC.

Table 16: Call Work Codes Database Items

Database Item Description Type

ACD
(index)

The ACD number for which data was collected. A

ACDCALLS The number of times this call work code was entered 
while an agent was on a split/skill or direct agent ACD 
call or in call-related ACW.

C

ACDTIME The talk time of all ACDCALLS (not including 
HOLDTIME) associated with this call work code.

C

ACWTIME The time the agent spent in ACW for ACDCALLS that 
were associated with this call work code.

C

CWC
(index)

The call work code for which data was collected. A
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A

INCOMPLETE This indicates whether or not data collection is complete 
for this interval. Data collection is incomplete whenever 
the link goes down and whenever tracking is aborted for 
calls, due to trunk failures (System 85 and Generic 2 
switches), the trunk going maintenance busy with a call 
active (Generic 1 and Generic 3 switches), or protocol 
failures. The value for interval tables indicates whether 
data collection is incomplete for the interval (0 = data 
complete, 1 = data incomplete). The value in the daily, 
weekly, and monthly tables indicates the number of 
incomplete intervals in the day, week, or month.

C

INTRVL The number of minutes in the intrahour interval (15, 30, 
or 60).

INTRVL applies to intrahour intervals only.

A

ROW_DATE
(index)

The day for which data was collected.  C

STARTTIME The start time for the interval for which data was 
collected.

STARTTIME applies to the intrahour table only.

C

Table 16: Call Work Codes Database Items

Database Item Description Type
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Switch Cross- Reference 1

Table 17 lists the Call Work Codes database items and the switch(es) each 
item applies to.

Table 17: Switch Cross-Reference for Call Work Codes

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
G3V3 G3V4 ECS

ACD X X X X X

ACDCALLS X X X X X

ACDTIME X X X X X

ACWTIME X X X X X

CWC X X X X X

INCOMPLETE X X X X X

INTRVL X X X X X

ROW_DATE X X X X X

STARTTIME X X X X X
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AAgent Login/Logout Database Items 1

The Agent Login/Logout database item descriptions (Table 18) are 
historical items. They apply to the Agent Login/Logout (haglog ) table. 
The indexes are SPLIT and ROW_DATE.

Table 18: Agent Login/Logout Database Items

Database Item Description

ACD (index) The ACD number for which data was collected.

EXTN The extension number of the station that the agent staffed.

INFLAG If not null, indicates that the agent was already logged in when 
the link came up. Values are NULL and <.

LOGID The Login ID that was used to staff the extension. Agents in 
multiple splits/skills have one LOGID.

LOGIN The time at which the agent logged into this extension and 
split/skill with the given login ID.

LOGONSKILL2-20 The skill number of the agent’s second through twentieth skills. 
The number of skills per agent depends on the type of switch.

Available on Generic 2.2 and later Generic 3 switches with EAS.

LOGOUT The time at which the agent logged out.

LOGOUT_DATE The date on which the agent logged out.

LOGOUTREASON The reason code (0 through 9) associated with the agent’s 
logout. For switch releases earlier than the ECS switch releases 
that do not have the EAS feature and reason codes active, this 
field will always contain 0 when the agent has logged out.

OUTFLAG If not null, indicates that the agent logged out while the link 
was down. Values are NULL and >.

ROW_DATE (index) The date the agent logged in.
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SKILLTYPE The type (primary or secondary) of the first skill the agent 
logged into.

Available on Generic 3 Version 2 and later Generic 3 switches 
with EAS. Because skill level 1 is primary, skill level 2 is 
secondary, and skill levels 3 through 16 are blank on the ECS, it 
is recommended that you use SKLEVEL instead of 
SKILLTYPE.

SKILLTYPE2-4 The type (primary or secondary) of the second skill the agent 
logged into, the third skill the agent logged into, and the fourth 
skill the agent logged into.

Available on Generic 3 Version 2 and later Generic 3 switches 
with EAS.

SKLEVEL The skill level (1 through 16) associated with SPLIT.

SKLEVEL2-20 The skill levels (1 through 16) associated with LOGONSKILL2 
through LOGONSKILL20.

SPLIT
(index)

The split number to which the extension is assigned or skill 
number that the agent logged into.

Table 18: Agent Login/Logout Database Items

Database Item Description
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ASwitch Cross- Reference 1

Table 19 lists which Agent Login/Logout database items are supported by 
each of the switch releases.

Table 19: Switch Cross-Reference for Agent Login/Logout Database Items

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
G3V3 G3V4 ECS

ACD X X X X X X X X

EXTN X X X X X X X X

INFLAG X X X X X X X X

LOGID X X X X X X X X

LOGIN X X X X X X X X

LOGONSKILL2-4 X 
(EAS)

X 
(EAS)

X 
(EAS)

X 
(EAS)

LOGONSKILL5 X 
(EAS)

X 
(EAS)

LOGONSKILL6-20 X 
(EAS)

LOGOUT X X X X X X X X

LOGOUT_DATE X X X X X X X X

LOGOUTREASON X 
(EAS)

OUTFLAG X X X X X X X X

ROW_DATE X X X X X X X X

SKILLTYPE X 
(EAS)

X 
(EAS)

X 
(EAS)

SKILLTYPE2-4 X 
(EAS)

X 
(EAS)

X 
(EAS)
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SKLEVEL X 
(EAS)

X 
(EAS)

X 
(EAS)

SKLEVEL2-4 X 
(EAS)

X 
(EAS)

X 
(EAS)

SKLEVEL5-20 X 
(EAS)

SPLIT X X X X X X X X

Table 19: Switch Cross-Reference for Agent Login/Logout Database Items

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
G3V3 G3V4 ECS
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x 
AAgent Trace Database Items 1

The Agent Trace database item descriptions (Table 20) are historical items. 
They apply to the Agent Trace (ag_actv ) table. The indexes are LOGID 
and ROW_DATE.

The Optional database items collect data only when those items are selected 
in the CentreVu CMS System Setup: Agent Trace Record Contents window 
and are not used in any standard reports. To receive a report containing 
optional Agent Trace historical database items, a custom report must be 
created. 

Table 20: Agent Trace Database Items 

Database Item Description

ACD (index) The ACD number for which data was collected.

AGT_RELEASED The agent released or dropped the split/skill or direct agent 
ACD call. This is always true for ACD calls the agent 
transferred or conferenced.

Available on Generic 3 and later switches.

ASSIST_ACTV The agent requested supervisor assistance (pressed ASSIST 
key).

AUXREASON The reason code associated with the agent’s change to AUX 
mode. For agents in AUX on switch releases earlier than the 
ECS or on switches that do not have the EAS feature and reason 
codes active, this will be 0.

CALLER_HOLD The agent put the current call on hold. 

For System 85 and Generic 2.1 switches, CALLER_HOLD 
applies to split ACD calls.

For Generic 2.2 and Generic 3 switches, CALLER_HOLD 
applies to all calls.

CALLING_II The Information Indicator (II) digits associated with the call. 
These digits supply information about the originator location, 
for example, pay phone, hospital, or prison.

Available on the ECS.
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CALLING_PTY The calling party identification. This is the ANI/SID, for 
Generic 2.2 and Generic 3 Version 4 and later switches with 
ISDN ANI delivery. Otherwise, it is the extension or trunk 
equipment location identifying the originator of the call. The 
field is blank if the trunk is not measured or, for internal calls, if 
the originating extension is not measured.

CONFERENCE The agent activated a conference. 

Available on Generic 3 and Generic 2.2 switches.

DIGITS_DIALED The digits the agent dialed to originate a call. Trunk access 
codes, feature access codes, account and authorization codes are 
not included.

Available on Generic 2.2 and Generic 3 switches.

DIRECTION The direction of the call the agent is currently handling for any 
split/skill (IN, or OUT, or as defined in Dictionary). If the agent 
is not on a call, the value is blank (NULL).

DURATION The duration of current WORKMODE and DIRECTION for 
this split (that is, length of time in current AGSTATE for this 
split).

EVENT_TIME The time of day (hour, minute, and second) the WORKMODE 
or DIRECTION changed.

EXT_CALL_ORIG The agent originated an external (off-switch) call. 

Available on Generic 2.2 and Generic 3 switches.

KEYBD_DIALED The call was keyboard dialed. 

Available on Generic 2.2 switches with the ASAI Gateway 
Interface feature and Generic 3 switches with the ASAI feature.

LOGID
(index)

The Login ID that was used to staff the extension. Agents in 
multiple splits/skills have one LOGID.

LOGOUTREASON The reason code associated with the agent’s logout. For switch 
releases earlier than the ECS or switch releases that do not have 
the EAS feature and reason codes active, this field will always 
contain 0 when the agent has logged out.

Table 20: Agent Trace Database Items  (Contd)

Database Item Description
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A

MCT The agent activated a malicious call trace. 

Available on System 85, Generic 2, and Generic 3 (except for 
Generic 3i Version 1) switches.

RECONNECT This event represents the agent reconnecting to the call after 
putting it on hold. 

Available on System 85, Generic 2, and Generic 3 switches.

ROW_DATE
(index)

The date the event (WORKMODE or DIRECTION change) 
took place.

SPLIT The split number that the agent’s extension is assigned to or 
skill number associated with the agent’s current ACD call or 
ACW session.

STARTTIME The time of day (hour and minute) for which the agent trace 
report is being ordered. This is the time of day you enter to 
request the report.

TRANSFERRED The agent transferred the call. 

For Generic 1 switches, TRANSFERRED includes measured 
call-to-measured split or measured trunk-to-measured trunk 
transfers.

For System 85 and Generic 2.1 switches, TRANSFERRED 
includes calls transferred to a measured VDN or split.

For Generic 3 and Generic 2.2 switches, TRANSFERRED 
includes all calls that were transferred.

WMODE_SEQ The sequence number for events that occur in the same second.

WORKCODE The call work code the agent entered for the call. 

Available on Generic 3 and Generic 2.2 switches with call work 
codes.

Table 20: Agent Trace Database Items  (Contd)

Database Item Description
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Switch Cross- Reference 1

Table 21 lists which Agent Trace database items are supported by each of the 
switch releases.

WORKMODE The work mode in which the agent was working during the 
trace.

Agent work modes include AVAIL, ACD, ACW, AUX, DACD, 
DACW, RING, UNKNOWN, OTHER, and UNSTAFF. If the 
agent has not been logged in during the collection interval, the 
value is blank.

Table 21: Switch Cross-Reference for Agent Trace Database Items 

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
G3V3 G3V4 ECS

ACD X X X X X X X X

AGT_RELEASED X X X X

ASSIST_ACTV X X X X X X X X

AUXREASON X X X X X X X X

CALLER_HOLD X X X X X X X

CALLING_II X

CALLING_PTY X X X X X X X X

CONFERENCE X X X X X

DIGITS_DIALED X X X X X

DIRECTION X X X X X X X X

Table 20: Agent Trace Database Items  (Contd)

Database Item Description
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DURATION X X X X X X X X

EVENT_TIME X X X X X X X X

EXT_CALL_ORIG X X X X X

KEYBD_DIALED X X X X X

LOGID (index) X X X X X X X X

LOGOUTREASON X X X X X X X X

MCT X X X X X X X

RECONNECT X X X X X X X

ROW_DATE X X X X X X X X

SPLIT X X X X X X X X

STARTTIME X X X X X X X X

TRANSFERRED X X X X X X X X

WMODE_SEQ X X X X X X X X

WORKCODE X X X X X

WORKMODE X X X X X X X X

Table 21: Switch Cross-Reference for Agent Trace Database Items  (Contd)

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
G3V3 G3V4 ECS
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Call Record Database Items 1

The Call Record database item descriptions (Table 22) are historical items. 
They apply to the Call Record (call_rec ) table. The indexes are ACD and 
ROW_DATE.

Table 22: Call Record Database Items 

Database Item Description

ACD (index) The number of the ACD that handled this call.

ACWTIME The time spent, in seconds, in ACW (after call work) related to 
this call by the answering agent in this segment.

AGT_RELEASED The agent released or dropped the split/skill or direct agent 
ACD call. This is always true for ACD calls the agent 
transferred or conferenced. 

Available on Generic 3 switches.

ANSHOLDTIME The total time call was put on hold by the answering agent, in 
seconds, in this call segment. Note that in agent-to-agent calls, 
ANSHOLDTIME is accrued for the answering agent if the 
agent puts the call on hold, but not for the other agent (who 
continues to accrue talk time).

For System 85 and Generic 2.1 switches, ANSHOLDTIME 
includes split ACD calls held.

For Generic 2.2 and Generic 3 switches, and the ECS, 
ANSHOLDTIME includes all calls held.

ANSLOGIN The login ID of the agent who answered the call in this segment. 
This field is blank for unmeasured extensions when EAS is not 
active.

ANSREASON The reason code (0-9) associated with the answering agent’s 
mode, if the agent is in the AUX mode. For agents in AUX on 
switches with releases that are earlier than the ECS or that do 
not have EAS and reason codes active, this will only be 0.

ASSIST Whether or not the answering agent in this segment requested 
supervisor assistance on this call (YES or NO).
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AUDIO Whether or not an agent in this segment reported an audio 
difficulty problem (YES/NO).

CALLID A unique number assigned to this call and all its segments. 
Note that in the case of a conference or transfer, when the data 
for the conference/transfer is recorded, the same call ID will be 
recorded for all call segments of the conference/transfer. Note 
that in the case of “meet-me conferences, this may result in 
higher-numbered segments of the call starting before the first 
segment on the call. Call IDs are not necessarily strictly 
sequential, but will be unique for calls over a day.

CALLING_II The Information Indicator (II) digits associated with the call. 
These digits supply information about the originator location, 
for example, pay phone, hospital, prison.

Available on the ECS and later switches.

CALLING_PTY The Automatic Number Identification (ANI)/Station 
Identification (SID) (Generic 2.2 or Generic 3 Version 4 or later 
Generic 3 switches with ANI delivery), extension or trunk 
equipment location identifying the originator of the call. This 
field is blank if the trunk is not measured or, for internal calls, if 
the originating extension is not measured. (Up to 12 digits in 
this field.)

CONFERENCE Whether or not this call segment represents part of a conference 
(YES/NO). 

Available on Generic 3 and Generic 2.2 switches.

CONSULTTIME The time an agent talked on any outbound call, while in AUX 
work or ACW. This includes the time the originating agent 
spent talking to the destination party while establishing a 
conference or transferring a call. (This is the time between 
presses of the transfer or conference button.) It includes wait 
time if the agent is calling a VDN or split/skill extension, but 
the wait time can be subtracted out by subtracting the 
DISPTIME item from CONSULTIME.

Table 22: Call Record Database Items  (Contd)

Database Item Description
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DA_QUEUED Whether or not the call was queued as a direct agent call 
(YES/NO). 

Applies to Generic 3 switches only.

DIALED_NUM The number the caller dialed (up to 24 digits). This will be the 
VDN for inbound vectoring calls and dialed digits for 
outbound calls. This will be blank for inbound calls without 
vectoring.

DISPIVECTOR The number of the first vector associated with the disposition 
VDN (DISPVDN).

Table 22: Call Record Database Items  (Contd)

Database Item Description
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DISPOSITION This indicates whether the call was answered, connected, 
interflowed, abandoned, forced busy, forced disconnect, or 
other, in the call segment.

An answered call is any split/skill or direct agent ACD call for 
which CMS receives an indication that the call was answered by 
an agent. 

A connected call is a non-ACD call to a measured agent for 
which CMS receives an indication that the call was connected 
or, in the case of System 85 R2V4 and Generic 2.1 switches, any 
call that was delivered to an extension by a “route to” vector 
command (CMS receives no indication if the call abandons).

An interflowed call is a call that was redirected to an off-switch 
destination.

An abandoned call is any call for which CMS receives 
notification that the caller abandoned. This includes calls with 
talk times shorter than the phantom-abandoned call timer.

Forced busy calls are calls that CMS records as BUSYCALLS 
for the trunk group that carried them. These calls can be VDN 
calls that received a forced busy from the vector command or, 
on Generic 1 and Generic 3 switches and ECS a split/skill call 
that received a busy indication from the switch because the split 
queue was full, or no queue and no available agents, or no 
staffed agents.

Forced disconnect calls are VDN calls that are disconnected by 
the switch due to the execution of a disconnect vector command 
(Generic 2.2, Generic 3 Version 2, later Generic 3 switches, and 
the ECS) or, for System 85, Generic 2.1, and Generic 3 Version 1 
switches, calls that were given a forced disconnect 
announcement and listened to the entire announcement, then 
were disconnected by the switch. For Generic 3 Version 2 and 
later Generic 3 releases, disconnect calls also include calls 
disconnected because of the disconnect vector timer or because 
they reached the end of vector processing without being 
queued.

Other calls are any other calls.

Table 22: Call Record Database Items  (Contd)

Database Item Description
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DISPPRIORITY The priority the call had at its disposition in this segment. 
Priorities can be LOW, MED, HIGH, or TOP (with vectoring) or 
YES/NO (without vectoring). For Generic 3 switches with 
vectoring, calls directed to split/skills using “route to” or 
“messaging split/skill” commands and calls directly to 
splits/skills without going through a vector will have MED (no 
priority) or HIGH (priority) priority, depending on the class of 
restriction of the originator of the call (agent, extension, trunk 
group, or VDN).

If the call never queued to a split/skill, the priority will not be 
set.

DISPSKLEVEL The skill level (1-16) associated with the skill for which the 
agent answered the call or, for calls that abandoned from 
ringing or from a direct agent queue, with the agent from whom 
the call abandoned. 

Available on the ECS with EAS.

DISPSPLIT The number of the split or skill associated with the call at its 
disposition in this call segment. Calls that were not queued to a 
split or skill at the time of disposition will have DISPSPLIT set 
to null. Calls that were queued to an unmeasured split or skill 
at the time of disposition will have DISPSPLIT set to zero.

DISPTIME The wait time (in the vector, in queue, ringing) until the 
disposition recorded in DISPOSITION for the call segment. 
For extension calls made directly to agents (not through a 
VDN), this will always be zero.

DISPVDN The number of the VDN associated with the call at its 
disposition for this call segment. DISPVDN will be blank for 
calls that are not associated with a VDN at their disposition.

DURATION The total time the trunk was held. This is the overall trunk 
holding time from the beginning of the call segment until the 
caller is disconnected. For the first segment of a call, this will be 
the trunk holding time for the caller for the entire call (from 
seized until idle). With a transfer, the original trunk remains 
associated with both call segments until the call ends.

Table 22: Call Record Database Items  (Contd)

Database Item Description
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EQLOC The physical equipment location of the trunk that carried the 
call. This will be blank if the trunk is not measured.

EVENT1-9 The number of times each event (stroke count) button was 
pressed for this call segment. 

Available on System 85, Generic 2, and Generic 3 switches.

FIRSTVECTOR The number of the first vector associated with the first VDN for 
the call segment.

FIRSTVDN The number of the first VDN associated with the call segment.

HELD The total number of times this call was placed on hold by the 
answering agent in this call segment. With agent-to-agent calls, 
this count is incremented for the agent who puts the call on 
hold, regardless of whether that agent answered or originated 
the call, but not for the other agent who is continuing to accrue 
talk time). (for System 85 R2V4, Generic 2.1 switches, this 
includes only split ACD calls held. With Generic 2.2 and 
Generic 3 switches, this includes all calls the agent put on hold.)

HOLDABN Whether this call abandoned from hold (YES/NO) in this call 
segment.

With System 85 and Generic 2.1 switches, this is only for split 
ACD calls.

With Generic 2.2 and Generic 3 switches, this includes all calls 
the agent put on hold.

LASTCWC The last call work code (up to 16 digits) entered by the 
answering agent in this segment. This database item applies to 
Generic 2.2 and Generic 3 switches only.

Table 22: Call Record Database Items  (Contd)

Database Item Description
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LASTDIGITS The last set of collected digits sent to the CMS by the switch. 
These are digits the switch sends to CMS when it executes a 
“Collect” vector command. The digits may be digits the caller 
was prompted to enter, either through the prompting feature on 
the switch or through network-prompted digits (“caller-entered 
digits (ced)”), customer-database provided digits (“cdpd” from 
the network) or digits collected through a “Converse” vector 
command.

Available on the ECS.

LASTOBSERVER The login ID of the last agent that service-observed or bridged 
on to this call.

MALICIOUS This indicates whether or not a malicious call trace was 
activated for this call segment. Valid values for MALICIOUS 
are YES and NO.

Applies to Generic 2 and Generic 3 (except Generic 3i Version 1) 
switches.

OBSERVINGCALL Whether this call represents an agent observing or bridging on 
to an existing call. Valid values for OBSERVINGCALL are YES 
and NO.

ORIGLOGIN The Login ID of the agent originating the call. This is used for 
calls an agent originates to another agent, to an on-switch 
extension, or to an external destination.

ORIGREASON The reason code (0 - 9) associated with the originating agent’s 
mode, if the agent is in the AUX mode. For agents in AUX on 
switches with releases that are earlier than the ECS or that do 
not have EAS and reason codes active, this will only be zero.

ROW_DATE The date the call started.

ROW_TIME The time of day that the call started.

SEGMENT The number of the call segment. Segment numbers are from 1 
up to the number of segments in the call.

Table 22: Call Record Database Items  (Contd)

Database Item Description
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SEGSTART The time the call segment started. A new segments starts when 
CMS receives the first message for the call, since each call 
segment represents a call. (When an agent transfers or 
conferences a call, the agent makes another call to effect the 
transfer/conference.)

SEGSTOP The time when the call and any associated after call work 
ended. The call ends when all trunks and agents associated 
with the call segment have dropped off the call. This means that 
after call work time for the agent(s) is included when 
calculating the call segment stop time.

SPLIT1 The first split/skill to which the call queued in the first VDN 
with which it was associated in the call segment.

SPLIT2 The second split/skill to which the call was also queued to in 
the first VDN with which it was associated in the call segment. 
This only applies to Generic 2.2 with EAS and Generic 3 
switches with vectoring.

SPLIT3 The third split/skill to which the call was also queued in the 
first VDN with which it was associated in the call segment. This 
applies only to Generic 2.2 with EAS and Generic 3 switches 
with vectoring.

TALKTIME The total talk time for the answering agent in this call segment.

TKGRP The number of the trunk group that carried the call. This will be 
null if the trunk carrying the call is not measured.

TRANSFERRED Whether or not the agent initiated a transfer on this call 
segment. Valid values for TRANSFERRED are YES and NO.

For Generic 2.2 and Generic 3 switches, TRANSFERRED is set 
for any call transferred.

For System 85 and Generic 2.1 switches, TRANSFERRED is set 
for transfers to a measured VDN or split.

For Generic 1 switches, TRANSFERRED is set only if a 
measured call is transferred to a measured split or from a 
measured trunk to a measured trunk.

Table 22: Call Record Database Items  (Contd)

Database Item Description
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Switch Cross- Reference 1

Table 23 lists which Call Record database items are supported by each of the 
switch releases.

Table 23: Switch Cross-Reference for Call Record Database Items 

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
G3V3 G3V4 ECS

ACD X X X X X X X X

ACWTIME X X X X X X X X

AGT_RELEASED X X X X

ANSHOLDTIME X X X X X X X

ANSLOGIN X X X X X X X X

ANSREASON X X X X X X X X

ASSIST X X X X X X X X

AUDIO X X X X X X X

CALLID X X X X X X X X

CALLING_II X

CALLING_PTY X X X X X X X X

CONFERENCE X X X X X

CONSULTTIME X X X X X X X X

DA_QUEUED X X X X

DIALED_NUM X X X X X X X

DISPIVECTOR X X X X X X X

DISPOSITION X X X X X X X X

DISPPRIORITY X X X X X X X X

DISPSKLEVEL X 
(EAS)
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DISPSPLIT X X X X X X X X

DISPTIME X X X X X X X X

DISPVDN X X X X X X X

DURATION X X X X X X X X

EQLOC X X X X X X X X

EVENT1-9 X X X X X X X X

FIRSTIVECTOR X X X X X X X

FIRSTVDN X X X X X X X

HELD X X X X X X X

HOLDABN X X X X X X X

LASTCWC X X X X X

LASTDIGITS

LASTOBSERVER X X X X

MALICIOUS X X X (not 
G3iV1)

X X X

OBSERVINGCALL X X X X

ORIGLOGIN X X X X X X X X

ORIGREASON X X X X X X X X

ROW_DATE X X X X X X X X

ROW_TIME X X X X X X X X

SEGMENT X X X X X X X X

SEGSTART X X X X X X X X

SEGSTOP X X X X X X X X

Table 23: Switch Cross-Reference for Call Record Database Items  (Contd)

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
G3V3 G3V4 ECS
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SEQNUM X X X X X X X X

SPLIT1 X X X X X X X X

SPLIT2 X 
(EAS)

X X X X

SPLIT3 X 
(EAS)

X X X X

TALKTIME X X X X X X X X

TKGRP X X X X X X X X

TRANSFERRED X X X X X X X X

Table 23: Switch Cross-Reference for Call Record Database Items  (Contd)

Database Item G1 85 G2.1 G2.2 G3V1
G3V2
G3V3 G3V4 ECS
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In Table 24 through Table 29, the database item EXTYPE lists numerical 
values associated with exception types. The database item REASON in 
Table 30 lists numerical values associated with exception types. 

CentreVu CMS stores exception types using the numerical values, then 
translates the numbers into the text you see in standard exception reports. 

To select specific exception types for a custom report, you must enter the 
numerical value(s) in the Select rows where: statement. 
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Agent Exceptions Database Items 1

The Agent Exception database item descriptions (Table 24) are historical 
items. They apply to the Agent Exception (agex ) table.

Table 24: Agent Exception Database Items

Database Item Description

ACD (index) The ACD the agent was logged into.

EXTYPE The type of exception that occurred:

Numerical
ValueType

  1 Time Available
  2 Time on inbound ACD call (min) 
  3 Time on inbound ACD call (max)
  4 Time in after call work
  5 Time on outbound ACW call
  6 Time on inbound ACW call
  7 Time in AUX work
  8 Time on outbound AUX call
  9 Time on inbound AUX call
 10 Number of outbound ACW calls/agent

11 Number of inbound ACW calls/agent
 12 Number of outbound AUX calls/agent
 13 Number of inbound AUX calls/agent
 14 Login not in dictionary
 15 Time ACD call spent on hold*
 16 Number ACD calls placed on hold*
 17 Number ACD calls abandoned while on hold*
 18 Time on outbound ACD call (min)
 19 Time on outbound ACD call (max)†

 20 Number calls transferred**
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 21 Time on external outbound ACW call†

 22 Time on external outbound AUX call†

 23 Time on direct agent call‡

 24 Number external outbound ACW calls/agent**
 25 Number external outbound AUX calls/agent**
 26 Time ACD call spends ringing**
 27 Different logins on same extension
 28 Ringing call automatically redirected from agent
 29 Agent logged out with active/held calls

 30 Number of calls waiting in direct agent queue‡

 31 Time oldest call has waited in direct agent queue‡

 32 Number of calls abandoned from direct agent queue‡

 34 Number of calls outflowed from direct agent queue‡

 38 Number calls transferred
 48 Logout attempt without valid reason code
 49 Could not be logged in
 59 AUX attempt without valid reason code
 60 Time in AUX with reason code 0 (default)
 61 Time in AUX with reason code 1
 62 Time in AUX with reason code 2
 63 Time in AUX with reason code 3
 64 Time in AUX with reason code 4
 65 Time in AUX with reason code 5
 66 Time in AUX with reason code 6
 67 Time in AUX with reason code 7
 68 Time in AUX with reason code 8
 69 Time in AUX with reason code 9
 98 Agent denied login to some skills
 99 Invalid call work code

LOGID The Login ID of the agent who had the exception.

REASON_CODE The reason code that the agent was in when the exception 
occurred.

ROW_DATE The date on which the exception occurred.

ROW_TIME The time at which the exception occurred.

Table 24: Agent Exception Database Items (Contd)

Database Item Description
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*Available only on System 85, Generic 2, and Generic 3 switches.
†Available only with Generic 2.2 switches with the ASAI Gateway Interface feature and 
Generic 3 switches with the ASAI feature.
** Available only with Generic 2.1 or later and Generic 3 switches.
‡ Available only with Generic 3 switches with the ASAI or EAS feature.

SPLIT The split or skill in which the agent was doing work when the 
exception occurred.

THRESHOLD The limit, as a number of occurrences, administered for the 
exception type. An exception occurs when the agent's activity 
falls outside of that limit.

TIME The limit, as a number of seconds, administered for timed 
exceptions types. An occurrence is logged against the threshold 
when the agent's activity falls outside of that limit.

Table 24: Agent Exception Database Items (Contd)

Database Item Description
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The Split/Skill Exception database item descriptions (Table 25) are 
historical items. They apply to the Split/Skill Exception (spex ) table.

*Available only on System 85, Generic 2, and Generic 3 switches.
†Available only with Generic 2.2 switches with the ASAI Gateway Interface feature and 
Generic 3 switches with the ASAI feature.
** Available only with Generic 2.1 or later and Generic 3 switches.

Table 25: Split/Skill Exception Database Items

Database Item Description

ACD (index) The ACD of the split or skill.

EXTYPE The type of exception that occurred:

Numerical
ValueType

 30 Number calls waiting
 31 Time call has waited in queue
 32 Number calls abandoned
 33 Number intraflowed-in calls
 34 Number intraflowed-out calls
 35 Number interflowed-out calls
 36 Number calls offered while queue full*

 37 Number calls handled as backup†

 38 Number calls transferred**
 39 Average speed of answer (seconds)
 40 Rolling average speed of answer (seconds)
 41 Expected wait time (pri top)
 42 Expected wait time (pri high)
 43 Expected wait time (pri medium)
 44 Expected wait time (pri low)

ROW_DATE The date on which the exception occurred.

ROW_TIME The time at which the exception occurred.

SPLIT The split or skill in which the exception occurred.

THRESHOLD The limit, as a number of occurrences, administered for the 
exception type. An exception occurs when the split's/skill's 
activity falls outside of that limit.

TIME The limit, as a number of seconds, administered for timed 
exceptions types. An occurrence is logged against the threshold 
when the split's/skill's activity falls outside of that limit.
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The Trunk Group Exception database item descriptions (Table 26) are 
historical items. They apply to the Trunk Group Exception (tgex ) table.

Table 26: Trunk Group Exception Database Items

Database Item Description

ACD (index) The ACD of the trunk group.

EXTYPE The type of exception that occurred:

Numerical
ValueType

 50 Time trunk in use (min)
 51 Time trunk in use (max)
 52 Number trunks in use
 53 Total time trunks maintenance busy
 54 Number trunks maintenance busy
 55 Length of time all trunks busy
 56 Number trunk failures in group
 57 Number failures on any single trunk
 58 Audio difficulty

EQLOC The trunk location where the exception occurred.

LOGID The Login ID of the agent reporting audio difficulty.

ROW_DATE The date on which the exception occurred.

ROW_TIME The time at which the exception occurred.

THRESHOLD The limit, as a number of occurrences, administered for the 
exception type. An exception occurs when the trunk group's 
activity falls outside of that limit.

TIME The limit, as a number of seconds, administered for timed 
exceptions types. An occurrence is logged against the threshold 
when the trunk group's activity falls outside of that limit.

TKGRP The number of the trunk group where the exception occurred.
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The VDN Exception database item descriptions (Table 27) are historical 
items. They apply to the Agent Exception (vdnex ) table. VDN exceptions 
are available only with the vectoring feature.

Table 27: VDN Exception Database Items

Database Item Description

ACD (index) The ACD of the VDN.

EXTYPE The type of exception that occurred:

Numerical
ValueType

 2 Time at agent (min)
 3 Time at agent (max)
 30 Number calls in an ACD split queue
 32 Number calls abandoned while in vector
 33 Number calls flowed into VDN
 34 Number calls flowed out of VDN
 35 Number calls interflowed out of VDN
 37 Number calls handled by backup split
 71 Time in vector (max)
 72 Number calls forced busy
 73 Number calls disconnected
 74 Number unsuccessful lookahead attempts
 75 Number unsuccessful adjunct routing attempts
 76 Rolling average speed of answer

ROW_DATE The date on which the exception occurred.

ROW_TIME The time at which the exception occurred.

THRESHOLD The limit, as a number of occurrences, administered for the 
exception type. An exception occurs when the VDN activity 
falls outside of that limit.

TIME The limit, as a number of seconds, administered for timed 
exceptions types. An occurrence is logged against the threshold 
when the VDN activity falls outside of that limit.

VDN The VDN for which the exception occurred.

VECTOR The vector number associated with the exception.
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Vector Exceptions Database Items 1

The Vector Exception database item descriptions (Table 28) are historical 
items. They apply to the Vector Exception (vecex ) table. Vector exceptions 
are available only with the vectoring feature. 

Table 28: Vector Exception Database Items

Database Item Description

ACD (index) The ACD of the vector.

EXTYPE The type of exception that occurred:

Numerical
ValueType

 30 Number calls in an ACD split queue
 32 Number calls abandoned while in vector
 72 Number calls forced busy
 73 Number calls disconnected
 74 Number unsuccessful lookahead interflow 

attempts
 75 Number unsuccessful adjunct routing attempts
 80 Time in vector (min)
 81 Time in vector (max)

ROW_DATE The date on which the exception occurred.

ROW_TIME The time at which the exception occurred.

THRESHOLD The limit, as a number of occurrences, administered for the 
exception type. An exception occurs when the vector activity 
falls outside of that limit.

TIME The limit, as a number of seconds, administered for timed 
exceptions types. An occurrence is logged against the threshold 
when the vector activity falls outside of that limit.

VECTOR The vector number for which the exception occurred.
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The Malicious Call Trace Exception database item descriptions (Table 29) are 
historical items. They apply to the Malicious Call Trace Exception (mctex ) 
table.

Table 29: Malicious Call Trace Exception Database Items

Database Item Description

ACD (index) The ACD on which the malicious call was recorded.

ANI_SID The billing number or phone number from which the malicious 
call originated (available only if the switch has ANI/SID 
service).

EQLOC The location of the trunk that carried the malicious call.

EXTYPE Type of exception that occurred:

Numerical
ValueType

 90      Malicious call

II_DIGITS The Information Indicator digits. Indicates type of originating 
line of caller.

LOGID The Login ID of the agent reporting the malicious call.

ROW_DATE The date on which the malicious call was reported.

ROW_TIME The time at which the malicious call was reported.

SPLIT The split/skill of the agent reporting the malicious call.

THRESHOLD Not used.

TIME Not used.

TKGRP The number of the trunk group that carried the malicious call.

VDN The VDN that carried the malicious call. 

Available with System 85, Generic 2, and Generic 3 switches 
with vectoring.
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Data Collection Exceptions Database Items 1

The Data Collection Exception database item descriptions (Table 30) are 
historical items. They apply to the Data Collection Exception (linkex ) 
table.

Table 30: Data Collection Exception Database Items

Database Item Description

ACD (index) The ACD for which data collection was interrupted.

DURATION The length of time for which data collection was off.

REASON The reason for the interruption of data collection. The reasons 
may be as follows:

Numerical
ValueReason

 91 Data collection started
 92 Data collection started - new translations
 93 Data collection turned off
 94 Data collection busied out
 95 Data collection timed out
 96 Data collection clock was reset
 97 Data collection session down

ROW_DATE The date on which data collection was interrupted.

ROW_TIME The time at which data collection was interrupted.

THRESHOLD the limit, as a number of occurrences, administered for the 
exception type. An exception occurs when the data collection 
activity falls outside of that limit.
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Cross-Reference 1

Use Table 31 to identify how CentreVu CMS stores Agent State (names) and 
the applicable row search values.

Table 31: Agent State and Row Search Values Cross-Reference 

Status 
Database Items State Names

Numerical Values for Row 
Search

AG_DEST PBX
OFF

1
2

AG_DIR OUT
IN

1
2

AG_ORIG BLANK
PHONE
KEYBOARD

0
1
2

AG_PREF LVL
NEED

1
2

ALL_BUSY YES
NO

1
0

PER_CHG YES
NO

1
0

SLVL_CHG YES
NO

1
0

831.bk : A_Database_Items_and_Calculations.fm  Page 189  Wednesday, November 27, 1996  1:46 P



A-190 Agent State and Row Search Values Cross-Reference

Appendix A - Database Items and Calculations

TKSTATE UNKNOWN
IDLE
SEIZED
QUEUED
CONN
DABN
MBUSY
FBUSY
FDISC
HOLD
RING

0
1
2
3
4
5
6
7
8
9
80

TK_DIR IN
OUT

2
1

TK_PRI YES
NO

1
0

TK_QTYPE MAIN
BACKUP

1
2

WORKMODE UNKNOWN
UNSTAF
AVAIL
ACD
ACW
AUX
DACD
DACW
OTHER
RING
LOGON
LOGOFF
TRACE ON
TRACE OFF

0
10
20
30
40
50
60
70
220
80
100
110
120
121

Table 31: Agent State and Row Search Values Cross-Reference  (Contd)

Status 
Database Items State Names

Numerical Values for Row 
Search
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di

x 
ACall Disposition and Row Search Values 

Cross-Reference 1

Use Table 32 to identify how CentreVu CMS stores Call Disposition and the 
applicable row search values.

Table 32: Call Disposition and Row Search Values Cross-Reference

Status 
Database Items

State Names
Numerical Values for Row 
Search

DISPOSITION CONN
ANS
ABAN
IFLOW
FBUSY
FDISC
OTHER

1
2
3
4
5
6
7
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Standard Dictionary Calculations 1

Table 33 lists all of the standard CentreVu CMS Dictionary calculations. 
These calculations are used in real-time and historical reports. You can also 
use them in custom reports. 

Caution Do NOT modify any of the standard CentreVu CMS Dictionary 
calculations. If you modify the standard calculations the meaning 
of the data will be changed.

Table 33: Standard Dictionary Calculations 

Calculation Name Calculation Description

AGENTS_ON_EXT_CALLS (ONACWIN + ONAUXIN 
+ ONACWOUT 
+ONAUXOUT)

Agents on extension calls

AVG_ABANDON_TIME ABNTIME / ABNCALLS Average time to abandon

AVG_ABANDON_TIME_SU
M

sum(ABNTIME) / 
sum(ABNCALLS)

Total average abandon 
time

AVG_ACD_TALK_TIME ACDTIME / ACDCALLS Average ACD talk time

AVG_ACD_TALK_TIM_SUM (sum(ACDTIME) / 
sum(ACDCALLS)

Total average ACD talk 
time

AVG_ACW_TIME ACWTIME / ACDCALLS Average ACW time

AVG_ACW_TIME_SUM sum(ACWTIME) / 
sum(ACDCALLS)

Total average ACW time

AVG_AGENT_ACW_SUM sum(TOTAL_ACWTIME) / 
sum(TOTAL_ACDCALLS)

Total average agent ACW 
time

AVG_AGENT_ACW_TIME TOTAL_ACWTIME / 
TOTAL_ACDCALLS

Average ACW time
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x 
A

AVG_AGENT_TALK_SUM sum(TOTAL_ACDTIME) / 
sum(TOTAL_ACDCALLS)

Total average agent ACD 
talk time

AVG_AGENT_TALK_TIME TOTAL_ACDTIME / 
TOTAL_ACDCALLS

Average agent ACD talk 
time

AVG_ANSWER_SPEED ANSTIME / ACDCALLS Average speed of answer

AVG_ANSWER_SPEED_SUM sum(ANSTIME) / 
sum(ACDCALLS)

Total average answer 
speed

AVG_CONNECT_TIME CONNECTTIME / 
CONNECTCALLS

Average amount of time 
for call to connect to agent

AVG_CONNECT_TIME_SUM sum(CONNECTTIME) / 
sum(CONNECTCALLS)

Total average amount of 
time for call to connect to 
agent

AVG_HOLD_TIME HOLDTIME / 
HOLDCALLS

Average hold time

AVG_HOLD_TIME_SUM sum(HOLDTIME) / 
sum(HOLDCALLS)

Total average hold time

AVG_INB_ACD_TIME_SUM (sum(TOTAL_ACDTINE-
O_ACDTIME)) / 
INBOUND_ACDCALLS

Average inbound ACD 
time

AVG_INB_ACW_TIME_SUM (sum(TOTAL_ACWTIME-
O_ACWTIME))/
 INBOUND_ACDCALLS

Average inbound ACW 
time

AVG_OUTB_ACD_SUM sum(O_ACDTIME) / 
sum(O_ACDCALLS)

Total outbound average 
ACD talk time

AVG_OUTB_ACD_TIME O_ACDTIME / 
O_ACDCALLS

Outbound average ACD 
talk time

AVG_OUTB_ACW_SUM sum(O_ACWTIME) / 
sum(O_ACDCALLS)

Total outbound average 
ACW talk time

Table 33: Standard Dictionary Calculations  (Contd)

Calculation Name Calculation Description
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AVG_OUTB_ACW_TIME O_ACWTIME / 
O_ACDCALLS

Outbound average ACW 
talk time

AVG_POS_STAFF I_STAFFTIME / (INTRVL * 
60)

Average positions staffed

AVG_POS_STAFF_SUM sum(I_STAFFTIME) / 
sum(INTRVL * 60)

Average positions staffed 
total

AVG_TALK_TIME_IN (ACWINTIME + 
AUXINTIME) / 
(ACWINCALLS + 
AUXINCALLS)

Extension in calls average 
talk time

AVG_TALK_TIME_IN_SUM sum(ACWINTIME + 
AUXINTIME) / 
sum(ACWINCALLS + 
AUXINCALLS)

Extension in calls total 
average talk time

AVG_TALK_TIME_OUT (ACWOUTTIME + 
AUXOUTTIME) / 
(ACWOUTCALLS + 
AUXOUTCALLS)

Extension out calls 
average talk time

AVG_TALK_TIM_OUT_SUM sum(ACWOUTTIME + 
AUXOUTTIME) / 
sum(ACWOUTCALLS + 
AUXOUTCALLS)

Extension out calls total 
average talk time

AVG_TOP_STAFF sum(TOTAL_I_ACDACW+
TOTAL_I_ACDHOLD+TO
P_AVAUXTIME)/(INTRVL
*60)

Calculates average 
positions staffed for EAS, 
making use of the top 
agent concept to avoid 
double-counting agents’ 
time when they are staffed 
in multiple skills.

Table 33: Standard Dictionary Calculations  (Contd)

Calculation Name Calculation Description
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AVG_TOP_STAFF_SUM sum(TOT_I_ACDACW_SU
M+TOT_I_ACDHOLD_SU
M+TOP_AVAUXTIME_SU
M)/sum(INTRVL*60)

Calculates average 
positions staffed for EAS, 
summed over all records 
found in the search, 
making use of the top 
agent concept to avoid 
double-counting agents’ 
time when they are staffed 
in multiple skills.

AVG_TRK_HOLD_IN_SUM sum(INTIME) / 
sum(INCALLS)

Inbound total average 
trunk holding time

AVG_TRK_HOLD_OUT_SUM sum(OUTTIME) / 
sum(OUTCALLS)

Outbound total average 
trunk holding time

AVG_TRK_HOLD_TIME (INTIME + OUTTIME) / 
(INCALLS + OUTCALLS)

Average trunk holding 
time

AVG_TRK_HOLD_TIME_IN INTIME / INCALLS Inbound average trunk 
holding time

AVG_TRK_HOLD_TIM_OUT OUTTIME / OUTCALLS Outbound average trunk 
holding time

AVG_VDN_TIME (INTIME / INCALLS) Average VDN time

AVG_VDN_TIME_SUM sum(INTIME) / 
sum(INCALLS)

Average time in VDN 
total

AVG_VEC_TIME INTIME / INCALLS Average vector time

AVG_VEC_TIME_SUM sum(INTIME) / 
sum(INCALLS)

Average vector time total

BUSY_DISCONNECT (BUSYCALLS + 
DISCCALLS)

Number of calls that were 
busy and disconnected

CALLS_PER_POS (60 * INTRVL * 
ACDCALLS) / 
I_STAFFTIME)

Calls per position

Table 33: Standard Dictionary Calculations  (Contd)

Calculation Name Calculation Description
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CALLS_PER_POS_SUM (sum(60 * INTRVL) * 
sum(ACDCALLS))/ 
sum(I_STAFFTIME

Calls per position total

EXT_CALL_IN (ACWINCALLS + 
AUXINCALLS)

Incoming extension calls

EXT_CALL_OUT (ACWOUTCALLS + 
AUXOUTCALLS)

Outgoing extension calls

EXT_IN_TIME (I_ACWINTIME + 
I_AUXINTIME)

Time on incoming 
extension calls

EXT_OUT_TIME (I_ACWOUTTIME + 
I_AUXOUTTIME)

Time on outgoing 
extension calls

INBOUND_ACDCALLS (sum (TOTAL_ACDCALLS 
- O_ACDCALLS))

Total inbound ACD calls

INT_AUXTIME I_STAFFTIME - 
I_AVAILTIME - I 
I_ACDTIME - I_ACWTIME 
-I_OTHERTIME - 
I_RINGTIME - I 
I_DA_ACDTIME - 
I_DA_ACWTIME

Total AUX time

PERCENT_ACD_TIME 100 * ((I_ACDTIME + 
I_ACWTIME) / 
I_STAFFTIME)

Percent ACD time

PERCENT_ACD_TIME_SUM 100 * (sum(I_ACDTIME + 
I_ACWTIME) / 
sum(I_STAFFTIME))

Percent ACD time total

PERCENT_ALL_BUSY 100 * (ALLINUSETIME / 
SECS_PER_DAY)

Percentage of time all 
trunks in use

PERCENT_ALL_BUSY_D 100 * (ALLINUSETIME / 
d_secs.SECSPERDAY)

Percentage of time all 
trunks in use in the day

Table 33: Standard Dictionary Calculations  (Contd)

Calculation Name Calculation Description
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PERCENT_ALL_BUSY_M 100 * (ALLINUSETIME /
m_secs.SECSPERMN)

Percentage of time all 
trunks in use in the month

PERCENT_ALL_BUSY_W 100 * (ALLINUSETIME /
w_secs.SECSPERWK)

Percentage of time all 
trunks in use in the week

PERCENT_ALL_BUSY_SUM 100 * 
(sum(ALLINUSETIME) / 
sum(SECS_PER_DAY))

Percentage of time all 
trunks in use

PERCENT_AL_BSY_SUM_D 100 * 
(sum(ALLINUSETIME) / 
sum(d_secs.SECSPERDAY))

Percentage of time all 
trunks in use in the day

PERCENT_AL_BSY_SUM_M 100 * 
(sum(ALLINUSETIME) / 
sum(m_secs.SECSPERMN))

Percentage of time all 
trunks in use in the month

PERCENT_AL_BSY_SUM_W 100 * 
(sum(ALLINUSETIME) / 
sum(w_secs.SECSPERWK))

Percentage of time all 
trunks in use in the week

PERCENT_AUX_WORK 100 * (I_AUXTIME / 
I_STAFFTIME)

Percent AUX time

PERCENT_AUX_WORK_SUM 100 * (sum(I_AUXTIME) / 
sum(I_STAFFTIME))

Total percent AUX time

PERCENT_CALL_ABAN 100 * (ABNCALLS / 
(CALLSOFFERED))

Percentage of calls 
abandoned

PERCENT_CALL_ANS 100 * (ACDCALLS / 
CALLSOFFERED)

Percentage of calls 
offered that were 
answered

PERCENT_CALL_ANS_SUM 100 * (sum(ACDCALLS) / 
sum(CALLSOFFERED))

Total percent of calls 
offered that were 
answered

Table 33: Standard Dictionary Calculations  (Contd)

Calculation Name Calculation Description
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PERCENT_MBUSY 100 * (MBUSYTIME / 
(SECS_PER_DAY * 
TRUNKS))

Percent of time all trunks 
in use

PERCENT_MBUSY_D 100 * (MBUSYTIME / 
(d_secs.SECSPERDAY * 
TRUNKS))

Percent of time all trunks 
busied-out in the day

PERCENT_MBUSY_M 100 * (MBUSYTIME / 
(m_secs.SECSPERMN * 
TRUNKS))

Percent of time all trunks 
busied-out in the month

PERCENT_MBUSY_W 100 * (MBUSYTIME / 
(w_secs.SECSPERWK * 
TRUNKS))

Percent of time all trunks 
busied-out in the week

PERCENT_MBUSY_SUM_D 100 * (sum(MBUSYTIME) / 
(avg(d_secs.SECSPERDAY) 
* sum(TRUNKS)))

Percent of time all trunks 
busied-out in the day

PERCENT_MBUSY_SUM_M 100 * (sum(MBUSYTIME) / 
(avg(m_secs.SECSPERMN) 
* sum(TRUNKS)))

Percent of time all trunks 
busied-out in the month

PERCENT_MBUSY_SUM_W 100 * (sum(MBUSYTIME) / 
(avg(w_secs.SECSPERWK) 
* TRUNKS))

Percent of time all trunks 
busied-out in the week

PERCENT_MBUSY_SUM 100 * (sum(MBUSYTIME) / 
(avg(SECS_PER_DAY) * 
sum(TRUNKS)))

Percent time all trunks in 
use

PERCENT_SERV_LVL_SPL 100 * (ACCEPTABLE / 
CALLSOFFERED)

Percent of calls answered 
in service level for split

PERCENT_SERV_LVL_VDN 100 * (sum(ACCEPTABLE) 
/ sum(INCALLS))

Percent of calls answered 
within service level for 
VDN

PERCENT_SLVL_SPL_SUM 100 * (sum(ACCEPTABLE) * 
sum (CALLSOFFERED) )

Percent of total split calls 
answered in service level

Table 33: Standard Dictionary Calculations  (Contd)

Calculation Name Calculation Description
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PERCENT_VDN_ABAN 100 * (sum(ABNCALLS) / 
sum(INCALLS))

Percent of calls 
abandoned

PERCENT_VDN_ANSCONN 100 * (sum(ACDCALLS + 
CONNECTCALLS) / 
sum(INCALLS))

Percent of calls answered 
in service level

SECS_PER_DAY (24 * 60 * 60) Seconds per day

TOP_AVAUXTIME sum 
(I_TAUXTIME+I_TAVAILTI
ME)

Subcalculation that 
supports the new 
AVG_TOP_STAFF 
calculation. Sums the time 
top agents spent in AUX 
work and available.

TOP_AVAUXTIME_SUM sum 
(I_TAUXTIME+I_TAVAILTI
ME)

Subcalculation that 
supports the new 
AVG_TOP_STAFF_SUM 
calculation. Sums the time 
top agents spent in AUX 
work and available.

TOT_I_ACDACW_SUM sum(I_ACDTIME+I_ACWT
IME+I_DA_ACDTIME+I_D
A_ACWTIME+I_RINGTIM
E)

Subcalculation that 
supports the new 
AVG_TOP_STAFF_SUM 
calculation. Sums the 
ACD and ACW time for 
split/skill and direct 
agent calls, plus the 
(agent) ringing time for 
those calls.

TOT_I_ACDHOLD_SUM sum(I_ACDOTHERTIME+I
_ACDAUXTIME+I_ACDA
UX_OUTTIME)

Subcalculation that 
supports the new 
AVG_TOP_STAFF_SUM 
calculation. Sums the time 
agents spent with ACD 
calls on hold.

Table 33: Standard Dictionary Calculations  (Contd)

Calculation Name Calculation Description
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TOTAL_I_ACDACW sum (I_ACDTIME + 
I_ACWTIME 
+I_DA_ACDTIME+I_DA_
ACWTIME+II_RINGTIME)

Subcalculation that 
supports the new 
AVG_TOP_STAFF 
calculation. Sums the 
ACD and ACW time for 
split/skill and direct 
agent calls, plus the 
(agent) ringing time for 
those calls.

TOTAL_ACDCALLS (ACDCALLS + 
DA_ACDCALLS)

Total ACD calls

TOTAL_I_ACDHOLD sum (I_ACDOTHERTIME+ 
I_ACDAUXINTIME+I_AC
DAUX_OUTITME)

Subcalculation that 
supports the new 
AVG_TOP_STAFF 
calculation. Sums the time 
agents spent with ACD 
calls on hold.

TOTAL_ACDTIME (ACDTIME + 
DA_ACDTIME)

Total ACD time

TOTAL_ACWTIME (ACWTIME + 
DA_ACWTIME)

Total ACW time

TOTAL_I_ACDTIME (I_ACDTIME + 
I_DA_ACDTIME)

Total interval-based ACD 
time

TOTAL_I_ACWTIME (I_ACWTIME + 
I_DA_ACWTIME)

Total interval-based 
ACW time

Table 33: Standard Dictionary Calculations  (Contd)

Calculation Name Calculation Description
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